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Introduction

This book examines Fedora Linux 28 for the user. Though administrative tools are covered,
the emphasis is on what a user would need to know to perform tasks. The focus here is on
what users face when using Fedora, covering topics like installation, applications, software
management, the GNOME and Plasma (KDE) desktops, additional desktops such as
Cinnamon and Mate, shell commands, and both the Fedora administration and network
tools. Desktops are examined in detail, including configuration options. Applications
examined include Office Suites, editors, ebook readers, music and video applications and
codecs, email clients, Web and FTP browsers, and VoIP and IM applications. This book is
designed for the Fedora 28 desktop, with all the latest features of interest to users.

Part I focuses on getting started, covering Fedora information and resources, Fedora
Live DVDs, Live USBs, installing and setting up Fedora, and basic use of the desktop
as well as device access. The GNOME settings configuration tools such as power,
background, screen, network, and display are examined. Also covered is software
management using GNOME software, packages, DnfDragora, and the dnf command,
along with repositories and their uses, including the RPM Fusion repository.

Part IT keys in on applications such as office, mail, graphics, multimedia, Web,

FTP, VoIP, IM, and social networking applications. This part includes coverage of the
PulseAudio sound interface and music and video applications.

Part III covers the two major desktops—GNOME and Plasma (KDE)—discussing the
new GNOME 3 features, including the activities overviews, the dash, and the top bar.
Unique Plasma features like the dashboard and activities are also explored. In addition,
the shell interface is examined, including features like history, filename completion,
directory and file operations, among others. Additional desktops are also discussed,
including XFCE, LXDE, Mate, LXQT, Sugar (SoaS), and Cinnamon.

Part IV deals with administration topics, first discussing system tools like the GNOME
system monitor, the Disk Usage Analyzer, the Disk Utility storage manager, temperature
monitors, and the SELinux configuration dialog. Then there is a detailed chapter on Fedora
system administration tools, like those for managing users, authorization controls, and
Bluetooth, along with service management, file system access, and printer configuration.
The network configuration chapter covers a variety of network tasks, including
configuration of wired and wireless connections, firewalls, and Samba Windows access.
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CHAPTER 1

Fedora 28 Introduction

The Fedora release of Linux is maintained and developed by an open source project
called the Fedora Project (https://fedoraproject.org). The release consists entirely
of open source software. Development is carried out using contributions from Linux
developers. The project is designed to work much like other open source projects, with
releases keeping pace with the course of rapid online development. The Fedora Project
features detailed documentation of certain topics, such as installation and desktop user

guides, at https://docs.fedoraproject.org (see Table 1-1).

Table 1-1. Fedora Sites

Website

Description

https://fedoraproject.org
https://download.fedoraproject.org

https://docs.fedoraproject.org/f28/
install-guide/index.html

https://docs.fedoraproject.org/f28/
release-notes/index.html

https://docs.fedoraproject.org/
fedora-project/project/fedora-
overview.html

https://fedoraproject.org/wiki/FAQ
https://docs.fedoraproject.org

https://ask.fedoraproject.org/en/
questions/

Fedora resources
Fedora repository site, mirror link

Fedora installation guide

Fedora release notes

Fedora project overview

Fedora FAQ

Documentation and support tutorials for Fedora
releases

Ask Fedora site where you can submit question
and see answers popular questions

© Richard Petersen 2018
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Table 1-1. (continued)

Website Description
https://fedoramagazine.org/ Fedora Magazine with articles on latest
developments and projects
https://getfedora.org/ Fedora download page
https://alt.fedoraproject.org/ Fedora download page for alternative download
methods
https://admin.fedoraproject.org/ Fedora mirrors list
mirrormanager/
https://fedoraforum.org User discussion support forum, endorsed by the
Fedora Project; includes FAQs and news links
https://www.linuxfoundation.org/ The Linux Foundation, official Linux development
https://www.kernel.org/ Latest Linux kernels
https://www.redhat.com/ The Red Hat website
https://www.centos.org/ Community Enterprise Operating System CENTOS

(Red Hat—based)

This chapter covers the information about the Fedora release, where to obtain
information on it, and what versions are available for download. You can also
download and try out the Fedora release on a Live Workstation DVD or USB drive
without installing it.

Fedora Documentation

Documentation for Fedora can be found at https://docs.fedoraproject.org (see
Table 1-1). The Fedora Installation Guide provides a detailed description of all install
procedures. The Fedora System Administration Guide covers basic system configuration
and package management, as well as advanced topics such as server and system
monitoring. Several dedicated Fedora support sites are available that provide helpful
information, including https://fedoratorum.org, https://ask.fedoraproject.org/
en/questions/, and https://fedoraproject.org. The https://fedoratorum.org site
is a Fedora Project-sponsored forum for end-user support. Here you can post questions
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and check responses for common problems. The Ask Fedora site lets you ask a question
and view the responses to other user's questions. Questions are ranked by views, number
of answers, and votes.

Your Firefox browser will already be configured with the Fedora start page at
https://start.fedoraproject.org. There are buttons at the top of the page for
Fedora Documentation, Help for Fedora Users, and Get Fedora. The Help for Fedora
Users button opens the Ask Fedora site where you can ask questions; see
https://ask.fedoraproject.org/en/questions/. The Firefox browser is also
configured with bookmarks for accessing popular Fedora documentation and support
sites. There are bookmarks for Fedora Project, Fedora Forum, Fedora Magazine, Fedora
Docs, Planet Fedora, and Join Fedora. Check the Bookmarks sidebar's Fedora Project,
User Communities, and Red Hat folders. The Red Hat folder displays entries for Red Hat,
jBoss, OpenSource.com, and The Open Source Way (you may have to set the bookmarks
sidebar to display it; choose Bookmarks » Bookmarking Tools » View Bookmarks
Sidebar).

Fedora maintains detailed specialized documentation, such as information on
understanding how udev is implemented or how SELinux is configured. For much
of the documentation you must rely on installed documentation in /usr/share/
doc or on the man and info pages, as well as the context help button for different
applications running on your desktop. Websites for software such as GNOME, KDE,
and LibreOffice.org provide extensive applicable documentation. For installation,
you can use the Fedora installation guide at https://docs.fedoraproject.org/f28/
install-guide/index.html.

Fedora 28

The Fedora versions of Linux are entirely free. You can download the most current
version from https://getfedora.org/ or https://download.fedoraproject.org. The
https://download.fedoraproject.org address will link to the best available mirror
for you. You can update Fedora using the GNOME Software's Updates tab to access the
Fedora repository. Access is automatically configured during installation.

The Fedora distribution is also available online at numerous FTP sites. Fedora
maintains download sites at https://download.fedoraproject.org, along with a
mirror listing at https://mirrors.fedoraproject.org, where you can download the
entire current release of Fedora Linux, as well as updates and additional software.
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Fedora 28 Features

Fedora releases feature key updates to critical applications as well as new tools. The
following information is derived for the official Fedora release notes. Consult these
notes for detailed information about all new changes. You can find the release notes at
https://docs.fedoraproject.org/f28/release-notes/index.html. A list of changes
is available at https://fedoraproject.org/wiki/Releases/28/ChangeSet. Some of the
more prominent features of the Fedora Workstation are listed here.

Fedora provides the Mate and Cinnamon desktops. Mate is a
traditional desktop based on GNOME 2, and Cinnamon is the
Mint Linux desktop derived from GNOME 3, but with many
traditional features, such as the panel and applets.

GNOME Software has replaced PackageKit as the primary
frontend software management application, (gnome-software).
The DnfDragora software manager has replaced the older Yumex
software manager.

The System Status Area is combined into one menu showing
sound volume, brightness, network connections, the current user,
battery power, and buttons for settings, lock screen, and power off.
The Switch User item is only shown if more than one user is set up
for the system. Sound volume and screen brightness (laptops) are
adjusted using sliders on the System Status Area menu.

For systems with wireless devices, there is a WiFi entry in the
System Status Area menu that expands to a menu with options
to select a network, turn off the wireless device, and to open the
GNOME Network system setting dialog at the WiFi tab (WiFi
Settings).

GNOME windows and workspaces can be displayed easily and
accessed quickly from the overview.

A search box at the top of the overview allows you to search
directly for applications, installed and uninstalled. Uninstalled
entries open GNOME Software to let you install the application.
Search is also configured to search for files, GNOME Contacts,


https://docs.fedoraproject.org/f28/release-notes/index.html
https://fedoraproject.org/wiki/Releases/28/ChangeSet
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Documents, and Keys, as well as to conduct a web search. Use the
GNOME Settings Search dialog to select the applications that can
be searched. You can also add other applications.

The GNOME Tweak Tool lets you perform common desktop
configurations, such as placing your home folder on the desktop,
changing the theme for icons and windows, changing and
adjusting fonts, choosing startup applications, configuring how
the date is displayed on the top bar, and setting up static (fixed
number) workspaces.

Though GNOME workspaces are generated automatically
(dynamic) from the overview, you can also use the GNOME Tweak
Tool to set up static (fixed-number) workspaces instead.

The GNOME overview features a dash (Activities) that lists icons
for your favorite applications and opened applications, letting you
access them quickly. You can add applications to the dash. An
Applications icon on the dash opens the applications overview.

A search box at the top lets you search for applications and files.

A Frequent button at the bottom lets you display only frequently
accessed applications. A pager to the right lets you move through
the icons by page.

In the GNOME-shell, notifications are displayed in the message
tray at the top of the screen next to the calendar. Use the Super+m
key to display it (Windows key+m), or click the date button at the
center top of the screen.

On all GNOME windows, the toolbar and the title bar have been
combined into a header bar, with a single close box on the right side.

The GNOME Files file manager (Nautilus) features a sidebar. You
can quickly access any file system on removalbel devices, remote
networks, and internal drives, as well as your home folders.

The GNOME Classic desktop lets you use a GNOME 2-like
interface, but still operating on the same Fedora Workstation
GNOME 3 desktop.
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Fedora ISO Images

Fedora disks are released as a set of spins that collect software for different purposes.
Currently, there are two major Fedora distribution spins available: the Fedora
Workstation Live spin (GNOME Desktop) and the Fedora Server Live spin. The Fedora
Server Live spin includes a collection of server software, but not the entire collection. It
installs only the command-line interface. Spins are created with Revisor, which you can
use to develop your own customized spins.

Fedora Live Workstation ISO: The Fedora Workstation Live ISO,
include GNOME desktop and applications.

Fedora Server ISO: The Fedora Server Live ISO, designed for
network servers. Installs only a command-line interface.

Fedora Custom Spins

Custom spins are also available and can be downloaded from https://spins.
fedoraproject.org and https://fedoralabs.org. The official spins are listed at
https://fedoraproject.org/wiki/Releases/28/Spins.

Fedora Spins:

Fedora 28 Plasma Spin: Available for i686 and x86_64; includes
Plasma desktop (KDE).

Fedora 28 XFCE Spin: Features the XFCE desktop instead of
GNOME.

Fedora 28 LXDE Spin: Features the lightweight LXDE desktop
instead of GNOME.

Fedora 28 LXQT Spin: Features the lightweight LXDE desktop
based on the Qt libraries.

Fedora Mate-Compiz Desktop Spin: The Mate Desktop
Environment. Mate is an updated version of the GNOME 2
interface.

Fedora Cinnamon Desktop Spin: The Cinnamon Desktop
Environment. Cinnamon is an original desktop developed by
Linux Mint.


https://spins.fedoraproject.org
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Fedora Soa$S Desktop Spin: Sugar on a Stick spin for USB drives
featuring the Sugar desktop (OLPC).

Fedora Labs Spins:
Fedora Astronomy Spin: Astronomy applications and tools.
Fedora Games Spin: Games available on Fedora.
Fedora Design Suite: Image applications available on Fedora.

Fedora Security Lab Spin: Fedora Security Lab spin, a safe
environment for security testing and recovering a system.

Fedora Robotics Spin: Robotic simulation environment.
Fedora Science Spin: Scientific research.
Fedora Jam: Audio and music applications and tools.

Fedora Python Classroom: Python instruction tools.

Multimedia

Although licensed multimedia formats such as DVD are still excluded, open source formats
are all included, including Vorbis, Ogg, Theora, and FLAC. Multimedia codecs with licensing
issues can be directly downloaded with PackageKit, once you have configured DNF to use
the RPM Fusion (https://rpmfusion.org) or Negativol7.org (https://negativel7.org)
repositories on your system. Use one or the other, not both. These repositories are not
configured by default. For the RPM Fusion repository, install the https://rpmfusion.org
configuration package for Fedora 28, which is available from that site.

Fedora Workstation Live IS0

The Fedora Workstation Live ISO lets you run Fedora on any computer using a DVD-
ROM drive or a USB drive. The ISO image can be installed to either a DVD disc or a USB
drive. You can save files to removable devices such as USB drives. You can temporarily
install software, but the install disappears when you shut down. You can also mount
partitions from hard drives on the system you are running the Workstation Live DVD

or USB on. Find out more about Live discs at https://fedoraproject.org/wiki/
FedoraliveCD.
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The Workstation Live ISO provided by Fedora includes a limited set of software
packages. Servers are not included. For desktop support, you use GNOME. Other than
these limitations, you have a fully operational Fedora desktop. The Workstation Live
ISO enables Network Manager by default, automatically detecting and configuring your
network connection. You have the full set of administrative tools, with which you can
add users and change configuration settings while the Workstation Live ISO is running.
When you shut down, the configuration information is lost.

You can log out, but this will display a login screen with a simple login dialog for
automatic login and a language menu. The bottom panel of the login screen has menus
for setting the language and keyboard. You can shut down or restart from the shutdown
menu on the right side of the panel.

When you first boot, you can press the spacebar to display the boot options. These
include booting up the Workstation Live ISO directly (the default), booting with basic
video, verifying the disk media first, performing a memory test, or booting to another
OS already on your hard disk. If you press nothing, the Workstation Live ISO starts up
automatically. After your system starts up, you will be presented with the standard login
screen for the live user. Click for user login. The GNOME desktop (see Figure 1-1) will
then start up.

Activities [ Files =

@ Recent
% Stared

Desktop Documents
[ Documents
& Downloads [ =
dd Music

63 Fictures

- Videos

4 Trash

+ Other Locations Templates

Figure 1-1. Fedora Workstation Live ISO (run from a DVD disc or USB drive)
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Click the Activities button on the upper-left corner to enter the overview mode,
where you can access windows, search for applications and files, and open applications
(Applications icon on the dash, a favorites sidebar). From the dash, you can quickly open
applications (see Figure 1-2). The dash contains, as its last icon, an Install to Hard Drive
icon, which you can use to install Fedora on your hard drive.

Fri 12:50

@

fedorc® |

& Fedora © Help for Fedora & GetFedora
Documentation Users
atest rews from Fedara Magazine

-

Figure 1-2. Fedora Workstation Live DVD overview mode (Activities button)

An easy way to save data from a Live session is to use a USB drive. On GNOME, the
USB drive will appear as an entry on a file manager window sidebar. Double-click it to
open a file manager window for the USB drive. You can then copy files generated during
the session to the USB drive. Remember to eject the drive before removing it (click the
eject button next to the USB drive entry on the file manager sidebar).

Installing Fedora from a Workstation Live ISO

The Workstation Live DVD can also be used as an installation disk, providing its limited
collection of software on a system, that can be expanded and updated from Fedora
online repositories (see Chapter 2). Later, you add packages from repositories. Double-
click the Install to Hard Drive icon on the overview dash to start the installation (see
Figure 2-4 in Chapter 2).
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USB Live Drive

You can install a Fedora Workstation Live ISO image (or any Fedora spin) to a USB drive
instead of a DVD disc. The procedure is not destructive. Your original data on the USB
disk is preserved. To create a Live USB drive, you can either use the Fedora Media Writer
application (mediawriter package), or the livecd-iso-to-disk command (livecd-
iso-to-mediums package). A tutorial on using these tools to create USB Live drives is
available at https://docs.fedoraproject.org/quick-docs/en-US/creating-and-
using-a-live-installation-image.html.

Fedora Media Writer (mediawriter)

The mediawriter application is a GNOME application with an easy-to-use interface for
creating a Live USB image from a Live Workstation DVD ISO image file. It is a cross-
platform application with versions for Linux, Windows, and the Mac. You can download
it from https://getfedora.org/en/workstation/download/. On this page you see a
download button for the Fedora Media Writer. The version downloaded depends on
what kind of system you are using to access the page. On Fedora Linux, once installed,
you can start Fedora Media Writer from the applications overview to open the Fedora
Media Writer window. Click Custom Image to open an ISO image you have downloaded.
Check the Fedora Installation Guide » Preparing for Installation for a detailed tutorial
on using the Fedora Media Writer.

https://docs.fedoraproject.org/f28/install-guide/install/Preparing_
for Installation.html

livecd-iso-to-disk

You can also install Fedora Live images to a USB disk using the 1ivecd-iso-to-disk
command to install the image (part of the 1ivecd-iso-to-mediums package). This is
a command-line tool that you enter in a terminal window. Use the Live image and the
device name of the USB disk as your arguments.

/usr/bin/livecd-iso-to-disk Fedora-Workstation-Live-x86 64-28.1.1.iso
/dev/sdb1

Each Live Workstation DVD also provides a 1ivecd-iso-to-disk script in its LiveOS
directory.
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Live USB Persistence Storage

If you want to make changes to the Fedora OS on the USB Live version, set up an overlay
memory segment on the USB drive. To do this, use the --overlay-size-mb option

with the size of the overlay in megabytes. Be sure your USB drive is large enough to
accommodate both the overlay memory and the DVD image. The following allows for
512MB of persistent data that will be encrypted:

livecd-iso-to-disk --overlay-size-mb 512 Fedora-Workstation-Live-x86 64-
28.1.1.1is0 /dev/sbd1

Persistent Home Directory

If you want to save data to a /home directory on the USB Live version, set up a home
directory memory segment. To do this, use the --home-size-mb option with the size of
the home directory segment in megabytes. Be sure your USB drive is large enough to
accommodate the home memory and the DVD image, as well as a memory overlay, if
you also want to enable changes to the operating system. Your /home directory memory
segment will be encrypted by default, to protect your data in case it is lost or stolen.
Upon creating your overlay, you will be prompted for a passphrase. Whenever you boot
up your USB system, you will be prompted for the passphrase. The following allows for a
1024MB /home directory that will be encrypted:

livecd-iso-to-disk --home-size-mb 1024 Fedora-Workstation-Live-x86 64-
28.1.1.is0 /dev/sbd1

If you do not want the data encrypted, add the --unencrypted-home option when
creating the disk.

Combining the overlay and the /home memory would require a command such as
the following. In all, about 3GB of disk space would be required.

livecd-iso-to-disk --overlay-size-mb 512 --home-size-mb 1024 Fedora-
Workstation-Live-x86_64-28.1.1.iso /dev/sbd
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Fedora Logo

The Fedora logo depicts an fencased in a blue circle (see Figure 1-3). The logo is
designed to represent three features of the Linux community and development:
freedom, communication, and infinite possibilities. The fstands for “freedom,” which
melds into the infinity symbol, both encased in a speech bubble evoking communication
(voice). The logo, then, represents free and open software with infinite possibilities
developed through global communication. The idea is to evoke the spirit and purpose

of Linux development as one of infinite freedom given a voice. The logo incorporates

the four basic ideals of Fedora: open, free, innovative, and forward vision. See https://
fedoraproject.org/wiki/Logo for more details.

Figure 1-3. Fedora logo

Linux

Linux is a fast, stable, and open source operating system that features development tools,
desktops, and a large number of applications, ranging from office suites to multimedia
applications. Linux was developed in the early 1990s by Linus Torvalds, along with other
programmers around the world. Technically, Linux consists of the operating system
program, referred to as the kernel, which is the part originally developed by Torvalds.
But it has always been distributed with a large number of software applications. Linux
has evolved as part of the open source software movement. Currently, hundreds of open
source applications are available for Linux from the Fedora software repository and the
Fedora-compliant third-party repositories such as RPM Fusion (https://rpmfusion.org).
Most of the GNOME and KDE applications are incorporated into the Fedora repository,
using software packages that are Fedora-compliant. You should always check the Fedora
repository first for the software you want.
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Linux is distributed freely under a GNU General Public License, as specified by the
Free Software Foundation, making it available to anyone who wants to use it. GNU (the
acronym stands for “GNU’s Not UNIX”) is a project initiated and managed by the Free
Software Foundation to provide free software to users, programmers, and developers.
Linux is copyrighted, not public domain. However, a GNU public license has much the
same effect as the software being in the public domain. The GNU General Public License
is designed to ensure that Linux remains free and, at the same time, standardized.

Open Source Software

Most Linux software is developed as open source software. This means that the source
code for an application is distributed free with the application. Programmers can make
their own contributions to a software package’s development, modifying and correcting
the source code. Linux is an open source operating system. Its source code is included
in all its distributions and is freely available. Much of the software provided for Linux is
also open source projects, as are the KDE and GNOME desktops, along with most of their
applications. The LibreOffice office suite is an open source project. You can find more
information about the open source movement at https://opensource.org/.

Open source software is protected by public licenses. These licenses prevent
commercial companies from taking control of open source software by adding a few
modifications of their own, copyrighting those changes, and selling the software as
their own product. The most popular public license is the GNU General Public License
provided by the Free Software Foundation. This is the license that Linux is distributed
under. The GNU General Public License (GPL) retains the copyright, freely licensing
the software with the requirement that the software and any modifications made to it
always be available for free. Other public licenses have also been created to support the
demands of different kinds of open source projects. The GNU Lesser General Public
License (LGPL) lets commercial applications use GNU licensed software libraries. The
Qt Public License (QPL) lets open source developers use the Qt libraries essential to the
KDE desktop.

Linux is currently copyrighted under a GNU public license provided by the Free
Software Foundation, and it is often referred to as GNU software. GNU software is
distributed free, provided it is distributed to others for free. GNU software has proved
both reliable and effective. Many of the popular Linux utilities, such as C compilers,
shells, and editors, are GNU software applications. Installed with your Linux distribution
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are the GNU C++ and Lisp compilers, Vi and Emacs editors, and BASH and TCSH shells.
In addition, there are many open source software projects that are licensed under the
GNU General Public License. Chapter 4 describes in detail the process of downloading
software applications from online repositories and installing them on your system.

Under the terms of the GNU General Public License, the original author retains the
copyright, although anyone can modify the software and redistribute it, provided the
source code is included, made public, and provided free of charge. Also, no restriction
exists on selling the software or giving it away free. One distributor could charge for the
software, while another could provide it free of charge. Major software companies also
provide Linux versions of their most popular applications. For example, Oracle provides
a Linux version of its Oracle database.

Linux Documentation

The Linux Documentation Project (LDP) developed a complete set of Linux manuals,
available at https://www.tldp.org. The documentation includes a user guide, an
introduction, and administrative guides. These are available in text, PostScript, or web
page format. You can also find briefer explanations, in what are referred to as HOWTO
documents. The Linux documentation for your installed software is available in your
/usr/share/doc directory. As previously noted, some Fedora-specific documentation
is available at https://docs.fedoraproject.org. The https://www.gnome.org site
holds documentation for the GNOME desktop, while https://www.kde.org holds
documentation for the KDE desktop.
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CHAPTER 2

Installation and Upgrade

This chapter describes the installation and upgrade procedures for Fedora Linux 28.
Fedora uses the Anaconda installation program. Designed to be simple and fast, it
installs a core set of applications. A Fedora Linux 28 installation guide is available online.
First check the new Fedora installation guide at https://docs.fedoraproject.org/
t28/install-guide/.

You can also link to this guide from the Fedora download page (right-side links) at
https://getfedora.org/. Scroll to the bottom of the page and under the Support list
click the “Installation Guide” link.

If you are upgrading your system from Fedora 27, check the section for upgrading
at the end of this chapter. There are several methods you can use, including a direct
upgrade from the online repositories. A clean install, if possible, is always recommended
over an upgrade, as conflicts can occur with some software if configuration file formats
and supporting software libraries change too much. You can only upgrade to Fedora 28
from a Fedora 27 install. If you want to upgrade from Fedora 26, you first have to upgrade
to Fedora 27, before you can upgrade to Fedora 28.

Obtaining the DVDs

To obtain the current version of Fedora Linux, go to the Fedora Project download
website at https://getfedora.org. There are large icons for Workstation, Server, and
Atomic (cloud images). Click on the Workstation icon. You can also scroll to the bottom
of the page and, under the Download list, click the Get Fedora Workstation link. On this
same list is the Fedora Spins link, which lets you download alternate spins, such as the
KDE and Mate versions. Also, under the Download list, the Alternative Downloads link
opens the https://alt.fedoraproject.org/ site with other methods for downloading,
such as BitTorrent and Network installers, as well as other architectures such as ARM.
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Fedora Linux 28 is also available on mirror sites. You can directly access a Fedora
mirror site by entering the following URL: https://download.fedoraproject.org.
You then need to navigate to the releases and the version directory (in this case 28)
to find the Workstation directory, and then the architecture (x86_64) and media
(iso) directories to where the Fedora Workstation iso image is kept (releases/28/
x86_46/1s0).

You can also access a specific mirror at the following URL: https://mirrors.
fedoraproject.org/publiclist/. The current Fedora mirror and their addresses are
listed there. The addresses include web and FTP addresses. You can use an FTP client
such as gFTP or Filezilla to perform a direct download.

Basic Install of the Fedora Workstation

Once you download and burn the Fedora Workstation DVD, place it in your DVD drive
and boot your system from it. The system starts up automatically and displays the
following menu (see Figure 2-1). Once the installation program begins, you follow the
instructions, screen by screen. Most of the time, you need only make simple selections.
The installation program progresses through several phases. You perform some basic
configuration, set up Linux partitions on your hard drive, configure your bootloader,
then install the software packages.

Fedora-Workstation-Live 28

Start Fedora-Workstation-Live Z8
Test this media & start Fedora-Workstation-Live 28

Troubleshooting >

Figure 2-1. Install menu
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By default, the first entry, Start Fedora Workstation Live 28, is selected. Press Enter to
start Fedora. Should you need to add options directly to the boot command, press the Tab
key. A command line is displayed on which you can enter the options (see Figure 2-2).
Current options will already be listed. Use the Backspace key to delete and the arrow keys
to move through the line. Press the ESC key to return to the menu.

Fedora-Workstation-Live 28

Start Fedora-bWorkstation-Live 28
Test this media & start Fedora-Workstation-Live 28

Troubleshooting >

> vmlinuz initrd=initrd.img root=1ive:CDLABEL=Fedora-WS-Live-28-1-1 rd.live.im
age quiet_

Figure 2-2. Install menu with boot options

For more startup options and testing, use the arrow key to move to the
Troubleshooting entry. The Troubleshooting menu enables you to use the basic
graphics mode, test the media, test the memory, and boot from a hard drive (see
Figure 2-3). Use the arrow keys to move from one menu entry to the next, then press
Enter to select the entry.
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The first option (Start Fedora Workstation Live 28 in basic graphics mode) starts
up with basic video. The second (Test This Media & Start Fedora Live) will test if your
DVD/CD media is okay. The third (Run a Memory Test) performs a hardware memory
test. The last (Boot from Local Drive) will boot a local OS on a connected hard drive, if
there is one.

Troubleshoot ing

Start Fedora-Workstation-Live 28 in basic graphics mode
Run a memory test

Boot from local drive
Return to main menu <

Try this option out if you’re having trouble starting
Fedora-Workstation-Live 28.

Figure 2-3. Install menu’s Troubleshooting options

When you first start the Live disk, you can choose whether to try Fedora or to install
it (see Figure 2-4). If you want to install Fedora directly on your system, click the Install to
Hard Drive icon to start the standard install procedure (Anaconda).

You can also install Fedora at any time while you are using the Fedora Workstation
Live desktop. On the Activities dash, there is an icon showing the hard disk and Fedora
logo image with the label Install to Hard Drive (see Figure 2-5).
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Activities # Welcome to Fedora > Tue 13:59
-

= Fa P ¥

Welcome to Fedora

Try Fedora Install to Hard Drive

You are currently running Fedora from live media.
You can install Fedora now, or choose “Install to Hard Drive” in the Activities
Overview at any later time.

Figure 2-4. Fedora Install window

©
=
-

fd Install to Hard Drive

Figure 2-5. Fedora Install icon on Fedora Workstation Live dash
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The install steps shown are as follows:
Language: Select your language.

Installation Summary: Configure your installation. The Fedora
Live install has three options: Date & Time, Keyboard, and
Installation Destination. A warning emblem is displayed on
those options that require configuration. Ordinarily, only the
Installation Destination option has a warning emblem. You
cannot continue until all options with warnings are configured.
Network configuration is performed automatically.

Date & Time: Select your city from the map or the pop-up menu
or click the time zone on the map. This option may not have a
warning on it but could still be incorrect. Be sure to check it.

Keyboard: Select and configure your keyboard, if you need to.

Installation Destination: Choose the hard drive to install on and
set up your partitions. You have the option to manage your own.
Once you finish configuring your installation summary items, the
installation begins, showing a progress bar.

When the installation finishes, a simple Quit button will be displayed with a message
to restart, to complete the installation. You can close at this point, to return to the Fedora
Live Desktop, and then restart, to reboot to your installed system.

On reboot, you enter the Fedora Setup Agent procedure, where you can set the date
and time and create a standard user, which you can use to log in as a normal user (not
as root). More users can be created later. After setup, your login screen appears, and you
can log in to your Fedora system.

You may have to update many of the applications installed from the DVD. Open
GNOME Software to the Updates tab to start the update process. Applications and
updates are downloaded from the Fedora repository and installed.

The installation process used on Fedora is a screen-based program that takes you
through all installation steps as one continuous procedure. You can use the mouse or
the keyboard to make selections. When you finish with a screen, click the Continue
button at the bottom to move to the next screen. If you have to move back to the previous
screen, click Back. You can also use Tab, the arrow keys, the spacebar, and Enter to
make selections. You have little to do other than make selections and choose options.
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Some screens provide a list of options from which you make a selection. The installation
process will first install Linux on your system. It will then reboot and start a Setup
process to let you set the time and date and create a user to log in as. The steps for each
part of the procedure are delineated in the following sections.

As each screen appears in the installation, default entries will be selected, usually
by the auto-probing capability of the installation program. Selected entries will appear
highlighted. If these entries are correct, you can simply click Next to accept them and go
on to the next screen.

The install program (Anaconda) will automatically detect and configure your video
card so that it can run a graphical interface for the install procedure. If it has difficulty
configuring the video card, you can choose to use a basic video driver instead, which
means you can still use the graphical install. Choose Install Fedora in Basic Graphics
Mode from the Troubleshooting menu.

Initial Setup

If your basic device and hardware configuration were appropriately detected, a Welcome
screen is displayed, with a Continue button in the lower-right corner. Once you've
completed a step, you click Continue to move on. In some cases, you can click a Back
button to return to a previous step.

Tip Your mouse will be automatically detected. If you have a USB mouse that is
not being detected, try reinserting the USB connector several times. If you cannot
use your mouse for some reason, you can use the Tab key to move to different
components and buttons. Use the arrow keys to select and enter a list. Press the
Enter key to click a selected button or entry. The Tab key will cycle through entries
on a screen sequentially. To return to a button or component, just continue to press
the Tab key.

On this screen, you are asked to select your language. A default language is already
selected, usually English (see Figure 2-6).
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Figure 2-6. Welcome and language selection

INSTALLATION AND UPGRADE

FEDORA 28 INSTALLATION

Bus Helgl
WELCOME TO FEDORA 28.
What language would you like to use during the installation process?
Afrikasns Afrikaans English {United Kingdom)
AT Amharic Englsh (lndia)
i Anglka English [Australia}
_ : A-. B English [Canada)
" e English (Denmark)
: Assamese English [ireland)
Asturianu Asturian English [Mew Zealand)
Bunrapcru Bulgarian English [Nigeria)
e Bangla English [Hong Kong SAR China)
Sy Tibetan English (Philippines)
Brezheneg Breton English (Singapore)
@ Bida English (South Africa)
_ o English (Zambia)
Bosanski Bosnian English (Zimbabwe)
Catala Catalan P S
[
- I

You are then presented with an Installation summary screen with categories for

Localization and System (see Figure 2-7). For Localization, you can configure the Date

& Time and the Keyboard. For System, you can configure the Installation. A warning

emblem appears on options that have to be configured, usually only the Installation

Destination, although you should also check that the date and time are correct. A Quit

button at the bottom-left of the screen lets you quit the installation. A Begin Installation

button at the bottom-right remains grayed out as long as there are warnings. When all

options are configured and the warning emblems disappear, this button becomes active,

and you can click it to continue the installation.

For the Install DVD, the Installation Summary screen shows a Software category
with Installation Source and Software Selection (see Figure 2-7). On the DVD install,

Localization also has a Language Support icon. See the section “Software Installation
Configuration with the Fedora Install DVD/CDs,” later in this chapter.
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INSTALLATION SUMMARY FEDORA 28 INSTALLATION
Bus Helgl
LOCALIZATION
KEYBOARD TIME & DATE
English (US) Americas/Los Angeles timezone

SYSTEM

INSTALLATION DESTINATION
L Automatic partitioning selected

fedora
WORKSTATION

o

We wont touch your disks until you click ‘Begin nstallation

Figure 2-7. Installation Summary screen

With warning emblems present, a warning appears at the bottom of the screen.

To check and configure your time, date, and time zone, click the Date & Time icon.
On the Date & Time screen, you have the option of setting the time zone by using a map
or pop-up menu to specify your location (see Figure 2-8). The selected city will appear
as the pop-up menu selection. There is a switch that lets you turn off network time (the
time obtained from NTP servers). A configure button next to this switch opens a dialog
that lets you specify the NTP time servers to use. Click the Done button in the upper-left
corner when you're finished.
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TIME & DATE

Done

~ | A~ ‘
1112 *) 24-hour T )
14'@_ ) AM/PM 06w ¥l 03w Y| 2018

Figure 2-8. Time zone selection

On the Installation Summary page, click the Keyboard icon to configure your
keyboard (see Figure 2-9). Keyboard layouts are listed on the left scroll box. Clicking the
plus button at the bottom of this box lets you add another language layout. The Keyboard
button displays an image showing all the keys. A text box to the right lets you test the
keyboard. The Options button lets you specify which keys to use to switch layouts.
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KEYBOARD LAYOUT
Done

FEDORA 28 INSTALLATION

Which keyboard layouts would you like to use on this system? You may move any layout to the top of the list to select it as the
default.

English (US)

Test the layout configuration below:

Layout switching not configured.

Options

Figure 2-9. Keyboard selection

On the Installation Summary screen, click the Installation Destination icon to open

the Installation Destination screen, where you can choose the hard disk device on which
to perform the installation (see Figure 2-10).
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RA 28 INSTALLATION
|

-
Device Selection
Select the device(s) you'd like to install to. They will be left untouched until you click cn the main menu's “Begin Installation” button.
Local Standard Disks

465.76 GiB

ATA WDC WDS000LPVX-7 On50014ectaf549d88s
sda ! 1.99 MiB free

Disks laft unzalectad here will not be fouched

Specialized & Network Disks

ol

Add a disk...
Disks ieft unselected here will not be touched.

Storage Configuration
(8] Rustomatic () Custom ) Advanced Custom (Blvet-GLI)
[ 1 would like to make additional space avaitable,
Encryption
() Encrypt my data. You'l set a passphrase next

k nd loader,., 1 disk selected: 465.76 GIB capacity: 1.99 M&E free Rofrash.

Figure 2-10. Installation Destination

The top icon bar shows your installation devices. The local drives are shown under
the Local Standard Disks heading. If you have only a single local hard drive, that drive is
automatically selected for you.

The Storage section lets you specify partitions on your hard drive and whether you
want to encrypt it or not. Encryption sets a passphrase that you will be prompted for
when you start up your system. Storage Configuration can be Automatic, Custom, or
Advanced Custom. For a standard fresh install that overwrites your hard drive, using
a standard set of partitions, simply choose the Automatic option. This is the default.
The Custom and Advanced Custom options starts up the partitioner, which will let you
create, edit, and delete partitions, as described in the next section. You can set your
own size and type for your partitions. Use this option should you want to create added
partitions or separate partition for certain system folders, such as the /var folder. You
can also us the partitioner to preserve or reuse any existing partitions. You also have the
option to free up additional space, should your hard drive have an operating system that
you want to preserve, and has a large amount of unused space that can be freed up.
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At the bottom of the screen, information is displayed about the selected disk. The
Full Disk Summary and Options link opens with information about the device, as well
as buttons to remove the device and install the bootloader. You can use this dialog to
choose not to install the bootloader. If you have several hard disks, you can choose
which one to install the bootloader on (should this be an issue). Usually, you install the
bootloader on the same device as Fedora.

A check box at the bottom lets you encrypt the device.

When you have selected the device you want, click the Done button on the upper-left
side of the screen.

Upon pressing Begin Installation from the Installation Summary screen, your
installation begins with a progress bar at the bottom of the screen.

When installation finishes, a completion message is displayed at the bottom of the
screen. The Fedora Workstation Live installation shows a Quit button that returns you
to the Fedora Workstation Live Desktop (see Figure 2-11). You can then power off and
restart your system to start up your new installation.

Figure 2-11. Installation complete

Manual Partitioning: Partitions, BTRFS, RAID, and Logical
Volumes

On the Installation Destinations screen in the Storage Configuration section, you are
given the option of customizing the disk partitioning. Click the Custom check box, and
then click the Done button. This opens the Manual Partitioning screen (see Figure 2-12).
The left-side scroll box lists the partitions as you create them. If your hard drive is blank,
it will be empty. The button bar at the bottom of the scroll box has buttons for adding
partitions, deleting them, and displaying information.

At the top right of the dialog is a Help button for the Help dialog. It is highly
recommended that you read through the Help dialog, which provides a very detailed
explanation of how to configure your partitions.
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FEDORA 28 INSTALLATICN

~ New Fedora 28 Installation
You havenit created any maunt paints for your Fedora 28 installation yet. You can

= Create new mount points by dicking the '+ button.
New maunt points will use the following partitioning scheme:

Lv -

When you create mount peants for your Fedora 28 installation, youll be able 1o view their details here.

Reset All

Figure 2-12. Manual Partitioning dialog

You are asked to designate the Linux partitions and hard disk configurations you
want to use on your hard drives. Fedora provides automatic partitioning options if you
just want to use available drives and free space for your Linux system. You can create
specific partitions, configure RAID devices, or set up logical volumes (LVM).

No partitions will be changed or formatted until you leave the Manual Partitioning
screen and, from the Installation Summary screen, you click the Done button. You can
opt out of the installation any time until that point, and your original partitions will
remain untouched. A default layout sets up a home partition, swap partition, a boot
partition of type ext4 (Linux native) for the kernel, and an LVM partition that will hold all
your applications and files, as well as a boot EFI partition if needed.

Initially, with no Linux partition set up and space available, you can click the Click
Here to Create These Automatically link, to create a default set of Fedora partitions.
These are a boot, root, home, and swap partitions (see Figure 2-13). The root and swap
partitions are LVM volumes. The boot partition is a standard ext4 partition. This is the
default set of partitions used, should you skip manual partitioning.

30



CHAPTER 2  INSTALLATION AND UPGRADE

| MANUAL PARTITIONING D) INSTALLATION
~ Mew Fedora 28 Installation fedora_localhost-live-home
DATA
0E > Mount Point: Device(s):
» Ao v
i Ox500140eBal945088 (sda)
p Iboon Desired Capacity:
fboot/e
S 200MIB | | 406748
! 50 GiB
fedora.localhont-lve-root Device T Vol -
: roup:
fboot 1024 MiB e N
dal LM > | [ Enenpt fedora_localhost-live (0 B free)
SWRp 7.82GiB File : =
fedora_lccalhast-lve-sonp B Modiy...

oxtd > | [+ Reformat

Label: Name:

home

Nate: The settings you make on this screen will not
be applied until you click on the main menu's Begin
Installation’ button.

1014.5 KiB |l 465.76 GiB

Reset All

Figure 2-13. Default partitions

The side pane lists the partitions, showing the device name and size. The right pane
shows the configuration for a selected partition. It displays the name, mount point, label,
size, device type, file system, and encryption option. You can make changes to any of
the entries. (No changes are actually made to the hard disk until you begin the software
installation.)

Creating Partitions

To manually create a new partition, click the Plus button to display the Add a New Mount
Point dialog, where you can choose the mount point and the size (see Figure 2-14).
Mount points begin with a slash (/). If you enter a slash, a drop-down menu appears
under the Mount Point text box. The common mount points for file systems are /, /boot,
/home, /usz, and /var. If you have a root and boot system already configured, only the
/home, /usr, and /var entries appear.
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ADD A NEW MOUNT POINT

More customization options are available
after creating the mount point below.

Mount Point: Ivar 4

Desired Capacity: 209H

Cancel Add mount point

Figure 2-14. New partition

The new partition appears on the Manual Partitioning screen. Select it to configure
the partition. You can set the size (in megabytes), the device type, and the file system
type. For the device type, you have the choice of a Standard Partition, BTRFS, Software
RAID, and LVM. For Software RAID, you can create RAID partitions and RAID devices, to
which you can assign RAID partitions. For LVM, you can create Logical Volumes (logical
partitions to which physical partitions are assigned) and a Volume Group (the group to
which logical volumes are assigned). Physical volumes are set up for you.

There are several kinds of file systems supported during installation: ext2, ext3,
ext4, swap, btrfs, xfs, and vfat. The ext2 and ext3 partitions are older forms of the Linux
standard partition type, ext4.

To make configuration changes to any partition, select it and make the changes to its
entries.

Logical Volumes

Fedora supports Logical Volume Management (LVM), which enables you to create
logical volumes that you can use instead of hard disk partitions directly. LVM provides
a more flexible and powerful way of dealing with disk storage, organizing physical
partitions into logical volumes in which memory can be managed easily. Disk storage
for alogical volume is treated as one pool of memory, though the volume may in fact
contain several hard disk partitions on different hard disks. There is one restriction. The
boot partition cannot be a logical volume. You still have to create a separate hard disk
partition as your boot partition with the /boot mount point in which your kernel will be
installed.
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If you selected default partitioning, the /boot partition will have already been set up
for you, along with an LVM volume partition for the rest of the system. A logical group
will be set up with volumes for both the swap and root partitions. The logical group
will be labeled with a name such as fedora. You can change these names by editing the
logical group and volumes during installation. Click the Modify button to the right of the
volume group entry.

Creating logical volumes is now a simple process of specifying the LVM device type
and the volume group. The physical LVM partitions that logical volumes are based on are
generated automatically by Fedora. For a particular LVM partition (logical volume), you
will have a Volume Group entry in which you can specify the volume group it belongs to.

RAID and BTRFS

You also have the option of creating RAID devices. Such devices are for use with the
Linux software RAID service, and shouldn’t be used for your motherboard RAID devices,
as these are automatically detected. If you have already decided to use the motherboard
RAID support, you do not require Software RAID. Linux supports both motherboard/
computer RAID devices (DMRAID), as well as its own Linux Software RAID. The RAID
option is visible only if you have selected two or more hard disks.

BTRES is the new file system format, still under development. If operates much like
RAID devices, providing RAIDO (stripe), RAID (mirrors), and RAID10 (optimization)
levels of support. You create the BTRFS sub-volumes, and the installer creates the BTRFS
volume for you.

Advanced Custom (Blivet-GUI)

Choosing the Advanced Custom option on the Installation Destination screen, displays
the Blivet-GUI disk configuration tool (see Figure 2-15). Blivet provides more detailed
partitioning options.

33



CHAPTER 2 INSTALLATION AND UPGRADE

BLIVET GUI PARTITIONING FEDORA 28 INSTALLATION
Disks Logical View
da —_—
m

+.0 JJ"Q e 0

Device Type Format Size  Mountpoint

free space free space

1 pending action Undo last action Reset All

Figure 2-15. Blivet-GUI

GRUB on Restart

When you reboot, a GRUB bootloader briefly displays a startup message indicating which
operating system on your disk will be started. The default is usually your Linux system. If
Fedora is the only operating system on your system, GRUB will skip the startup message
and the GRUB menu access and start Fedora immediately. Fedora 28 uses GRUB2. You
can find out more about GRUB2 at https://fedoraproject.org/wiki/GRUB_2.

If you have encrypted your hard disk partitions, you are then prompted to enter the
LUKS passphrase for them. A standard installation will prompt for the same passphrase
for your swap and root partitions on your LVM file system. The prompt will use the
physical partition name used for the LVM group, in this example, /dev/sda2. There
are two prompts: one for the LVM volume for the root file system, and one for the LVM
volume swap file system.
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The startup screen then shows the progress of your boot procedures. If your graphics
card supports kernel mode settings, the Plymouth bootup screen will be displayed;
otherwise, a simple progress bar is shown. You can press the ESC key to see startup
messages.

GNOME Initial Setup and GNOME Help

The first time you start up Fedora, the GNOME initial setup is run (see Figure 2-16).
Click the Next button to continue to the next screen, Previous to go back. On the Privacy
screen, you choose privacy options, location service, and automatic problem reporting
(see Figure 2-17). On the Online Accounts screen you can configure online accounts
such as Google, Facebook, and Microsoft (see Figure 2-18). If you do not want to
configure your accounts at this time, just click the Skip button.

Welcome

Welcome!

Figure 2-16. GNOME initial setup
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Previous Privacy

Privacy

Location Services E

Allows applications to determine your geographical location. An
indication is shown when location services are in use.

Uses Mozilla Location Service: Privacy Policy

Automatic Problem Reporting “:

Sending reports of technical problems helps us to improve Fedora.
Reports are sent anonymously and are scrubbed of personal data.

Problem data will be collected by Fedora: Privacy Policy

Privacy controls can be changed at any time from the Settings application.

Figure 2-17. GNOME initial setup: Privacy

Previous Online Accounts

Skip

Connect Your Online Accounts

Connect your accounts to easily access your email,
online calendar, centacts, documents and photos.

5 Googee

B e

=. | Microsoft

n Facebook

Accounts can be added and removed at any time from the Settings application.

Figure 2-18. GNOME initial setup: Online Accounts
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On the About You screen you create a user account, specifying the name and
password (see Figure 2-19). You can click on the image to select an image from an image

menu.

Previous About You Next

A

About You

We need a few details to complete setup.

Full Name | Richard Petersen v

Usermname | richard v |

This v

Set Up Enterprise Login

Figure 2-19. GNOME initial setup: About You

On the Ready to Go screen (see Figure 2-20), click on Start Using Fedora to start the
desktop.
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Ready to Go

You're ready to go!

Start Using Fedora

Figure 2-20. GNOME initial setup: Ready to Go

After completing the setup, the GNOME Help browser starts up at the Getting Started
page (see Figure 2-21). The page displays icons for animations on basic tasks, such as
starting applications using the dash, responding to messages using the message tray, and
managing windows and workspaces.
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{1l
b 4

e Getting Started =i =

Getting Started

D O | @ B °
3 @ A& C a
< n g ,
* w oA @ X 4 4
Launch applications Switch tasks Use windows and workspaces

Common Tasks

Browse the web Change the date, time and timezone Change the wallpaper
Connect to online accounts Use the system search Use windows and workspaces
Get online Launch applications Switch tasks

GNOME Help

Figure 2-21. GNOME Help: Getting Started animations

Upgrading Fedora Linux

You can only upgrade an existing Fedora 27 system to Fedora 28. If you have Fedora 26,
you first have to upgrade to Fedora 27. Be sure to back up your system, including the
home, etc, and boot directories. You can use the dnf command to perform the upgrade.
If not already installed, install the dnf-plugin-system-upgrade package. See
https://fedoraproject.org/wiki/DNF_system upgrade for details.

sudo dnf install dnf-plugin-system-upgrade

From a terminal window, you use the dnf system-upgrade command to perform the
upgrade, specifying the release.

sudo dnf system-upgrade download --refresh --releasever=28
To remove unneeded files, use the autoremove option.

sudo dnf autoremove
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If you have customized any system configuration files in the /etc directory, the
upgrade will leave the original intact and add the new configuration file with a . rpmnew
extension. You can then manually modify the new version to incorporate any custom
changes. This process can be automated with the rpmconf command (rpmconf package).

rpmconf -a

Creating Boot Disks

You can use mkbootdisk to create a boot CD-ROM. Use the --iso option and the
--device option with the name of an ISO image file to create (install the mkbootdisk
package). You then use CD-ROM-burning software to create the CD-ROM from the
image file. The following example creates a CD-ROM image file called mybootcd. iso that
can be used as a boot CD-ROM:

mkbootdisk --iso --device mybootcd.iso 4.16.3-301.fc28.x86_64

Booting in Rescue Mode

If you are not able to boot or access your system, it may be due to conflicting
configurations, libraries, or applications. In this case, you can boot your Linux system
in a rescue mode and then edit configuration files with a text editor, remove the
suspect libraries, or reinstall damaged software with dnf. To enter the rescue mode,
run the Fedora Workstation Live DVD and then select Rescue a Fedora System from the
Troubleshooting menu.

You will boot into the command-line mode with your system’s files mounted at
/mnt/sysimage. You will be notified that you can use the chroot command to set the
/ directory as the root. Issue the following command at the command-line prompt:

chroot /mnt/sysimage

Use the cd command to move between directories. Check /etc and /etc/sysconfig
for your configuration files. You can use vi to edit your files and the less command to
view them. To reinstall files, use the dnf install command. When you are finished, use
the exit command.
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If you have a command-line system, enter the following at the boot prompt:

linux rescue

Reinstalling the Bootloader

If you have a dual-boot system, where you are running Windows and Linux on the
same machine, you may run into a situation where you have to reinstall your GRUB
bootloader. This problem occurs if you have installed a new version of Windows after
installing Linux. Windows will automatically overwrite your bootloader (alternatively,
you could install your bootloader on your Linux partition instead of the MBR). You will
no longer be able to access your Linux system.

All you have to do is reinstall your bootloader. First, in rescue mode as described in
the previous section.

As noted in the preceding section, this boots your system in rescue mode. Then use
grub2-install and the device name of your first partition to install the bootloader. At
the prompt, enter

sudo grub-install /dev/sda1

This will reinstall your current GRUB bootloader, assuming that Windows is included
in the GRUB configuration. You can then reboot, and the GRUB bootloader will start up.

You then have to create a new configuration file (/boot/grub2/grub.cfg), using the
grub2-mkconfig command, as follows:

sudo grub2-mkconfig -o /boot/grub2/grub.cfg

If your Linux rescue disks are unable to access your system, you can use a Fedora
Workstation Live DVD to start up Fedora and then manually mount your Fedora
partitions. You will have to know your partition device names (use GParted). Once they
are mounted, you can access the system files on the mounted partition and make any
required changes.
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Usage Basics: Login,
Desktop, and Help

To start using Fedora, you must know how to access your Fedora system and, once

you are on the system, how to use and configure the desktop. A set of desktop GNOME
Settings tools lets you easily configure such features as network access, desktop
background, display resolution, and power usage. Access is supported through a
graphical login. A simple screen appears with menus for selecting login options and your

username.

GNOME Users

User access to the system is provided through accounts. To gain access to the system,
you must have a user account set up for you. A system administrator creates the account,
assigning a username and password for it. You then use your account to log in to and use
the system. You can create other new user accounts, by using the system administration
tool GNOME Users in GNOME Settings » Details (accessible from the system-status-
area menu). You can access these tools from any user account, provided you supply the
administrative password. You had to provide a root user password when you installed
your system. This is the administrative password required to access any administrative
tool, such as the one for managing user accounts.

GRUB Start Menu and Boot Problems

When you boot up, the GRUB screen is displayed for a few seconds before the boot
procedure begins. Should you want to start a different operating system or add options
to your startup, you have to display the GRUB startup menu (see Figure 3-1). Do this by
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pressing any key on your keyboard. The GRUB menu will be displayed and will list Linux
and other operating systems you specified, such as Windows. Your Linux system should
be selected by default. If not, use the arrow keys to move to the Linux entry, if it is not
already highlighted, and press Enter.

To change a particular line, use the up/down arrow keys to move to the line.
You can use the left/right arrow keys to move along the line. The Backspace key will
delete characters and, simply by typing, will insert characters. The editing changes
are temporary. Permanent changes can be made only by directly editing the GRUB
configuration files. Fedora Linux uses GRUB2, which uses the configuration file /etc/
default/grub. GRUB?2 files are kept in the /etc/grub.d directory. Run as root the
following grub2-mkconfig to apply changes made in /etc/default/grub:

grub2-mkconfig -o /boot/grub2/grub.cfg

See the GRUB2 page at https://fedoraproject.org/wiki/GRUB_2 for more
information.

When your Fedora Linux operating system starts up, an Fedora Linux logo appears.
You can press the Esc key to see the startup messages instead. Fedora Linux uses
Plymouth with its kernel-mode setting ability to display a startup animation. The
Plymouth Fedora Linux logo theme is installed by default.

For graphical installations, some displays may have difficulty running the graphical
startup display known as the Plymouth boot tool. This tool replaces the Red Hat
Graphical Boot tool but still uses the command rhgb. If you have this problem, you can
edit your Linux GRUB entry and remove the rhgb term from the Linux line. Press the e
key to edit a Grub Linux entry (see Figure 3-2). Then move the cursor to the Linux line
and perform your edit. Use the Backspace key to delete. Then press Ctrl+x to boot the
edited GRUB entry.

Your system will start up, initially using the text display for all the startup tasks, then
shift to the graphical login.
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Fedora (4.16.12-300.fcZ28.xB6_64) 28 (Workstationm Edition)

Fedora (4.16.3-301.fc2B.x86_64) 28 (Workstation Edition)
Fedora (O-rescue-520d469e636fd4bf4a4947cb3Zb6efad3c) 28 (Workstation Editi-

Use the t and | keys to change the selection.

Press ‘e’ to edit the selected item, or ‘¢’ for a command prompt.

Figure 3-1. GRUB menu

setparams 'Fedora (4.16.12-300.fc28.xB6_64) 28 (Workstation Edition)

load_video

set gfxpayload=keep

insmod gzio

insmod part_msdos

insmod extZ

set root="hd0,msdos1’

if [ xSfeature_platform_search_hint = xy 1: then

search --no-floppy --fs-uuid --set-root --hint="hd®,msdos1’ 85fa0f3n

5-996d-49a1-af 1f -dd537ba89203

else

search —-no-floppy --fs-uuwid --set=root 857a0f35-996d-4%a1-af 1f-dd53~
7baB9203
fi |
Press Ctrl-x to start, Ctrl-c for a command prompt or Escape to

discard edits and return to the menu. Pressing Tab lists
possible completions.

Figure 3-2. GRUB Edit window

Should you have difficulty displaying your graphical interface, you can instead
choose to boot up the command-line interface. From the command-line interface, you
can make any needed configuration changes. To boot to the command-line interface
from GRUB, edit the Linux line of the Linux GRUB entries, and add a 3 to the end of the
line. The 3 indicates the command-line interface. In previous versions of Fedora Linux,
the 3 indicated a run level. Now it refers to a systemd target.
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The Display Manager: GDM

The graphical login interface displays a login window with a box listing a menu of
usernames. When you click a username, a login box replaces the listing of users,
displaying the selected username and a text box in which you then enter your password.
Upon clicking the Sign In button or pressing Enter, you log in to the selected account,
and your desktop starts up.

Graphical logins are handled by the GNOME Display Manager (GDM). The
GDM manages the login interface, in addition to authenticating a user password and
username, and then starts up a selected desktop. From the GDM, you can shift to
the command-line interface with Ctrl+Alt+F2, and then shift back to the GDM with
Ctrl+Alt+F1 (from a desktop, you would use the same keys to shift to a command-line
interface and to shift back). The keys F2 through F6 provide different command-line
terminals, as in Ctrl+Alt+F3 for the second command-line terminal. These terminals are
known as TTY devices (teletypewriter), devices that only accept typed commands on a
keyboard.

When the GDM starts up, it shows a listing of users (see Figure 3-3). A System Status
Area at the top right of the screen displays icons indicating the status of the sound and
battery. Clicking the icons displays the System Status Area menu, which shows the
entries for sound adjustment, the battery status (if a laptop), and the status of your
network connections. A power button at the bottom will display a power off dialog with
options to Power Off and Restart. To shut down your system, click the Power Off button
on the Power Off dialog.
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Tue 13:36

E Richard Petersen

i George Petersen

E Mark Petersen
@ Robert Petersen
[~

fedora’

Figure 3-3. The Fedora Linux GDM user listing

At the top center of the screen is the date (day of the week) and time. Clicking on the
time displays the calendar with the full date specified, and the notifications menu.

Next to the System Status Area icons is a menu for accessibility, which displays
a menu of switches that let you turn on accessibility tools and such features as the
onscreen keyboard, enhanced contrast, and the screen magnifier.

To log in, click a username from the list of users. You are then prompted to enter
the user’s password (see Figure 3-4). A new dialog replaces the user list, showing the
username you selected and a Password text box in which you can enter the user’s
password. Once you enter the password, click the Sign In button or press Enter. By
default, the GNOME desktop starts up. If the name of a user you want to log in as is not
listed, click the Not Listed entry at the end, to open a text box, which prompts you for a
username, and then the password.

A session button (gear icon) is displayed below the Password text box next to the
Sign In button. Click that Session button to open a menu listing the installed desktops,
then click the one you want to use (see Figure 3-5). The GNOME option is the main
GNOME desktop, which runs under the new Wayland display server. You also have the
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choice to choose GNOME on Xorg, which runs under the older Xorg display server, or to
choose GNOME Classic, which runs GNOME with older GNOME 2 features such as an
Applications menu and a task bar. Though GNOME is the primary desktop for Fedora,

it is possible to install and use other desktops, such as KDE (plasma-desktop), Xfce, and
Mate. They are available on the Fedora Linux repository. Your installed desktops will
appear as options on the Session menu.

Tue 13:37

D Richard Petersen

P

Cancel ¥ Signin

fedora®

Figure 3-4. GDM login
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Richard Petersen

Cancel S

e GNOME
GNOME Classic
GNOME on Xorg

Plasma

fedora

Figure 3-5. GDM Session menu

The System Status Area

Once you're logged in, the System Status Area is displayed on the right side of the top
bar (see Figure 3-6). The area will include status icons for features such as sound and
power. Clicking the button displays the System Status Area menu, with items for sound,
brightness, wired and wireless connections, Bluetooth connections, the battery, and
the current user, in addition to buttons at the bottom for opening GNOME Settings,
activating the lock screen, and shutting down or rebooting the system. The sound and
brightness items at the top include sliding bars with which you can adjust the volume
and brightness. The Wired, WiFi, Bluetooth, Battery, and current user entries expand
to submenus with added entries. The buttons at the bottom open separate dialogs for
GNOME Settings, the lock screen, and poweroff and restart.
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Wired Connected
Wi-Fi Not Connected

On

Fully Charged

Power Settings

Richard Petersen

Figure 3-6. System Status Area menu

On systems that are not laptops, there will be no brightness slider or battery entry on
the System Status Area menu. If the system also has no wireless device, the WiFi entry
will also be missing. A system of this kind will only have a sound slider and a current
user entry.

To log out or switch to another user, you click the current user entry to expand the
menu to show Switch User and Log Out entries. The Log Out entry returns you to the
GDM login screen. The Switch User entry suspends the current user and returns you to
the GDM login screen, where you can log in as another user. If only one user is defined,
there is no user entry, and, so, no Log Out entry, as there are no other users to log in.

For network connections, Fedora Linux uses Network Manager. Network Manager
will detect available network connections automatically (see “Network Connections,”
later in this chapter).
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Desktops

Several alternative desktop interfaces, such as GNOME and the K Desktop (KDE), can be
installed on Fedora Linux. Each has its own style and appearance. It is important to keep
in mind that the GNOME and KDE interfaces are two very different desktop interfaces,
with separate tools for selecting preferences.

KDE

The K Desktop Environment (KDE) displays a panel at the bottom of the screen. The
file manager operates much the same way as the GNOME file manager. There is a
Settings entry in the main menu that opens the KDE Settings window, from which you
can configure every aspect of the KDE environment, such as desktop effects, workspace
appearance, and devices such as monitors and printers, and networking.

GNOME

Fedora Linux 28 uses the GNOME 3 desktop. It provides easy-to-use overviews and
menus, along with a flexible file manager and desktop. GNOME 3 is based on the
gnome-shell, which is a compositing window manager.

The screen displays a top bar, through which you access your applications, windows,
and settings. Clicking the System Status Area button at the right side of the top bar
displays the status user area menu, from which you can access buttons at the bottom to
display the system setting dialog, lock the screen, and shut down the system
(see Figure 3-7).

To access applications and windows, use the Activities overview mode. Click the
Activities button at the left side of the top bar (or move the mouse to the left top corner,
or press the Windows button). The overview mode consists of a dash listing your favorite
and running applications, workspaces, and windows (see Figure 3-8). Large thumbnails
of open windows are displayed on the Windows Overview (the desktop area). You
can use the Search box at the top to locate an application quickly. Partially hidden
thumbnails of your desktop workspaces are displayed on the right side. Initially, there
are two. Moving your mouse to the right side displays the workspace thumbnails.

You can manually leave the overview at any time by pressing the Esc key or by
clicking a window thumbnail.
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The dash is a bar on the left side with icons for your favorite applications. Initially,
there are icons for the Firefox web browser, files (the GNOME file manager), Mail,
Rhythmbox, Shotwell, GNOME Software, GNOME Software, and the Applications
overview, as depicted in Figure 3-9. The last icon opens an Applications overview that
you can use to start other applications. To open an application from the dash, click its
icon or right-click on the icon and choose New Window from the pop-up menu. You can
also click and drag the icon to the Windows Overview or to a workspace thumbnail on
the right side.

Fri 10:36

Figure 3-7. The Fedora GNOME desktop
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Activities Fri 10:37

Figure 3-8. GNOME Activities overview mode for applications

You can access windows from the Windows Overview, which is displayed when you
start Activities. The Windows Overview displays thumbnails of all your open windows.
When you pass your mouse over a window thumbnail, a close box appears, at the upper-
right corner, with which you can close the window. You can also move the window on
the desktop to another workspace.

To move a window on the desktop, click and drag its title bar. To maximize a window,
double-click its title bar or drag it to the top bar. To minimize, double-click the title bar
again or drag it away from the top bar. To close a window, click its close box
(upper right).

Two sub-folders are available on the applications overview: Utilities and Sundry.
Utilities lists several tools, such as the text editor and system monitor, and Sundry lists
additional administrative tools, such as system-config-printer and firewall-config.
These sub-folders function like a submenu, overlaying the main overview with a sub-
folder. You can use the GNOME Software Installed tab to create your own sub-folders
and place application icons in them.
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GNOME File Manager

You can access your home folder from the Files icon on the dash. A file manager window
opens, showing your Home folder (see Figure 3-9). Your Home folder will already

have default directories created for commonly used files. These include Documents,
Downloads, Music, Pictures, and Videos. Your office applications will automatically save
files to the Documents folder by default. Image and photo applications place image files
in the Pictures directory. The Desktop folder will hold all files and directories saved to
your desktop. When you download a file, it is placed in the Downloads directory.

< | > 4« 1 Home » Qo =il b= X
©® Recent -
W Starred
m Desktop Documents Downloads
) Documents
+ Downloads | o - | o
dd Music
2 Pictures Music Pictures Public
vl Videos ’
| o | o
1 Trash
1 e s Templates Videos

Figure 3-9. File manager for the Home folder

The file manager window displays several components, including a header bar,
which combines the title bar and toolbar, and a sidebar. When you open a new directory,
the same window is used to display it, and you can use the forward and back arrows to
move through previously opened directories. The header bar displays navigation folder
buttons that show your current folder and its parent folders. You can click a parent folder
to move to it. The GNOME file manager also supports tabs. You can open several folders
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in the same file manager window. Click on the menu button on the right side of the title
bar to display the file manager tools with buttons to add a new folder, tab, or bookmark,
as well as zoom buttons for enlarging or reducing the size of the folder icons. You can
also sort files and show hidden files.

GNOME Customization with the Tweak Tool: Themes,
Fonts, Startup Applications, and Extensions

You can perform common desktop customizations using the GNOME Tweak Tool.

Areas to customize include the desktop icons, fonts, themes, startup applications,
workspaces, window behavior, and the time display. You can access the Tweak Tool from
the Applications Overview » Utilities. The GNOME Tweak Tool has tabs for Appearance,
Extensions, Fonts, Keyboard and Mouse, Power, Startup Applications, Top Bar, Typing,
Windows, and Workspaces (see Figure 3-10).

Q Tweaks Appearance X

Appearance
Extensions

Themes
Fonts Applications Adwaita (default)
Keyboard & Mouse Cursor Adwaita (default)  ~
Power Icons Adwaita (default) -
Sound Shell A v
Startup Applications Background

™

Top Bar Image @ f28.xml B
Windows Adjustment Zoom -
Workspaces LocES e

Image @ f28.xml =

Adjustment Zoom -

Figure 3-10. GNOME Tweak Tool, Appearance tab (themes)
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The Appearance tab lets you set the theme for your windows, icons, and cursor.
GNOME 3 uses the Adwaita Theme. This theme has a light and dark variant. The Global
Light Theme is the default, but you can use the switch on the Appearance tab to enable
the Global Dark Theme. The Global Dark Theme shades the background of windows to a
dark gray, while text and button images appear in white.

As you add other desktops, such as Cinnamon, the available themes increase. There
are many window themes to choose from, including Clearlooks, Mist, and Glider. For
icons, you can choose among Oxygen (KDE), Mist (Cinnamon), and GNOME.

Desktop fonts for window titles, interface (application or dialog text), documents,
and monospace (terminal windows or code) can be changed in the Fonts tab (see
Figure 3-11). You can adjust the size of the font or change the font style. Clicking the font
name opens a Pick a Font dialog from which you can choose a different font. The quality
of text display can be further adjusted with Hinting and Antialiasing options. To simply
increase or decrease the size of all fonts on your desktop interface, you can adjust the

Scaling Factor.
Q Tweaks Fonts x
Appearance
Window Title Cantarell Bold 1
Extensions
Interface Cantarell Reqular 11 Concel Rk Font

Keyboard & Mouse i 3 o
Monospace Monospace Regular 11 The qUiCk bI'DWn fOX jm

Power Carlito Regular
Hinting () Full Antialiasing () Subpixel (for LCD screens) The CIUiCk brown fox jUITI
Sound Medium *) Standard (grayscale) Carlit Bold Htallc
Startigs Applications * Slight ) None The quick brown fox jum...
() None CarttoBold .
Top Bar The quick brown fox ju...
Windows Scaling Factor 100 - | + Crtolale R
The quick brown fox jumps over the lazy dog.
Workspaces = 11 = P

Figure 3-11. GNOME Tweak Tool, Fonts tab

At times, there may be certain applications that you want started up when you log in,
such as the Gedit text editor, the Firefox web browser, or the Videos movie player. On the
Startup Applications tab, you can choose the applications to start up (see Figure 3-12).
Click the plus (+) button to open an applications dialog from which you can choose an
application to start up. Once added, you can later remove the application by clicking its
Remove button.
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Close |

el

@Contacts
Enisk Usage Analyzer

@ Disks
|Qd| Document Viewer

\3\.&! NAariimante

Figure 3-12. GNOME Tweak Tool, Startup Applications tab

For the GNOME Tweak Tool, extensions add different capabilities to the GNOME
desktop. Installed extensions are listed on the Extensions tab of the Tweak Tool, where
you can turn them on or off. Several extensions add GNOME Classic (GNOME 2)
features to your GNOME 3 desktop (see Figure 3-13). Add the Applications menu and
the Places menu to the top bar. The Applications menu organizes applications by the
older and familiar menu categories such as Office and Sound & Video. The Applications
menu replaces the Activities button, which you can still access as the last item on the
Applications menu. The Places menu lists the default folders such as Documents and
Pictures, along with Computer and Browse Network. The Window list extension adds a
bottom bar showing the task bar applet for open windows and a window list applet to the
right (see Figure 3-14).
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Applications = |2 Tweaks =

Extensions

Fonts Applications menu
Keyboard & Mouse

Power Background logo

Sound

Startup Applications
Top Bar
Windows Places status indicator

Workspaces

Figure 3-13. GNOME Tweak Tool, Extensions tab

Bl anomE Tweaks

Figure 3-14. GNOME Tweak Tool, Window list extension

Logging Out and Shutting Down GNOME

If you want to exit your desktop and return to the GDM login screen, or switch to a
different user, you click the user entry in the System Status Area menu to expand to a
menu with entries for Switch User and Log Out (see Figure 3-15). Click the Log Out entry
to display a dialog that shows buttons for Cancel and Log Out. Click Log Out to log out
of your account, exiting GNOME and returning to the login screen, where you can log in
again as a different user or shut down the system. A countdown will commence in the
dialog, showing how much time you have before it performs the logout automatically.
From the login screen, you can shut down the system: choose Power Off from the
System Status Area menu on the lower right of the menu. This displays a power off dialog
with options to restart or power off. A countdown will commence in the dialog, showing
how much time you have before it performs the shutdown automatically.
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The Switch User entry switches out from the current user and runs the GDM to
display a list of users you can log in as. Click the name to open a password prompt and
display a session button. You can then log in as that user. The sessions of users already
logged will continue with the same open windows and applications that were running
when the user switched off. You can switch back and forth between logged-in users, with
all users retaining their session from where they left off. When you switch off from a user,
that user’s running programs will continue in the background.

") Richard Petersen

Switch User
Log Out

Account Settings

Figure 3-15. GNOME Log Out menu entry

Network Connections

Network connections will be set up for you by Network Manager, which will detect

your network connections automatically, both wired and wireless. Network Manager
provides status information for your connection and allows you to switch easily from one
configured connection to another, as needed. For initial configuration, it detects as much
information as possible about the new connection.

Network Manager is user specific. Wired connections will be started automatically.
For wireless connections, when a user logs in, Network Manager selects the connection
preferred by that user. From a menu of detected wireless networks, the user can select a
wireless connection to use.

Network Manager displays active network connections in the System Status Area:
Wired for the wired connection and WiFi for a wireless connection. Each entry will
indicate its status as connected or not connected. The Network Manager icon for these
entries will vary according to the connection status: solid for an active connection and
faded for a disconnected connection (see Figure 3-16). On wired systems that have no
wireless devices, there is no WiFi network entry in the System Status Area menu.
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Wi-Fi Not Connected
Select Network

Turn Off

Wi-Fi Settings

Figure 3-16. Network Manager, wireless

Network Manager Wired Connections

For computers connected to a wired network, such as an Ethernet connection, Network
Manager automatically detects and establishes the network connection. Most networks
use DHCP to provide such network information as an IP address and DNS server.

With this kind of connection, Network Manager can connect automatically to your
network whenever you start your system. Click the Wired entry in the System Status
Area to expand the menu to show entries from which to connect or disconnect to wired
networking and open the GNOME Network Settings dialog at the Wired tab (Wired
Settings).

Network Manager Wireless Connections

With multiple wireless access points for Internet connections, a system could have
several network connections to choose from. This is particularly true for notebook
computers that access different wireless connections at different locations. Instead of
manually configuring a new connection each time one is encountered, the Network
Manager tool can configure and select a connection to use automatically.

Network Manager will scan for wireless connections, checking for Extended Service
Set Identifiers (ESSIDs). If an ESSID identifies a previously used connection, it is
selected. If several are found, the recently used one is chosen. If only new connections
are available, Network Manager waits for the user to choose one. A connection is
selected if the user is logged in.

Click the WiFi entry in the System Status Area to expand the menu to show entries
from which to select a network, turn off wireless networking, and open the GNOME
Network Settings dialog at the WiFi tab (WiFi Settings). Click the Select Network item
to open a dialog that shows a list of all available wireless connections (see Figure 3-17).
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Entries display the name of the wireless network and a wave graph showing the strength
of its signal. To connect to a network, click its entry, then click the Connect button, to
activate the connection. If this is the first time you are trying to connect to that network,
you will be prompted to enter the password or encryption key (see Figure 3-18).

Wi-Fi Networks
Select a network

—
O

surfturtle
Ponohapa
xfinitywifi
NETGEAR25
Branleur
Sonic-1366
ADE-Net-2.4G

AMETATCANDAD

Cancel Connect

Figure 3-17. Network Manager connections menu, wireless

Authentication required by wireless network

n key required to access
surftu

Figure 3-18. Network Manager wireless authentication
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You can turn off wireless by clicking the Turn Off entry in the expanded WiFi section
of the System Status Area (see Figure 3-19). When it’s turned off, the entry label changes
to Turn On. To reactivate your wireless connection, click the Turn On entry.

= surfturtle
Select Network

Turn Off

Wi-Fi Settings

Figure 3-19. Network Manager wireless on and off

Settings WiFi and Network

On the GNOME Settings dialog, there is a WiFi tab for wireless configuration and a
Network tab for wired, VPN, and proxy configurations. For WiFi, choose the Choose
WiFi Settings from the expanded WiFi entries in the System Status Area, or click the WiFi
tab in the Settings dialog, to open the WiFi tab (see Figure 3-20). On the WiFi tab, an
Airplane Mode switch and a list of visible wireless connections are listed to the right. The
currently active connection will have a checkmark next to its name. On the top-right bar
is a switch for turning wireless on and off. A menu to the right of the switch list entries for
connections to hidden networks, turning your computer's WiFi hotspot capability and
listing previously accessed WiFi networks.
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Q Settings Wi-Fi m: = X

Airplane Mode

$ Bluetooth OFF
@ Background
Visible Networks

AT ication

urfty v a7
Q S

ir =
B Region & Lanquage

' as

€ Univer Acce

=
1
x

Connect to Hidden Network...

Turn On Wi-Fi Hotspot...

1 and md¢

Known Wi-Fi Networks

Figure 3-20. Settings Network wireless connections

Your current active connection will have a checkmark next to it and a gear button to
the right. Click the gear button to display a dialog with tabs for managing the connection.
The Details tab provides information about the connection (see Figure 3-21). The
Security, Identity, IPv4, and IPv6 tabs let you perform a detailed configuration of your
connection, as described in Chapter 10. The settings are fixed to automatic by default.
Should you make any changes, click the Apply button to have them take effect. The
Details tab has options both for connecting automatically and for providing availability
to other users. These are set by default. Should you not want to connect to the wireless
network automatically, be sure to uncheck this option. To remove a network’s connection
information, click the Forget button on the Details tab.
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surfturtle Apply

Details Identity IPv4 IPv6 Security

£¥

3

Forget Connection

Figure 3-21. Settings Network wireless connection, Details tab

The Identity tab has options for connecting automatically and for providing
availability to other users. These are set by default. Should you not want to connect to the
wireless network automatically, be sure to uncheck this option.

The Turn on Wi-Fi Hotspot entry in the wireless menu opens a dialog letting you set
up your computer as a wireless router that other computers can connect through.

The Connect to Hidden Wi-Fi Network entry in the wireless menu lets you connect
to a hidden network, not one visible. This opens the Connect to Hidden Wi-Fi Network
window (see Figure 3-22), where you can enter the network name and security

information.
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Connect to Hidden Wi-Fi Network X

Hidden Wi-Fi network

o

Enter the name and security details of the hidden Wi-Fi
network you wish to connect to

Connection: New... -

Network name:

Wi-Fi security: | WPA & WPA2 Personal v

Password: sz
() Show password

Cancel
Figure 3-22. Connect to a Hidden WiFi Network

For a wired connection, click the Network tab on GNOME Settings to display lists for
Wired, VPN, and Network Proxy. The Wired list shows your current wired connections
with on and off switched for each. A plus button at the top right of the Wired list lets you
add more wired connections. Next to a connection's switch a gear button is displayed
(see Figure 3-23). Clicking the gear button opens a configuration dialog with tabs for
Details, Identity, IPv4, IPv6, and Security.

Q Settings Network ®
% UNVersar AcCess
D¢ Online Accounts Wired T
W Privacy Connected - 100 Mb/s E e
=, Sharing
VPN +
49 Sound
Not set up
& Power
Network
Network Proxy off | %
%o Devices >
B Details >

Figure 3-23. Settings Network wired connection
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Clicking on the Network proxy gear button opens a Network Proxy dialog with
Disabled, Manual, and Automatic options (see Figure 3-24). The Manual option lets you
enter address and port information. For the Automatic option, you enter a configuration

address.
Network Proxy x
) Automatic
* Manual
Disabled
HTTP Proxy 8080 - +
HTTPS Proxy 0 +
FTP Proxy 0 +
Socks Host 0 +
lgnore Hosts | localhost, 127.0.0.0/8, ::1
Network Proxy Manual | £

Figure 3-24. Network proxy settings (Settings Network)

To add a VPN connection, click the plus (+) button to the right of the VPN title to
open Add VPN Dialog Network.

Settings

You can configure desktop settings and perform most administrative tasks using the
GNOME configuration tools (see Table 3-1) listed in the GNOME Settings dialog,
which is accessible from the System Status Area dialog (lower-left button). It displays
tabs for different desktop and system configurations (see Figure 3-25). There are two
subheadings for system administration (Details) and device configuration (Devices).
Devices include keyboards, displays, and printers. Details has tabs for users, the date
and time, and default applications. A few settings tabs invoke the supported system
tools available from previous releases, such as Sound (PulseAudio). Most use the new
GNOME 3 configuration and administrative tools such as Background, Privacy, Users,
and Power (see Table 3-1).
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Background *

< Devices

B Keyboad

@ Mouse & Touchpad

Background

L4 Details

© Date & Time

& Printers
# Removable Media

€ Thunderbolt

dg Users
#4 Wacom Tablet

W Default Applications
&b Color

Figure 3-25. GNOME system tools (settings)

Table 3-1. Settings

Setting Description

Personal

WiFi Lets you configure and manage wireless networks.

Bluetooth Sets Bluetooth detection and configuration

Background Sets desktop and screen lock backgrounds (wallpaper, color, and image)

Notifications Turns on notifications for different applications

Search Specifies the resources and locations searched by the GNOME overview
search box

Region & Language  Chooses a language, region (formats), and keyboard layout

Universal Access
Online Accounts
Privacy

Sharing

Sound

Enables features such as accessible login and keyboard screen
Configures online accounts for use by email and browser applications
Turns on privacy features, such as screen lock and purging trash
Turns on sharing for media, remote login, and screen access

Configures sound effects, output volume, input volume, and sound
application settings

(continued)
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Table 3-1. (continued)

Setting Description

Power Sets the power options for laptop inactivity

Network Lets you turn wired networks on or off; allows access to an available wired
networks and specifies proxy configuration, if needed

Devices

Displays Changes your screen resolution, refresh rate, and screen orientation

Keyboard Configures repeat key sensitivity and shortcut keys for special tasks, such
as multimedia operations

Mouse & Touchpad Sets mouse and touchpad configuration; selects hand orientation, speed,
and accessibility

Printers Turns printers on or off and accesses their print queues

Removable Media
Wacom Tablet
Color

Details

About

Date & Time
Users

Default Applications

Default applications for removable media
Provides tablet options

Sets the color profile for a device

Sets the hostname of your computer, displays hardware information, and
assigns default applications for certain basic tasks

Sets the date, time, time zone, and network time
Manages accounts

Default applications for different for user files

Background

With the Background dialog, you can set your background for both the desktop and

screen lock backgrounds: wallpaper, picture, or color. You can access the Background

dialog from the Settings Background tab (see Figure 3-26). The current backgrounds are

shown for the desktop and the screen lock. Click one to open the background dialog,

with tabs for Wallpapers, Pictures, and Colors (see Figure 3-27). The dialog is the same

for both desktop and screen lock backgrounds. If you choose Wallpapers, the installed

backgrounds are displayed. The Colors tab displays solid color images you can use
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instead. The Pictures tab displays images in your Pictures folder, which you can scroll
through to select one to use for your background. To add your own image, first add the
image to your Pictures folder. Then click the Pictures tab to display all the images in
your Pictures folder. Once you make your selection, click the Select button at the upper
right. You return to the main Background dialog, showing your new background. The
background on your display is updated immediately.

Q Settings Background X
T Wi-Fi
32 Bluetooth

A Notifications

Q, Search

B3 Region & Language Background Lock Screen
€ Universal Access

£ Online Accounts

Figure 3-26. Background

Cancel Wallpapers Pictures Colors

Figure 3-27. Select Background

Install the gnome-background-extra package to add a collection of GNOME
backgrounds. You can download more GNOME backgrounds (wallpapers) from
https://www.gnome-1look.org/.
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Date & Time

The Date & Time calendar and menu are located on the top bar at the center (see
Figure 3-28). The dialog displays the current time and day of the week but can be
modified to display 24-hour or AM/PM time. The calendar shows the current date, but
you can move to different months and years using the month scroll arrows at the top
of the calendar. The Add World Clocks link opens the GNOME Clocks tool for selecting
world clocks. The Weather link opens GNOME Weather.

Fri 17:51

Friday

May 18 2018

k)

No Notifications

Select a location...

Figure 3-28. Date & Time dialog
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You can further adjust the top bar time display using the GNOME Tweak Tool’s Top

Bar tab (see Figure 3-29). In the Clock section, there are options to show the date and

seconds. For the Calendar, you can show week numbers.

Q

Fonts
Keyboard & Mouse
Power

Sound

Startup Applications

Windows

Workspaces

Tue May 29, 17:45:41

Application Menu

Battery Percentage

Clock

Date

Seconds

Calendar
Week Numbers

Figure 3-29. GNOME Tweak Tool’s Top Bar with clock options on

Date & Time options are set using the Settings Details » Date & Time tab. The

Date & Time tab lets you set the time zone and time. Both are configured for automatic

settings using Internet time servers (see Figure 3-30). The time zone or the time and date

can be set manually by turning off the Automatic switches. Once turned off, the Date &

Time and the Time Zone links become active.
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< Details Date & Time
4+ About

e s o .
&3 Users Automatic Time Zone 1

% Default Applications

< Details

4+ About

&g Users

% Default Applications

Figure 3-30. Date & Time Settings dialog with automatic settings turned on (top)

and off (bottom)

The Date & Time link opens a dialog with settings for the hour, minutes, day, and
year, with a menu for the month (see Figure 3-31). You can use the plus (+) and minus (-)

‘ OFF
thul[d': internet access -
Date & Time 18 May 2018, 17:53
Time Zone PDT (Los Angeles, United States)
Time Format 24-hour =
Date & Time

Automatic Date & Time

OFF
P»_‘-qunes internet access
Automatic Time Zone ]

F

RF{][JI[E". internet access 4 “
Date & Time 18 May 2018, 17:53
Time Zone PDT (Los Angeles, United States)

Time Format 24-hour =

buttons to sequentially change the values.
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Date & Time x

+ ‘ + ‘ Month | May -
: 54 Dy 18 -+

- ‘ _ J Year12013 e [

Figure 3-31. Date & Time manual settings

The Time Zone link opens a dialog with a map of the time zones and the current one
selected (see Figure 3-32). Click a new time zone to change the zone.

‘ Q Search for a city x

Figure 3-32. Time Zone dialog

You can set the system date and time either manually or by referencing an Internet
time server. You could also use your local hardware clock. To set the system time
manually, you use the date command. The date command has several options for
adjusting both displaying and setting the date and time. Check the date man page for a
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detailed list, man date. You can set the time with the --set option and a string specifying
the date. You use human readable terms for the time string, such as Mon or Monday for
the day and Jul or July for the month. Hour, minute, and second can be represented by
numbers separated by colons. The following sets the date to July 9, 8:15 AM 2018.

sudo date --set='Monday July 9 08:15 2018'
To just set the time you would enter something like:
sudo date --set='12:15:43"

To access the hardware clock, you use the hwclock command. The command will
display the hardware clock time.

sudo hwclock

The --hctosys option will set the system clock using the hardware clock's time, and
the - -systohc option resets the hardware clock using the system time. Use the --set
and --date options to set the hardware clock to a certain time.

sudo hwclock --systohc

The time zone was set when you installed your system. If you need to change it, you can
copy a new time zone from the files in the /usr/share/zoneinfo subdirectories. They
are arranged by location and city. Copy the new time zone to the /etc/localtime file.

Notifications

The Settings Notifications tab lets you configure notifications for different applications.
You can also have the options show pop-up notices or show notices on the lock screen.
Both are turned on by default. A listing of supported applications for notifications is
displayed (see Figure 3-33).
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Q Settings Notifications
T Wi-Fi

Notification Popups
3 Bluetooth s
@ Background Lock Screen Notifications
A Notifications

Applications

Q  Search

a Archive Manager

o Clocks

g Desktop Sharing

B Region & Language
€ Universal Access
9 Online Accounts
W Privacy L__f® Evolution

«5 Sharing . Files

Figure 3-33. Notifications dialog

(i
B |

On

On

On

On

On

Click an application to display a dialog from which you can turn notifications for the

application on or off, as well as set options such as sound alerts, pop-up notifications,

and lock screen notification (see Figure 3-34).
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Archive Manager
Notifications
Sound Alerts

Notification Popups
Notifications will continue to appear in the notification list
when popups are disabled.

Show Message Content in Popups

Lock Screen Notifications

o Wsflslalf

Show Message Content on Lock Screen

i

Figure 3-34. Notification settings for an application

Privacy

The Settings Privacy tab allows you to turn privacy features, such as the screen lock,
usage and history logs, and the purging of trash and temporary files, on or off

(see Figure 3-35). Screen Lock and Usage & History are turned on by default. The Purge
Trash & Temporary Files and Location Services are turned off. Location Services allows
your geographical location to be determined.
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Q Settings Privacy x

I Region & Language

Screen Lock Off
€ Universal Access
D¢ Online Accounts Location Services On

Usngs & History on

« Sharing

Purge Trash & Temporary Files Off
1) Sound
fe Power Problem Reporting Automatic

E

@? Network

Figure 3-35. Privacy

Clicking the Screen Lock entry opens the Screen Lock configuration dialog, from
which you can turn the Screen Lock on or off or set it to turn on after a period of idle time
and allow or deny notifications on the Screen Lock screen (see Figure 3-36).

Screen Lock x

The Screen Lock protects your privacy when you are away.

Automatic Screen Lock ﬂ:]

Lock screen after blank for Screen Turns Off =

Show Notifications m:]

Figure 3-36. Privacy, Screen Lock configuration
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Click the Usage & History entry to open a dialog from which you can turn usage
history on or off and set how long to keep it. The entry also has a button that allows you
to clear recent history (see Figure 3-37).

Usage & History X

Remembering your history makes things easier to find
again. These items are never shared over the network.

Recently Used ﬂ:]

Retain History Forever =
Clear Recent History

Figure 3-37. Privacy, Usage & History configuration

The Purge Trash & Temporary Files entry has options to automatically empty trash
and remove temporary files (see Figure 3-38). You can also set a time limit for purging
files. These options are turned off by default. The link also has buttons that allow you to
empty trash and purge temporary files immediately.

Purge Trash & Temporary Files X

Automatically purge the Trash and temporary files to help
keep your computer free of unnecessary sensitive information.

Automatically empty Trash ‘ ”i OFF

Automatically purge Temporary Files ‘ | OFF

Purge After 30 days =
Empty Trash... Purge Temporary Files...

Figure 3-38. Privacy, Purge Trash & Temporary Files configuration
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About (System Information)

The Settings Details » About tab shows your hardware specifications (memory, CPU,

graphics card chip, and free disk space), in addition to the hostname (device name) and
the OS type (64- or 33-bit system) (see Figure 3-39). You can change the hostname here
if you wish. A Check for Updates button is displayed, which opens GNOME Software to

its Updates tab, allowing you to check for updates (see Chapter 4). If updates have been
already detected an Install Update button is displayed instead.

< Details

© Date & Time
&z Users

% Default Applications

Device name
Memory
Processor
Graphics
GNOME

OS type

Disk

Figure 3-39. Details » About

About X

Fedora 28

localhost.localdomain

7.7 GiB

Intel® Core ™ i3-4030U CPU @ 1.90GHz x 4
Intel® Haswell Mobile

Version 3.28.2

64-bit

482.6 GB

Check for updates

You can also use the hostnamectl command with the set-hostname option in a

terminal window to set the hostname.

sudo hostnamectl set-hostname richard-laptop

Just the hostnamectl command will display your hostname.
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Default Applications

The Details » Default Applications tab lets you set default applications for basic types
of files: Web, Mail, Calendar, Music, Video, and Photos (see Figure 3-40). Use the menus
to choose installed alternatives, such as Thunderbird instead of Evolution for Mail or
Shotwell instead of Image Viewer for Photos.

< Details Default Applications x
4+ About
Web | @ Firefox v
© Date & Time '
Mail | &&Evolution v
&z Users

Calendar = [JCalendar
% Default Applications
Music | t®f Rhythmbox

Video = [llVideos

4

4

4

Photos | @ Image Viewer ¥

Figure 3-40. Details » Default Applications

Using Removable Devices and Media

Fedora Linux supports removable devices and media, such as digital cameras, PDAs,
card readers, and USB printers. These devices are handled automatically with device
interfaces set up for them when needed. Removable media, such as CD and DVD discs,
USB storage disks, and digital cameras, will be displayed as entries in the Removable
Devices menu. On the Overview screen, when you click on the message number notice
at the bottom of the screen, the Removable Devices icon is displayed. Clicking this icon
displays a menu of all your removable devices, with an Eject button next to each entry.
Click an entry to open the device in its associated applications, such as a file manager
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window for a USB drive. Be sure always to click the Eject button for device entry before
removing a drive, such as a USB drive or removable disk drive. Removing the drive
before clicking eject can result in incomplete write operations on the disk.

Removable storage devices and media will also appear in the file manager Devices
sidebar with eject buttons that you can use instead of the message menu to eject the
devices. For example, when you connect a USB drive to your system, it will be detected
and can be displayed as a storage device with its own file system by the file manager.

Removable devices and media, such as USB drives and DVD/CD discs, can be
ejected using Eject buttons in the Devices section of the file manager sidebar. The
sidebar lists all your storage devices, including removable media. Removable devices
and media will have an Eject button to the right. Just click the Eject button, and the
media is ejected or unmounted. You can right-click the Device entry and, from a pop-up
menu, choose the Eject entry.

The Settings Devices » Removable Media tab lets you specify default actions for
CD Audio, DVD Video, Music Player, Photos, and Software media (see Figure 3-41). You
can select from menus the application to use for the different media. These menus also
include options for Ask What To Do, Do Nothing, and Open Folder. The Open Folder
option will open a window displaying the files on the disc. A button labeled Other Media
opens a dialog that lets you set up an association for less used media such as BluRay
discs and Audio DVD. Initially, the Ask What To Do option is set for all entries. Possible
options are listed for the appropriate media, such as Rhythmbox Media Player for CD
audio discs and Videos (Totem) for DVD-Video. Photos can be opened with the Shotwell
photo manager.
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< Devices Removable Media x
& Displays
Select how media should be handled
E3 Keyboard
CD audio | Ask what to do v
¢ Mouse & Touchpad '
DVD video | Ask what to do v
= Printers
Music player | Ask what to do v

# Removable Media
Photos | Ask what to do -

9 Tmdeibok Software | < Run Software -

£4 Wacom Tablet
Other Media...

& Color

(] Never prompt or start programs on media insertion

Figure 3-41. Details, Removable Media defaults

When you insert removable media, such as a CD audio disc, its associated
application is automatically started, unless you change that preference. If you want to
turn off this feature for a particular kind of media, you can select the Do Nothing entry
from its application drop-down menu. If you want to be prompted for options, use the
Ask What To Do entry. Then, when you insert a disc, a dialog with a drop-down menu
for possible actions is displayed. From this menu, you can select another application or
select the Do Nothing or Open Folder options.

You can turn the automatic startup off for all media by checking the box labeled
Never Prompt or Start Programs on Media Insertion, which is at the bottom of the
Removable Media tab.

Sharing

On the Sharing dialog, you can allow access to your account and your screen. A switch
lets you turn all sharing on or off (see Figure 3-42). You can also choose what network
device to use you if you have more than one.
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svs I -

€ Universal Access
9 Online Accounts
W Privacy
1" Sound
[f& Power

g? Network

Figure 3-42. Sharing

Computer Name

localhost.localdomain

File Sharing Off
Media Sharing Off
Remote Login Off

Clicking the File Sharing entry opens a dialog from which you can allow access to your

Public folder by other users. You can also require and set a password (see Figure 3-43).

Media Sharing allows you to share the Music, Videos, and Pictures folders.
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BN | Fite Sharing x

File Sharing allows you to share your Public
folder with others on your current network
using: dav://linux.local

Require Password | OFF

dSSWOIC  FE XN RNN

Networks

A e EX

Figure 3-43. Sharing, File and Media access by other users

Power Management

For laptops and systems with remote battery devices such as mice, a power icon is
displayed in the System Status Area (right side of the top bar). The System Status Area
menu shows the current strength of the battery (see Figure 3-44). The entry expands to
show a Power Settings entry, which you can use to open the Settings Power dialog.

[#) Fully Charged

Power Settings

Figure 3-44. GNOME Power Manager menu

The GNOME Power manager is configured with the Power tab, accessible as Power
from Settings (see Figure 3-45). The dialog is organized into four sections: Battery, Devices,
Power Saving, and Suspend & Power Off. On laptops, the Battery section shows the battery
charge. The Devices section shows the strength of any remote devices, such as a wireless
mouse. In the Power Saving section, you can set power saving features for your monitor,
wireless devices, and network connections. When it’s inactive for a period of time, you can
choose to turn off the screen, as well as dim it whenever it is inactive. For laptops, you can
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also set the screen brightness. You can also choose to turn off Bluetooth, WiFi, and Mobile

broadband. In the Suspend & Power Off section, you can turn on the automatic suspend

for when a system remains inactive and when the power button is pressed.

Using the GNOME Tweak Tool’s Power tab, you can further specify the action to take,

such as suspend or shut down, when the laptop lid is closed.

Q Settings

3 Bluetooth

@ Background

A Notifications

Q, Search

B Region & Language
€ Universal Access
P Online Accounts
W Privacy

=5 Sharing

49 Sound

(& Power

@2 Network

%o Devices >

B Details >

{9 Sound

(& Power

o2 Network

"o Devices >

Power

Battery

Fully charged

Devices

Wireless Mouse M525 100%

Power Saving

Screen brightness

Keyboard brightness

Dim screen when inactive

Blank screen

Wi-Fi
Turn off Wi-Fi to save power.

Bluetooth
Turn off Bluetooth to save power

Suspend & Power Button

Automatic suspend

When the Power Button is pressed

Figure 3-45. GNOME Power manager

100%

Suspend -

:

5 minutes -
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Off
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powertop, tuned, and BLTK

For more refined power management, you can use the powertop and tuned tools. The
powertop tool runs in a terminal window as the root user. It will detect and display
information about the use of the CPU by running applications and connected devices.
Recommendations are listed on how to configure the power usage. To display a listing of
the powertop results including recommendations, add the -d option.

sudo powertop

For automatic tuning of hard disk and network devices, you can use tuned (the tuned
and tuned utils packages). The tuned daemon monitors your system and tunes the
settings dynamically. You can use tuned's diskdevstat and netdevstat tools to monitor
your hard disk and network devices.

For laptops, you can use the Battery Life Tool Kit (BLTK) to test and analyze battery
performance. Options specify different types of workloads, such as -0 for office suite
use and -P for multimedia usage. Depending on the option you specified, different
applications will open and run during the test, such as LibreOffice Writer or the Totem
multimedia player.

bltk -0
You can also run the test on desktop systems using an -a option.

bltk -a -0

Mouse and Touchpad

The Mouse & Touchpad tab is the primary tool for configuring your mouse and touchpad
(see Figure 3-46). Mouse preferences allow you to choose the mouse’s speed, the
primary button, and scrolling. A Test Your Settings button lets you check clicks, speed,
and scrolling. For laptops, you can configure your touchpad, enabling touchpad clicks
and disabling them when typing. You can turn the touchpad on or off.

The GNOME Tweak Tool’s Keyboard and Mouse tab has options to enable a middle-
click paste for the mouse and to highlight the location of the pointer on the screen.

86



£ Devices

14

Displays
E® Keyboard
= Printers
# Removable Media
€ Thunderbolt
£ Wacom Tablet

& Color

CHAPTER 3  USAGE BASICS: LOGIN, DESKTOP, AND HELP
Mouse & Touchpad Test Your Settings x
~ General B B -
Primary Button
Sets the order of physical buttons Left Right
on mice and touchpads.
Mouse
Mouse Speed
Matural Scrolling OFF
Scrolling moves the content, not the view —
Touchpad
Touchpad

Matural Scrolling

Scrolling moves the content, not the view

Touchpad Speed

Tap to Click

Two-finger Screlling

Edge Scrolling

Figure 3-46. GNOME system tools, mouse and touchpad

Display (Resolution and Rotation)

The display drivers for Linux used on Fedora Linux support user-level resolution
and orientation changes. Any user can specify a resolution or orientation, without
affecting the settings of other users. The Settings Devices » Displays tab provides a
simple interface for setting orientation, resolution, and refresh rate for your monitor
(see Figure 3-47). Click on an entry to display an appropriate menu listing possible
configurations. From the resolution menu, you can set the resolution.
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< Devices

Built-in display

E2 Keyboard
§° Mouse & Touchpad
= Printers

Removable Media

¢ Thunderbolt
£ Wacom Tablet

& Color

Displays
Orientation Landscape
Resolution 1366 = 768 (16:9)
Refresh Rate 60.04 Hz
Night Light Off
Resolution 1366 = 768 (16:9)
1366 x 768 (16:9)
Refresh Rate 1280 x 720 (16:9)
11024 = 768 (4:3) |
800 = 600 (4:3)
Niaht Liaht orr
Orientation Landscape
Landscape
Resolution 1 Portrait Right
Portrait Left
Refresh Rate

Figure 3-47. Displays
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The graphics interface for your desktop display is implemented by the X Window
System. The version used on Fedora Linux is X.org (x.org). X.org provides its own
drivers for various graphics cards and monitors. You can find out more about X.org at
www. X.0rg. X.org will automatically detect most hardware. The /etc/X11/xorg.conf
file is no longer used for the open source drivers (nv and amd). Information such as the
monitor used is determined automatically.

Universal Access

The Universal Access dialog in Settings lets you configure alternative access to your
interface for your keyboard and mouse actions. Four sections set the display (Seeing),
sound properties (Hearing), typing, and point-and-click features. Seeing lets you
adjust the contrast and text size, and whether to allow zooming or use of screen reader
(see Figure 3-48). Hearing uses visual cues for alert sounds. Typing displays a screen
keyboard and adjusts key presses. Pointing and Clicking lets you use the keyboard for
mouse operations.
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Figure 3-48. Universal Access
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Keyboard and Language

The Settings Keyboard dialog shows tabs for shortcuts (see Figure 3-49). You can assign
keys to perform such tasks as starting the web browser. The plus button at the bottom of
the screen lets you create custom shortcuts. The Reset All button resets the shortcuts to
their default values. Click on an entry to set the shortcut. When the Set Shortcut dialog
appears, type the keys for the shortcut, usually three. The keys appear on the next dialog
with a Set button in the upper-right corner. The changed entry then appears on the
Keyboard dialog with a delete box you can click to remove your shortcut setting. The plus
button opens an Add Custom Shortcut dialog where you enter the name and command
before setting the shortcut.

On the GNOME Tweak Tool’s Keyboard & Mouse tab, you can click the Additional
Layout Options button to display a dialog where you can specify the behavior of certain
keys, such as the key sequence to stop the X server, the Caps Lock behavior, and the
numeric keypad layout.

< Devices Keyboard Q 5

& Displays

Keyboard Shortcuts Reset All...
B3 Keyboard
Launchers

§° Mouse & Touchpad

Home folder Explorer
= Printers Launch calculator Calculator
§ Removable Media Launch email client Mail

Launch help browser Disabled
¢ Thunderbolt

Launch web browser WWW
Bi Wacom Tablet Search Search
e Color Settings Tools

Mavigation

Figure 3-49. Keyboard
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The Region & Language dialog lets you set the input source for the keyboard
(see Figure 3-50). The current input language source is listed and selected. You can
access the Region & Language dialog directly from Settings. Click the plus (+) button
to open a dialog listing other language sources, which you can add. Click the Keyboard
button to see the keyboard layout of your currently selected input source.

Q Settings Region & Language x
= Wi-Fi |

$ Bluetooth Language English (United States)

@ Background Formats United States (English)

A Notifications

Input Sources
Q, Search
English (US)
B3 Region & Language
= — A v R

€ Universal Access

9 Online Accounts

Figure 3-50. Region & Language dialog with input sources

Color Profiles (GNOME Color Manager)

You can manage the color for different devices by using color profiles specified with
the Color tab accessible from Settings. The Color tab lists devices for which you can
set color profiles. Click the menu button at the right of the device entry to display the
color profiles for that device (see Figure 3-51). Your monitor will have a profile set up
automatically. Click on a profile to display buttons to Set For All Users, Remove Profile,
and View Details. Click the View Details button for the color profile information.
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< Devices Color x
& Displays
Each device needs an up to date color profile to be color
managed. Learn more
B8 Keyboard
§° Mouse & Touchpad Laptop Screen E &
= Printers v  Automatic - Inspiron 3542
& Removable Media Set for all users | Remove profile View details
€ Thunderbolt
£ Wacom Tablet
Inspiron 3542 x

Information CIE1931 TRC From sRGB TosRGB  Metadata

Profile type Display device
Colorspace RGB
Created May 18 2018, 05:32:57 PM
Version 4.3
Manufacturer AU Optronics
Madel Inspiron 3542
Display correction No
White point 6400K
Copyright  This profile is free of known copyright restrictions.
File size 1.3 kB
Filename /home/richard/.local/share/icc/edid-a5b8cc84cdf48dbe931986930d3303b8.icc

Figure 3-51. Color management dialog
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Online Accounts

You can configure your online accounts using the Online Accounts dialog in Settings.
Instead of separately configuring mail and chat clients, you can set up access once, using
online accounts. Click on an entry to start the sign-in procedure. You are prompted to

sign in using your email and password. Access is provided to Google, Facebook, Flickr,
Microsoft, Microsoft Exchange, Nextcloud, Foursquare, and Pocket. Once access is granted,
you will see an entry for service. Clicking on the service shows the different kinds of
applications that it can be used for, such as mail, calendar, contacts, chat, and documents
(see Figure 3-52). Switches that you can use to turn access on and off are provided.

Q Settings Online Accounts x
@ Background

& Hioiiotions Connect to your data in the cloud

Q Search

Add an account

B3 Region & Language

5 coogee
€ Universal Access -
¥ Online Accounts a Nextcloud

Privac

Py n Facebook
«% Sharing

B Microsoft
49 Sound L=
Ce Power @@ Flickr
@? Network pm—

u Pocket

Figure 3-52. Online Accounts dialog
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Accessing File Systems and Devices

When you attach an external storage device such as a USB, CD/DVD-ROM, or ESATA
drive, it will be mounted automatically, and you will be prompted to open it in a file
manager window. Be sure to unmount (eject) a drive before removing it, so that data
will be written.

Your file systems and removable media appear as entries in the file manager sidebar
(see Figure 3-53). External devices such as USB drives are mounted automatically and
have Eject buttons next to their entries. Internal hard drive partitions not mounted at boot,
such as Windows file systems, are not mounted automatically. Double-click the hard drive
partition entry to mount them. An Eject button then appears next to the hard drive entry.
You are also prompted to open the drive’s file system in a new file manager window.

© Fedora-WS-Live-28-1-1 &

M USB30FD

»

Figure 3-53. Devices sidebar in the file manager window

File systems on removable media will also appear automatically as entries directly on
your desktop notifications dialog (see Figure 3-54). A notice briefly appears at the top of
the screen that shows the name of the device. If you move your mouse to the notice, an
Open with notice appears, which you can click to open the device. Should you not open
the device at this time, you can later display it in the message tray. The message tray
remains hidden, unless you access it manually by clicking the date button at the center
of the top bar, or by pressing the Super key with the m key on the keyboard (Super+m,
Super is the Windows key—see Figure 3-54). Clicking the device message opens itin a
new file manager window.

When you eject a removable device, a notice briefly appears letting you know you
can remove it (see Figure 3-55). A notice will also appear on the message tray.
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Tue 11:04
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Figure 3-54. Removable Devices notifications

Tue 11:06
y unplugged

L

Tue 11:05

safely unplugged

Figure 3-55. Removable Devices notifications, Eject

A DVD/CD-ROM is automatically mounted when you insert it into your DVD/
CD-ROM drive, displaying an entry for it in the file manage sidebar. The same kind of
access is also provided for card readers, digital cameras, USB drives, and external USB/
ESATA hard drives (hot-plugged). When you attach an external USB/ESATA drive, it will
be mounted automatically and opened in a file manager window. Be sure to unmount
(eject) the USB and external USB/ESATA drives before removing them, so that data will
be written.

If you have already configured associated applications for video and audio DVD/
CDs, or disks with images, sound, or video files, the disk will be opened with the
appropriate application, such as Shotwell for images, Rhythmbox for audio, and Movie
Player for DVD/video. If you have not yet configured these associations, you will be
prompted to specify which application you want to open it with.
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To see network resources, click the Other Location entry in the file manager sidebar.
The Networks section will list your connected network computers. Opening these
networks displays the shares they provide, such as shared folders that you can have
access to. Drag-and-drop operations are supported for all shared folders, letting you
copy files and folders between a shared directory on another computer with a directory
on your system. You first must configure your firewall to accept Samba connections
before you can browse Windows systems on GNOME. Opening a network resource may
require you to log in to access the resource.

Video Drivers

You can obtain the NVIDIA vendor graphics drivers from RPM Fusion (the nonfree
repository). You can download and install them with DNFE. RPM Fusion is the best
repository for specialized kernel drivers and modules. Keep in mind, however, that due
to open sourcing of some of the NVIDIA vendor driver software, the X.org open source
versions are becoming almost as effective, especially for 2D display support. For normal
usage, you might not need vendor driver support.

Installing the NVIDIA drivers can be a complex operation depending on what
graphics card you have. The drivers are located on the RPM Fusion repository, not on
Fedora. Check the RPM Fusion site for instructions on installing the NVIDIA drivers.

https://rpmfusion.org/Howto/Nvidia

For a simple install, a search on nvidia displays NVIDIA modules for each kernel
version. The vendor graphic drivers use two packages, one for the supporting software
and another for the kernel. The kernel modules are specific to the kernel you are using.
Each time you update to a new kernel, you will require a new graphics kernel module
created specifically for that kernel. This will be automatically downloaded and installed
for you as a dependent package when you update your kernel (the RPM Fusion non-free
repository must be active). The driver package is named xorg-x11-drv-nvidia and the
kernel module generator is named akmod-nvidia.

xorg-x11-drv-nvidia
akmod-nvidia
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You can use adnf list command entered in a terminal window with nvidia* to list
all NVIDIA packages.

dnf list nvidia*

You can then use the dnf install command to install the packages you need.
AMD drivers have been fully open sourced. You can download and install the driver
from the Fedora repository. The name of the driver is amdgpu.

xorg-x11-drv-amdgpu

You could use a dnf command entered in a terminal window that references all the
NVIDIA packages, by using an asterisk (*), for example:

dnf install nvidia*

If, once installed, your vendor driver fails (hangs or freezes), you must remove the
vendor software packages. The easiest way to do this is to start up your system in the
command-line mode. When the boot menu displays, edit the Fedora kernel line (press e)
and add a 3 at the end of the 1inux line (see “GRUB Start Menu and Boot Problems,” at the
beginning of this chapter). You start up with the command-line interface. Log in as the
root user and then use the dnf command to remove the vendor driver, such as NVIDIA.
Use an asterisk (*) to select all the vendor packages. The following example will remove
all the NVIDIA vendor packages.

sudo dnf remove nvidia*

When you restart, your system reconfigures automatically to the originally installed
Xorg drivers.

Multimedia Support: MP3, DVD Video, and DivX

Due to licensing and other restrictions, the Fedora distribution does not include MP3,
DVD video, or DivX media support. You cannot play DVD video disks or DivX files after
installing Fedora. RPM Fusion (https://rpmfusion.org) and Negativol7.org
(https://negativo17.org) provide the needed libraries and support files for these
media formats. These are RPM packages that you can install with dnf, after first
downloading and installing their repository configuration files. Use one or the other, not
both. Their packages may conflict.
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The commercial DVD-Video codec (DVDCSS) is available from the the Livna
repository, http://www.livna.org.

DivX support can be obtained using the open source version of DivX, called Xvid
(xvid-core). It’s available on the RPM Fusion and Negativol7.or repositories and will
play most DivX files.

Check https://fedoraproject.org/wiki/Multimedia for more information.
There are many forbidden items that cannot be included with Fedora, due to licensing
restrictions, including MP3 support, Adobe Reader, and NVIDIA vendor-provided
drivers. Check https://fedoraproject.org/wiki/ForbiddenItems for details.

Terminal Window

The Terminal window allows you to enter Linux commands on a command line. It also
provides you with a shell interface for using shell commands instead of your desktop.
The command line is editable, allowing you to use the Backspace key to erase characters
on the line. Pressing a key will insert that character. You can use the left and right arrow
keys to move anywhere on the line, and then press keys to insert characters, or use
backspace to delete characters (see Figure 3-56). Folders, files, and executable files are
color-coded: black for files, blue for folders, green for executable files, and aqua for links.
Shared folders are displayed with a green background.

The terminal window will remember the previous commands you entered. Use the
Up and Down arrows to have those commands displayed in turn on the command line.
Press the Enter key to re-execute the currently displayed command. You can even edit
a previous command before running it, allowing you to execute a modified version of a
previous command. This can be helpful if you need to re-execute a complex command
with a different argument, or if you mistyped a complex command and want to correct
it without having to re-type the entire command. The terminal window will display all
your previous interactions and commands for that session. Use the scroll bar to see any
previous commands you ran and their displayed results.

99


http://www.livna.org
https://fedoraproject.org/wiki/Multimedia
https://fedoraproject.org/wiki/ForbiddenItems

CHAPTER 3 USAGE BASICS: LOGIN, DESKTOP, AND HELP

Activities [ Terminal = Fri 18:48

New Window

Preferences

my er vacation.odt =]
[richard@localhost Documents]$ H

Help
About

Quit

Figure 3-56. Terminal window

You can open as many terminal windows as you want, each working in its own shell.
Instead of opening a separate window for each new shell, you can open several shells in
the same window, using tabs. Use the keys Shift+Ctrl+t or click the Open Tab item on the
File menu to open a new tab. A tab toolbar opens at the top of the terminal window with
the folder name and a close button for each tab. Each tab runs a separate shell, letting
you enter different commands in each (see Figure 3-57). You can right-click on the tab's
folder name to display a pop-up menu to move to a different tab, or just click on a tab's
folder name. You can also use the Tabs menu, or the Ctrl+PageUp and Ctrl+PageDown
keys, to move to different tabs. The Tabs menu is displayed if multiple tabs are open.

richard@localhost:~/Videos
File Edit View Search Terminal Tabs Help
i@localhost:~/Document: richard@localhost:~/Videos

[richard@localhost Documents]$ cd .. () richard@localhost:~/Documents

[richard@localhost ~]$ cd Videos S _
(® richard@localhost:~/Videos

[richard@localhost Videos]$ 1s

[richard@localhost Videos]$ []

Figure 3-57. Terminal Window with tabs
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The terminal window also supports desktop cut/copy and paste operations. You can
copy a line from a web page and then paste it to the terminal window (you can use the
Paste entry on the Terminal window's Edit menu or press Shift+Ctrl+v). The command
will appear and then you can press Enter to execute the command. This is useful for
command-line operations displayed on an instructional web page. Instead of typing
in a complex command yourself, just select and copy from the web page directly and
then paste to the Terminal window. You can also perform any edits on the command,
if needed, before executing it. Should you want to copy a command on the terminal
window, select the text with your mouse and then use Shift+Ctrl+c keys (or the Copy
entry on the Terminal window's Edit menu) to copy the command. You can select part of
a line or multiple lines, as long as they are shown on the terminal window.

You can customize terminal windows using profiles. A default profile is set up
already. To customize your terminal window, select Preferences from the Edit menu.
This opens a window for setting your default profile options with option categories on
the sidebar for Global and Profiles. In the Profiles section there will be an Unnamed
profile, the default. Click on the down menu button to the right to open a menu with
the options to copy the profile or change the name. To add another profile, click on the
plus button to the right of the Profiles heading to open a dialog to create a new profile.
For profiles you create you have the added options to delete them and or to set one as
the default. A selected profile displays tabs for Text, Colors, Scrolling, Command, and
Compeatibility (see Figure 3-58). On the Text tab, you can select the default size of a
terminal window in text rows and columns.
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Preferences - Profile “Unnamed”

Global Tex Colors

N Text and Background Color
General

Use colors from system theme
Shortcuts Built-in schemes:  Tango dark =

Text Background

Default color: -

Bold color:

Cursor color: -

Profiles +

Unnamed & ~

Highlight color: [l

Transparent background

Palette

Built-in schemes:  Tango -
Color palette: - -
EHE EEENEN

+ Show bold text in bright colors

Figure 3-58. Terminal Window Profile configuration

Your terminal window will be set up to use a dark background with white text. To
change this, you can edit the profile to change the background and text colors on the
Colors tab. De-select the Use Colors from System Theme entry. This enables the Built-

In Schemes menu from which you can select a Black on White display. Other color
combinations are also listed, such as Black on Light Yellow and Green on Black. The
Custom option lets you choose your own text and background colors. The colors on your
open terminal window will change according to your selection, allowing you to see how
the color choices will look. For a transparent background, choose the Use Transparent
Background entry and then set the amount of shading (none is completely transparent
and full shows no transparency).
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The Scrolling tab specifies the number of command lines your terminal history will
keep, as well as other scroll options such as the scroll speed and whether to display
the scroll bar. These are the lines you can move back through and select to re-execute.
You can unselect the Limit Scrollback option to set this to unlimited to keep all the
commands.

You can create new profiles with customized preferences. To create a new profile,
choose New Profile from the File menu to open the New Profile window where you can
enter the profile name and select any profile to base it on. The default profile is chosen
initially. Use the Change Profile submenu on the Terminal menu to change profiles.

To edit a particular profile, select Preferences from the Edit menu to open the
Preferences window, and then click on the one you want in the Profiles section.

Command-Line Interface

When using the command-line interface, you are given a simple prompt into which you
type a command. Even when you are using a desktop like GNOME, you sometimes need
to execute commands on a command line. You can do so in a terminal window, which is
accessed from the dash.

Linux commands make extensive use of options and arguments. Be careful to place
your arguments and options in the correct order on the command line. The format for a
Linux command is the command name followed by options, and then by arguments, as
shown here:

$ command-name options arguments

An option is a one-letter code preceded by one or two hyphens, which modifies the
type of action the command takes. Options and arguments may or may not be optional,
depending on the command. For example, the 1s command can take an option, -s. The
1s command displays a listing of files in your directory, and the -s option adds the size
of each file in blocks. You enter the command and its option on the command line as
follows:

$ 1s -s

If you are uncertain what format and options a command uses, you can check the
command syntax quickly by displaying its man page. Most commands have a man page.
Just enter the man command with the command name as an argument.
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An argument is data the command may need to execute its task. In many cases,
this is a filename. An argument is entered as a word on the command line that appears
after any options. For example, to display the contents of a file, you can use the more
command with the file’s name as its argument. The less or more command used with

the filename mydata would be entered on the command line as follows:
$ less mydata

The command line is actually a buffer of text you can edit. Before you press Enter to
execute the command, you can edit the command on the command line. The editing
capabilities provide a way to correct mistakes you make when typing a command and
its options. The Backspace key lets you erase the character you just typed (the one to the
left of the cursor), and the Del key lets you erase the character the cursor is on. With this
character-erasing capability, you can backspace over the entire line if you want, erasing
what you entered. Ctrl+u erases the whole command line and lets you start over again at
the prompt.

You can use the Up Arrow key to redisplay your last executed command. You can
then re-execute that command, or you can edit it and execute the modified command.
This is helpful when you have to repeat certain operations, such as editing the same file.
It is also helpful when you have already executed a command you entered incorrectly.

Running Windows Software on Linux: Wine

Wine is a Windows compatibility layer that allows you to run many Windows
applications natively on Linux. The actual Windows operating system is not required.
Windows applications will run as if they were Linux applications, and they can access the
entire Linux file system and use Linux-connected devices. Applications that are heavily
driver-dependent, such as graphic-intensive games, may not run. Others that do not rely
on any specialized drivers may run very well, including Photoshop, Microsoft Office,
and newsreaders like Newsbin. For some applications, you may also have to copy over
specific Windows dynamic link libraries (DLLs) from a working Windows system to your
Wine Windows System32 or System directory.

Once installed, Wine applications can be accessed from the Other overview. These
applications include Wine configuration, the Wine software uninstaller, and the Wine file
browser, as well as a Regedit registry editor, a notepad, and a Wine help tool.
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To set up Wine, start the Wine Configuration tool. This opens a window with tabs
for Applications, Libraries (DLL Selection), Audio (Sound Drivers), Drives, Desktop
Integration, and Graphics. On the Applications tab, you can select the version of
Windows an application is designed for. The Drives tab lists your detected partitions,
as well as your Windows-emulated drives, such as drive C. The C drive is actually just a
directory, .wine/drive_c, and not a partition of a fixed size. Your actual Linux file system
will be listed as the Z drive.

Once configured, Wine will set up a .wine directory on the user’s home directory.
(The directory is hidden, so Show Hidden Files must be enabled in the file manager View
menu to display it.) Within that directory will be the drive_c directory, which functions
as the C drive that holds your Windows system files and program files in the Windows
and Program File subdirectories. The System and System32 directories are located in
the Windows directory. This is where you place any needed DLL files. The Program Files
directory holds your installed Windows programs, just as they would be installed on a
Windows Program Files directory.

To install a Windows application with Wine, double-click the application install icon
in a file manager window, or right-click the application install icon and choose Open
with Wine Windows Program Loader. Alternatively, you can open a terminal window and
run the wine command with the Windows application as an argument. The following
example installs the popular Newsbin program:

$ wine newsbin.exe

Icons for installed Windows software will appear on your Other overview. Just
double-click an icon to start up the application. It will run normally within a Linux
window, as would any Linux application.

Wine works on both .exe and .msi files installation files. You may have to make
them executable by checking the file’s Execute check box (from the Permissions tab on
the Properties dialog).

Tip Alternatively, you can use Crossover Office, the commercial Windows
compatibility layer. This is a commercial product tested to run certain applications
such as Microsoft Office. Check https://www.codeweavers.com for more
details. Crossover Office is based on Wine, which CodeWeavers supports directly.
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Help Resources

A great deal of support documentation is already installed on your system, in addition to

being accessible from online sources. Table 3-2 lists Help tools and resources accessible

on your Fedora Linux system.

Table 3-2. Fedora Linux Help Resources

Resource Description

KDE Help Center KDE Help tool, desktop interface for documentation on
KDE desktop and applications, man pages, and info
documents

GNOME Help Browser GNOME Help tool, desktop interface for accessing
documentation for the GNOME desktop and applications

/usr/share/doc Location of application documentation

man command

info application

https://fedoraproject.org

https://docs.fedoraproject.org

https://www.redhat.com

https://library.gnome.org
https://fedoratorum.org

https://fedorasolved.org
https://ask.fedoraproject.org

Linux man pages, detailed information on Linux
commands, including syntax and options

GNU info pages, documentation on GNU applications

Fedora Project site, with numerous documentation,
FAQ, and help resources and links, with links to forums,
newsgroups, and community websites

Online documentation, guides, HOWTQs, and FAQs for
Fedora Linux

Red Hat Enterprise documentation, guides, HOWTOs,
and FAQs; located under Support and Documentation;
much of the Red Hat Linux documentation may be
helpful

GNOME documentation site

End-user discussion support forum, endorsed by the
Fedora Project; includes FAQs and news links

Solutions to common problems

Ask Fedora site, on which you can ask questions and
search for previously answered questions
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GNOME and KDE Help

Both the GNOME and KDE desktops feature Help systems that use a browser-like
interface to display help files (Utilities » Help). To start the GNOME Help browser,
search for help on the Applications overview (see Figure 3-59). It opens with the GNOME
desktop guide, showing links for desktop tasks and topics such as video, GNOME
Settings, networking, and universal access. The Go menu’s All Documents entry lists
links for manuals for different applications, such as the Archive Manager, Empathy,
Gedit, and the Totem movie player. The GNOME Help browser and the KDE Help
Center also incorporate browser capabilities, including bookmarks and history lists for
documents you view.

Both GNOME and KDE, in addition to other applications, provide context-sensitive
help. Each KDE and GNOME application features detailed manuals that are displayed
using their respective Help browsers. Also, system administrative tools feature detailed
explanations for each task.

< | > GNOME Help x||lQ = x
a

% GNOME Help

Getting Started with GNOME

New to GNOME? Learn how to get around.

Introduction to GNOME

A visual introduction to your desktop, the top bar, and the Activities overview.

Log out, power off or switch users

Learn how to leave your user account, by logging out, switching users, and so on.

Start applications

Launch apps from the Activities overview.

Your desktop Networking, web & email Sound, video & pictures

Calendar, no ans, keyboard shortcuts, Wireless, connection problems, web Digital cameras, iPods, editing photos, playing
nindows and 43 f)lf.'.'.'&..".:._;. videos.

Files, folders & search User & system settings Hardware & drivers

Searching, delete files, backups, removable Keyboard, mouse, display, languages, user

drives accounts.

Universal access Tips & tricks Get more help ’/‘ "\

Seeing, hearing, mobility, braille, screen Special characters, middle click shortcuts Tips on using this guide, help improve this
magnifier quide, mailing lst, IRC

About

Figure 3-59. GNOME Help browser
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Application Documentation

On your system, the /usr/share/doc directory contains documentation files installed by
each application. Within each directory, you can usually find HOWTO, README, and
INSTALL documents for that application.

The Man Pages

Each Linux command usually has a corresponding man page that describes its syntax,
options, and examples of its use. A man page is a screen of text displayed from the
command line, which you can access from a terminal window. To display a man page,
enter the man command with the name of the command you want information about.
The following example asks for information about the 1s command:

$ man 1s

Use basic keyboard keys to navigate the page. Press the spacebar to display the next
page. The b key moves you back a page. When you finish, press the q key to quit. To
perform a search, press either the slash (/) or question mark (?). The / searches forward,
and the ? searches backward. When you press the /, a line opens at the bottom of your
screen on which you enter a word to search for. Press Enter to activate the search. You
can repeat the same search by pressing the n key.

The Info Pages

Some applications also provide info page documentation. The info pages are similar
to man pages but tend to be more detailed. You can also access this documentation by
entering the info command, to display a listing of applications. The info interface has
its own set of commands. You can learn more about it by entering info info. Them
command lets you search for an application by using a search pattern.

Web Resources

You can obtain documentation on Fedora from the Fedora Project site at https://docs.
fedoraproject.org and from the Fedora forum at https://fedoraforum.org. The Ask
Fedora Project site at https://ask.fedoraproject.org displays answers to common
questions and lets you ask your own.
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Most Linux applications are covered by the Linux Documentation Project. It shows
you how to use the desktop and takes you through a detailed explanation of Linux
applications. The GNOME and KDE websites also contain extensive documentation.

Shared Network Access for Windows (Samba):
Samba

Shared Windows folders and printers on any of the computers connected to your local
network are automatically accessible from your Fedora desktop. Supporting Samba
libraries are already installed and will let you access directly any shared Windows
folders. Currently, both Linux and Windows are in the process of transitioning from the
older SMBv1 protocol (Server Message Block) to the more secure SMBv3 protocol. As a
result, network browsing through the Linux file manager does not work currently. You
can access Windows shares directly using the Connect to Server entry on the GNOME
file manager's Other Locations window. Enter the smb:// protocol and the name of the
shared folder or that of the remote Windows system you want to access (see Figure 3-60).
After being prompted to enter your password (see Figure 3-61), the particular shared
folder or the shared folders on that host will be displayed (see Figure 3-62).

v Videos

{@ Trash

+ Other Locations Connect to Server smb://richard-asus/ © - Connect

Figure 3-60. Accessing Windows shared folders on GNOME
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Password required for richard-asus

Username

Domain | WORKGROUP

Password o...ooooool

() Forget password immediately
(¢) Remember password until you logout
() Remember forever

Figure 3-61. Password for Samba Windows access

r

> <« | Windows shares on richard-asus » Q ||i=|| =
© Recent h
* Starred
r Home  c— —  —
ADMIN Cs myshared-data
[ Documents
<, Downloads . . '
dd Music
— :___ - . _'.u'__ . - — — -
[ Pictures print$ Samsung_Printer$ Users
v Videos
{@) Trash

+ Other Locations

Figure 3-62. Windows shared folders, accessed from Fedora Linux
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Should you want to share a Linux folder on your Ubuntu computer with users on
other Windows computers, you must install Samba and have the Server Message Block
services enabled, using the smb and nmb daemons. Before you can use Samba, your
network has to have a configured and running Samba server on a Linux system. If your
network does not have a Samba server, you can install one on your Fedora workstation.
The name of the Samba package is samba. You will have to use the dnf install
command in a terminal window to install it. This will install an /etc/samba/smb.conf
file, which you can use to configure Samba.

sudo dnf install samba

The names of the Samba servers are smb and nmb. Be sure to enable them. They are
started automatically when you start up your system.

sudo systemctl enable smb
sudo systemctl enable nmb
sudo systemctl start smb
sudo systemctl start nmb

You will also have to create a Samba user for accessing any shared folders on your
Fedora system. You can use the pdbedit command with the -a option to add a user
(alternatively you can use the smbpasswd command, also with the -a option). This is a
user you have set up on your Fedora system, usually your username. You are prompted
to create a password, which you will use to access shares.

sudo pdbedit -a richard
new password:
re-type new password:

You will have to make sure that the firewall allows Samba access. You can use
firewall-config to do this, as described in Chapter 14. A basic command-line
operation is shown here.

sudo firewall-cmd --add-service=samba --permanent

You also have to make sure that SELinux allows Samba access. You can do this with
policycoreutils-gui, as discussed in Chapter 12. The policycoreutils-gui package
is on the RPMFusion repository, so you will have to configure that repository first, as
discussed in Chapter 4. Use the dnf install command in a terminal window to install
the package. You have to set the Samba options on the Boolean tab. There are several
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options, depending on the level of access you want to afford. Alternatively, you could use
a simple command-line operation to allow access to your home directories. In this case,
the shared Samba folder you are creating is your home folder, the same as your username.

sudo setsebool -P samba enable home dirs on
To disable access, just turn it off.
sudo setsebool -P samba_enable home dirs off

Make sure your /etc/samba/smb. conf file has the workgroup entry set to the name of
your Windows workgroup. The default name set up by Windows is workgroup.

workgroup = workgroup

You will may have to edit the file to change its entries. Use the sudo command and an
editor such as nano or Leafpad in a terminal window. Be sure the editors are installed.

sudo nano /etc/samba/smb.conf

To add a particular shared folder, edit the /etc/samba/smb.conf file and add an
entry for it. Be sure the folder already exits. If not, create it and set the permissions you
want to give it. You will have to enter the full pathname for the folder (path), starting
from the root directory, the Samba users (valid users) that can access the folder, and
read/write permission (read only). The following are two samples of shared folders, one
for a /mydocs folder and another for the Pictures folder of the user's home directory.

[mydocs]

path = /mydocs

valid users = richard
read only = no

[Pictures]

path = /home/richard/Pictures
valid users = richard

read only = no

Once you have made your changes, run the testparm command to see if the entry
was added correctly.

Whenever you make changes to the smb. conf file, be sure to restart the Samba
servers, smb and nmb.
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sudo systemctl restart smb
sudo systemctl restart nmb

To see a list of your shares, use the smbclient -L command with your hostname
(hostname of the Samba server).

smbclient -L richard-laptop

Accessing Samba shares from Windows is an issue for Windows 10. Upgrades to
Windows 10 has disabled the SMBv1 network browsing capabilities of Windows, as it
transitions to SMBv3 from SMBv1. You could try to manually re-enable SMBv1 browsing,
but SMBv1 is being disabled due to security issues. It is not advisable to re-enable it. This
means you cannot simply browse a Linux host currently, but you can still easily set up
access to each Samba shared folder on that Linux host.

It is still easy to access your Samba Linux shares from Windows 10. You can simply
add a new network location for it. It will then be accessible from a shortcut you can set
up for it on your Windows file manager’s This PC folder. To set up the shortcut, open the
Windows file manager to any folder and right-click on the This PC entry in the sidebar
to display a menu. Click on the Add a Network Location entry to open the Add Network
Location wizard and click Next. Click on the Choose a Custom Network Location entry
and click Next. In the text box labeled Internet or Network Address, enter the hostname
of your Linux system that holds the shares you want to access, beginning with the two
backward slashes and followed by a backward slash (you may have to also enter the
name of one of the shared folders on that system).

\\richard-laptop\

You can then click the Browse button to open a dialog showing a tree of all the
shared folders on that host. You can choose a share, or any of a share's subfolders. The
file’s pathname is automatically added to the address text box. Alternatively, you could
enter the folder pathname in the text box directly with the subfolders separated by single
backward slashes. If you are sharing your Linux home directories, then the shared folder
is the name of the user's home folder, the username. Samples are shown here.

\\richard-laptop\richard
\\richard-laptop\richard\Pictures
\\richard-laptop\mydocs

Once the locations for your shared folders are set up in Windows, you can access
them again quickly from their shortcuts in the This PC folder.

113



CHAPTER 4

Installing and Updating
Software: DNF, GNOME
Software, Packages,
DnfDragora, and RPM

Fedora software is distributed through an online Fedora software repository. Table 4-1

lists Fedora software information and site locations. Software is added to your system by
accessing software repositories with the DNF package manager. The DNF package manager
replaces the YUM (Yellowdog Update, Modified) software package manager. Use the dnf
command in place of yum. Options remain much the same, and you can still use the yum
command instead. The commonly used Fedora software repositories are listed in Table 4-2.

Table 4-1. Fedora Software Information and Sites

Internet Site Description
https://getfedora.org Fedora distribution disks, download links for all formats
https://rpmfusion.org RPM Fusion repository for third-party multimedia and driver

Fedora-compliant software (Fedora Project extension)

https://fedoraproject.org/  Packages notincluded in the main Fedora software
wiki/ForbiddenItems repository

https://fedoraproject.org/  Information on multimedia packages available for Fedora
wiki/Multimedia

https://negativo17.org Negativo17.org repository for third-party multimedia and
driver Fedora-compliant software
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Software applications, with all the needed programs, configuration files, and
supporting library binaries, are combined into packages by the RPM Package Manager
that will install all the components into the appropriate system folders. DNF manages
all these RPM packages for your system, keeping track of updates and what collection of
packages belong to different systems and collections such as your desktop or office suite.
It also keeps track of dependencies, such as what supporting software an application
may need. Multimedia applications may need sound support. To easily manage DNF
operations you can use desktop frontends, such as GNOME Software, PackageKit, and
DnfDragora. GNOME Software lets you manage software by topic, whereas Packages
searches for particular RPM packages. DnfDragora does both.

Fedora provides only open source applications in its own repository. For proprietary
applications such as NVIDIA’'s own graphics drivers, or multimedia applications that
may have patent issues, you must use a third-party repository like RPM Fusion. The
list of forbidden items for the official Fedora repository can be found at https://www.
fedoraproject.org/wiki/ForbiddenItems. The list includes such items as the NVIDIA
graphics drivers.

Software Repositories

For Fedora, you can add software to your system by accessing software repositories
supporting DNE In addition, many software applications, particularly multimedia ones,
have potential licensing conflicts. By leaving such software in third-party repositories,
Fedora avoids possible legal issues. Many of the popular multimedia applications,

such as video and digital music support, can be obtained from third-party repositories
using the same simple dnf commands you use with Fedora-sponsored software. The
commonly used Fedora software repositories are listed in Table 4-2.
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Table 4-2. Fedora and Fedora-Compliant Software Repositories

Internet Site Description

https://download.fedoraproject.org  Links are provided to the best available mirror.

https://rpmfusion.org/Configuration  Fedora applications not included with the
distribution, due to licensing and other
restrictions, are provided. Go to the Configuration
page to download the DNF configuration files.

https://negativo17.org Negativo17.org repository for third-party
multimedia and driver Fedora-compliant
software.

https://get.adobe.com/flashplayer/ The Adobe repository. Select the Linux for YUM
to download the Adobe YUM configuration file.
Select YUM for Linux from the drop-down menu.

https://www.google.com/ Provides Google repositories for accessing
linuxrepositories/ Google software.

Most software is now located on the Internet-connected repositories. With the
integration of DNF into your Fedora system, you can now think of that software as an
easily installed extension of your current collection. You can find out more about how
DNF is used on “Fedora Software Management Guide”.

You could also browse many of these repositories and download packages
individually, although this is not recommended, as you would lose the automatic
updating support provided by DNE

Fedora Software Repositories

The Fedora Linux distribution provides a comprehensive selection of software, ranging
from office and multimedia applications to Internet servers and administration
services. The complete set is available on the Fedora repository. During installation,
DNF is configured on your system, to access the Fedora repository. Some third-party
applications with licensing issues are not included, though Fedora-compliant versions
are provided on associated software repositories.
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For Fedora, you can update to the latest software from the Fedora DNF repository
using GNOME Software or PackageKit's Package Updater. They are already configured to
access the Fedora repositories.

RPM Fusion

Due to licensing restrictions, multimedia support for popular operations such as MP3,
DVD, and DivXis not included with Fedora distributions. The Fedora Project associated
site, RPM Fusion (https://rpmfusion.org), does provide support for these functions.
Here, you can download support for MP3, DVD, and DivX software. This repository
integrates support previously provided by Livna, Freshrpms, and Dribble. Fedora does
include the generic X.org NVIDIA drivers, which will provide all the capabilities most
people need. You do not have to use the NVIDIA proprietary drivers.

The Fedora-compliant repositories, such as RPM Fusion, will have Fedora-compliant
DNF configuration files that you can download and install as an RPM package. You can
then use the GNOME Software, PackageKit (Packages), DnfDragora, or the dnf command
to select, download, and install software from the associated repository directly.

Adobe and Livna

Two smaller additional third-party repositories are often configured for desktop users:
the Adobe repository and the Livna repository. The Adobe repository holds packages for
the Linux version of the Adobe Flash software. (Two alternative Flash-compatible open
source versions are already available, swfdec and gnash.) The Livna repository provides
the commercial DVD video codec, 1ibdvdcss. The repository contains only this one
package. If you want to play commercial DVD video disks, you have to configure access
to this repository so that you can install the codec.

Third-Party Linux Software Archives

Though almost all applications should be included in the Fedora software repository or
its associated repositories, such as https://rpmfusion.org, you could download and
install software from third-party software archives. Always check to see if the software
you want is already in the Fedora or Fedora-associated repositories. If it is not available,
you can download it from a third-party online site.
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Several third-party repositories make it easy to locate and find information about
an application. Of particular note are https://www.sourceforge.net and https://
www. 1inux-apps.com/. Sites for Linux software are listed in Table 4-3, along with several
specialized sites, such as those for commercial and game software. When downloading
software packages, always check to see if the versions are packaged as RPM packages
and if they are already available on the Fedora and RPM Fusion repositories.

Table 4-3. Third-Party Linux Software Archives

URL Internet Site

https://sourceforge.net SourceForge, open source software development site for
Linux applications

https://www.linux-apps.com/ Linux software repository

WWW . gNU . 0Tg GNU archive
https://1gdb.org/ Linux games
https://www.fluendo.com Licensed multimedia codecs for Linux, including free MP3 code

Updating Fedora: GNOME Software and Software
Update

New updates are continually being prepared for particular software packages. These are
posted as updates that you can download from software repositories and install on your
system. They include new versions of applications, servers, and even the kernel. Such
updates may range from single software packages to whole components.

Updating your Linux system has become a very simple procedure, using the
automatic update tools. For Fedora, you can update your system by accessing software
repositories supporting the DNF (Dandified YUM) update methods. DNF uses RPM
headers to determine which packages need to be updated.

If updates are detected, GNOME Software will display an update message in the
message tray (see Figure 4-1). Clicking the entry button opens a dialog prompting you to
restart and install the updates. Clicking the Restart & Install button immediately shuts
down your system, then restarts, and, as part of the startup process, downloads and
installs updates. Once installed, a message is displayed.
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Fri 11:21
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May 18 2018
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Restart & Install Up

The system will automatically restart and install updates in 60
seconds.

Cancel Restart & Install

Fri 12:56

Friday

May 18 2018

May

Figure 4-1. Update notification message and icon

To perform manual updates, you can use either GNOME Software to perform
updates (the default), or you can use the older Package Updater. Package Updater is a
graphical update interface for DNF (part of PackageKit), which performs all updates
from the desktop. From a command line, you can perform updates using the dnf
upgrade command.

Updating Fedora with GNOME Software Update

GNOME Software is the primary update tool for Fedora. You can view updates by using
the Updates tab on GNOME Software (see Figure 4-2). The tab will display the number
of updates. Clicking an update opens a dialog showing information about the update.
Some entries, such as OS Updates, will have several packages that have to be updated
(see Figure 4-3). When you are ready, click the Restart & Update button on the header
bar to shut down your system and install the updates as it restarts.
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e All Installed Updates [T x
0OS Updates Includes performance, stability and security improvements.
— Calendar gnome-calendar 3.28.2 release. * Don't show time labels on full day events * Fix
27 | 3.28.1» 3.28.2 Week grid collapsing non-overlapping events * Force timed events square box to be...
Contacts GNOME 3.28.2
3.28.1»328.2
Evince This update fixes a crash in EvMediaPlayerKeys.
QJ 3.28.2-1» 3.28.2-2
. Evolution GNOME 3.28.2 Py
P U
v 3.28.1»3.28.2
©
Figure 4-2. GNOME Software Updates tab
05 Updates *
Includes performance, stability and security improvements.
Updates
evince 3.28.2-2.fc28 x LibRaw 0.18.8-1.fc28» 0.18.11-1fc28
. NetworkManager 1:110.6-1fc28» 1:1.10.8-1.c28
Q/ Evince
- :1.10.6-1.f :1.10.8-1.f
A Document viewer for popular document formats NetworkManager-ads| 1.1.10.6-1.fc28 » 1:1.10.8-1.1c28
NetworkManager-bluetooth 1:1.10.6-1.fc28 » 1:1.10.8-1.fc28
This update fixes a crash in EvMediaPlayerKeys. NetworkManager-config-connectivity-fed..  1:1.10.6-Lfc28 » 1:1.10.8-1fc28
NetworkManager-libnm 1:1106-1fc28» 1:1.10.8-1fc28
NetworkManager-team 1:1.10.6-1.fc28 » 1:1.10.8-1.fc28
NetworkManager-wifi 1:1.10.6-1fc28 » 1:1.10.8-1.fc28

Figure 4-3. GNOME Software: Update information dialog
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Updating Fedora with Package Updater (PackageKit)

If you install PackageKit (Packages), the Package Updater package will also have been
installed. You can, if you wish, use it to update your system, instead of using GNOME
Software. You can open Package Updater from the Applications overview. Package
Updater displays the Package Updater dialog showing your updates (see Figure 4-4).

== x

There are 140 updates available
= Package updates correct errors, eliminate security vulnerabilities, and provide new features.

OpenPrmtEng CUPS fllters and backends - cupsfilters and fontembed libraries

-libs / (b4-bit)

v Evolution extension for Exchange Web Services

on-ews-3.26.2-2.fc27 (64-bit
Translatlons for evolutlon -ews
ev n-ews-langpacks-3.26.2-2.fc27
Apphcatnon deployment framework for desktop apps

atpak-0.10.1-1.fc27 (64-bit

" Fjbran‘es for ﬂatpak o

= flatpak-libs-0.10 c27 (64-bit)
The GNU vers:on cf the AWK text processing utility
'.}.'..'.r 4.1L.9-0 27 (64-bit)

The GNOME Display Manager

V] 538.4 kB

Ubrary for creat!ng and parsmg MIME messages
gmime 30-3.0.4-1.fc: 1-bit

ot
w

+ Details

For more information about bugs fixed by this update please visit this website:
« https://bugzilla.redhat.com/show_buq.cqi?id=1512212. ?

Figure 4-4. Software Update: Selected package with displayed description

The number of updates is shown at the top, along with Install Updates button on the
right side of the title bar. To perform the updates, click the Install Updates button. If you
want to review the updates and perhaps deselect certain updates, you scroll through the
list of updates, selecting the ones you want more information on. All needed updates are
selected automatically when Software Update starts up. The check boxes for each entry
let you deselect particular packages you may not want to update. At the bottom of the
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dialog is an expandable entry name Details. This entry becomes active when you select
a package. Expanding the Details entry display information about this package's update.
The displayed information includes features such as the version and repository.

Click the Install Updates button to start updating. During the update, a status
message is displayed at the bottom of the dialog for the different update stages along
with a progress bar.

Update with the dnf Command

To perform a complete update of all your installed packages, you use the dnf command
with the upgrade option.

sudo dnf upgrade

To update just a particular package, specify that package. The following would
update an already installed Gnumeric package.

sudo dnf upgrade gnumeric

You can use the updateinfo option to see what packages need to be updated. With
no option just a count of the kinds of updates is listed. With the --1ist option, the
packages to be updated are shown. For details about each update, use the --info option.

dnf updateinfo
dnf updateinfo --list
dnf updateinfo --info

Automatic DNF Updates with dnf-automatic

If you want updates performed automatically, you can install the dnf-automatic
package. This package installs timers and services for three automatic update options:
notifyonly, download, and install. The download option notifies and downloads only.
The install option notifies, downloads, and installs. To designate an option, you enable
and start its timer. The three timers are:

dnf-automatic-notifyonly.timer
dnf-automatic-download.timer
dnf-automatic-install.timer
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To choose the download and notify option, you would enter the following in a
terminal window.

sudo systemctl enable dnf-automatic-download.timer
sudo systemctl start dnf-automatic-download.timer

To notify, download, and install, enable and start the install timer.
sudo systemctl start dnf-automatic-install.timer
To change from one option to another, be sure to disable the current one.

sudo systemctl disable dnf-automatic-install.timer
sudo systemctl enable dnf-automatic-notifyonly.timer
sudo systemctl start dnf-automatic-notifyonly.timer

Configuration for dnf-automatic is held in the /etc/dnf/automatic. conf file. The
default entries for updates, download updates and apply updates, are overridden by
the timer you have enabled. You can customize other entries such as those for email.
Check the man page for dnf.automatic for configuration details.

Installing Software Packages

Installing software is an administrative function performed by a user with administrative
access. Unless you chose to install all your packages during your installation, only
some of the many applications and utilities available to Linux users were installed on
your system. On Fedora, you can install or remove software from your system with the
GNOME Software software manager or the dnf install command. You could also use
the PackageKit (Packages) and DnfDragora package managers (not installed by default).
Alternatively, you can install software as individual packages, with the rpm command or
by downloading and compiling its source code. The procedure for installing software
using its source code has been simplified to just a few commands, though you have a
great deal of flexibility in tailoring an application to your specific system.

The dnf command remains the best way to access all available packages. GNOME
Software and PackageKit do not detect and display all the packages available, such as the
server software. They focus primarily on desktop applications.
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An RPM software package operates like its own installation program for a software
application. A Linux software application often consists of several files that must be
installed in different directories. The program is most likely placed in a directory called
/usr/bin; online manual files go in another directory; and library files go in yet another
directory. In addition, the installation may require modification of certain configuration
files on your system. The RPM software packages perform all these tasks for you. Also,
if you later decide you don’t want a specific application, you can uninstall packages to
remove all the files and configuration information from your system.

The software packages on your install disk, as extensive as they are, represent only
some of the software packages available for Fedora Linux. Most reside on the Fedora
Software repository, a repository whose packages are available for automatic download
using the GNOME Software application. Many additional multimedia applications and
support libraries can be found at the RPM Fusion repository (https://rpmfusion.org)
and, once configured, downloaded directly with DNF and GNOME Software. Table 4-2
lists several Fedora software repositories. Fedora and RPM Fusion are DNF-supported,
meaning that a simple DNF configuration enables you to directly download and install
software from those sites using the dnf command, GNOME Software, and any other
software manager that supports DNE such as PackageKit and DnfDragora. Fedora
repository configuration was performed during the installation of your Fedora system.
PackageKit and DnfDragora include repository configuration when installed. RPM
Fusion provides DNF configuration files that you download and install manually from its
website.

Managing Software with DNF

Downloading Fedora software or software from any Fedora repository is a simple
matter of using the Dandified YUM (DNF) package manager (http://fedoraproject.
org/wiki/Features/DNF). DNF uses many of the same commands and options as
YUM, which it replaces. GNOME Software and Packages (PackageKit) provide desktop
interfaces for the DNF package manager.

You can use the dnf command, in a terminal window or command-line interface,
to access Fedora repositories and install new software. To use the dnf command,
enter the dnf command with the install option on a command line. The package
will be detected, along with any dependent software, and you will be asked to confirm
installation. The download and installation is automatic. For query operations such as
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list, you do not need administrative access. But for actions such as install and remove,
you do need administrative access, for which you use the sudo command. The following
command installs Gnumeric:

sudo dnf install gnumeric

You can also remove packages, as well as search for packages and list packages by
different criteria, such as those for update, those on the repository not yet installed, and
those already installed. The following example lists all installed packages:

dnf list installed
The available option shows uninstalled packages.
dnf list available

To quickly to see if a package is available, you can use the 1ist command. The 1ist
command works on a package name. Add the asterisk for a pattern search.

dnf list vsftpd
dnf list *ftp*
dnf list bind*

To search package descriptions, use the search command and a pattern.
dnf search wine

For details about a package, use the repoquery command with the -1 option. The -1
option lists the files the package will install.

dnf repoquery -i gnumeric

When removing a package, in some rare cases, the entire GNOME desktop, along
with the GDM and Packages, could be selected and accidently removed. If this is the
case, you should reinstall GNOME, GDM, and GNOME Software with dnf commands
in a terminal window or by using the command-line interface. You might also have to
reinstall graphics drivers. You can use group to install the entire GNOME desktop. The
group list command displays groups.

sudo dnf group install gnome-desktop
sudo dnf install gdm
sudo dnf install gnome-software
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GNOME Software (Software)

GNOME Software is the GNOME software management frontend for DNE It is designed
to be a cross-distribution package manager that can be used on any DNF-supported
Linux distribution. GNOME Software performs a variety of different software tasks,
including installation, removal, updating of software, as well as the management of
system add-ons such as codecs, fonts, drivers, and desktop (shell) extensions. See
https://fedoraproject.org/wiki/Changes/AppInstaller for more information.

GNOME Software is currently designed to install client and system applications. It
does not install server software, such as the DNS name server or the Apache Web server.
It also does not install many of the older system configuration tools, such as system-
config-samba. To manage such software, you will have to install using the dnf command
in a terminal.

To use GNOME Software, click the Software icon on the Activities dash or on the
Applications overview. GNOME Software will start up by gathering information on all
your packages. A window opens with three tabs at the top, for All, Installed, and Updates.
You can install applications from the All tab which displays a collection of category
buttons, a search button on the title bar you can click to display a search box, and
several sets of picks to choose from (Editor, Recent Releases, Recommended Games, and
Recommended Productivity Applications) (see Figure 4-5).
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Figure 4-5. GNOME Software

The category buttons are Audio & Video, Games, Communication & News, Graphics
& Photography, Productivity, and Add-ons. Click on any category button to open a dialog
with subcategories. The Add-ons category covers enhancements to your desktop, such as
codecs, fonts, drivers, and desktop (shell) extensions.

Categories allow you to further filter the selection using a Show menu. The Graphics
& Photography category has filters such as Vector Graphics, Scanning, and Photography
(Figure 4-6). A Sort menu lets you also sort items by name or rating. The software in each
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category is listed as icons. A few featured packages are listed at the top. Packages already
installed have a checkmark on a packet emblem displayed in the upper-right corner of
the package icon.

£ Graphics & Photography *

Featured Graphics & Photography

darktable ——c Photos & ! Shotwell &
Organize and develop images - Access, organize and share your j Popular photo manager
from digital cameras photos on GNOME

Show = All v Sott TopRated v
All - ﬂ -
l 3D Graphics .{ .) M @
== Photography L o
Simple Scanning lender GNU Image .. darktable Flameshot Inkscape Dia Diagram .
w kA Vector Graphics kv ok kk ok AR hE kRN ke h R whk kR
T Viewers r
C N, ,_
/Aq. ’ L
Okular Krita OpenSCAD digiKam FreeCAD Gwenview MyPaint
"k kk ko ke ok kokkk ok *kkk A Tk ko h ok
< Graphics & Photography x
Featured All tography
3D Graphics
Photography = Photos o ! Shotwell o
Scanning relop images from - Access, organize and share your j Popular photo manager
ho! GNOME
Vector Graphics et
Viewers [
Show  Vector Graphics ~ Sort = Top Rated B
(V] - ; ) &
* A o B e
Inkscape QElectroTech Synfig Studio LibreOffice D... JaxoDraw Karbon
LA 2 d Wi W LR 2

Figure 4-6. GNOME Software: Graphics category

Click a software icon to open its description page, which provides a brief description
of the software and a link to its related website (see Figure 4-7). Uninstalled software
displays an Install button below the software's name, and installed software shows a
Remove button. To the right of the name is a star rating with the number of reviews.
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Figure 4-7. GNOME Software: Software descriptor page
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Click the Install button to install the software. As the software is installed, an
Installing progress bar appears (see Figure 4-8). When it’s complete, the Launch and
Remove buttons are displayed below the name. You can use these to start or uninstall
the software.

< Inkscape x
Inkscape L 2 & & & i
Create and edit Scalable Vector Graphics images
Installing 56%
< Inkscape x
Inkscape o o ek (64)
=  Create and edit Scalable Vector Graphics images

Figure 4-8. GNOME Software: Installing software

You can also search for a package using the search box on the All tab. Enter part of
the name or a term to describe the package (see Figure 4-9). Results are listed, showing
an icon, name, and description. Click on an entry to open its description page where you
can perform possible actions such as install, remove, or launch.
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*ok ko k Xara X, using the W3C standard Scalable Vector Graphics (SVG) file format. Inkscape sup..

1V

Synfig Studio Synfig Studio is a free and open-source 2D animation software, designed as powerful
ik ok industrial-strength solution for creating film-quality animation using a vector and bitmap ar...

=

Xfig Xfig is an X Window System tool for creating basic vector graphics, including bezier curves,
lines, rulers and more. The resulting graphics can be saved, printed on PostScript printers ...

¥ LibreOffice Draw  LibreOffice Draw is an easy-to-use graphics editor, which empowers you to create anything
G W okok from quick sketches to complex diagrams. It provides a powerful set of tools and shapes f...
fig

Figure 4-9. GNOME Software: using the search box

The Installed tab lists your installed software (see Figure 4-10). If the applications
are located on the overview within a folder, that folder name is listed under the
application name. The applications are organized into three sections: Applications,
System Applications, and Add-ons. To remove an application, click its Remove button.
You can also use the Installed tab to organize the applications overview, creating new
category folders on the overview or moving applications into existing folders. Click on
the check box at the right on the title bar on the Installed tab. Round check boxes will
appear to the left of each software entry, which you can click to select that application
(see Figure 4-11). Three buttons are listed at the bottom of the window, labeled Add to
Folder, Move to Folder, and Remove from Folder. When you select an item, the possible
buttons become active. Initially, most applications are not in folders, so when you select
and application, only the Add to Folder button becomes active. Clicking on it opens an
Add to Applications Folder dialog, which lists possible folder to move the application to.
Clicking on the plus icon below the list opens a dialog where you can create a new folder
with a name of your choosing. Click the Cancel button at the top right when you are
finished. This feature lets you organize your Applications Overview using folders of your
choosing.
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All Instalied Updates - x

Writer is the word processor inside LibreOffice productivity suite.
Use it for everything. from dashing off a quick letter to producing a...

Nautilus, also known as Files, is the default file manager of the

Remove

GNOME desktop. It provides a simple and integrated way of manag..  © 9
14108

A simple application to access, organize and share your photos on Re
GNOME. It is meant to be a simple and elegant replacement for usi... )
Pidgin is a chat program which lets you log in to accounts on Remove
multiple chat netwaorks simultanecusly. This means that you can be...
Pitivi is a video editor that aims to appeal to hobbyists and e
professionals alike, with a strong focus on efficiency, quality and us...

All Installed Updates v x

A simple application to keep your disk usage and available space under control.
Disk Usage Analyzer can scan specific folders, storage devices and online accounts...

This is a document viewer for the GNOME desktop. It supports the following
document formats: PDF, PS, EPS, XPS, DjVu, TIFF, DVI (with SyncTeX), and Comic ...

The Eye of GNOME is the official image viewer for the GNOME desktop. It
Integrates with the GTK+ lock and feel of GNOME, and supports many image form...

gedit is the official text editor of the GNOME desktop environment. While aiming at
simplicity and ease of use, gedit is a powerful general purpose text editor. Wheth..

All Installed Updates v x

Ibus-typing-booster is a predictive input method and predicts
complete words based on context and partial input. One can then... _ =

The Hangul input methed is designed for entering Korean text. Input methods are
typing systems allowing users to input complex languages. They are necessary bec...
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Kana Kanji conversion library as backend, whose algorithm is based on 3-gram stati...

The multilingualization input method allows entering many languages using the
tables from the m17n library. Input methods are typing systems allowing users to i...

Figure 4-10. GNOME Software: Installed tab
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Figure 4-11. GNOME Software: Installed tab, organize applications overview

Using the Add-ons category, you can easily manage your fonts, graphics drivers,
multimedia codecs, and any additional third-party apps or features you want installed
on your system. Clicking on the Add-ons category on the All tab opens the Add-ons
dialog with tabs for Codecs, Fonts, Hardware Drivers, Input Sources, Localization,
and Shell Extensions (see Figure 4-12). Installed software will show an emblem with a
checkmark in the top-right corner of their icons. To install or remove an add-on, click on
its icon to open a description dialog. Installed add-ons will show a Remove button, and
uninstalled ones will show an Install button.
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Figure 4-12. GNOME Software: Add-ons tab

The Shell Extensions tab shows extensions you can add to your desktop
(see Figure 4-13). You are warned to install them at your own risk. Clicking on the Shell
Extensions button allows you to turn on support for application indicators on the top
bar. The button then becomes an Extension Settings button, which you can use to
display the extensions you have installed and turn them on or off (see Figure 4-14).
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Figure 4-13. GNOME Software: Add-ons tab, Shell Extensions
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Figure 4-14. GNOME Software: Installed shell extension management

Many of the shell extensions are designed to operate as indicators on the top bar.
Others add features to the desktop, such as Dash to Dock, which adds a dash-like dock
to the main screen, letting you start favorite applications directly from the desktop. Keep
in mind that the extensions are not guaranteed to work. Some extensions are already
installed but not turned on, such as the Applications menu, which can add the GNOME
Classic applications menu to the top bar in place of the Activities button. Some of the
extensions will have a configuration button you can click to display features you can set
such as that for the Background Logo, which sets the position, size, opacity, and border
of the Fedora logo on your desktop (see Figure 4-15). You can even change the logo.

To remove the logo, just turn off the extension.
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Figure 4-15. GNOME Software: Installed Shell Extension Configuration

PackageKit (Packages)

PackageKit is an older software management frontend for DNE It is designed to be a
cross-distribution package manager that can be used on any DNF-supported Linux
distribution. See www. packagekit.org for more information. PackageKit provides a variety
of applications for different software tasks, including installation, removal, updates,
repository management, logs, and install of an individual RPM file (see Table 4-4). The
primary PackageKit application is gpk-application, accessible as Packages. The gpk-
update-viewer (Software Update) lets you examine and select updates. The gpk-1log
displays a list of all your previous install, removal, and update operations, including major
updates and individual package installs (accessible on PackageKit from the Applications
menu [top bar], as the Software Log menu item).
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Table 4-4. PackageKit Applications

Application Description

gpk-application Packages

gpk-update-viewer  Updates your system with
Package Updater

gpk-prefs Configures repositories with
Package Sources

gpk-log Views history of updates and
installs

To use PackageKit, click the Packages icon on the Applications overview. PackageKit
will start up by gathering information on all your packages. A Software window opens
with a search box at the top and packages listed below (see Figure 4-16). Before you
install any packages, it is advisable to first refresh your software lists. This is a listing of
software packages available on your enabled repositories. Select Refresh Package Lists
from the PackageKit applications menu.

@ Packages - Sat 14:19

Check for Updates

€ graphics

quichan-0.8.2-17.fc28 (64-bit)

The Cairo graphics library for Guile Scheme
quile-cairo-1.4.0-21.fc28 (64-bit)

. ImageMagick Magick++ library (C++ bindings)

I ImageMagick-c++-1:6.9.9.38-1.fc28 (64-bit)
Vector-based drawing program using SVG
inkscape-0.92.3-1.fc28 (64-bit)
Documentation for Inkscape
inkscape-docs-0.92.3-1.fc28 (64-bit)

Debugging tools for Intel graphics chips i I\
intel-gpu-tools-2.99.917-32.20171025.fc 28 (64-bit) =

Figure 4-16. PackageKit (Packages)
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Search for packages by entering the package name or descriptive term in the
search box. Packages searches package descriptions, not just the filename. Uninstalled
packages have faded package icons with an empty check box, and installed packages
have a solid color with a checkmark in the check box.

To access information about a particular package, select it. A pane then opens at
the bottom and displays a description of the software and a button bar to the right, with
buttons to install the package (or remove if already installed),for the software’s website
(Homepage), and a list of installed files (Files). The Homepage button opens your
browser to the package home page where you can find more detailed information about
it. The Files button opens a window that lists all the files the package installs. This can be
helpful for tracking down the command names and location of the configuration files.

To install a package, first click its check box (see Figure 4-17). The box is checked,
and a plus sign (+) appears on the package icon. You can click several packages to select
them for installation. Once you are ready to install, click the Apply Changes button
(upper right). A progress bar will show the install task’s progress. The PackageKit task
messages are displayed at the top-center on the title bar. During the download phase, a
Cancel button is displayed on the left side of the title bar, letting you cancel the install.
Once the package is installed, the package icon color will change from faded to a solid
color, and a checkmark will be displayed in its check box. If dependent or additional
packages are required by the software you want to install, these are listed, and you are
prompted to confirm their installation. Click Continue.
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a Packages Apply Changes x

€ graphics

The Cairo graphics library for Guile Scheme
L1 quile-cairo-1.4.0-21.fc28 (64-bit)

== ImageMagick Magick++ library (C++ bindings)
T imageMagick-c++-1:6.9.9.38-1.fc28 (64-bit)

4=y Vector-based drawing program using SVG
G-t

Documentation for Inkscape
. inkscape-docs-0.92.3-1.fc28 (64-bit)

Debugging tools for Intel graphics chips
L intel-gpu-tools-2.99.917-32.20171025.fc28 (64-bit)

Inkscape s a vector graphics editor, with capabilities similar to Remove
Illustrator, CorelDraw, or Xara X, using the W3C standard Scalable Vector
Graphics (SVG) file format. It is therefore a very useful tool for web Homepage

designers and as an interchange format for desktop publishing. Files

Download size 18.3 MB
License GPLv2+ and CC-BY
Source Fedora 28 - x86_64 - Updates

Figure 4-17. Package information

If you choose to remove an installed package, click its check box. The check box
becomes empty, and a wastebasket image is displayed on the package icon. Then
click Apply Changes to uninstall. Once the package is removed, the package icon
color becomes faded. You could also just select it and click the Remove button in its
description.

Instead of showing all your available packages, both installed and uninstalled, you can
filter the package listings. Two filter options are available from the PackageKit GNOME
applications menu. You can filter by newest versions and native packages. Native packages
are those for your system architecture, such as 64-bit (x86_64) or 32-bit (i686).

PackageKit also has a CLI (command-line interface) version called pkcon. You can
use the pkcon command in a terminal window to install and remove packages.

sudo pkcon install inkscape
sudo pkcon remove inkscape

The get-packages option lists all your packages and the get-files option lists

all the files installed by a package. The get-details option displays the package
description.
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sudo pkcon get-packages
sudo pkcon get-details inkscape
sudo pkcon get-files inkscape

Managing Repositories

DNF is the primary package-management tool. When you install a package, DNF is
invoked and automatically selects and downloads the package from the appropriate
repository. After having installed your system, when you then want to install additional
packages, GNOME Software and Packages will use DNF to install from a repository.
This will include all active DNF online repositories you have configured, such as sites
like https://rpmfusion.org, not just the Fedora and update repositories configured
during installation. You can manage your repositories, enabling or disabling them, with
GNOME Software, Packages, DnfDragora, and the dnf command.

You can enable or disable your configured DNF repositories using GNOME
Software's Software Repositories dialog (choose Software Repositories from the
GNOME Software application's menu). From the Software GNOME application’s menu,
select Software Sources. Click the Software Sources tab to see a list of your configured
repositories (see Figure 4-18).

Software Repositories x
GMNOME Shell Extensions Repository Enabled |
Linux Vendor Firmware Service Enabled

Linux Vendor Firmware Service (testing) sabled

RPM Fusion for Fedora 28 - Free Enabled

1 application and 1 add-on installed
RPM Fusion for Fedora 28 - Free - Test Updates Disabled

RPM Fusion for Fedora 28 - Free - Updates Enabled

Figure 4-18. Software Repositories: Configured software repositories (GNOME
Software)
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The repositories listed have DNF configuration files in the /etc/yum.repos.d
directory, holding information such as URLs, GPG keys, and descriptions. The Fedora
repository names include the release number and the platform, such as x86_64 for the
64-bit version. Fedora and Fedora Update repositories will be enabled. If you want to see
the package from just one repository, you can deactivate the others. For example, if you
wanted to see only the RPM Fusion repository, you could deactivate all others, including
Fedora. You can reactivate the other repositories later.

On GNOME Software's Software Sources dialog, all configured repositories are listed
along with their status, disabled or enabled. To enable a disabled repository, click on
its entry to display an Enable button, which you can click to enable the repository. For
enabled repositories, a Disable button is shown, when their entry is clicked. Also, when
you click a repository entry, the URL of its repository is displayed.

Repositories also have specialized repositories for development, debugging, and
source code files. Here you find applications under development that may be useful, as
well as the latest revisions. Some will have testing repositories for applications not yet
completely validated for the current release. These applications might not work well.
Source, Test, and Debug repositories will normally be disabled. Test is the development
repository for a future release currently under development. The source repositories
hold source code packages.

Fedora Linux designated certain repositories as third-party repositories, as listed at:

https://fedoraproject.org/wiki/Workstation/Third Party Software Repositories

These include PyCharm (Python development environment), Google Chrome,
the RPM Fusion NVIDIA graphics driver repository, and the RPM Fusion Steam client
repository. When you first start GNOME Software, a notice asks you if you want to enable
these repositories, as shown here.

All Installed Updates Q  x

Enable Third Party Software Repositories?

Access additional software from selected third party sources. Some of this software is proprietary and
therefore has restrictions on use, sharing, and access to source code. Find out more._

Featured Application

143


https://fedoraproject.org/wiki/Workstation/Third_Party_Software_Repositories

CHAPTER 4  INSTALLING AND UPDATING SOFTWARE

A Third Party Repositories section for those repositories is displayed at the top of
the Software Repositories dialog. A Third Party Repositories noticeg at the top of the
dialog has a Remove All button (see Figure 4-19), which you can click to remove these
repositories, including their configuration files from /etc/yum.repos.d. Upon removal,
the button becomes an Install button, which you can use to restore these repositories.
The Remove and Install actions only affect these repositories, not any other third-party
repositories you may have installed, such as Livna and the free and non-free RPM Fusion
repositories.

Software Repositories X

Third Party Repositories

Remove All

Copr repo for PyCharm owned by phracek Disabled

google-chrome Enabled

om/inux/chrome/rpm/stable/x86_64

Disable...

RPM Fusion for Fedora 28 - Nonfree - NVIDIA Driver Disabled

RPM Fusion for Fedora 28 - Nonfree - Steam Disabled

Figure 4-19. Software repositories: Third-party repositories (GNOME
Software)

Using the Package's Package Sources dialog (choose Package Sources from
the Packages application's menu), you can also enable and disable repositories
(see Figure 4-20). Enabled repositories are checked. You can disable a repository
by unchecking it. A check box at the bottom of the dialog lets you hide debug and
development repositories, showing just the main repositories.
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Package Sources x

A package source contains packages that can be installed on this computer.

v Adobe Systems Incorporated
Copr repo for PyCharm owned by phracek
Fedora 28 openh264 (From Cisco) - x86.64
Fedora 28 - Source
Fedora 28 - Test Updates Source
Fedora 28 - Updates Source
Fedora 28 - x86_64
Fedora 28 - x86.64 - Test Updates
Fedora 28 - x86_64 - Updates
google-chrome
+ RPM Fusion for Fedora 28 - Free

RPM Fusion for Fedora 28 - Free - Source

L8

K3

Show debug and development package sources

Figure 4-20. Package Sources: Configured software repositories (Packages)

You can also manage repositories using the dnf config-manager command with the
--set-enabled and --set-disabled options. The following disables the RPM Fusion
non-free repository.

sudo dnf config-manager --set-enabled rpmfusion-nonfree
You could later then enable it.
sudo dnf config-manager --set-enable rpmfusion-nonfree

To remove a repository, use the dnf remove command. This is a permanent removal.

Using the RPM Fusion Repository

The RPM Fusion repository (https://rpmfusion.org) holds popular third-party drivers
and codecs. These include the vendor graphics drivers for Linux, when they become
available, such as those provided by NVIDIA. Also included are multimedia codecs with
licensing issues, such as MP3, AC3, and MPEG2 codecs, as well as MPEG4 and DivX (Xvid).
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To access the RPM Fusion repository, you first must download and install both its
DNF configuration file and its GPG authentication key. These are both included in RPM
Fusion’s rpmfusion-free package. Simply download and install this package using your
web browser. The package is located at https://rpmfusion.org/Configuration
(see Figure 4-21). Click the Configuration link at the top of the page to go to the
Configuration page. There are free and non-free packages, with links for each. Be sure
to install the free package first. The non-free package is optional. On the section titled
“Graphical Setup via Firefox Web Browser,” click the link labeled “RPM Fusion Free for
Fedora 28” to download the rpmfusion-free configuration package. When you click the
link, Fedora detects that it is a software package and opens a dialog with the option to
install it directly.

Configuration - RPM Fusion - Mozilla Firefox *x

@ Configuration - RPM Fusi x | +

«)=> c Q @ & https -.'rpmfusion.org-l onfiguration E - @ ﬁ N 0
RPM Fuslon Configuration ReportingBugs Howto FAQ Contribute A

Opening rpmfusion-free-release-28.noarch.rpm

/s ) l | - - L
Configuratiof rensecosenwopen

Login

S = fusion-free-release-28. h.
Vea esta pagina en espafiol | bt B Utk B e ROl User

which is: RPM package (20.4 KB)
from: https://download.rpmfusion.org

Password

Installing Free af

We have two separate software r

What should Firefox do with this file? Login

*)Open with | Software Install (default) ~
» free for Open Source Softwar Save Fie dora project cannot ship due to
other reasons T
» nonfree for redistributable so Do this automatically for files like this from now on. dora Licensing Guidelines); this
includes software with publicly ctions
Installation can be done either us Cancel OK
Graphical Setup via FirefoxX Web browser

1. First enable access to the free repository. For users of gpk (gnome package kit) or kpackagekit in Fedora that is easy and
basically only one step: just click on one of the following files, depending on what distribution you use and then follow the
default options that Firefox and Package Kit offer by clicking Enter a few times (%):

o RPM Fusion free for Fedora 26
o RPM Fusion free for Fedora 27
o RPM Fusion free for Fedora 28

Figure 4-21. RPM Fusion repository configuration file downloaded from
rpmfusion.org

After installing the free package, you can install the non-free package if you wish.
Click the link labeled RPM Fusion Nonfree for Fedora28, listed under the second
paragraph in the Graphical Setup section, then proceed with the install.
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The page also tells you how to perform an installation of both free and non-free RPM
Fusion configuration packages from the command line using the dnf command. The
command is extensive and, instead of typing it on a command line in a terminal window,
you can copy and paste the entire command from the web page to a terminal window.
Click and drag the command on the web page to select it, then press Ctrl+c to copy it to
the clipboard. Open a terminal window and press Ctrl+Shift+v to paste the command to
the current command line. Then press Enter to run the command.

Once the repository is installed, you can open Software Sources to check that the
RPM Fusion repository is enabled. On GNOME Software, select Software Repositories
from its application menu to open the Software Repositories dialog and scroll down to the
RPM Fusion for Fedora 28 entries. The ones for free and non-free should be enabled. On
Packages, select Package Sources from its applications menu to open the Package Sources
dialog, which should have the entries for Fedora 28 checked, both free and non-free.

With the RPM Fusion repository now enabled, you can use GNOME Software and
Packages to search, select, and install any packages on its repository. Both RPM Fusion
and the Fedora repositories have their packages intertwined on the GNOME Software
and Packages software listings. When you first install the repository configuration, be
sure to update your Packages package lists so that the new repository packages will be
listed. From the Packages Applications menu, select Refresh Package Lists.

DnfDragora

DnfDragora is the replacement for the YUM Extender (dnf-yumex). It is an alternative
desktop interface for managing software packages on your DNF repositories

(see Figure 4-22). DnfDragora provides detailed package information and allows you to
turn repositories on and off directly.
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Software Management - dnfdragora x
File + | Information + @ Options « Help ~
u Software Management
All « | Toupdate = || innames hd #sSearch ? Clear search

B NetworkManager-openvpn NetworkManager VPN plugin for OpenVPN

| NetworkManager-openvpn-gnome NetworkManager VPN plugin for OpenVPN - GNOME files

L] sDL2 Cross-platform multimedia library

|| abrt-java-connector JNI Agent library converting Java exceptions to ABRT probler
| anaconda Graphical system installer
| anaconda-core Core of the Anaconda installer

R — A e i e M i i

NetworkManager-openvpn - NetworkManager VPN plugin for OpenVPN

This package contains software for integrating VPN capabilities with the OpenVPN server with NetworkManager.
Update information

Apply Check all Quit

Figure 4-22. DnfDragora (dnfdragora)

DnfDragora displays three panes: a side pane for listing groups, a right pane for
listing packages, and a bottom pane for display information about a selected package.
A toolbar above the pane lets you organize and refine the display of your packages.

The first menu button lets you choose to view all packages or to organize them by
groups and display just those in the group (see Figure 4-23). The second menu lets you
choose the type of packages you want displayed (All, Installed, To Be Updated, and Not
Installed). For the searches you can search in package names, descriptions, summaries,
or their filenames. Clicking a package displays detailed information about it, including
a list of dependencies, files included with the package, a link to its repository, and

the change log, if available. To install a selected package, click the Apply button at the
bottom of the window.
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Software Management - dnfdragora x
File = | Information ~ | Options « Help ~
U Software Management
Groups * | Not installed * | innames - #Search * Clear search
- g Applications Name Summary
ﬂ_g'; Audio Production [ code-editor Lightweight and cross-platform text and code editor based on 1
] Authoring and Publishing & emacs GNU Emacs text editor
f_j Design Suite |_| emacs-auctex Enhanced TeX modes for Emacs
(] emacs-bbdb A contact management utility for use with Emacs
[EE Educational Software [} emacs-ess Files to run Emacs Speaks Statistics under GNU Emacs
=¥ Engineering and Scientific (] emacs-vm Emacs VM mail reader
i = a 3. . . 2 { - R e B T T T S Lo T e P e P |

emacs - GNU Emacs text editor
Emacs is a powerful, customizable, self-documenting, modeless text editor. Emacs contains special code editing features, a scripting language

(elisp), and the capability to read mail, news, and more without leaving the editor. This package provides an emacs binary with support for X
windows.

Apply Check all Quit

Figure 4-23. DnfDragora groups

To manage your repositories, choose the Repositories entry from the File menu.
The top pane lists your available repositories with checkmarks next to the ones that are
enabled (see Figure 4-24). To enable other repositories, click their check boxes. Disable
a repository, click its check box to remove the checkmark. Clicking on any repository
entry displays details about the repository, such as the location of the cache it uses, if it is
enabled, its gpgkey, the number of retries allowed, and the repository type.
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Repository Management X

tp) Repository Management

Mame Enabled
adobe-linux-x86-64 v

fedora-cisco-openh264
fedora-cisco-openh264-debuginfo
fedora-debuginfo

fedora-source

google-chrome

livna

Al

basecachedir: /var/cache/dnf
cost: 1000
deltarpm: True

deltarpm_percentage: 75
enabled: True
enablearoups: True

Apply Cancel

Figure 4-24. DnfDragora Repository Management

Installing Individual Packages with Your Browser

You can use your browser to download an individual package from a site directly.

You should use this method only for packages not already available from DNF-
supported repositories. This is true for certain packages, such as the RPM Fusion DNF
configuration packages you need to install before you can access the RPM Fusion
repository. You also have to install any needed dependent packages manually, as well as
check system compatibility. Your Fedora web browsers will let you perform a download
and install in one simple operation. A dialog opens that prompts you to open with the
package installer, which invokes GNOME Software (see Figure 4-25, left). The package
is downloaded, and you are asked if you want to install the file (see Figure 4-25, right).
Subsequent dialogs show the installation progress.

150



CHAPTER 4 INSTALLING AND UPDATING SOFTWARE

»
[

Opening rpmfusion-nonfree-release-28.noarch.rpm x
You have chosen to open:
[] rpmfusion-nonfree-release-28.noarch.rpm

which is: RPM package (20.8 KB)
from: https://download . rpmfusion.org

What should Firefox do with this file?
=/Open with  Software Install (default) et
Save File

Do this automatically for files like this from now on,

Cancel

Figure 4-25. Web browser package install

On a GNOME desktop, packages that have already been downloaded can be installed
with a simple right-click, then choose the install selection from the menu invoking
GNOME Software, to perform the installation (gnome-software). As with the browser
download, you are prompted to install the package.

Installing Some Popular Third-Party Software

For most third-party multimedia packages, you first install the DNF configuration file for
arepository that carries them. Once configured, installation is a simple matter of using
Software to search for and install packages. DNF downloads the package and performs
the installation. It will also be careful to select the package for your architecture, such as
x86_64 for 64-bit or i686 for 32-bit. DNF will ask for confirmation before installing, listing
any dependent packages that will also have to be installed.

Multimedia Packages

For your third-party packages, you can use RPM Fusion, which carries collections of
multimedia packages, including GStreamer and MPlayer. DVD/MPEG video players you
might want include Xine, MPlayer, and VideoLAN. All support DVD, DVB, HDTV, H264,
and MP3, provided the needed codecs are installed.
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Tip For information on multimedia applications available for Fedora, go to
https://fedoraproject.org/wiki/Multimedia.

Many of the following packages are automatically selected and installed for you
as dependents when you install MPlayer. It may be simpler to just install one of these,
rather than try to install all the added packages separately.

For audio, you may want HDTV audio, DVD/MPEG2 audio support, DTS, and MP3.
Search for the following RPM Fusion packages using Software.

a52dec HDTV audio (ATSC A/52, AC3)

faad2 MPEG2/4 AAC audio decoding, high quality
faac MPEG2/4 AAC sound encoding and decoding
libdca DTS Coherent Acoustics playback capability
lame MPEG1 and MPEG2 audio decoding

For video, you may want DVD video capability, MPEG and MPEG2 playback, DVB/
HDTV playback, and H264 (HD media) decoding capability.

libdvbpsi MPEG TS stream (DVB and PSI) decoding and encoding

vlc DVD video playback capability, VideoLAN project

libdvdnav DVD video menu navigation

libdvdcss DVD video commercial decoding, Livna repo (http://rpm.1livna.org)
X264 H264/AVC decoding and encoding (high-definition media)

For all GStreamer supported applications, you will want the bad and ugly packages.

gstreamer-plugins-bad Not fully reliable codecs and tools for GStreamer, some with
possible licensing issues

gstreamer-plugins-ugly Reliable video and audio codecs for GStreamer that may have
licensing issues
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The Win32 codecs are not available on the Fedora repositories. Keep in mind that
wmv files and Win32 codecs are already supported by the ffmpeg Linux codecs and will
play on Totem and Dragon Player. You can download the Win32 codecs separately from
the MPlayer website (www.mplayerhq.hu/MPlayer/releases/codecs).

Vendor Video Driver Support

You can obtain the NVIDIA vendor graphics drivers from RPM Fusion (the non-free
repository). You can download and install them with DNF. RPM Fusion is the best
repository for specialized kernel drivers and modules. Keep in mind, however, that due
to open sourcing of some of the NVIDIA vendor driver software, the X.org and Nouveau
open source versions are becoming almost as effective, especially for 2D display support.
For normal usage, you might not need vendor driver support.

Installing the NVIDIA drivers can be a complex operation depending on what
graphics card you have. The drivers are located on the RPM Fusion repository, not on
Fedora. Check the RPM Fusion site for instructions on installing the NVIDIA drivers.

https://rpmfusion.org/Howto/Nvidia

For a simple install, a search on nvidia displays NVIDIA modules for each kernel
version. The vendor graphic drivers use two packages, one for the supporting software
and another for the kernel. The kernel modules are specific to the kernel you are using.
Each time you update to a new kernel, you will require a new graphics kernel module
created specifically for that kernel. This will be automatically downloaded and installed
for you as a dependent package when you update your kernel (the RPM Fusion non-free
repository must be active). The driver package is named xorg-x11-drv-nvidia, and the
kernel module generator is named akmod-nvidia.

xorg-x11-drv-nvidia
akmod-nvidia

You can use adnf list command entered in a terminal window with nvidia* to list
all NVIDIA packages.

dnf list nvidia*
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AMD drivers have been fully open sourced. You can download and install the driver
from the Fedora repository. The name of the driver is amdgpu.

xorg-x11-drv-amdgpu

You can also install the drivers using GNOME Software's Add-ons Hardware Drivers
tab (see Figure 4-26). Be sure that third-party repositories are enabled (Software
Repositories dialog). Click on the driver you have determined that you need, such as
the NVIDIA driver. This opens a GNOME Software software description dialog with an
Install button and a description of the software including its version, its repository, and
whether it is proprietary or free (License). Once you have installed the driver, the Install
button changes to a Remove button. On the Hardware Drivers tab, a checkmark emblem
appears on the upper-right corner of the driver icon, indicating that it is installed.

Figure 4-26. Video Drivers install: GNOME Software Add-ons Hardware Drivers
tab and install dialog
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Using Repositories

A few repositories provide much of the software you will normally require. The main
Fedora software repository will most likely contain the software you want. Always
check this repository first, before trying a third-party repository. Some specialized
applications, such as vendor-supplied graphics drivers, as well as third-party multimedia
support, can be located at http://rpmfusion.org and at https://negativo17.org.
These repositories make up a set of software sites that you can use to provide most of
the functionality users expect from a desktop system. All are DNF-compliant, with DNF
configuration files designed for specific Fedora releases.

To see what packages are available, you can use your web browser to access the sites.
Fedora and RPM Fusion provide repodata directories for detailed listings.

To use DNF on a software repository, DNF has to be configured to access them.
This is a simple matter of listing the site’s URL, both its web address and directory
location. Configurations for repositories are placed in repo files located in the /etc/yum.
repos.d directory on your Linux system. The repo files for Fedora are already installed.
You must add repo files for RPM Fusion before you can access them with DNE. RPM
Fusion provides RPM packages, free and non-free collections, named rpmfusion-free-
release-28.noarch.rpmand rpmfusion-nonfree-release-28.noarch.rpm, on their
website. When these are installed, they automatically set up the DNF configuration files.
For RPM Fusion, these are rpmfusion-free.repo and rpmfusion-nonfree.repo, with
corresponding update and development repo files.

The repository sites and their repo files are:

https://download.fedoraproject.org  The Fedora Repository, mirror link: Fedora-
compliant software, fedora.repo

https://download1.rpmfusion.org RPM Fusion: Repository for driver, multimedia,
and other Fedora packages, rpmfusion-free.
repo and rpmfusion-nonfree.repo

https://negativo17.org/repos/ negativo17.org: Repository for driver,
multimedia, and other Fedora packages, fedora-
negativol7.repo
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Repository Repo Package Files

When you are installing packages, PackageKit, Yumex, and the dnf command
automatically use the repo files to check your enabled repositories. One important
exception to this rule is the initial install of the repository configuration files from third-
party repositories. These configuration files (repo files) are usually contained in their own
RPM packages. You download and install a repo package directly from the repository
website, using your web browser. For example, the repo package for the RPM Fusion
third-party Fedora DNF repository is rpmfusion-free-release-28.noarch.rpm. You
download and install this package directly, using a web browser. Repository configuration
files are located in the /etc/yum.repos.d directory and have the extension .repo.

Fedora Repository

The Fedora repository is already configured for use by DNF. To download any Fedora
package, simply use GNOME Software, Packages, or enter the dnf command with the
install option on a command line. The package will be detected, along with any
dependent software, and you will be asked to confirm installation. The download and
installation will be automatic. The first time you install a package from the Fedora
repository, you are prompted to install the Fedora GPG key, used to authenticate the
packages. Just click Yes to install the key.

A section of the following Fedora repo file (/etc/yum.repos.d/fedora.repo) lists
several repository options. The name is Fedora, with releasever and basearch used to
determine the release and architecture parts of the name. The mirrorlist option is used
instead of baseurl, which is commented out (metalink provides mirror access, selecting
the fastest available mirror). Again, the releasever is used to specify the release.

The gpgkey used, RPM-GPG-KEY-fedora, is already installed in the /etc/pki/rpm-gpg
directory. The skip if unavailable option is set to False so that the Fedora repository
must always be checked.

[fedora]
name=Fedora $releasever - $basearch
failovermethod=priority
#baseurl=http://download.fedoraproject.org/pub/fedora/linux/
releases/$releasever/Everything/basearch/os/
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metalink=http://mirrors.fedoraproject.org/metalink?repo=fedora-
$releasever8arch=%$basearch

enabled=1

metadata expire=7d

repo-gpgcheck=0

type=rpm

gpgcheck=1
gpgkey=file:///etc/pki/xpm-gpg/RPM-GPG-KEY-fedora-$basearch
skip_if unavailable=False

RPM Fusion

The https://rpmfusion.org site provides access to popular software for many software
applications, including multimedia applications such as MPlayer, as well as those not
included with Fedora, due to licensing issues. Several of the more popular packages
include the vendor NVIDIA graphics drivers (when available). RPM Fusion specializes
in configuring sometimes difficult drivers for compatibility with Fedora. For example,
you can download the NVIDIA Linux driver directly from the NVIDIA website and try

to install it on your Fedora system. But there can be complications, and the driver could
require additional configuration. As an alternative, RPM Fusion provides a version of the
driver that has already been configured for Fedora.

To configure DNF on your system to access https://rpmfusion.org, justinstall the
rpmfusion-free-release and rpmfusion-nonfree-release packages for your version
of Fedora. These will install the rpmfusion-free.repo and rpmfusion-nonfree.repo
configuration files in the /etc/yum.repos.d directory, as well as download the RPM
Fusion GPG key. You can install the GPG manually or just wait until you install a package
from RPM Fusion, in which case, DNF will install it for you, after prompting for approval.
Check the RPM Fusion configuration page at http://rpmfusion.org for details. The
name of the package will be something like rpmfusion-free-release.

You can download and install the package directly with the rpm command from
within a terminal window. Use a preceding sudo command for administrative access.
The RPM Fusion site’s configuration page provides a detailed example.

The GPG keys are included in the packages and installed automatically in the /etc/
pki/rpm-gpg directory. They are named RPM-GPG-Key-rpmfusion-free-fedora and
RPM-GPG-Key-rpmfusion-nonfree-fedora.
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To see which packages are available on RPM Fusion, use your web browser to go
to https://downloadl.rpmfusion.org. Here, you will find a listing of directories for
each supported release. After selecting your release directory, you then choose your
architecture, such as i386 (32-bit) or x86_64 (64-bit). Here, you will see a simple file
listing of all available packages. Alternatively, on PackageKit, you could deselect all
software sources except RPM Fusion, so that only the RPM Fusion packages are listed in
the Software window.

Part of the rpmfusion-free.repo configuration file installed by the rpmfusion-free-
release package is shown here. The configuration specifies the mirror list located at
http://mirrors.rpmfusion.org.

[rpmfusion-free]
name=RPM Fusion for Fedora $releasever - Free
#baseurl=http://downloadl.rpmfusion.org/free/fedora/releases/$releasever/
Everything/$basearch/os/
metalink=https://mirrors.rpmfusion.org/metalink?repo=free-fedora-
$releasever&arch=%$basearch
enabled=1
enabled-metadata=1
metadata expire=14d
gpgcheck=1
repo-gpgcheck=0
gpgkey=file:///etc/pki/xpm-gpg/RPM-GPG-KEY-rpmfusion-free-fedora-
$releasever

The corresponding part of the rpmfusion-nonfree.repo configuration file installed
by the rpmfusion-nonfree-release package is shown here:

[rpmfusion-nonfree]

name=RPM Fusion for Fedora $releasever - NonFree
#baseurl=http://downloadi.rpmfusion.org/nonfree/fedora/
releases/$releasever/Everything/$basearch/os/
metalink=https://mirrors.rpmfusion.org/metalink?repo=nonfree-fedora-
$releasever8arch=$basearch

enabled=1

enabled-metadata=1
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metadata expire=14d

gpgcheck=1

repo-gpgcheck=0
gpgkey=file:///etc/pki/xpm-gpg/RPM-GPG-KEY-rpmfusion-nonfree-fedora-$releasever

Livna (dvdcss)

The Livna repository (http://rpm.livna.org) provides access to one package, the
commercial DVD video codec, called 1ibdvdcss. Install the livna-release.rpm
package. It contains the repository file, 1ivna.repo.

[livna]

name=rpm.livna.org for $releasever - $basearch
#baseurl=http://rpm.livna.org/repo/$releasever/$basearch/ http://ftp-stud.
tht-esslingen.de/pub/Mirrors/rpm.livna.org/repo/$releasever/$basearch/
mirrorlist=http://rpm.livna.org/mirrorlist

failovermethod=roundrobin

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/xpm-gpg/RPM-GPG-KEY-1ivna

Adobe (Flash)

The Adobe repository provides access to the Adobe proprietary version of the Adobe
Flash player for Linux. Adobe provides 32- and 64-bit software. The Fedora project Flash
wiki explains the procedure in detail (see https://fedoraproject.org/wiki/Flash).

First, download the RPM package for the repository configuration. Select YUM for
Linux.

https://get.adobe.com/flashplayer/

Then install the repository configuration package, called adobe-release. You can
do this directly from the web browser by choosing to install and then clicking Yes, when
prompted, to install the unsigned software, as the package key is not yet installed (it is
included in the repository package). You could also first download the package, then
install it with the following rpm command in a terminal window for the 64-bit version:

sudo su -c 'rpm -vhi adobe-release-x86 64-1.0-1.noarch.rpm'
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This installs the /etc/yum.repos.d/adobe-1inux-x86_64.repo file, shown here

[adobe-1linux-x86 64]

name=Adobe Systems Incorporated
baseurl=http://linuxdownload.adobe.com/linux/x86_64/
enabled=1

gpgcheck=1
gpgkey=file:///etc/pki/xpm-gpg/RPM-GPG-KEY-adobe-1inux

Software Sources will list the repository as Adobe Systems Incorporated. You can
then use GNOME Software and Packages to search for Flash and select the Flash package
for installation. The Flash plugin package is flash-plugin and has the title “Adobe Flash
Player”.

The first time you install any package from the Adobe repository, you will be
prompted to install its package key. A dialog will be displayed with the message “Do You
Trust the Source of the Packages?” Click Yes to install the Adobe repository package key.

Alternatively, you can manually install the Adobe repository package key with the
following command:

sudo su -c 'rpm --import /etc/pki/rpm-gpg/RPM-GPG-KEY-adobe-linux'

Restart Firefox to enable your Flash plugin. On the Tools » Add-ons Plug-ins tab,
you will find an entry for Flash.

Google

For Linux-compatible Google applications, you should configure access to the Google
repository, which allows you to install applications such as Picasa from PackageKit.
Google installs a separate repository file for each major application. Google Chrome has
a google-chrome.repo file, and Google Earth has a google-earth.repo file. The signing
key is installed automatically. Follow the instructions for the RPM at: https://www.
google.com/linuxrepositories/

Installation is performed using a terminal window. Click and drag to select the wget
command on the browser.

wget https://dl-ssl.google.com/linux/linux_signing key.pub
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Then open a terminal window and press Ctrl+Shift+v to copy the command to that
window. The signing key is then installed. Next, import the key with the following rpm
command.

sudo rpm --import linux_signing_key.pub
A copy of the google-chrome.repo file follows:

[google-chrome]

name=google-chrome
baseurl=http://dl.google.com/linux/chrome/rpm/stable/x86 64
enabled=1

gpgcheck=1
gpgkey=https://dl.google.com/1linux/linus/linux_signing_key.pub

DNF Configuration

DNF options are configured in the /etc/dnf/dnf. conf file, and the /etc/yum.repos.d
directory holds repository (repo) files that list accessible DNF repositories. The
repository files have the extension . repo. Check the dnf.conf man page for a listing

of the different DNF options, along with entry formats. The dnf.conf file consists of
different segments separated by bracket-encased headers, the first of which is always
the main segment. Segments for different DNF server repositories can follow, beginning
with the repository label encased in brackets. On Fedora, however, these are currently
placed in separate repository files in the /etc/yum.repos.d directory. In addition to
dnf.conf, DNF also supports an /etc/dnf directory that can hold additional

configuration information.

/etc/dnf/dnf.conf

The dnf.conf file contains the main segment with settings for DNF options, as

shown here:

[main]

gpgcheck=1

installonly limit=3

clean _requirements on remove=True
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gpgcheck is a repository option that is set globally for the repo files. It checks for GPG
software signatures. The installonly limit option limits the number of packages that
can be installed concurrently. The clean_requirements _on_remove option checks for
and removes unused dependent packages (packages installed only as dependencies).

There are also general DNF options, such as logdir, which lists the location of DNF
logs, and pluginspath, which specifies the location of DNF plugins. You can elect to
keep the downloaded packages with keepcache.

Repository Files: /etc/yum.repos.d

The repository entries in the repo files begin with a bracket-enclosed server ID, a
single-word unique name. Repository-specific options govern the access of software
repositories. These include gpgcheck, which checks for GPG software signatures; gpgkey,
which specifies the location of the signature; metalink, which references fast links
from a mirror list; and mirrorlist, which references a URL holding mirror sites. The
repository-specific name option provides a name for the repository. The URL reference
is then assigned to the baseurl option. There should be only one baseurl option, but
you can list several URLs for it, each on its own line. With the mirrorlist option, you
can just list a URL for a list of mirrors, instead of listing each mirror separately in the
baseurl option. The URL entries often use special variables, releasever and basearch.
The releasever obtains the release information from the distroverpkg option set in
the main segment. The basearch variable specifies the architecture you are using, as
determined by DNF, such as i386. The enabled option actually turns on access to the
repository. By setting it to 0, you choose not to access a specific repository. The gpgcheck
option specifies that you should perform a GPG authentication check to make sure the
download is intact. The enabled option will enable a repository, allowing DNF to use it.
You can set the enable bit to 0 or 1 to turn off or on access to the repository.

The gpgkey option provides an authentication check on the package to make
sure you have downloaded the appropriate version. Downloads can sometimes be
intercepted and viruses inserted. The GPG key check protects against such attacks. It can
also check to make sure the download is not corrupt or incomplete. The Fedora public
GPG key may already be installed on your system. If you have already used DNE, you
have already downloaded it. The Fedora GPG key allows you to access Fedora packages.
The RPM Fusion free and non-free repositories use their own public keys, referenced
with the gpgkey option in their repos files. The keys for all these repositories will be
installed in the /etc/pki/rpmgpg directory.
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Managing DNF Caches

With the keepcache option enabled, DNF will keep its downloaded packages in the
/var/cache/dnf directory. Should you want to save or copy any particular packages, you
can locate them there. Caching lets you easily uninstall and reinstall packages without
having to download them again. The package is retained in the cache. If caching is
disabled, the packages are automatically deleted after they are installed.

Your cache can increase rapidly, so you may want to clean it out on occasion. If you
just want to delete these packages, as they are already installed, you can use the clean
packages option.

dnf clean packages

Manually Installing Packages with rpm

You can use the rpm command to install individual RPM packages that are not part of a
DNF repository. Keep in mind that most software resides on DNF-supported, Fedora-
compliant repositories. For such software, you use the dnf command or the Packages
frontend. DNF has the advantage of automatically installing any dependent packages,
whereas the rpm command, although it will detect needed packages, will not install
them. Using only the rpm command, you would have to separately install any dependent
packages in the correct order.

The rpm command is useful for packages that are not part of any DNF-supported
repository, such as custom-made packages, and that have few or no dependent
packages. You can also use the rpm command to bypass DNF, forcing installation of a
particular package, instead of from DNF repositories.

The rpm command performs installation, removal, and verification of software
packages. An RPM package is an archive of software files. Each archive has a name that
ends with . rpm, indicating it is a software package that can be installed by the Red Hat
Package Manager.

The rpm command uses a set of options to determine what action to take. The -1
option installs the specified software package, and the -U option updates a package. With
an -e option, rpm uninstalls the package. A q placed before an i (-qi) queries the system to
see if a software package is already installed and displays information about the software
(-gp1i queries an uninstalled package file). The rpm command with no options provides a
complete list of rpm options. A set of commonly used options is shown in Table 4-5.
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Table 4-5. rpm Command Options

Option Action

-U Updates a package

-i Installs a package

-e Removes a package

-qi Displays information for an installed package

-ql Displays a file list for an installed package

-gpi Displays information from an RPM package file (used for uninstalled packages)
-qpl Displays the file list from an RPM package file (used for uninstalled packages)
-K Authenticates and performs an integrity check on a package

The software package name includes information about the version and release date.
In the next example, the user installs the xvidcore package using the rpm command.
Notice that the full filename is entered. In most cases, you would install packages with
the -U option, for update. If the package is not already installed, -U will install it. The
following examples use the DivX xvidcore RPM packages downloaded from
http://rpmfusion.org.

$ rpm -Uvh xvidcore-1.3.5-1.fc28.x86_64.rpm

To list the full name, you can use the 1s command with the first few characters and
an asterisk (*), as follows:

1s xvid*
You can also use the * to match the remainder of the name, as in the following:
1s xvidccore-1*.rpm

When RPM performs an installation, it first checks for any dependent packages.
These are other software packages with programs the application you are installing has
to use. If other dependent packages must be installed first, RPM cancels the installation
and lists those packages. You can install those packages and then repeat the installation
of the application. To determine if a package is already installed, use the -qi option with
rpm. The -q stands for query. To obtain a list of all the files the package has installed, as
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well as the directories it installed to, use the -ql option. To query package files, add the p
option. The -qpi option displays information about a package, and -qp1 lists the files in
it. The following example lists all the files in the xvidcore package:

$ rpm -gpl xvidcore-1.3.5-1.fc28.x86_64.rpm

To remove a software package from your system, first use rpm -qi to make sure it is
actually installed, then use the -e option to uninstall it. As with the -qi and -e options,
you needn’t use the full name of the installed file. You only need the name of the
application. In the following example, the user removes the DivX xvidcore package from
the system:

$ rpm -e xvidcore

Package Security Check

DNF automatically performs integrity and authentication checks on all software
downloaded from Fedora-compliant repositories, confirming that the package was
obtained from a valid source, and that it has not been modified. Each repository
configuration file in the /etc/yum.repos.d directory will have its gpgcheck option set
to 1. Should you want to turn off this check for a particular repository, you can set its
gpgcheck option to 0.

For packages not downloaded from a DNF repository, you may want to manually
check their integrity and authentication. To authenticate a package, you check its
digital signature. Packages are signed with encrypted digital keys that can be decrypted
using the public key provided by the author of the package. This public key has to be
downloaded and installed on the encryption tool used on your system. Fedora, along
with most Linux distributions, uses the GNU Privacy Guard (GPG) encryption tool. To
use a public key to authenticate an RPM package, you first must install it in the RPM
key database. For all RPM packages that are part of the Fedora distribution, you can use
the Fedora public key, placed during installation in the /etc/pki/rpm-gpg/ directory.
Here, you will find the RPM GPG keys for all your configured repositories, including
RPM Fusion.
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The Fedora key is RPM-GPG-KEY-fedora-28-primary. Several keys are links to this
key, such as RPM-GPG-KEY-28-fedora and RPM-GPG-KEY-fedora-28-x86 64. The RPM
Fusion keys will have the same structure, with a primary key, such as RPM-GPG-KEY -
rpmfusion-free-fedora-28-primary, and links to it, such as RPM-GPG-KEY-rpmfusion-
free-fedora-28.

You must import the key to the RPM database before you can check Fedora RPM
packages. The first time you use PackageKit to install a package, you will be prompted to
import the GPG key. Once imported, you need not import it again. Alternatively, you can
manually import the key, as follows:

rpm --import /etc/pki/rpm-gpg/RPM-GPG-KEY-fedora

If you have downloaded an RPM package from another site, you can also download
and install its public key, with which you can authenticate that package. For example,
there are public keys for both the RPM Fusion free and non-free Fedora DNF
repositories. These are included in the RPM Fusion DNF configuration files, which you
can download and install, such as rpmfusion-free-release-28.noarch.rpmfor RPM
Fusion repositories. The keys will be automatically installed with the configuration.

Once the public key is installed, you can check the package authentication using the
rpm command with the -K option.

rpm -K xvidcore-1.3.5-1.fc28.x86 _64.rpm

To see a list of all the keys you have imported, you can use the -ga option and match
the gpg-pubkey* pattern. Using rpm with the -qi option and the public key, you can display
detailed information about the key. The following example shows the Fedora public key:

$ rpm -qa gpg-pubkey*
gpg-pubkey-4f2a6fd2-3f9dod3b
gpg-pubkey-db42a60e-37ea5438

You can manually check a package’s integrity with the rpm command with the -K and
the --nosignature options. A value called the MD5 digest measures the contents of a
package. If the value is incorrect, the package has been tampered with. Some packages
provide just digest values, allowing only integrity checks. In the next example, the user
checks whether the xvidcore package has been tampered with. The --nosignature
option says not to perform authentication, performing the integrity check only.

rpm -K --nosignature xvidcore-1.3.5-1.fc28.x86 64.rpm
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Installing Source Code Applications

Some applications are available for Linux in source code format. These programs are
stored in a compressed archive that you have to decompress and then extract. The
resulting source code can then be configured, compiled, and installed on your system.
Always check the README and INSTALL files that come with the source code to check
the appropriate method for creating and installing that software. Be sure that you have
installed all development packages onto your system. Development packages contain
the key components, such as the compiler, GNOME and KDE headers and libraries, and
preprocessors. You cannot compile the source code software without them.

Several tools you may need for installing and managing source code are already be
installed. To install the full set of tool, use the groupinstall option with “Development
Tools” and “C Development Tools and Libraries”.

sudo dnf groupinstall "Development Tools"
sudo dnf groupinstall "C Development Tools and Libraries"

Extracting the Archive: Archive Manager (File Roller)

From the desktop, you can extract compressed archives with Archive Manager. Archive
Manager is the Fileroller application. Archive Manager displays the top-level contents
of the archive, which you can browse if you want, even reading such text files as README
and INSTALL. You also can see which files will be installed. To extract the archive, click
Extract.

Alternatively, on a command line (terminal window), you can use the tar command
to extract archives. On the command line, enter the tar command with the xvjf options
(j for bz2 and z for gz), as in the following:

tar xvjf freeciv-2.6.1.tar.bz2

Configure, Compile, and Install

Extracting the archive creates a directory with the name of the software, in this case,
freeciv-2.3.4. Once it is extracted, you must configure, compile, and install the
software, using command-line commands (terminal window).
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Change to the software directory with the cd command.
cd freeciv-2.6.1

Run the command ./configure to generate a compiler configuration for your
particular system (creates a custom makefile used to compile the source code).

./configure
Compile the software with the make command.
make
Then install the program with the make install command.

make install
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CHAPTER 5

Office Applications, Email,
Editors, and Databases

Several office suites are now available for Fedora (see Table 5-1). These include
professional-level word processors, presentation managers, drawing tools, and
spreadsheets. The freely available versions are described in this chapter.

Table 5-1. Linux Office Suites

Website Description
https://www.libreoffice.org LibreOffice open source office suite
https://www.calligra.org Calligra suite, for KDE
https://www.openoffice.org Apache Open0Office
https://www.codeweavers.com CrossOver Office (Microsoft Office support)
https://www.scribus.net Scribus desktop publishing tool

Linux provides many text editors that range from simple text editors to those with
complex features such as spell checking, buffers, or complex searches. All generate
character text files and can be used to edit Linux text files.

Fedora also provides a wide range of electronic mail applications, including desktop
email applications featuring calendars and address books. Evolution and Thunderbird
are the primary applications, both of which support GNOME Contacts. Newsreaders are
also supported.

Fedora also supports several ebook readers, such as Calibre and FBReader, which
run natively on Linux.

Fedora includes MySQL and PostgreSQL open source databases in its distribution,
which can support smaller databases. Several database management systems are also

available for Linux.
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Office Applications

LibreOffice is currently the primary office suite supported by Fedora. Calligra is an

office suite designed for use with KDE. CodeWeavers CrossOver Office provides reliable
support for running Microsoft Office Windows applications directly on Linux, integrating
them with KDE and GNOME. You can also download the Apache OpenOffice suite
(originally, Oracle/StarOffice). For desktop publishing, especially PDF generation, you
can use Scribus, a cross-platform tool available from the Fedora repository.

LibreOffice

LibreOffice is a fully integrated suite of office applications developed as an open source
project and freely distributed to all. It is the primary office suite for Fedora, accessible
from the Applications overview. LibreOffice is the open source and freely available office
suite derived originally from OpenOffice. LibreOffice is supported by the Document
Foundation, which was established after Oracle’s acquisition of Sun, the main developer
for OpenOffice. LibreOffice is now the primary open source office software for Linux.
LibreOffice has replaced OpenOffice as the default office software for most Linux
distributions.

LibreOffice includes word processing, spreadsheet, presentation, and drawing
applications (see Table 5-2). Versions of LibreOffice exist for Linux, Windows, and
MacOS. You can obtain information such as online manuals and FAQs, as well as current
versions, from the LibreOffice website at https://www.libreoffice.org.

Table 5-2. LibreQffice.org Applications

Application  Description

Calc LibreOffice spreadsheet

Draw LibreOffice drawing application

Writer LibreOffice word processor

Math LibreOffice mathematical formula composer

Impress LibreOffice presentation manager

Base Database frontend for accessing and managing a variety of different databases

172


https://www.libreoffice.org
http://libreoffice.org

CHAPTER 5  OFFICE APPLICATIONS, EMAIL, EDITORS, AND DATABASES

LibreOffice is an integrated suite of applications. You can open the writer,
spreadsheet, or presentation application directly from the Applications overview. The
word processing, spreadsheet, and presentations applications are also accessible from
the Launcher: Writer, Calc, and Impress. You can also open existing office documents
(Open button) and manage document templates. Buttons at the bottom of the dialog let
you download new features and templates and access the LibreOffice website.

The LibreOffice Writer word processor supports standard word processing features,
such as cut-and-paste, spell checking, and text formatting, as well as paragraph styles
(see Figure 5-1). Context menus let you format text easily. Wizards (Letter, Web Page,
Fax, and Agenda) let you generate different kinds of documents quickly. You can embed
objects within documents, such as using Draw to create figures that you can then drag
and drop to the Writer document. LibreOffice Writer is compatible with earlier versions
of Microsoft Word. It will read and convert Word 2003 and earlier documents to a
LibreOffice Writer document, preserving most features, including contents, tables, and
indexes. Writer documents also can be saved as Word documents.

vacation.odt - LibreOffice Writer x
Fle Edit View Insert Format Styles Table Form Tools Window Help F
H-B8-H-Jdea A A1 T-HOT =F-Q =B WE Z2 /68
DefautStyle | « |(F @) LberstionSe (v | 12 |+ A @ gd Py G A-¥Y-E-E-ES=EE I=E-F E=

Hi.

How was your vacation

Pagelofl 5 words, 77 characters | Detaut Seyte | Engleh (US4 | =| 0 0b @

Figure 5-1. LibreOlffice: Writer word processor

LibreOffice provides access to many database files. File types supported include
ODBC (Open Database Connectivity), JDBC (Java), MySQL, PostgreSQL, and MDB
(Microsoft Access) database files. You can also create your own simple databases. Check
the LibreOffice Features » Base page at https://www.libreoffice.org/discover/base
for detailed information on drivers and supported databases.
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LibreOffice Calc is a professional-level spreadsheet. With LibreOffice Math
(LibreOffice Formula), you can create formulas that you can embed in a text
document. With the presentation manager (LibreOffice Impress), you can create
images for presentations, such as circles, rectangles, and connecting elements like
arrows, as well as vector-based illustrations. Impress supports advanced features, such
as morphing objects, grouping objects, and defining gradients. Draw is a sophisticated
drawing tool that includes 3D modeling tools (LibreOffice Drawing). You can create
simple or complex images, including animation text aligned on curves. LibreOffice
also includes a printer setup tool with which you can select printers, fonts, paper sizes,
and page formats.

Also for use on GNOME is Scribus, the open source desktop publishing tool
(see Figure 5-2) at www.scribus.net. Scribus provides professional-level page layout
capabilities for all Linux distribution, with color management and PDF generation.

Note The former Oracle OpenOffice suite is now Apache OpenOffice. It is a fully
integrated and Microsoft Office—compatible suite of office applications developed
and supported originally by Sun Microsystems under the name StarOffice. It is
now developed and supported by Apache; see www.openoffice.org. You can
download and install directly from the website. It is not yet available on the Fedora
repositories.
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Figure 5-2. Scribus desktop publisher
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Calligra

Calligra is an integrated office suite for the K Desktop Environment (KDE), consisting

of several office applications, including a word processor, a spreadsheet, and graphics
applications (calligra package). Calligra is the new version of KOffice, integrating many
of the older applications provided by KOffice. Calligra allows components from any one
application to be used in another, allowing you to embed a spreadsheet from Calligra
Sheets or diagrams from Karbon in a Calligra Words document. It also uses the open
document format (ODF) for its files, providing cross-application standardization. There
is also a Windows version available. You can obtain more information about Calligra
from https://www.calligra.org.

Currently, Calligra includes Calligra Sheets, Calligra Flow, Calligra Words, Karbon,
Krita, Plan, Calligra Stage, Braindump, and Kexi (accessible from Office and Graphics;
see Table 5-3). The contact application, Kontact, has been spun off as a separate project.
Kontact is an integrated contact application including Kmail, Korganizer, Kaddressbook,
and Knotes. Calligra Sheets is a spreadsheet; Calligra Stage is a presentation application;

Karbon is a vector graphics program; and Calligra Words is a publisher-like word

processor. Krita is a paint and image editor. Kexi provides database integration with

Calligra applications, currently supporting PostgreSQL and MySQL.

Table 5-3. Calligra Applications

Application Description
Braindump Whiteboards for notes, images, and charts
Calligra Flow Flowchart applications

Calligra Stage
Calligra Words
Calligra Sheets
Karbon

Kexi

Plan

Krita

Kontact (separate project)

Presentation application

Word processor (desktop publisher)
Spreadsheet

Vector graphics program

Database integration

Project management and planning
Paint and image-manipulation program

Contact application including mail, address book, and organizer
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Calligra Sheets is the spreadsheet application, and it incorporates the basic
operations found in most spreadsheets, with formulas similar to those used in MS
Excel. You can also embed charts, pictures, or formulas using Krita and Karbon. With
Calligra Stage, you can create presentations consisting of text and graphics modeled
using different fonts, orientations, and attributes, such as colors. Karbon is a vector-
based graphics program, much like Adobe Illustrator and LibreOffice Draw. It supports
the standard graphic operations, such as rotating, scaling, and aligning objects. Calligra
Words can best be described as a desktop publisher, with many of the features found in
publishing applications. Although it is a fully functional word processor, Calligra Words
sets up text in frames that are placed on the page like objects. Frames, like objects in a
drawing program, can be moved, resized, and reoriented. You can organize frames into a

frame set, having text flow from one to the other.

GNOME Office Applications

There are several GNOME applications that are used for Office tasks, including AbiWord,
Gnumeric, Evince, and Evolution. These applications are located on the Fedora
repository. A current listing of the common GNOME applications for Office related

tasks is shown in Table 5-4. All applications implement the support for embedding
components, ensuring drag-and-drop capability throughout the GNOME interface.

Table 5-4. Office Applications for GNOME

Application Description

AbiWord Cross-platform word processor

Gnumeric Spreadsheet

Evince Document viewer

Evolution Integrated email, calendar, and personal organizer
Dia Diagram and flowchart editor

GnuCash Personal finance manager

Glom Database frontend for PostgreSQL database
glabels Label designer

Inkscape Vector graphics and presentation creation
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AbiWord is an open source word processor that aims to be a complete cross-platform
solution, running on Mac, UNIX, and Windows, as well as Linux. It is part of a set of
desktop productivity applications being developed by the AbiSource project
(www.abisource.com).

Gnumeric is a professional-level GNOME spreadsheet meant to replace commercial
spreadsheets. Gnumeric supports standard desktop spreadsheet features, including auto
filling and cell formatting, and an extensive number of formats. Gnumeric also supports
plugins, making it possible to extend and customize its capabilities easily.

Dia is a drawing program designed to create diagrams, such as database, circuit
object, flowchart, and network diagrams. You can create elements along with lines and
arcs with different types of endpoints, such as arrows or diamonds. Data can be saved in
XML format, making it transportable to other applications.

GnuCash (www.gnucash.org) is a personal finance application for managing
accounts, stocks, and expenses.

Running Microsoft Office on Linux: Wine and CrossOver

One of the concerns that new Linux users have relates to the kind of access they will have to
their Microsoft Office files, particularly Word files. The major Linux Office suites, including
Calligra, LibreOffice, and Oracle OpenOffice, all read and manage Microsoft Office files.

Wine (Windows Compatibility Layer) allows you to run many Windows applications
directly, using a supporting virtual windows API. See the Wine website for a list
of supported applications; see also www.winehq.org, the AppDB tab. Well-written
applications may run directly from Wine, like the Newsbin newsreader. Each user
can install a version of Wine with its own simulated C partition on which Windows
applications are installed. The simulated drive is installed as drive c in the .wine
directory. The .wine directory is a hidden directory. It is not normally displayed with
the 1s command or the GNOME file manager (View » Show Hidden Files). You can also
use any of your Linux directories for your Windows application data files instead of the
simulated C drive. These are referenced by Windows applications as the z: drive.

It is possible to install Microsoft Office on Fedora using Wine. Although there may
be difficulties with the latest Microsoft Office versions, earlier versions, such as 2002,
should work fine for the most part (see waw.winehq.org, AppDB tab, search on Word).
Applications are rated platinum, gold, silver, bronze, and garbage. Although effective,
Wine support is not as stable as CrossOver.
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CrossOver Office is a commercial product that lets you install and run most
Microsoft Office applications (it has a silver rating). CrossOver Office was developed
by CodeWeavers, which also supports Windows web browser plugins as well as several
popular Windows applications, such as Adobe Photoshop. CrossOver features both
standard and professional versions, providing reliable application support. You can find
out more about CrossOver Office at www.codeweavers . com.

CrossOver can be installed either for private multiuser mode or managed multiuser
mode. In private multiuser mode, each user installs Windows software, such as full
versions of Office. In managed multiuser mode, the Windows software is installed
once, and all the users share it. Once the software is installed, you will see a Windows
Applications menu on the main menu, from which you can start your installed Windows
software. The applications will run within a Linux window, but they will appear just as if
they were running in Windows.

With VMware, you can run Windows under Linux, allowing you to run Windows
applications, including Microsoft Office, on your Linux system. For more information,
check the VMware website at https://www.vmware.com.

Another option, for users with high-powered computers that support virtualization,
is to install the Windows OS on a virtual machine, using the Boxes virtual machine
manager. You could then install and run Windows on the virtual machine and install
Microsoft Office on it.

GNOME Documents

You can use the GNOME Documents application to access and search for local and
cloud-based documents. Documents can be text (word processing), spreadsheets,
presentations, or PDF files. Currently, both Google docs and Microsoft SkyDrive
documents are supported. You have to enable access from the Online Accounts dialog
on GNOME Settings.

GNOME Documents is accessible from the Applications overview. The Documents
dialog shows tabs for both Documents and Collections. Documents lists your local and
cloud-based documents (see Figure 5-3). The Documents GNOME applications menu lets
you view the documents in a grid (icons) or as a list. Collections are categories you can set
up to organize your documents. There are buttons at the right of the title bar for searching,
sorting, and editing. Click the Search button to open a search box with a menu that lets you
search for source (local or cloud), type, and search target (title or author).
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Figure 5-3. GNOME Documents, with search

Click the checkmark button at the top right to open a taskbar, which lets you open
the document or print it (see Figure 5-4). In the list view, click the check box to the left of
the document you want to perform the task on. In the grid view, a check box is displayed
at the lower right of each icon. When you click a check box, the taskbar is displayed
with buttons to open the document in the appropriate application, print the document,
and delete it. The Properties button displays information about the document. The
Collections button lets you place the document in a collection. When you're finished,
click the Done button.
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vacation
Open with LibreOffice Writer <= = Collections Properties

Figure 5-4. GNOME Documents tasks

Document Viewers and Scanning (PostScript, PDF,
and DVI)

Although technically considered graphics applications, PostScript, PDE DVI, and
viewers are more commonly used with Office applications (see Table 5-5). Evince and
Okular can display both PostScript (. ps) and PDF (. pdf) files. Evince is the default
document viewer for GNOME. It is started automatically whenever you double-click a
PDF file on the GNOME desktop. Okular is the default document viewer for KDE, with its
overview icon as Okular.
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Table 5-5. PostScript, PDE and DVI Viewers

Viewer Description
Evince Document viewer for PostScript, DVI, and PDF files
Okular KDE tool for displaying PDF, DVI, and PostScript files (replaces KPDF,

Kghostview, and Kdvi)
Xpdf X Window System tool for displaying PDF files only

Acrobat Reader for Linux Adobe PDF viewer and ebook reader (https://get.adobe.com/
flashplayer/otherversions)

Scribus Desktop publisher for generating PDF documents
Simple Scan GNOME Scanner interface for scanners (Graphics » Simple Scan)
Yagf and cuneiform OCR text conversion supporting multiple languages (install with dnf)

Okular, Evince, and Xpdf are PDF viewers. They include many of the standard Adobe
Reader features, such as zoom, two-page display, and full-screen mode. Alternatively, you
can use Acrobat Reader from Adobe to display PDF files. You can install it with Packages
once you have enabled the Adobe repository (https://get.adobe.com/flashplayer/
otherversions/ as Linux and (Yum)). The package name is flash-plugin.

All these viewers can also print documents. To generate PDF documents, you can
use LibreOffice Writer or the Scribus desktop publisher (https://www.scribus.net),
and to edit PDF documents, you can use pdfedit.

Linux also features a professional-level typesetting tool, called TeX, commonly used
to compose complex mathematical formulas. TeX generates a DVI document that can be
displayed by DVI viewers, several of which are available for Linux. DVI files generated by
the TeX document application can be viewed by Evince, Okular, and LibreOffice.

To scan documents directly, you can use Simple Scan, which you can save as JPEG,
PNG, or PDF files. For OCR tasks, you can use cuneiform. Yagf provides a desktop
frontend for cuneiform, allowing you to scan and convert text. You can choose from
several languages.
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Ebook Readers: FBReader and Calibre

On Fedora, you can use the Linux versions of Calibre and FBReader for ebooks

(see Table 5-6). FBReader is an open source reader that can read non-DRM ebooks,
including Mobipocket, HTML, EPUB, text, and RTF (install the fbreader-gtk package).
The toolbar holds operations that move you through the text and configure your reader,
adding books and setting interface preferences (see Figure 5-5). To see your selection of
books, click the Library Tree icon on the left. You can organize text by author or tag.

On the Options window, the Library tab lets you choose where your books are stored.

Table 5-6. Ebook Readers

Reader Description
Calibre Ebook reader and library, also converts various inputs to EPUB
ebooks

Ebook reader (Ebook reader) FBReader ebook reader, search under E-book reader (install with dnf)

Kindle Cloud Reader Amazon Kindle ebook reader

FI-LID€E€EdP QR E i a 2
About FBReader I

FBReader is an e-book reader for Linux/Windows XP
PDA/UMPC/desktop computer. FBReader supports several
e-book formats: ePub, fb2, chm, rtf, plucker, etc. Direct

reading from zip, tar, gzip and bzip2 archives is also sup-

ported. ! ‘

Figure 5-5. FBReader ebook reader
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Calibre reads PDF, EPUB, Lit (Microsoft), and Mobipocket ebooks (see Figure 5-6).
Calibre functions as a library for accessing and managing your ebooks. Calibre can convert
many document files and ebooks to the EPUB format, the new open source standard used
by Apple (iPad) and Amazon (Kindle). It can take as conversion input text, HTML, RTE and
ODT (LibreOffice), as well as ebooks.

Note For older PDAs, you can use the pilot tools to access your handheld device,
transferring information between it and your system. You can use the J-Pilot,
KPilot, and GnomePilot applications to access your PDA from your desktop. The
pilot-1ink package holds tools you can use to access your PDA. Check
www.pilot-link.org for detailed documentation and useful links.

calibre - || Calibre Library ||

*
R & 1 B Ee? I B o W
Add books [Edit metadata Convert books View Gt hooks Feteh news Help Remove booke Calitye Library Save to disk Connect/share  Edit book
= O Search [ Saved search

Is Virtual library 0 Search [For advanced search click the gear koon to the left)

v & Authors 1 Title Author(s) Date =~ Size(MB) Rating Tags  Series  Publisher  Published Quick Start Gulde
. 1 b} Cuick Start Guide John Schember 19 May 2018 ol
Lncrisges -
Ty Series o €T
W
» M Formats 1 'f‘?u
2]
8 Publisher o Ly
Rating 0
@ News o Authors: John
o Togs o Schember
I ienifiers o Formats: EFUB
A Path:  Click to
open
. calibre Quick Start
# Confiqure X\ Find Guiide

calibre 3,19 created by Kovid Goyal [one book, 1 selected] #Lyout () Jobs: 0

Figure 5-6. Calibre ebook reader and converter

GNOME Notes

The GNOME Notes (Bijiben) application lets you create and organize simple notes on
your desktop. The Notes window lists your new and recent notes, showing the note title
and the first few lines of text (see Figure 5-7). In the header bar, the search button opens
a search box that lets you search for notes. The list button lets you switch between icon
and list views. The check button lets you delete or organize your notes. A check box is
displayed at the lower-right corner of the note icons. Clicking on that check box opens a
taskbar at the bottom with buttons to delete the note, add it to a collection (notebooks),
or email it. There is also a color button that you can use the background color.
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New New and Recent Q[ [ 2] [ « x
vacation things to do today
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travel
vacation things to do today

—_—
Figure 5-7. GNOME Notes

To create a new note, click the New button on the title bar to open a new text. The first
line is the title of your note. Press the Enter key to move to the next line (see Figure 5-8).
A color button lets you change the background color. The task menu (menu button)
provides undo/redo functions, deletion, and email options. You can also add the note to a
notebook. You can use notebooks to organize your notes. The share button lets you share
the note with other users.

£ Untitled = x

How was your vacation OPen in New Window

Undo
Redo

Notebooks
Email this Note

Move to Trash

Cancel Note Color

Last updated Today

Figure 5-8. GNOME Documents tasks
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Clocks

Two helpful tools are the clocks and weather applications. Clocks has four tabs: World,
Alarm, Stopwatch, and Timer. The World tab displays the current time at any city and at
your current location (see Figure 5-9). Click the New button to open a dialog in which you
can add a city. To remove a city, click the check button to display a check box in the lower-
right corner of each time icon. Check the ones you want to delete, and then click the Delete
button. The Alarm tab works as an alarm clock. The Stopwatch tab operates a stopwatch,
letting you mark laps. The timer counts down in time. You set the start amount.

World Alarm Stopwatch Timer 0 x

!' T Y

12:04 12:04 18:04

" E-,
L S 1 i

@ Daly City, California, United States San Diego, California, United States Rio de Janeiro, Rio de Janeiro, Brazil

07:04

Tomorrow

Barcelona, Spain Sydney, New South Wales, Australia g

Figure 5-9. GNOME Clocks, World tab

Weather

The weather tool lets you display the weather at any city. Click the Places button to open
a dialog in which you can enter the name of a city. A partial entry is matched, giving you
a listing of possible cities. Choose the one you want. A full image of the weather for that
city is displayed, with the temperature and forecast for the next 24 hours, and a sidebar
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with the forecast for the next several days (see Figure 5-10). To see recently viewed cities,
click the Places button to open a dialog where you can choose a city from the Recently
Viewed list (see Figure 5-11).

Weather = ThulZi2e

San Francisco, San Francisco International Airport

Temperature unit -

Al £

62 °F 61 °F 60 °F

San Franc

London

Figure 5-11. GNOME Weather: City with forecast
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The Fedora desktops (GNOME and KDE) support powerful text editors with full mouse
support, scroll bars, and menus. These include basic text editors, such as Gedit and Kate,

as well as word processors, such as LibreOffice Word, AbiWord, and KWord. Fedora also

provides the cursor-based editors Nano, Vim, Emacs, and Leafpad. Nano is a cursor-based

editor with an easy-to-use interface supporting menus and mouse selection (if it’s run from

a terminal window). Vim is an enhanced version of the vi text editor used on UNIX. These

editors use simple, cursor-based operations to give you a full-screen format. Table 5-7

lists several desktop editors for Linux. Vim and Emacs have powerful editing features that

have been refined over the years. Emacs, in particular, is extensible to a full-development

environment for programming new applications. Later versions of Emacs and Vim—such as

GNU Emacs, XEmacs, and Gvim—provide support for mouse, menu, and window operations.

Table 5-7. Desktop Editors

Application Description

Desktop

KEdit Text editor

Kate Text and program editor

Words Desktop publisher, part of Calligra

Gedit Text editor

GNU Emacs Emacs editor with X Window System support

XEmacs X Window System version of Emacs editor

gvim Vim version with X Window System support

AbiWord Word processor (install with dnf)

OpenWriter LibreOffice word processor that can edit text files
Command-Line Interface

Vim Vim version of vi

Emacs Emacs command-line editor

Nano Screen-based command-line interface editor (install with dnf)
Leafpad Screen-based command-line interface editor with mouse support

when run from a terminal window on desktop (install with dn¥)
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Text editors are often used in system administration tasks to change or add entries
in Linux configuration files found in the /etc directory or in the user’s initialization or
application configuration files located in a user’s home directory (dot files). You can use
any text editor to work on source code files for any of the programming languages or
shell program scripts.

GNOME Text Editor: Gedit

The Gedit editor is the basic text editor for the GNOME desktop. It provides full mouse
support, implementing standard desktop operations, such as cut-and-paste to move
text, and click-and-drag to select and move/copy text. It supports standard text-editing
operations such as Find and Replace. You can use Gedit to create and modify your text
files, including configuration files. Gedit also provides more advanced features, such
as Print Preview and configurable levels of undo/redo operations, and it can read data
from pipes. It features a plugin menu that provides added functionality, and it includes
plugins for spell checking, encryption, email, and text-based web page display.

KDE Editor: Kate (KWrite)

The KDE editor Kate provides full mouse support, implementing standard desktop
operations, such as cut-and-paste to move text, and click-and-drag to select and move/
copy text. The editor is accessible from the Applications » Utilities menu on the KDE
desktop, and as KWrite on GNOME. Kate is an advanced editor, with such features as
spell checking, font selection, and highlighting. Most commands can be selected by
using menus. A toolbar of icons for common operations is displayed across the top of
the Kate window. A sidebar displays panels for a file selector and a file list. With the

file selector, you can navigate through the file system, selecting files to access. Kate

also supports multiple views of a document, letting you display segments in their own
windows, vertically or horizontally. You can also open several documents at the same
time, moving among them with the file list. Kate is designed to be a program editor for
editing software programming/development-related source code files. Kate can format
the syntax for different programming languages, such as C, Perl, Java, and XML.
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Leafpad

Leafpad is a very simple text editor that provides basic mouse support, letting you edit a
file easily (install the leafpad package). It uses an interface similar to Windows Notepad,
displaying a menu bar with the File, Edit, Search, and Options menu items. Features are
limited to basic operations such as open, save, print, cut, copy, paste, find, and replace.

Nano

Several simple keyboard-based editors are available for Fedora that work on the
command-line interface, such as nano and joe. The Nano editor is a simple screen-based
editor that lets you visually edit your file, using arrow and page keys to move around the
file (install the nano package). You use control keys to perform actions. Ctrl+x will exit and
prompt you to save the file; Ctrl+o will save it. You start Nano with the nano command.

nano myreport

To edit a configuration file, you need administrative access, so you first have to use
administrative access with the sudo command. Figure 5-12 shows the Nano editor being
used to edit the GRUB configuration file, /etc/default/grub.

sudo nano /etc/default/grub

richard@localhost:~

File Edit View Search Terminal Help
GNU nano 2.9.5 fetc/default/grub

3 TIMEOUT=

em-release)"

ap rd.lvm.lv=fedora localhost-live/$

¢ Get Help (§ Write Out
i Read File

Figure 5-12. Editing with Nano
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Emacs Editor

The Emacs editor is tailored for program development, enabling you to format source
code according to the programming language you use. The versions usually included
with Linux distributions are GNU Emacs and XEmacs. GNU Emacs is desktop-capable,
with features such as menus, scroll bars, and mouse-based editing operations. You can
find more information about Emacs at www.emacs.org and about XEmacs at its website
at www.Xxemacs.org.

The Emacs editor operates much like a standard word processor. The keys on your
keyboard represent input characters. Commands are implemented with special keys,
such as the control (Ctrl) and alternate (Alt) keys. There is no special input mode, as in
vi. You type in your text, and if you have to execute an editing command, such as moving
the cursor or saving text, you use a Ctrl key. Such an organization makes the Emacs
editor easy to use. You invoke the Emacs editor with the command emacs. You can enter
the name of the file you want to edit, and if the file does not exist, it is created. In the
following example, the user prepares to edit the file mydata with Emacs:

emacs mydata

The GNU Emacs editor supports basic desktop-editing operations such as selection
of text with click-and-drag mouse operations, cut/copy/paste, and a scroll bar for
moving through text. The Mode line and Echo areas are displayed at the bottom of the
window, where you can enter keyboard commands.

Note XEmacs is the complete Emacs editor with a graphical user interface and
Internet applications, including a web browser, a mail utility, and a newsreader.
XEmacs is available on the Fedora repository.

The Vi Editor: Vim and Gvim

The Vim editor included with most Linux distributions is an enhanced version of the vi
editor. It includes all the commands and features of the vi editor. Vi, which stands for
“visual,” remains one of the most widely used editors in Linux. There are two versions
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of Vim available, vim-minimal, which is installed by default and provides vi editing
capabilities, and vim-enhanced, which provides more advanced features such as Perl and
Python interpreters, useful if you use vi to create Perl or Python scripts.

Keyboard-based editors like Vim and Emacs use a keyboard for two different
operations: to specify editing commands and to receive character input. Used for
editing commands, certain keys perform deletions, some execute changes, and others
perform cursor movement. Used for character input, keys represent characters that can
be entered into the file being edited. Usually, these two different functions are divided
among different keys on the keyboard. Alphabetic keys are reserved for character input,
while function keys and control keys specify editing commands, such as deleting text or
moving the cursor. Such editors can rely on the existence of an extended keyboard that
includes function and control keys.

Editors in UNIX, however, were designed to assume a minimal keyboard with
alphanumeric characters and some control characters, as well as the Esc and Enter
keys. Instead of dividing the command and input functions among different keys, the
vi editor has three separate modes of operation for the keyboard: the command and
input modes and a line-editing mode. In command mode, all the keys on the keyboard
become editing commands; in the input mode, the keys on the keyboard become input
characters. Some of the editing commands, such as a and i, enter the input mode.

On typing i, you leave the command mode and enter the input mode. Each key now
represents a character to be input to the text. Pressing Esc automatically returns you to
the command mode, and the keys once again become editor commands. As you edit
text, you are constantly moving from the command mode to the input mode and back
again. With Vim, you can use the Ctrl+o command to jump quickly to the command
mode and enter a command, and then automatically return to the input mode. Table 5-8
lists a basic set of vi commands to get you started.
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Table 5-8. Editor Commands

Command Description

h Moves the cursor left one character.

1 Moves the cursor right one character.

k Moves the cursor up one line.

j Moves the cursor down one line.

Ctrl+f Moves forward by a screen of text; the next screen of text is displayed.

Ctrl+b Moves backward by a screen of text; the previous screen of text is
displayed.

Input (All input commands place the user in input; the user leaves input
with Esc.)

a Enters input after the cursor.

i Enters input before the cursor.

) Enters input below the line the cursor is on; inserts a new empty line
below the one the cursor is currently on.

Text Selection (Vim)

% Visual mode; move the cursor to expand selected text by character.
Once selected, press a key to execute an action: ¢ change, d delete, y
copy, : line-editing command, J join lines, U uppercase, u lowercase.

V Visual mode; move cursor to expand selected text by line.

Delete

X Deletes the character the cursor is on.

dd Deletes the line the cursor is on.

Change Except for the replace command, r, all change commands place the
user into input after deleting text.

cw Deletes the word the cursor is on and places the user into the input

mode.
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Command Description

T Replaces the character the cursor is on. After pressing r, the user
enters the replacement character. The change is made without entering
input; the user remains in the vi command mode.

R First places into input mode, and then overwrites character by
character. Appears as an overwrite mode on the screen but actually is
in input mode.

Move Moves text by first deleting it, moving the cursor to desired place of
insertion, and then pressing the p command. (When text is deleted, it is
automatically held in a special buffer.)

p Inserts deleted or copied text after the character or line the
cursor is on.

P Inserts deleted or copied text before the character or line the
cursor is on.

dw p Deletes a word, and then moves it to the place you indicate with the
cursor (press p to insert the word after the word the cursor is on).

yyorY p Copies the line the cursor is on.

Search The two search commands open a line at the bottom of the screen and
enable the user to enter a pattern to be searched for; press Enter after
typing in the pattern.

/pattern Searches forward in the text for a pattern.

?pattern Searches backward in the text for a pattern.

n Repeats the previous search, whether it was forward or backward.

Line-Editing Commands

W

q

Effect
Saves the file.

Quits the editor; q! quits without saving.

193



CHAPTER 5  OFFICE APPLICATIONS, EMAIL, EDITORS, AND DATABASES

Although you can create, save, close, and quit files with the vi editor, the commands
for each are not very similar. Saving and quitting a file involves the use of special line-
editing commands, whereas closing a file is a vi editing command. Creation of a file is
usually specified on the same shell command line that invokes the vi editor. To edit a file,
type vi or vim and the name of a file on the shell command line. If a file by that name
does not exist, the system creates it. In effect, entering the name of a file that does not
yet exist instructs the vi editor to create that file. The following command invokes the vi
editor, working on the file booklist. If booklist does not yet exist, the vi editor creates it.

$ vim booklist

After executing the vim command, you enter vi’s command mode. Each key
becomes a vi editing command, and the screen becomes a window onto the text file.
Text is displayed screen by screen. The first screen of text is displayed, and the cursor is
positioned in the upper-left corner. With a newly created file, there is no text to display.
When you first enter the vi editor, you are in the command mode. To enter text, you must
enter the input mode. In the command mode, a is the editor command for appending
text. Pressing this key places you in the input mode. Now the keyboard operates like a
typewriter, and you can input text to the file. If you press Enter, you merely start a new
line of text. With Vim, you can use the arrow keys to move from one part of the entered
text to another and work on different parts of the text. After entering text, you can leave
the input mode and return to the command mode by pressing Esc. Once you've finished
with the editing session, you exit vi by typing two capital Zs, ZZ. Hold down the Shift key
and press Z twice. This sequence first saves the file and then exits the vi editor, returning
you to the Linux shell. To save a file while editing, you use the line-editing command w,
which writes a file to the disk. w is equivalent to the Save command found in other word
processors. You first type a colon to access the line-editing mode and then type w and
press Enter, :w.

You can use the :q command to quit an editing session. Unlike the ZZ command,
the :q command does not perform a save operation before it quits. In this respect, it has
one major constraint. If any modifications have been made to your file since the last save
operation, the :q command will fail, and you will not leave the editor. However, you can
override this restriction by placing a ! qualifier after the :q command. The command
:q! will quit the vi editor without saving any modifications made to the file during that
session (the combination :wq is the same as ZZ).
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To obtain online help, enter the :help command. This is a line-editing command.
Type a colon, enter the word help on the line that opens at the bottom of the screen,
and then press Enter. You can add the name of a specific command after the word help.
Pressing the F1 key also brings up online help.

As an alternative to using Vim in a command-line interface, you can use gvim, which
provides X Window System-based menus for basic file, editing, and window operations.

The package vimis called the vim-X11 package, which includes several links to Gvim,
such as evim, gview, and gex (open Ex editor line). To use Gvim, you can enter the gvim
command at a terminal prompt. The standard vi interface is shown, but with several
menu buttons displayed across the top, along with a toolbar with buttons for common
commands like search and file saves. All the standard vi commands work as described
previously; however, you can use your mouse to select items on these menus. You can
open and close a file, or open several files, using split windows or different windows. The
editing menu enables you to cut, copy, and paste text as well as undo or redo operations.

In the editing mode, you can select text with your mouse with a click-and-drag
operation or use the Editing menu to cut or copy and then paste the selected text. Text
entry, however, is still performed using the a, i, or o commands to enter the input mode.
Searches and replacements are supported through a dialog window. There are also
buttons on the toolbar for finding next and previous instances. You can also split the
view into different windows to display parts of the same file or different files. Use the
:split command to open a window, and use :hide to close the current one. Use Ctrl+w
with the up and down arrow keys to move between them. On Gvim, you use entries in
the Windows menu to manage windows. Configuration preferences can be placed in the
user’s .vimrc file.

Mail (Email) and News

Electronic mail utilities perform the same basic tasks of receiving and sending messages.
Some mail clients operate on a desktop, such as KDE or GNOME. Others are designed to
use a screen-based interface and can be run only from the command line (the terminal
window). For web-based Internet mail services, such as Gmail and Yahoo, you can use a
web browser instead of a mail client to access mail accounts provided by those services.
Table 5-9 lists several popular Linux mail clients. Mail is sent to and from destinations
using mail transport agents, such as Sendmail, Exim, and Smail.
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Table 5-9. Linux Mail Clients

Mail Client Description

Kontact (KMail, Includes the K Desktop mail client, KMail; integrated mail, address

KAddressBook, KOrganizer)  book, and scheduler

Contacts GNOME contact database synced with Online Accounts (currently
supports only Google contacts)

Documents GNOME documents for locating local and cloud-based documents;
synced with Online Accounts (Google Docs and Microsoft SkyDrive)

Evolution Email client

Thunderbird Mozilla group standalone mail client and newsreader

Sylpheed Gtk mail and news client (install with dn)

Claws Mail Extended version of the Sylpheed email client (install with dnf)

GNU Emacs and XEmacs
Mutt

Emacs mail clients

Screen-based mail client (install with dnf)

Mail Original UNIX-based command-line mail client
Squirrel Mail Web-based mail client (install with dn)
Evolution

Evolution is the primary mail client for the GNOME desktop. Although it’s designed

for GNOME, it works equally well on other desktops. Evolution provides a mail client,

calendar, and address book. The mailer supports several protocols (SMTP, POP, and

IMAP), multiple mail accounts, and encryption. It also supports Pretty Good Privacy

(PGP) and GNU Privacy Guard (GPG) encryption. Messages are indexed for easy

searching. Junk mail filtering is provided. See the Evolution website (https://wiki.

gnome.org/Apps/Evolution) for a complete description of its features.

You can access Evolution from the Applications overview. The Evolution mailer

provides a simple desktop interface, with a toolbar for commonly used commands

and a sidebar for shortcuts. A set of buttons on the lower left allows you to access other

operations, such as the calendar and contacts. The mail screen is divided into two

panes, one for listing the mail headers and the other for displaying the currently selected
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message (see Figure 5-13). You can click any header title to sort your headers by that
category. Evolution also supports the use of virtual folders created by the user to hold
mail that meets specified criteria. Incoming mail can be automatically distributed to a
particular virtual folder.

Mail — Evolution ®
File Edit View Message Folder Search Help
New ¥ Send/Recewe = L roL y v ~ = g -
Mail Show: All Messages w | Search:| Q Subject or Addresses contal in| Current Folder
+ On This Computer 4 8 O From Subject Date ToDe
2 Inbox Today
 Drafts Tomorrow
< Junk 05/20/2018
S Outhax 05/21/2018
Sent 05/22/2018
Templates 05/23/2018
@ Trash 05/24/2018

= Search Folders
TUnmatched
Mail

a Contacts
[] catendar
[Q Tasks

Figure 5-13. Evolution email client

To configure Evolution, select Preferences from the Edit menu (Edit » Preferences).
On the Evolution Preferences window, a sidebar shows icons for mail accounts, contacts,
mail preferences, composer preference, network preferences, calendar and tasks, and
certificates. The main accounts entry displays a list of current accounts. An Add button
lets you add new accounts, and the Edit button allows you to change current accounts.

Numerous plugins are available to extend Evolution’s capabilities. Most are installed
and enabled for you automatically, including the SpamAssassin plugin for handling junk
mail. To manage your plugins, select the Plugins entry in the Edit menu (Edit » Plugin)
to open the Plugin Manager. The plugins are listed in a left scroll window, and the
configuration tabs for a selected plugin are on the right.

Evolution also supports contact operations such as calendars, contact lists, and
memos. On the left-side pane, the bottom section displays buttons for these different
functions: Mail, Contacts, Calendars, Tasks, and Memos. To see and manage your
contacts, click the Contacts button on the left sidebar. The Calendar displays a browsable
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calendar on the left pane to move easily to a specific date. The right pane shows a daily
calendar page by the hour, with sections for tasks and memos. You can set up several
calendars, which you can access at the top of the right pane. A personal calendar is set
up for you already. To add a new calendar, select Calendar from the New menu. This
opens a New Calendar dialog, from which you can choose the type and name.

Thunderbird

Thunderbird is a full-featured standalone email client provided by the Mozilla project
(www.mozilla.org). It is designed to be easy to use, highly customizable, and heavily
secure. It features advanced intelligent spam filtering, as well as security features

such as encryption, digital signatures, and S/MIME. To protect against viruses, email
attachments can be examined without being run. Thunderbird supports both the
Internet Message Access Protocol (IMAP) and the Post Office Protocol (POP). It also
functions as a newsreader and features a built-in RSS reader. Thunderbird also supports
the use of the Lightweight Directory Access Protocol (LDAP) for address books.
Thunderbird is an extensible application, allowing customized modules to be added to
enhance its capabilities. You can download extensions such as dictionary search and
contact sidebars from the website.

Thunderbird provides integration with popular online mail services like Gmail,
saved searches, and customized tags for selected messages. You can access Thunderbird
from the Applications overview.

The Thunderbird interface uses a standard three-pane format, with a side pane for
listing mail accounts and their mailboxes (see Figure 5-14). The top pane is the message
list pane, and the bottom pane shows a selected message’s text. Commands can be
run using the toolbar, the tool menu (button at the right of the toolbar), or keyboard
shortcuts. You can even change the appearance using different themes. Thunderbird
also provides a Tasks tab and Calendar tab for scheduling events and noting dates.
Upcoming tasks are listed on the main window on a sidebar on the right.
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Figure 5-14. Thunderbird email client

To edit an email account, select the Preferences » Account Settings from the
menu opened by the menu button at the right of the toolbar. In the Account Settings
window, you will see an entry for your mail account, with tabs for Server Settings,
Copies & Folders, Composition & Addressing, Offline & Disk Space, Return Receipt, and
Security. The Server Settings tab has entries for your server name, port, username, and
connection and task configurations, such as when to check for messages. The Security
tab shows a Manage Certificates button, which opens the Certificate Manager, from
which you can select security certificates to use to digitally sign or encrypt messages.

Thunderbird provides an address book in which you can enter complete contact
information, including email addresses, street addresses, phone numbers, and notes.
Select the Address Book button on the toolbar to open the Address Book window.
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GNOME Contacts

If you have enabled contacts for Online Accounts, you can use the GNOME Contacts
application to manage and access those contacts (see Figure 5-16). Contacts are
downloaded from the enabled online accounts. Currently, only Google is supported.
You can then access and edit those contacts with the Contacts application, which is
accessible from the Applications overview. First be sure to switch on Contacts in System
Setting’s Online Accounts (see Figure 5-15).

Q Settings Online Accounts x
+ Wi-Fi
Connect to your data in the cloud

3 Bluetooth
© Background Add an account
A Notifications S Google
Q, Search

B oot
B Region & Language

@ Universal Access Facebook

¢ Online Accounts

um
u

Microsoft
W Privacy
®® Flickr
=5 Sharing .
40 Sound £ Podket
(e Power
a Foursquare
& Network E. n
»
Microsoft Exchaj o
fo Devices > -

Figure 5-15. Online Accounts contacts switch

Contacts displays a sidebar listing your contacts. A search box lets you search for
contacts. To add a contact manually, click the plus button (+) above the search box
(see Figure 5-16). The selected contact shows the name, icon used, and the email
address. The email entry is a mail button, which you can click to open your mailer to
compose a message to be sent to that address.
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Q, Type to search
All Contacts
. Richard Petersen
] 3
Personal richardipetersen@yahoo.com
Home Ca

g

To edit the contact information, click the edit button (pencil icon) at the top-right

Figure 5-16. GNOME Contacts

corner. You then can edit entries or provide additional information, such as the address,
phone, links, website, birthday, and notes (see Figure 5-17). For each entry, you can
classify whether it is work, home, or other. To remove a contact, click the Remove
Contact button at the lower right. You can also remove the contact by clicking on its
entry in the sidebar to display a check box, which, when clicked, displays a Remove
button at the bottom of the sidebar.

Editing Richard Petersen

Q, Type to search

..
Richard Petersen
Work = richardlpetersen@yahoo.com o}
Work wr Street =
Extension
City
Ca
Zip/Postal Code
PO box
Country

New Detail v Linked Accounts

Figure 5-17. GNOME Contacts edit
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The KDE Mail Client: KMail

The KDE mail client, KMail, provides a full-featured desktop interface for composing,
sending, and receiving email messages. KMail is part of the KDE Personal Information
Management suite (KDE-PIM), which also includes an address book (KAddressBook),
an organizer and scheduler (KOrganizer), and a note writer (KNotes). All these
components are directly integrated on the desktop into Kontact. You can start up

KMail directly or as part of the Kontact applications (Mail). KMail, along with Kontact,
KOrganizer, and KAddressBook, is accessible from the KDE Desktop Office and Internet
menus. On GNOME, you can access it from Applications overview. You can access
Kontact in the Office filter. KMail is installed as part of the KDE desktop, but you can
install it separately.

To quickly set up a new email account, you can use the Account Wizard (Tools »
Account Wizard). A series of dialogs will prompt you to enter the account type, the
account name and address, a login name and password, and the incoming and outgoing
servers. For more detailed configuration, select the Configure Kmail entry in the Settings
menu (Settings » Configure Kmail).

Emacs Mail

The GNU version of Emacs includes a mail client, in addition to other components, such
as a newsreader and editor. GNU Emacs is included on Fedora distributions. Check the
Emacs website at www. gnu.org/software/emacs for more information. When you start
GNU Emacs, menu buttons are displayed across the top of the screen. If you are running
Emacs in an X Window System environment, you have full desktop capabilities and can
select menus using your mouse. To access the Emacs mail client, select from the mail
entries in the Tools menu. To compose and send messages, just select the Send Mail item
in the Tools menu.
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Command-Line Mail Clients

Several mail clients use a simple command-line interface. They are simple and easy to
use but include an extensive set of features and options. Two of the more widely used mail
clients of this type are Mail and Mutt. Mail is the mailx mail client that was developed for
the UNIX system. It is considered a default mail client that can be found on all UNIX and
Linux systems. Mutt is a cursor-based client that runs from the command line.

Mutt

Mutt has a cursor-based interface with an extensive set of features. You can find more

information about Mutt from the Mutt website at www.mutt.org. Here, you can download
recent versions of Mutt and access online manuals and help resources. The Mutt manual
islocated in the /usr/doc directory under Mutt. To use Mutt, enter the mutt command in

a terminal window or on the command line.

Mail

The Mail utility was originally created for BSD UNIX and is called, simply, mail. Later
versions of UNIX System V adopted the BSD mail utility and renamed it mailx. Now, it
is simply referred to as Mail. Mail functions as a default mail client on most UNIX and
Linux systems. It is installed on Fedora with the mailx package.

To send a message with Mail, type mail on the command line, in addition to the
address of the person to whom you are sending the message. Press Enter, and you are
prompted for a subject. Enter the subject of the message and press Enter again. At this
point, you are placed in input mode. Anything you type is considered the contents of
the message. Pressing Enter adds a new line to the text. When you finish typing your
message, press Ctrl+d on a line of its own to end the message. You will then be prompted
to enter a user to whom to send a carbon copy (cc) of the message. If you do not want
to send a carbon copy, just press Enter. You will then see EOT (end of transmission)
displayed after you press Ctrl+d.

You can send a message to several users at the same time by listing those users’
addresses as arguments on the command line following the mail command. In the
following example, the user sends the same message to chris and aleina:

$ mail chris aleina
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To receive mail, you first enter the mail command and press Enter. This invokes
a Mail shell with its own prompt and mail commands. A list of message headers is
displayed. Header information is arranged into fields, beginning with the status of the
message and the message number. The status of a message is indicated by a single
uppercase letter, usually N for “new” or U for “unread.” A message number, used for easy
reference to your messages, follows the status field. The next field is the address of the
sender, followed by the date and time the message was received, and then the number of
lines and characters in the message. The last field contains the subject the sender gave
to the message. After the headers, the Mail shell displays its prompt, an ampersand (&).
At the Mail prompt, you enter commands that operate on the messages. An example of a
Mail header and prompt follows:

$ mail
Mail version 8.2 01/15/2001. Type ? for help.
"/var/spool/mail/larisa": 3 messages 1 new 2 unread

1 chris@turtle.mytrek. Thu Jun 7 14:17 22/554 "trip"

>U 2 aleina@turtle.mytrek Thu Jun 7 14:18 22/525 "party"

U 3 dylan@turtle.mytrek. Thu Jun 7 14:18 22/528 "newsletter"
& q

Mail references messages either through a message list or through the current
message marker (>). The greater-than sign (>) is placed before the current message. The
current message is referenced by default when no message number is included with
a Mail command. You can also reference messages using a message list consisting of
several message numbers.

Use the R and r commands to reply to a message you have received. The R command
entered with a message number generates a header for sending a message and then
places you into input mode to type the message. The q command quits Mail. When
you quit, messages you have already read are placed in a file called mbox in your home
directory. Instead of saving messages in the mbox file, you can use the s command to
save a message explicitly to a file of your choice. Mail has its own initialization file, called
.mailrc, which is executed each time Mail is invoked, for sending or receiving messages.
Within it, you can define Mail options and create Mail aliases.
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Accessing Mail on Remote Mail Servers

Most new mail clients are equipped to access mail accounts on remote servers. Mail
clients, such as Evolution, KMail, Sylpheed, and Thunderbird, enable you to set up
a mailbox for such an account and access a mail server to check for and download
received mail. You must specify what protocol a mail server uses. This is usually either
the Post Office Protocol (POP) or the IMAP protocol (IMAP). Using a mail server address,
you can access your account with your username and password.

For email clients, such as Mail and Mutt, that do not provide mail server access,
you can use Fetchmail to have mail from those accounts sent directly to the inbox of
your Linux account. All your mail, whether from other users on your Linux system or
from remote mail accounts, will appear in your local inbox. Fetchmail checks for mail
on remote mail servers and downloads it to your local inbox, where it appears as newly
received mail. Enter fetchmail on the command line with the mail server address and
any needed options. The mail protocol is indicated with the -p option and the mail
server type, usually POP3. If your email username is different from your Linux login
name, you use the -u option and the email name. Once you execute the fetchmail
command, you are prompted for a password. The syntax for the fetchmail command for
a POP3 mail server follows:

fetchmail -p POP3 -u username mail-server

You will see messages telling you if you have mail and how many messages are being
downloaded. You can then use a mail client to read the messages from your inbox. You
can run Fetchmail in daemon mode to have it check automatically for mail. You must
include an option specifying the interval in seconds, for checking mail.

fetchmail -d 1200

To have Fetchmail run automatically, you can set the START DAEMON option to yes in
the /etc/default/fetchmail file.
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You can specify options, such as the server type, username, and password, in a
.fetchmailrc file in your home directory. You can also include entries for other mail
servers and accounts. Once Fetchmail is configured, you can enter fetchmail with no
arguments; it will read entries from your . fetchmailzrc file. You can also make entries
directly in the . fetchmailrc file. An entry in the . fetchmailrc file for a particular
mail account consists of several fields and their values poll, protocol, username, and
password. The poll field refers to the mail server name. You can also specify your
password, instead of having to enter it each time Fetchmail accesses the mail server.

Mailing Lists

Users on mailing lists automatically receive messages and articles sent to the lists.
Mailing lists work much like a mail alias, broadcasting messages to all users on the list.
Mailing lists were designed to serve specialized groups of people. Numerous mailing
lists, as well as other subjects, are available for Linux. By convention, to subscribe to
a list, you send a request to the mailing list address with a -request term added to its
username. For example, to subscribe to gnome-1ist@gnome.org, you send a request
to gnome-1ist-request@gnome.org.

You can use the Mailman program to manage your mailing lists automatically.
Mailman is the GNU mailing list manager that is included with Fedora. You can find out
more about Mailman at www.1ist.org.

Usenet News

Usenet is an open mail system on which users post messages that include news,
discussions, and opinions. It operates like a mailbox to which any user on your Linux
system can read or send messages. Users’ messages are incorporated into Usenet files,
which are distributed to any system signed up to receive them. Each system that receives
Usenet files is referred to as a sife. Certain sites perform organizational and distribution
operations for Usenet, receiving messages from other sites and organizing them
into Usenet files, which are then broadcast to many other sites. Such sites are called
backbone sites, and they operate like publishers, receiving articles and organizing them
into different groups.

To access Usenet news, you require access to a news server. A news server receives
the daily Usenet newsfeeds and makes them accessible to other systems. Your network
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may have a system that operates as a news server. If you are using an Internet service
provider (ISP), a news server is probably maintained by your ISP for your use. To
read Usenet articles, you use a newsreader, a client program that connects to a news
server and accesses the articles. On the Internet and in TCP/IP networks, news servers
communicate with newsreaders using the Network News Transfer Protocol (NNTP) and
are often referred to as NNTP news servers. You can also create your own news server on
your Linux system to run a local Usenet news service or to download and maintain the
full set of Usenet articles. Several Linux programs, called news transport agents, can be
used to create such a server.

You read Usenet articles with a newsreader, such as KNode, Pan, Thunderbird,
or tin, which enables you to select a specific newsgroup and then read the articles in
it. A newsreader operates like a user interface, letting you browse through and select
available articles for reading, saving, or printing. Most newsreaders employ a retrieval
feature called threads, which pulls together articles on the same discussion or topic.
Several popular newsreaders are listed in Table 5-10.

Table 5-10. Linux Newsreaders

Newsreader Description

Pan GNOME desktop newsreader (install with dnf)

KNode KDE desktop newsreader

Thunderbird Mail client with newsreader capabilities (X-based)

Sylpheed GNOME Windows-like newsreader (install with dn<)

slrn Newsreader (cursor-based) (install with dnf)

Emacs Emacs editor, mail client, and newsreader (cursor-based) (install with dn+)
tin Newsreader (command-line interface) (install with dnf)

kwooty Binary only NZB-based news grabber (install with dnf)

Most newsreaders can read Usenet news provided on remote news servers that use
the NNTP. Desktop newsreaders, such as KNode and Pan, have you specify the Internet
address for the remote news server in their own configuration settings. Shell-based
newsreaders such as tin obtain the news server’s Internet address from the NNTPSERVER
shell variable, configured in the .profile file.
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NNTPSERVER=news.domain.com
export NNTPSERVER

There are few binary-based newsreaders for Linux that can convert text messages to
binary equivalents like those found in alt.binaries newsgroups. There are some news
grabbers, which are applications designed only to download binaries. The binaries are
normally encoded with RAR compression, which can be decoded by Fedora. Binaries
normally consist of several rar archive files, some of which may be incomplete. To repair
them, you can use par2. Install the par2cmdline package. A binary should have its own
set of par2 files also listed on the new server that you can download and use to repair
any incomplete rar files. The principle works much the same as RAID arrays using parity
information to reconstruct damaged data.

The slrn newsreader is cursor-based. Commands are displayed across the top of
the screen and can be executed using the listed keys. Different types of screens exist for
the newsgroup list, article list, and article content, each with its own set of commands.
An initial screen lists your subscribed newsgroups with commands for posting, listing,
and subscribing to your newsgroups. When you start s1rn for the first time, you may
have to create a . jnewsrc file in your home directory. Use the following command: slrn
-f .jnewsrc -create. Also, you must set the NNTPSERVER variable and make sure it is
exported. The s1rn newsreader features a utility called s1rn-pull that you can use to
download articles in specified newsgroups automatically.

Table 5-11. Database Management Systems for Linux

System Site

LibreOffice Base LibreOffice.org database: https://www.libreoffice.org
PostgreSQL The PostgreSQL database: www. postgresql.org (install with dnf)

MariaDB Advanced and fully open source version of MySQL (Fedora default) (install with dnf)
Derby Apache JAVA-based database (install with dnf)

MongoDB Document-based database (install with dnf)

Hadoop Apache distributed database for very large data sets

SQLite Simple SQL database (install with dn)
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Database Management Systems

Several database systems are provided for Fedora, including LibreOffice Base, MariaDB,
Derby, and PostgreSQL. MariaDB is derived from MySQL but is fully open sourced. It is
the default MySQL type database for Fedora. MariaDB is supported and developed by
the original MySQL developers. The original MySQL is owned by Oracle and features
commercial versions. You can still install the older noncommercial version of MySQL,
if you wish. In addition, commercial SQL database software is also compatible with
Fedora. Table 5-11 lists database management systems currently available for Linux.

Derby is a Java-based database developed by Apache. SQLite is a simple and fast
database server requiring no configuration and implementing the database on a single-
disk file. For small embedded databases, you can use Berkeley DB (db4).

In addition, Fedora also supports document-based non-SQL databases such as
MongoDB and Hadoop. MongoDB is a document-based database that can be quickly
searched. Hadoop is an Apache project for accessing very large data sets distributed
across a network.

SQL Databases (RDBMS)

SQL databases are relational database management systems (RDBMSs) designed for
extensive database management tasks. Many of the major SQL databases now have
Linux versions, including Oracle, Informix, Sybase, and IBM. These are commercial
and professional database management systems. Linux has proved itself capable of
supporting complex and demanding database management tasks. In addition, many
free SQL databases are available for Linux that offer much the same functionality. Most
commercial databases also provide free personal versions.

LibreOffice.org Base

LibreOffice provides a basic database application, called LibreOffice Base, which can
access many database files. You can set up and operate a simple database as well as
access and manage files from other database applications. When you start up LibreOffice
Base, you will be prompted either to start a new database or connect to an existing one.
File types supported include ODBC (Open Database Connectivity), JDBC (Java), Adabas
D, MySQL, PostgreSQL, and MDB (Microsoft Access) database files (install the unixodbc
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package). You can also create your own simple databases. Check the LibreOffice Base
page athttps://www.libreoffice.org/discover/base/ for detailed information on
drivers and supported databases.

MariaDB

MariaDB, included with Fedora, is a true multiuser, multithreaded SQL database server.
MySQL is an open source product available free of charge under the GPL license. It

is the default MySQL type database for Fedora. MariaDB is supported and developed
by the original MySQL developers. MariaDB is designed to be fully compatible with
MySQL. The original MySQL is owned by Oracle and features commercial versions. You
can obtain current information on MariaDB from its website at https://mariadb.org.
You can use the MySQL documentation for MariaDB that is available at https://dev.
mysql.com/doc/.

PostgreSQL

PostgreSQL is based on the POSTURES database management system, although it

uses SQL as its query language. PostgreSQL is a next-generation research prototype
developed at the University of California, Berkeley. Linux versions of PostgreSQL are
included in most distributions, including Red Hat, Fedora, Debian, and Ubuntu. You can
find more information about it from the PostgreSQL website at waw.postgresql.org.
PostgreSQL is an open source project developed under the GPL license.
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CHAPTER 6

Graphics and Multimedia

The Fedora repositories provide an extensive variety of graphic and multimedia
applications, including image viewers, advanced image-manipulation programs

like GIMP, music and CD players like Rhythmbox, and video players like Totem and
VLC. Graphics tools available for use under Linux are listed in Table 6-2. Additionally,
there is strong support for multimedia tasks from video and DVD to sound and music
editing (see Tables 6-5 and 6-6).

Support for many popular multimedia codecs, specifically MP3, DVD, MKV, and
DivX, are not included with the Fedora distribution, because of licensing and other
restrictions. To play MP3, DVD, MKY, or DivX files, you must download and install
support packages from third-party repositories. Precompiled RPM binary packages
for many popular media applications and libraries, such as MPlayer and Xvid, are
available on the RPM Fusion repository (see https://rpmfusion.org). RPM Fusion
is an official Fedora repository that provides RPM Fedora-compatible packages for
many multimedia and other applications that cannot be included with the Fedora
distribution. These include MP3 support and DVD and DivX codecs. Current
multimedia sites are listed in Table 6-1.
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Table 6-1. Linux Multimedia Sites

Project/Site Description

Fedora repository Fedora Repository, which includes most GNU licensed multimedia
applications: https://fedoraprojet.org

RPMFusion Repository for drivers and multimedia applications and libraries that
are not included with Fedora. This is an official extension of the Fedora
project: https://rpmfusion.org

PulseAudio PulseAudio sound interface, now the default for Fedora: https://
www . freedesktop.org/wiki/Software/PulseAudio/

Advanced Linux Sound The Advanced Linux Sound Architecture (ALSA) project for current
Architecture (ALSA) sound drivers: http://www.alsa-project.org

Open Sound System Open Sound System, drives for older devices:
http://www.opensound.com

Design Suite A Fedora Linux spin featuring Linux applications for graphic design and
multimedia production: https://labs.fedoraproject.org/en/
design-suite/

For the commercial DVD video codec, you still have to use the http://rpm.livna.org
repository. Here you will find only one package, the 1ibdvdcss package, for playing
DVD video. Enable the Livna repository (1ivna-release.rpm) and then use PackageKit
to install the 1ibdvdcss package. You can also download it directly from http://xpm.
livna.org/repo/28/.
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Table 6-2. Graphics Tools for Linux

Tool Description

Shotwell GNOME digital camera application and image library manager http://www.
yorba.org/shotwell/

Photos GNOME photo viewer and organizer

Cheese GNOME Web cam application for taking pictures and videos

Digikam Digital photo management tool, works with both GNOME and KDE

KDE

Gwenview Image browser and viewer (default for KDE)

ShowFoto Simple image viewer, works with DigiKam (www.digikam.org)

Spectacle Screen grabber

KolourPaint Paint program

Krita Image editor (www.calligra.org/krita)

GNOME

Eye of GNOME GNOME Image Viewer

GIMP GNU Image Manipulation Program (www.gimp.org)

Inkscape GNOME Vector graphics application (www. inkscape.org)

Blender 3D modeling, rendering, and animation

Synfig Studio 2D modeling, rendering, and animation

Entangle Camera and Computer linked photographic system

RawTherapee Digital processing and raw image converter

LibreOffice Draw  LibreOffice Draw program

X Window

System

Xfig Drawing program

ImageMagick Image format conversion and editing tool
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For those who want to install a multimedia system, such as for an HTPC, you can use the
Korora Project spin (https://kororaproject.org). It includes Fedora as well as many free
and non-free multimedia codecs and applications available from the RPM Fusion repository.

For those that wish to work primarily with graphics applications, you can install the
Fedora Design Suite, a Fedora spin that installs available Fedora image applications
such as Inkscape (vector graphics), Blender (3D modeling), and Darktable (virtual
darkroom), as well as Scribus (desktop publishing), https://1labs.fedoraproject.
org/en/design-suite/.

Graphics Applications

The GNOME and KDE desktops support an impressive number of graphics applications,
including image viewers, screen grabbers, image editors, and paint tools. These tools can
be found in the Applications overview.

Photo Management: Shotwell, Cheese, and Photos

The Shotwell photo manager provides an easy and powerful way to manage, display,
import, and publish your photos and images (https://wiki.gnome.org/Apps/
Shotwell). It is the default photo manager for Fedora 28. See the Shotwell user manual
for full details (Help » User Manual, http://shotwell-project.org/doc/html/).
You can open the Shotwell Photo Manager as Shotwell, using either the Applications
overview or the Shotwell icon on the Activities sidebar.

You can import folders from cameras, folders (see Figure 6-1). Photo thumbnails
are displayed in the main right pane. The View menu lets you control the thumbnail
display, allowing you to sort photos, zoom, show photo filenames (Titles), or select
by rating. You can adjust the size of the displayed thumbnails using a slider bar in the
toolbar located at the bottom right of the Shotwell window. The small figure button
to the left of the slider reduces thumbnails to their smallest size, and the large figure
button to the right of the slider expands them to the largest size. To see a full-screen
slideshow of the photos, choose the slideshow entry from the View menu (F5). The
slideshow starts automatically. Moving your mouse to the bottom middle of the screen
displays slideshow controls for pausing and stepping through photos (see Figure 6-2).
The Settings button opens a dialog in which you can set the display time. To end the
slideshow and return to the desktop, click the Full Screen button. The slideshow buttons

are shown here.
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Shotwell ®

File Edit View Photos Events Tags Help
= Library
EhPhotos
@ Last Import
@ Trash
- Events
1 All Events
» 712011
» 712009
~ Folders
» “richard

Title: P139098...
Date: Sat Jan 2...
Time: 11:21:55 ..
Size: 4320 = 3.
Exposure: 1/320 s, f...
I1SO 80 % Rotate » Enhance @& Publish Q Find A& 2/

Figure 6-1. Shotwell photo management

& Ul ¢ | Settings ¥
Figure 6-2. Shotwell slideshow controls

Photos are organized automatically according to the time they were taken. Dates are
listed under the Events entry in the left sidebar, arranged by year, month, and date. To
name a photo, right-click it and choose Edit Title. This opens a dialog in which you can
enter the name. You can also tag photos by placing them in groups, making them easier
to access. To tag a photo, right-click it and choose Add Tags to open a dialog in which
you can enter a tag name. The tag will show up as a label for the photo. You can access
photos by tags by using the Tags entries in the left sidebar. For each photo, you can also
set a rating indicated by five stars or fewer. You can also mark a photo as rejected. To
rate a photo, right-click it and choose Set Rating, which then lists rating options in a
submenu. Use the Show Photos button in the bottom toolbar to display photos by rating.
You can select several photos at once by using click-and-drag, Ctrl-click, or Shift-click (as
you do for files in a file manager window), then right-click to give them the same rating
(Set Rating) or same tag (Add Tags).

215



CHAPTER6  GRAPHICS AND MULTIMEDIA

When you select a photo or a group of photos, the Rotate, Enhance, and Publish
buttons in the bottom toolbar become active. The Publish button lets you publish the
photo on a web service: Facebook, Flickr, or Picasa. The Rotate button rotates the photo
(from the Photos menu, you can also flip the photo horizontally or vertically). The
Enhance button adjusts the photo automatically.

To perform more complex edits, select the photo and then choose View »
Fullscreen (F11) to open the photo in the Shotwell photo editor (see Figure 6-3). Move
your mouse to the bottom of the screen to display the editing toolbar, which includes
the Rotate, Crop, Red-eye, Adjust, and Enhance buttons. You can also enlarge or reduce
the photo display by using the slider bar. The Crop button opens an adjustable border,
with a menu for choosing the display proportions, such as HD video or postcard. The
Adjust button opens a dialog for refined changes, such as exposure, saturation, tint,
temperature, and shadows. The toolbar will keep disappearing. Click the Pin button to
have it displayed permanently. Edits are stored in a Shotwell database; they are not made
to the original photo. To revert to the original photo, right-click and choose Revert to
Original or choose that entry from the Photos menu.

Exposure;
Contrast:
Saturation
Tint:

Temperature:

g Shedows:

Highiights:

Figure 6-3. Shotwell photo editing
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The Shotwell Preferences dialog (Edit » Preferences) lets you set the background
intensity, choose a photo library folder, and select a photo editor. To open a photo with
an external photo editor, right-click the photo thumbnail and select Open with External
Editor. Photos are stored in your Pictures directory under the Events subfolders, by year
and then month. To open a photos folder, right-click and select Show in File Manager.

DigiKam (www.digiKam.org) is a KDE photo manager with many of the same
features as F-Spot. A side panel allows easy access by album, date, tags, or previous
searches. The program also provides image-editing capabilities, with numerous effects.
The DigiKam configuration (Settings menu) provides extensive options, including image
editing, digital camera support, and interface configuration.

Tip The Windows version of Photoshop is supported by Wine. You can use Wine
to install Photoshop CS on Fedora. Once started, Photoshop will operate like any
Linux desktop application.

Cheese is a web cam picture-taking and video-recording tool (www.gnome.org/
projects/cheese). You can snap pictures from your web cam and apply simple effects.
You can open it from the Applications overview. Click the Photo button to manage
photos and the Video button to record video. Icons of photos and video appear on the
bottom panel, letting you select ones for effects or removal. The Effects pane shows
effects that can be turned on or off for the current image. To save a photo, right-click its
icon on the lower panel and select Save from the pop-up menu.

GNOME Photos is a simple image viewer and organizer for the images in your
Pictures folder. GNOME Photos has three tabs: Photos, Albums, and Favorites (see
Figure 6-4). It opens to the Photos tab. You can click a photo to open it, and then use
arrow buttons to display the next or previous ones (see Figure 6-5). To return to the main
window, click the left arrow button at the left side of the title bar. At the lower right is a
button you can click to display zoom buttons to enlarge and reduce the photo. On an
enlarged photo you can use the mouse to move around the photo. There are button at
the right side of the title bar above the photo for favorite, edit, share, and menu. The
favorite button (star) marks the photo as a favorite. The share button (network) lets you
email the photo. The edit button (pencil) opens an editing dialog with an expandable
sidebar for Crop, Colors, Enhance, and Filters. Click on an entry to show the options.
Click the Done button at the upper right when you're finished.
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P1390989

Figure 6-5. GNOME Photos: image display
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The menu has options to export, print, delete, or set as the background for your
desktop or lock screen. You can also open it with Image Viewer. The Properties option
opens the Properties dialog for the photo, displaying detailed information about the
image and lets you give it a name (Title).

From the main window, you can choose several photos to work on by clicking the
checkmark button at the top right. Check boxes appear on the lower-right corner of
each image (see Figure 6-6). A menu at the top center lets you choose all or de-select
all images. When you check a single image, a toolbar appears at the bottom that lets
you print the image, check its properties, add it to an album, or tag it as a favorite. If you
check several photos, you can add them to an album or mark them as favorites.

1 selected

Add to Album

Figure 6-6. GNOME Photos: selection

You can use the search button to select a subset of photos, which you can then work
on, displaying only that set of photos or clicking the checkmark button to work on just
those.
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When you open a photo, you can also tag it as a favorite by clicking the favorite
button (star) at the right side of the title bar. On the Photos tab, favorite images show a
star emblem in the lower-right corner of the image. To remove an image from favorites,
open the photo and click its favorite button again.

Photos can be organized into albums. The albums are also displayed on the Photos
dialog. When you add a photo to an album, you are prompted to choose an existing
album or to create a new one.

GNOME Graphics Tools

Many powerful and easy-to-use graphic applications are available for use on
GNOME. The Eye of GNOME is the GNOME image viewer accessible as Image Viewer.
It lets you display images and provides rotation capability and zooming. You can display
images in a slideshow. An image gallery toolbar lets you quickly choose an image.

GIMP is the GNU image-manipulation program, much like Adobe Photoshop.
You can use GIMP for such tasks as photo retouching, image composition, and image
authoring. It supports features such as layers, channels, blends, and gradients. GIMP
makes effective use of the GTK+ widget set. You can find out more about GIMP and
download the newest versions from its website at https://www.gimp.org. GIMP is freely
distributed under the GNU Public License.

Note The gPhoto project provides software for accessing digital cameras
(http://www.gphoto.org). Several frontend interfaces are provided for a
core library, called 1ibgphoto2, consisting of drivers and tools that can access
numerous digital cameras.

Inkscape is a GNOME-based vector graphics application for SVG (Scalable Vector
Graphics) images (see Figure 6-7). It has capabilities similar to professional-level vector
graphics applications such as Adobe Illustrator. The SVG format allows easy generation
of images for web use as well as complex art. Though its native format is SVG, it can also
export to the Portable Network Graphics (PNG) format. It features layers and easy object
creation, including stars and spirals. A color bar lets you quickly change color fills.
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Figure 6-7. Inkscape

KDE Graphics Tools

The KDE desktop features the same variety of graphics tools found on the GNOME
desktop. Many are available from the Fedora main repository. Most do not require a full
installation of the KDE desktop. The KSnapshot program is a simple screen grabber for
KDE. Gwenview is an easy-to-use image browser and viewer supporting slideshows and
numerous image formats. It is the default viewer for KDE. KolourPaint is a basic paint
program with brushes, shapes, and color effects; it supports numerous image formats.
Krita is the Calligra professional image paint and editing application, with a wide range
of features, such as the ability to create web images and modify photographs (formerly

known as Krayon and KImageShop).

X Window System Graphic Programs

X Window System-based applications run directly on the underlying X Window System.
These applications tend to be simpler, lacking the desktop functionality found in
GNOME or KDE applications. Most are available on the Fedora repository. XPaint is a
simple paint program that allows you to load graphics or photographs and then create

221



CHAPTER6  GRAPHICS AND MULTIMEDIA

shapes, add text and colors, and use brush tools with various sizes and colors. Xfig is a
drawing program. ImageMagick lets you convert images from one format to another; you
can, for instance, change a TIFF to a JPEG image. Table 6-2 lists some popular graphics
tools for Linux.

Multimedia

Many applications are available for both video and sound, including sound editors, MP3
players, and video players (see Tables 6-5 and 6-6). Linux sound applications include
mixers, digital audio tools, CD audio writers, MP3 players, and network audio support.

Note Linux has become a platform of choice for many professional-level
multimedia tasks, such as generating computer-generated images (CGl), using
such demanding software as Maya and Softimage. Linux graphic libraries include
those for OpenGL, MESA, and SGl.

Information about many applications designed specifically for the GNOME or KDE
user interface can be found at their respective software sites (https://wiki.gnome.org/
Apps and https://www.kde.org/applications/). Precompiled binary RPM packages for
most applications are at the Fedora or RPM Fusion repositories.

Codec Support with PackageKit

PackageKit is designed to work with GStreamer to detect and install needed codecs.
Whenever you try to run a media file using a GStreamer-supported application such as
the Totem movie player, and the codec is missing, GNOME Software is run to check for
supporting codec packages and lets you install them (see Figure 6-8). A dialog lists the
required packages (including any required additional plugins), and you are prompted to
install them.
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Unable to play the file

decodsr is required 1o play the file, but

Figure 6-8. Detecting and installing needed multimedia codecs

If you have RPM Fusion support installed for DNE, GNOME Software, or Packages, will
find and install multimedia codecs not included with the official Fedora release. For MP3,
you can download the MP3 codec directly. There are also several multimedia codecs, such
as MPEG2 (DVD video), MPEG4 (DivX), Dolby AC3 audio, and MPEG video playback.

For the commercial DVD video codec, you still must use the http://rpm.livna.org
repository. Here, you will find only one package, the 1ibdvdcss package, for playing
DVD video. You can install repository support for rpm.livna.org by installing the 1ivna-
release package, which you can download from http://rpm.livna.org. Figure 6-9
shows the libdvdcss package available from the Livna repository.

richard@localhost:~ X

File Edit View Search Terminal Help

[richard@localhost ~]$ dnf repoquery -i libdvdcss
Last metadata expiration check: ©:01:01 ago on Mon 21 May 2018 ©5:52:47 PM PDT.

Name : libdvdcss

Version : 1.4.0

Release : 1.fc24.remi

Arch : x86_64

Size : 69 k

Source : libdvdcss-1.4.0-1.fc24.remi.src.rpm

Repo : livna

Summary : A portable abstraction library for DVD decryption
URL : http://www.videolan.org/libdvdcss/

License : GPLv2+

Description : This is a portable abstraction library for DVD decryption which
: is used by the videolLAN project, a full MPEG2 client/server
: solution. You will need to install this package in order to have
: encrypted DVD playback with the VideoLAN client and the Xine
: navigation plugin.

None

[richard@localhost ~]%$ dnf list libdvdcss

Last metadata expiration check: 0:01:18 ago on Mon 21 May 2018 ©5:52:47 PM PDT.
Available Packages

libdvdcss.x86 64 1.4.0-1.fc24.remi livna
[richard@localhost ~1% |

Figure 6-9. DVD codec and support
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Note You can also purchase third-party commercial and fully licensed codecs
such as Window media or Dolby codecs from Fluendo (https://www.fluendo.
com). Fluendo provides many licensed codecs, most for a small fee. Fluendo
currently provides a free MP3 licensed codec for playing MP3 music files.

Third-Party Multimedia Codecs with License Issues

Fedora does not include any codecs or applications that may have licensing restrictions
of any kind. These include multimedia codecs such as the DVD video decoder and the
MP3 music decoder, as well as proprietary vendor graphics drivers like NVIDIA's own
graphics driver. A list of forbidden items is located at https://fedoraproject.org/
wiki/ForbiddenItems.

Many of these codecs are available from RPM Fusion; see https://rpmfusion.org.
A listing of popular multimedia codecs available at these sites is shown in Table 6-3. Of
particular interest may be the a52dec, faad2, and lame codecs for sound decoding, as
well as the xvidcore, x264, and 1ibdvbpsi for video decoding. For GStreamer-supported
applications such as the Totem movie player, you need a special set of packages called
gstreamer-plugins-bad and gstreamer-plugins-ugly. The packages labeled freeworld
provide open source solutions for added capability, such as DVD support for Xine and MP3
support for Audacious. For extensive video and DVD support, you can install the VLC media
player (v1c package). The commercial DVD video codec dvdcss is available only from the
Livna repository, http://xpm.1livna.org, directly, not from RPM Fusion. The libdvdcss
package is the only package on Livna; all the others have been moved to RPM Fusion.

Table 6-3. Multimedia Third-Party Codecs

Package Description

as2dec HDTV audio (ATSC A/52, AC3)

faad2 MPEG2/ 4 AAC audio decoding, high quality

ffmpeg, ffmpeg-1ibs Play, record, convert, stream audio and video. Includes digital

streaming server, conversion tool, and media player

gstreamer-ffmpeg ffmpeg plugin for GStreamer

(continued)

224


https://www.fluendo.com
https://www.fluendo.com
https://fedoraproject.org/wiki/ForbiddenItems
https://fedoraproject.org/wiki/ForbiddenItems
https://rpmfusion.org
http://rpm.livna.org

Table 6-3. (continued)

CHAPTER6  GRAPHICS AND MULTIMEDIA

Package

Description

gstreamer-plugins-bad

gstreamer-plugins-ugly

audacious-plugins-
freeworld-mp3, -aac, -wma,
-alac

lame
libdca
libdvbpsi

libdvdnav
libfame
libmad
libmpeg3

libquicktime
mpeg2dec
twolame

X264
xvidcore
swftools

vlc

libdvdcss

Not fully reliable codecs and tools for GStreamer, some with
possible licensing issues

Reliable video and audio codecs for GStreamer that may have
licensing issues

MP3, AAC, WMA, ALAC plugin packages for Audacious, among
others

MP3 playback capability, not an official MP3 decoder
DTS Coherent Acoustics playback capability

MPEG TS stream (DVB and PSI) decoding and encoding
capability, VideoLAN project

DVD video menu navigation
Fast Assembly MPEG video encoding
MPEG1 and MPEG2 audio decoding

MPEG video audio decoding (MPEG1/2 audio and video, AC3,
IFO, and VOB)

QuickTime playback

MPEG2 and MPEG1 playback

MPEG audio layer 2, MP2 encoding

H264/AVC decoding and encoding (high definition media)
OpenDivx codec (DivX and Xvid playback)

Adobe Flash utilities for SWF files

DVD video playback capability, VideoLan project

DVD-Video codec for commercial DVDs; available only from
Livna site at http://rpm.livna.org
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Obtaining the DVDCSS DVD Video Codec from Livna

The dvdcss decryption coded used to play back commercial DVD video disks is not
included in the RPM Fusion repositories, free or non-free. Due to licensing issues, the
dvdcss codec could not be included in the RPM Fusion repository. Instead, this codec
remains the only software package still available on the Livna repositories. All other
packages from Livna have been transferred to RPM Fusion and are no longer available
on the Livna repository (beginning with Fedora 10). In effect this repository has only one
package, the dvdcss DVD video decryption package.

To obtain the dvdcss decryption package, either download it directly from Livna
and install it, or install the Livna repository YUM configuration package, and then
use Packages to install the dvdcss package from Livna. The Livna website is located at
http://rpm.livna.org.

You can install repository support for rpm.livna.org by installing the 1ivna-release
package, which you can download from http://rpm.livna.org. You can install
directly from the website by using your web browser or run an rpminstall command in
a terminal window. The “How to Use rpm.livna.org” section on the website provides a
link to download the 1ivna-release package, as well as the following command-line
alternative. Clicking the link, you will be prompted to open the package with the package
installer. You will then be prompted to install the file.

The command-line install is shown here. The sudo command logs in as the
administrative user, and the command to run is an rpm command to install (ivh) the
livna-release.rpmpackage

sudo rpm -ivh http://rpm.livna.org/livna-release.rpm

Once the file is installed, you can install the 1ibdvdcss package using dnf ina
terminal window (see Figure 6-9). The first time you install a package from Livna,
you will be prompted to install its package key, asking if you trust packages from this
repository. Click Yes to install the key.

The actual Livna 1ibdvdcss package is located at: http://rpm.1livna.org/repo/28/.
There are x86_64 and i386 directories.
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GStreamer

Many GNOME-based applications use GStreamer. GStreamer is a streaming media
framework based on graphs and filters. Using a plugin structure, GStreamer applications
can accommodate a wide variety of media types (https://gstreamer.freedesktop.org).
Fedora includes several GStreamer applications, such as the Totem video player, which
uses GStreamer to play DVDs, VCDs, and MPEG media. Rhythmbox provides integrated
music management. Sound Juicer is an audio CD ripper.

GStreamer can be configured to use different input and output sound and video
drivers and servers. You can make these selections using the GStreamer properties tool
(install the gnome-media-apps package). Enter gstreamer-properties in a terminal
window. The properties window displays two tabbed panels: one for audio and the
other for video. The output drivers and servers are labeled Default Output, and the input
drivers are labeled Default Input. There are pop-up menus for each, listing the available
sound or video drivers or servers. For output, the AutoDetect option for a driver will use
the default. You can change this to a specific device, such as using ALSA or OSS instead
of PulseAudio.

GStreamer Plugins: The Good, the Bad, and the Ugly

Many GNOME multimedia applications such as Totem use GStreamer to provide
multimedia support. To use such features as DVD video and MP3, you must install
additional GStreamer plugins. You can find out more information about GStreamer and
its supporting packages at https://gstreamer.freedesktop.org.

For version 1.0 and above, GStreamer establishes four support packages: the base,
the good, the bad, and the ugly. The base package is a set of useful and reliable plugins.
These are in the Fedora repository. The good package is a set of supported and tested
plugins that meets all licensing requirements. This is also part of the Fedora repository.
The bad is a set of unsupported plugins whose performance is not guaranteed and may
crash but still meets licensing requirements. The ugly package contains plugins that
work fine but may not meet licensing requirements, such as DVD support. The bad and
ugly can be obtained from the RPM Fusion repositories:

The base—Reliable, commonly used plugins

The good-Reliable, additional, and useful plugins
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The ugly-Reliable, but not fully licensed, plugins (DVD/MP3
support)

The bad-Possibly unreliable but useful plugins (possible crashes)

Another plugin for GStreamer that you may want to include is ffmpeg,
gstreamer-ffmpeg (RPM Fusion repositories). ffmpeg provides several popular codecs,
including ogg and 264. For Pulse (sound server) and Farsight (video conferencing)
support, use their respective GStreamer plugins on the Fedora repository.

Packages will automatically detect the codec you will need to use for your GStreamer
application. For commercial codecs such as MP3 or AAC, Packages will select the
appropriate RPM Fusion package (with RPM Fusion enabled). This capability is provided
by the gstreamer-plugin, installed during installation. For commercial DVD video, you
can install the 1ibdvdcss package from the Livna repository (http://rpm.1livna.org).

To download and install the GStreamer plugin packages, just search for gstreamer
on Packages. If you have enabled RPM Fusion or repository, you will also see entries for
the ugly and bad packages. Alternatively, you could use the following dnf command
to install all plugins at once. Be sure to include the asterisk (*) to match all the plugin
packages. Your architecture (1586, 1686, or x86_64) will be detected automatically.

dnf install gstreamer-plugins*

GStreamer MP3 Compatibility

To play MP3 and iPod song files and to configure other MP3 devices to work with GNOME
applications such as Rhythmbox, you have to install MP3 support for GStreamer. MP3
support is not included with Fedora distributions because of licensing issues. Install the
GStreamer gstreamer-plugins-ugly package, which contains most multimedia support
codecs and applications that are not included with the distribution. This is a RPM Fusion
package. Be sure that the RPM Fusion repository is configured for your system. The
package will then appear in Packages, which you can then use to install it.

iPod

To play songs from your iPod, Fedora provides the 1ibgpod library for GNOME. It allows
player applications such as Rhythmbox, Banshee, and Amarok to use your iPod Touch
and iPhone. GStreamer MP3 support is provided by the gstreamer-plugins-ugly
package. To sync, import, or extract from your iPod, you can also use gtkpod.
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Music Applications

Many music applications are currently available for GNOME, including sound editors,

MP3 players, and audio players (see Table 6-4). You can use Rhythmbox, Banshee,

GNOME Music, and Clementine to play music from different sources and the GNOME

Sound Recorder to record sound sources. Several applications are also available for

KDE, including the media player Amarok, a mixer (KMix), and a CD player (Kscd).

Rhythmbox, Banshee, and Amarok provide access to the iPod iTouch and iPhone. For

sound and music editing, you can use Audacity.

Table 6-4. Music Players, Editors, and Rippers

Application Description

Rhythmbox Music management (GStreamer); default CD player with iPod support
Sound Juicer GNOME CD audio ripper (GStreamer)

Amarok KDE4 multimedia audio player

Banshee Multimedia player

Audacious Multimedia player

Kscd Music CD player

Juk KDE4 music player (jukebox) for managing music collections

GNOME Music GNOME Music player

GNOME CD Player CD player

GNOME Sound
Recorder

XMMS
Clementine
Radio Tray
Audacity
Ardour2
Rosegarden4
FluidSynth

Qtractor

Sound recorder

CD player

Clementine music player (based on Rhythmbox)

The RadioTray radio streaming player, works from the panel like an applet
Professional multitrack audio editor

Digital Audio Workstation (DAW) and Hard Disk Recorder (HDR)
Audio/MIDI multitrack sequencer and score editor

Software synthesizer

Audio/MIDI multitrack sequencer base on Qt toolkit
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GNOME includes sound applications such as the GNOME CD player, Sound Juicer
(Audio CD Extractor), GNOME Music, and Rhythmbox. Rhythmbox is the default sound
multimedia player, supporting music files, radio streams, and podcasts (see Figure 6-10).
In addition, you can use the Banshee and Clementine music players (similar to
Rhythmbox), and the RadioTray radio streaming player (simple message tray access).

Mon 11:10

Rhythmbox

LT I v e 4 Not Playing

Library Edit Browse  ViewAll  Import
D Play Queue
dMusic
# Podcasts
06 Last.fm
0 Libre.fm
3 Radio

Playlists
Q My Top Rated
Q Recently Added
Q, Recently Played

L = I 0 |
|
-

2 songs, 11 minutes, 121.1 MB

The Little Thing. Unknown
Track 3.wav Unknown

Figure 6-10. Rhythmbox GNOME multimedia player

GNOME Music is the new GNOME music player with tabs for Albums, Artists, and
Songs (see Figure 6-11). GNOME Music accesses sound files in your Music folder. On the
Songs tab, you can click on a file to play it. A toolbar opens at the bottom with buttons
to control the playback. The button to the right opens a menu with shuffle and repeat
options. At the top, click the Search button to search the list of sound files. To add files to
the playlist, click the check button to display the check box next to each sound file, which
you can check and then click the Add to Playlist button.
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Albums Artists Songs Playlists v || X
> Untitled v 3.07 Unknown Artist Untitled
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Unknown Artist -, : :
144 ] i Gigiiag =) 0:18 / 3:07 — v E

Figure 6-11. GNOME Music

KDE music applications include Amarok and JuK. Amarok is the primary multimedia
player for the KDE desktop but will play on the GNOME desktop (see Figure 6-12). It
includes access to Internet sources, local music files, and local devices such as Audio
CDs. JuK (Music Jukebox) is the KDE4 music player for managing music collections.
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Figure 6-12. Amarok KDE multimedia player
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Due to licensing and patent issues, Fedora does not install MP3 support by default.
MP3 playback capability has been removed from multimedia players such as Rhythmbox
and Banshee. The Fedora codec wizard will prompt you to install MP3 support when you
first try to play an MP3 file, usually the GStreamer package and the free Fluendo MP3
codec. As an alternative to MP3, you can use Ogg Vorbis compression for music files
(https://xiph.org/vorbis/).

Musicians should check the Fedora Musicians Guide for details on using Fedora
applications for music development. Applications covered include Audacity (multitrack
audio editor), Ardour (Digital Audio Workstation), Qtractor (multitrack sequencer),
Rosegarden (audio and MIDI sequencer), FluidSynth (software synthesizer), LilyPond
(music notation engraving), and GNU Solfege (music education).

Several DVD/CD ripper and writer programs can be used for CD music and MP3
writing (burners and rippers). These include Sound Juicer, Brasero (see Chapter 3), and
K3b (see Table 6-5). GNOME features the CD audio ripper Sound Juicer. For burning
DVD/CD music and data disks, you can use the Brasero DVD/CD burner. The Brasero
DVD/CD burner is integrated into the GNOME file manager, the default file manager for
the GNOME desktop. For KDE, you can use K3b.

Table 6-5. DVD/CD Burners

Application Description

Brasero Full-service DVD/CD burner for music, video, and data disks

Sound Juicer (audio CD extractor)  GNOME music player and CD burner and ripper (sound-juicer

package)
ogmrip DVD ripping and encoding with DivX support
K3b KDE CD-writing interface
dvdauthor Tools for creating DVDs

Brasero, K3b, and dvdauthor can all be used to create DVD video disks. All use the
mkisofs, cdrecord, and cdda2wav DVD/CD-writing programs installed as part of your
desktop. OGMrip can rip and encode DVD video. DVD video and CD music rippers may
require additional codecs, for which the codec wizard will prompt you.
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Burning DVD/CDs with GNOME (Brasero)

GNOME performs disk-burning operations using the Brasero Disc Burner application.
Brasero is integrated into GNOME. The DVD/CD disk’'s GNOME desktop menu (right-
click the DVD/CD disk’s desktop icon) displays DVD/CD disk operations, such as
burning data using a GNOME file manager window, copying disks, erasing them, and
checking a disk.

Using the GNOME file manager to burn data to a DVD or CD is a matter of dragging
files to an open blank CD or DVD and clicking the Write To Disk button. When you insert
a blank DVD/CD, a window will open labeled CD/DVD Creator. To burn files, just drag
them to that window. Click the Write To Disc button when you’re ready to burn a DVD/
CD. A Brasero Disc Burning Setup dialog will open, which will perform the actual write
operation. You can also click the Properties button to open a dialog with burning options
such as the burn speed.

The GNOME desktop also supports burning ISO images using Brasero. Just double-
click the ISO image file or right-click the file and select Open with Brasero. This opens
the Image Burning Setup dialog, which prompts you to burn the image. Be sure first to
insert a blank DVD or CD into your DVD/CD burner.

You have the option of writing an ISO image to another disk. For the ISO image file,
the Properties dialog lets you choose the folder to save the file. For copying to another
disk, the Properties dialog lets you choose the burning speed and such options as using
burnproof or performing a simulation first. Check Disc will check the integrity of the
disk, with the option of using the disk’s MD5 file, if available. The menu for DVD/CD RW
disks will also display a Blank Disc entry, which will erase a disk.

For more complex DVD/CD burning options, you can use the Brasero DVD/CD
burner application interface, called Brasero Disc Burner. Brasero supports drag-and-
drop operations for creating audio CDs. In particular, it can handle DVD/CD read/write
disks and can erase disks. It also supports multi-session burns, which add data to DVD/
CD disks. Initially, Brasero displays a dialog with buttons for the type of project you want
to create. You can create a data or audio project, create a DVD video disk, copy a DVD/
CD, or burn a DVD/CD image file.

For a data project, the toolbar displays an Add button, which you use to select files
and directories to be burned to your disk. You also can drag-and-drop files and folders to
your data listing (right pane). You can choose to display a side panel (View menu), which
will let you select files and directories.
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Video Applications

Several projects provide TV, video, DivX, DVD, and DTV support for Linux. Most
applications are already available from the Fedora and RPM Fusion repositories
(http://xpmfusion.org). Be sure that the RPM Fusion DNF repository is configured

for your system, and then use Packages or GNOME Software to install the applications.
Aside from GStreamer applications, there are also several third-party multimedia
applications you may want. All are available on the Fedora and RPM Fusion repositories.

Video and DVD Players

The default video player is GNOME Videos, whose interface has undergone a major
change. The main dialog displays two tabs: Videos and Channels (see Figure 6-13). The
Videos tab lists videos on your system and for those at specific sites on the Internet. Click
the plus button at the left side of the header bar to display a menu for adding local or
web videos. For a web video, you enter the video's web address.

Videos Channels

Add Local Video...
Add Web Video...

myvideol

Figure 6-13. GNOME Videos: Videos tab
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To play a video, click on it (see Figure 6-14). For full-screen viewing, click the expand
arrows icon on the right side of the header bar. Move the mouse toward the bottom of
the dialog to display viewing controls, including pause/play, repeat, sound volume, and
skipping to the next or previous video. Click the back button (left side of the header bar)
to return to the video listing. The menu button displays a menu with entries for video
configuration such as aspect ratio, zoom, languages, subtitles, and screenshots. The
Properties entry displays a Properties dialog listing technical video and audio information.

myvideol.avi

Figure 6-14. GNOME Videos, playing a video

To play several videos in sequence click on the checkmark button at the right side of
the header bar to display check boxes at the corner of each video icon (see Figure 6-15).
Click the check boxes of the videos you want to see, and then click the Play button on
the lower-left corner of the dialog. To randomize the sequence, click the Shuffle button

instead.
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1 selected Q Cancel

myvideol

Play Shuffle Delete

Figure 6-15. GNOME videos, playing a video

To remove a video, click the check icon at the right side of the header bar to display
check boxes at the corner of each video icon. Click the check boxes of the videos you
want to remove and then click the Delete button on the lower-right corner of the dialog.

The Channels tab list streaming services, such as Euronews, Apple Movie Trailers,
and media on your system that you want to stream.

Clicking on the search icon opens a text box for searching for videos (see Figure 6-16).
The resource searched is shown on the right side of the text box. Clicking on the resource
name displays a menu with possible resources you can search, including your file system,
YouTube, bookmarks, and supported streaming services.
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Videos Channels

Bookmarks

« Local

YouTube

Vimeo

Rai.tv

myvideol

Figure 6-16. GNOME Videos search

From the GNOME Videos application menu on the top bar, you can select Preferences
to open the Preferences dialog where you can set the enable plugins, configure the display
color balance settings, and select the type of audio output (see Figure 6-17).

Preferences
General

External Subtitles

Load subtitle files when movie is loaded

Font: Sans Bold

Encoding:  Uni (UTF-8)

External Chapters

+ Load chapter files when movie is loaded
Plugins

Plugins...

Figure 6-17. GNOME Videos preferences
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Several popular video and DVD players are listed in Table 6-6.

Table 6-6. Video Players

Video Player

Description

Dragon Player

Kaffeine

MPlayer

Totem

VLC

Kodi

Xine

KDE multimedia player installed with KDE desktop but will play on the GNOME
desktop (see Figure 6-18).

KDE multimedia player (video and dvb) kaffeine package (see Figure 6-19).

Popular and capable multimedia/DVD players in use (RPM Fusion free repository).
It is a cross-platform open source alternative to RealPlayer and Windows Media
Player (www.mplayerhq.hu). MPlayer uses an extensive set of supporting
libraries and applications like 1irc, lame, 1zo, and aalib, which are also
available on the RPM Fusion repository. If you have trouble displaying video, be
sure to check the preferences for different video devices and select one that
works best.

GNOME movie player that uses GStreamer (see Figure 6-14). To expand Totem
capabilities, you need to install added GStreamer plugins. The codec wizard will
prompt you to install any needed media codecs and plugins.

The VideoLAN project (http://www.videolan.org) offers network-streaming
support for most media formats, including MPEG-4 and MPEG-2. It includes a
multimedia player, VLC, which can work on any kind of system (v1c package).
VLC supports high-def hardware decoding (see Figure 6-20).

Open source cross-platform integrated multimedia player incorporating a music,
video, and TV player, a PVR for TV recording, video and music streaming, and
photo viewing (formerly XBMC) https://kodi.tv/.

Multipurpose video engine and for Linux/UNIX systems that can play video, DVD,
and audio discs. Many applications like Totem and Kaffeine use Xine support to
play back DVD video. See http://xinehq.de for more information. For the
Xine user interface, install the xine-ui package.
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Play Settings Help
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Figure 6-18. KDE4 Dragon Player
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Figure 6-19. Kaffeine
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myvideol.avi - VLC media player X

Media Playback Audio Video Subtitle Tools View Help
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Figure 6-20. VLC Video Player (VideoLAN)

Totem Plugins

The Totem movie player uses plugins to add capabilities such as Internet video
streaming. Select the menu item Edit » Plugins to open the Configure Plugins window
(see Figure 6-21). Select the plugins you want. For added support, install the totem
plugin packages.

totem-youtube
totem-lirc

The lirc package gives infrared remote control support. YouTube support is
provided by the YouTube package.
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Configure Plugins

Always On Top
Keep the main window on top when playing a movie

Gromit Annotations
Presentation helper to make annotations on screen

Instant Messenger Status

Set your Instant Messenger status to away when a movie is playing

MPRIS D-Bus Interface

Send notifications of currently-playing videos and allow remote control using M...
Python Console

Interactive Python console

Rotation Plugin
Allows videos to be rotated if they are in the wrong orientation

L

About

Close

Figure 6-21. Totem movie player plugins

PiTiVi Video Editor

The PiTiVi video editor is an open source application that lets you edit your videos. It
is accessible from the Applications overview as PiTiVi video editor. Check the PiTiVi
website for more details (www.pitivi.org). You can download a quick-start manual from
the Documentation page. PiTiVi is a GStreamer application and can work with any video
file supported by an installed GStreamer plugin, including the ugly and bad plugins.
The PiTiVi window shows a Clip Library pane on the left and video playback for a
selected video clip on the right (see Figure 6-22). To run a video clip, right-click its icon
and select Play Clip. To add a video file to the library, click the Import Clips button on
the toolbar. You can also drag-and-drop files directly to the Clip Library. The timeline
at the bottom of the window displays the video and audio streams for the video clip you
are editing, using a rule to show your position. To edit a video, drag its icon from the
Clip Library to the timeline. To trim a video, you pass the mouse over the timeline video
and audio streams. Trimming handles will appear that you can use to shorten the video.
PiTiVi features ripple editing and rolling editing, splitting, and transitions.
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myvideoLavi

Figure 6-22. PiTiVivideo editor

TV Players

The TV players that are provided on Fedora repositories are listed in Table 6-7.

Table 6-7. TV Players

TV Player Description

Totem Movie player that can access DVB stations using gnome-dvb. Choose Watch TV
from the Movie menu. The Digital Television Assistant configures access to your
DVB card. ATSC cards are not yet supported.

tvtime TV player that works with many common video-capture cards, relying on drivers
developed for TV tuner chips on those cards, such as the Conexant chips. It can
only display a TV image. It has no recording or file playback capabilities. Check
http://tvtime.sourceforge.net for more information.

Dragon Player ~ These are KDE multimedia players that will also play TV.

Kaffeine KDE video recording and playback application on Linux systems. It can also play
ATSC over-the-air digital broadcasts.

MythTV Popular video recording and playback application on Linux systems. MythTV is
available from the RPM Fusion free repository.

Kodi Open source cross-platform integrated multimedia player with both TV viewing
and PVR capabilities for TV recording (formerly XBMC) https://kodi.tv/.

242


http://tvtime.sourceforge.net
https://kodi.tv/

CHAPTER6  GRAPHICS AND MULTIMEDIA

Note To play DivX media on Fedora, use the Xvid OpenDivX codec xvidcore.

Xvid (DivX) and Matroska (mkv) on Linux

MPEG4 compressed files provide DVD-quality video with relatively small file sizes. They have
become popular for distributing high-quality video files over the Internet. When you first try
to play an MPEG4, the codec wizard will prompt you to install the needed codec packages to
play it. Many multimedia applications such as VLC already support MPEG4 files.

MPEG4 files using the Matroska wrapper, also known by their file extension, mkv, can
be played on most video players, including the VideoLan VLC player, Totem, Dragon
Player, and Kaffeine. You will need HDTV codecs, such as MPEG4 AAC sound codec,
installed to play the high-definition mkv file files. If needed, the codec wizard will prompt
you to install them. To manage and create mkv files, you can install the mkvtoolnix
packages and use the mkvmerge application.

You use the open source version of DivX, known as Xvid, to play DivX video
(libxvidcore package). Most DivX files can be run using Xvid. Xvid is an entirely
independent open source project, but it is compatible with DivX files. You can also
download the XviD source code from http://xvid.org.

To convert DVD-Video files to an MPEG4/DivX format, you can use the ffmpeg
libraries. Many DVD burners can use these to convert DVD video files to DivX/Xvid files.

Sound Settings

Your sound cards are detected automatically for you when you start up your system by ALSA,
which is invoked by udev when your system starts up. Removable devices, like USB sound
devices, are also detected. See Table 6-8 for a listing of sound device and interface tools.

Table 6-8. Sound Device and Interface Tools

Sound Tool Description

KMix KDE sound connection configuration and volume tool

Sound GNOME Settings Sound, used to select and configure your sound interface
PulseAudio PulseAudio sound interface, the default sound interface for Fedora Linux

https://www.freedesktop.org/wiki/Software/PulseAudio/
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In addition to hardware drivers, sound systems also use sound interfaces to direct
encoded sound streams from an application to the hardware drivers and devices.
Fedora Linux uses the PulseAudio server for its sound interface. PulseAudio aims to
combine and consolidate all sound interfaces into a simple, flexible, and powerful
server. The ALSA hardware drivers are still used, but the application interface is handled
by PulseAudio. PulseAudio is installed as the default set up for Fedora Linux for both
GNOME and KDE. PulseAudio provides packages for interfacing with applications like
GStreamer and VLC.

PulseAudio is a cross-platform sound server, allowing you to modify the sound
level for different audio streams separately. See https://www.freedesktop.org/wiki/
Software/PulseAudio/ for documentation and help. PulseAudio offers complete control
over all your sound streams, letting you combine sound devices and direct the stream
anywhere on your network. PulseAudio is not confined to a single system. It is network
capable, letting you direct sound from one PC to another.

As an alternative, you can use the command-line ALSA control tool, alsamixer
(alsa-tools package). This will display all connections and allow you to use keyboard
commands to select (arrow keys), mute (m key), or set sound levels (Page Up and
Down). Press the Esc key to exit. The amixer command lets you perform the same tasks
for different sound connections from the command line. To actually play and record
from the command-line, you can use the play and rec commands.

Volume Control

Volume control for different applications is displayed on the application's dialog as the
speaker icon. You can click it to change your application's output sound volume using
a sliding bar. The sliding sound bar on the system status area menu also lets you set the
sound volume, as shown here.

To perform volume control for specific devices like a microphone, you use the
GNOME Settings Sound dialog.
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Sound: PulseAudio

You configure sound devices and set the volume for sound effects, input, output, and
applications using the GNOME Settings Sound dialog. The Sound dialog has four tabs:
Output, Input, Sound Effects, and Applications (see Figure 6-23). Corresponding sound
configuration is available on KDE, which also uses PulseAudio.

Q Settings Sound X
~—searen

Output Input Sound Effects Applications

€ Universal Access
Alert volume: % () )
4¥ Online Accounts
Choose an alert sound:
W Privacy
«& Sharing Bark
Drip
Sonar
(e Power
o Network
%o Devices >

[T WP

Figure 6-23. Sound preferences

Volume control is integrated into the Sound dialog. A sliding bar at the top of the
dialog, above the tabs, lets you set the output volume.

The Sound Effects tab lets you select an alert sound, such as Drip or Sonar. A sliding
bar lets you set the volume for your sound alerts, or turn them off by clicking the ON/
OFF switch.

On the Input tab, you set the input volume for an input device such as a microphone.
An ON/OFF switch lets you disable it. When speaking or recording, the input level is
displayed (see Figure 6-24). If you have more than one input device, they will be listed in
the “Choose a Device for Sound Input” section. Choose the one you want to configure.
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Figure 6-24. Pulse preferences: Input
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On the Output tab, you can configure balance settings for a selected output device. If

you have more than one device, it will be listed in the Profile menu. Choose the one you

want to configure. The available settings will change according to the device selected. For a

simple Analog Stereo Output, there is only a single balance setting (see Figure 6-25).
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Figure 6-25. Pulse preferences: Output
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The Applications tab will show applications currently using sound devices. You can
set the sound volume for each (see Figure 6-26).

Q Settings Sound X
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Output Input Sound Effects Applications
Universal Access —_—

Online Accounts @) virmoo 6 ——————O— « [ ]
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E
& Privacy
<

Sharing A Videos o) e— i)

(e Power
o Network

%o Devices >

et

Figure 6-26. Pulse preferences: Applications

Sound devices that support multiple interfaces like analog surround sound 7.1 and
digital SPDIF output, may have an extensive list of interface combinations in the Profile
menu. The Input and Output tabs will then display configuration settings for the selected
device. With Analog Surround 7.1 Output selected, the Output tab will show settings for
Balance, Fade, and Subwoofer. Configuring digital output for SPDIF (digital) connectors
is a simple matter of selecting the digital output entry on the Profiles menu.

Note To find the actual name of the SPDIF output is not always obvious. You may
need to run aplay -L in a terminal window to see what the name of the digital
output device is on your system. It will be the entry with Digital in it.
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PulseAudio Applications

For additional configuration abilities, you can also install the PulseAudio applications.

Most begin with the prefix pa in the package name. PulseAudio tools are accessible from

the Applications overview. The PulseAudio tools and their command names are shown

in Table 6-9.

Table 6-9. PulseAudio Commands (Command-Line)

Sound Tool Description

pacat Plays, records, and configures a raw audio stream.

pacmd Generates a shell for entering configuration commands.

pactl Controls a PulseAudio server, changing input and output sources and providing
information about the server.

padsp PulseAudio wrapper for 0SS sound applications.

pamon Links to pacat.

paplay Plays back audio. The -d option specifies the output device, the -s option
specifies the server, and the - -volume option sets the volume (link to pacat).

parec Records and audio streams (link to pacat).

parecord Records and audio streams (link to pacat).

pasuspender Suspends a PulseAudio server.

pax11ipublish  Accesses PulseAudio server credentials.

PulseAudio Volume Control, pavucontrol

PulseAudio Volume Meter, pavumeter

PulseAudio Manager, paman

You can use the PulseAudio Volume Control tool to set the sound levels for different

playback applications and sound devices (choose PulseAudio Volume Control on the

Applications overview). The PulseAudio Volume Control applications will show five tabs:

Playback, Recording, Output Devices, Input Devices, and Configuration (see Figure 6-27).

The Playback tab shows all the applications currently using PulseAudio. You can adjust

the volume for each application separately.
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Figure 6-27. PulseAudio volume control: Playback tab

You can use the Output tab panel to set the volume control at the source and
select different output devices, such as Headphones (see Figure 6-28). The volume
for input and recording devices are set on the Recording and Input Devices tabs. The
Configuration tab lets you choose different device profiles.

Volume Control X

Playback Recording Output Devices Input Devices Configuration

B Built-in Audio Analog Stereo @« U ©

Port: | Speakers

-

46% (-20.25d8)

w Advanced
Latency offset:  0.00

Show: All Output Devices -
2 @

Figure 6-28. PulseAudio volume control: Output Devices tab
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You can also use the PulseAudio Volume control to direct different applications
(streams) to different outputs (devices). For example, you could have two sound sources
running—one for video and another for music. The video could be directed through
one device to headphones, and the music through another device to speakers, or even
to another PC. To redirect an application to a different device, right-click its name in the
Playback tab. A pop-up menu will list the available devices and let you select the one you
want to use.

The PulseAudio Volume Meter tool will show the actual volume of your devices.

The PulseAudio Manager will show information about your PulseAudio
configuration, accessible from the Applications overview. The Devices tab shows the
currently active sinks (outputs or directed receivers) and sources (see Figure 6-29). The
Clients tab shows all the applications currently using PulseAudio for sound.

PulseAudio Manager [unix:/run/user/1001/pulse/native] x

PulseAudio Manager

View and control the internals of your sound server

Server Information | Devices | Clients | Modules  Sample Cache

Name Description
v Sinks
alsa_output.pci-0000.00_1b.0.analog-stereo Built-in Audio Analog Stereo
* Sources
~ alsa_output.pci-0000_00_1b.0.analog-stereo.monitor ~ Monitor of Built-in Audio Analog Stereo
#1 Peak detect
= alsa.input.pci-0000_00_1b.0.analog-stereo Built-in Audio Analog Stereo
#2 Peak detect
Ready

Figure 6-29. PulseAudio Manager: Devices tab
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Simultaneous output creates a virtual output device to the same hardware device.
This lets you channel two sources onto the same output. With PulseAudio Volume
Control, you could then channel playback streams to the same output device, but using
avirtual device as the output for one. This lets you change the output volume for each
stream independently. You could have music and voice directed to the same hardware
device, using a virtual device for music and the standard device for voice. You can then
reduce the music stream or raise the voice stream.
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Internet Applications:
Web and FTP

Fedora provides powerful web and FTP clients for accessing the Internet. Many are
installed automatically and are ready to use when you first start up your Linux system.
Linux also includes full Java development support, letting you run and construct Java
applets. This chapter covers some of the more popular web, Java, and FTP clients
available on Linux. Web and FTP clients connect to sites that run servers, using web
pages and FTP files to provide services to users.

Web browsers and FTP clients are commonly used to conduct secure transactions,
such as logging in to remote sites, ordering items, or transferring files. Such operations
are currently secured by encryption methods provided by the Secure Sockets Layer
(SSL). If you use a browser for secure transactions, it should be SSL-enabled. Most
browsers, such as Mozilla and ELinks, include SSL support. For FTP operations, you can
use the SSH version of ftp, sftp, or the Kerberos 5 version. Linux distributions include SSL
as part of a standard installation.

Web Browsers

Most web browsers are designed to access several different kinds of information. Web
browsers can access a web page on a remote website or a file on your own system. Some
browsers can also access a remote news server or an FTP site. The type of information
for a site is specified by the keyword http for websites, nntp for news servers, ftp for FTP
sites, or file for files on your own system.
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Popular browsers for Fedora include Firefox (Mozilla), Konqueror, Rekonq, GNOME
Web (Epiphany), Chrome (Google), and Lynx (see Table 7-1). Firefox is the default web
browser used on most Linux distributions, including Fedora. Rekongq is the KDE web
browser, accessible from the KDE desktop, and Epiphany is the GNOME web browser.
Chrome is the Google web browser. Lynx and ELinks are command-line-based browsers
with no graphics capabilities, but in every other respect they are fully functional web
browsers.

Table 7-1. Web Browsers

Website Description

Firefox The Mozilla project Firefox web browser; Fedora desktop default
browser https://www.mozilla.org

Konqueror KDE desktop web browser https://www.konqueror.org

Rekonq KDE desktop web browser https://rekonq.kde.org

GNOME Web (Epiphany)  GNOME web browser https://wiki.gnome.org/Apps/Web

Chromium Google Chrome web browser https://www.chromium.org

Lynx Text-based command-line web browser https://lynx.isc.org

ELinks Text-based command-line web browser https://elinks.or.cz

The Firefox Web Browser

Firefox is based on the Netscape core source code known as Mozilla (see Figure 7-1).

In current releases, Fedora uses Firefox as its primary browser. The Mozilla project

is an open source project based on the original Netscape browser code that provides

a development framework for web-based applications, primarily the web browser

and email client. The Mozilla project site is https://www.mozilla.org, and the site
commonly used for plugin and extension development is https://www.mozdev.org. You
can also sign up for a Firefox account which can then make your bookmarks available to
the Firefox browsers on all your devices. Firefox calls this feature the pocket. So you can
save a bookmark to your pocket on one of your Firefox browsers, and have it available on
the Firefox browsers on all your devices.
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Figure 7-1. Firefox web browser

Firefox is installed by default with icons on the dash and the Applications overview.
When opened, Firefox displays the first tab. Firefox is designed to display tabs, each of
which can display a complete web page, including the Firefox toolbar and sidebar. The
tab title is shown at the top, and next to it is a plus button (+) you can click to add a new
tab. You can also press Ctrl+t. You an easily switch from one page to another by click its
tab. You can rearrange tabs by clicking and holding on a tab title and moving it to the
right or left.

Within a tab, a navigation toolbar is displayed at the top, with an address bar (text
box) for entering a URL address and a series of navigation buttons for accessing web
pages. On the left side of the toolbar are the Next and Previous buttons for paging through
previously accessed web pages, followed by a cancel button for loading a page (X).

This becomes a refresh button when the page is fully displayed. Next to it is the Home
button to move you to your home page.

When you enter a web page name in the address bar, Firefox performs a dynamic
search on previously accessed pages and displays the pages in a drop-down menu,
which you can choose from. Within the address bar to the right are buttons for recent
history (down arrow), page actions (...), saving to the pocket (down arrow), and marking
the page as a bookmark (star). The page actions button displays a menu for tasks such as
bookmarking the page, saving to the pocket, and emailing the link.
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Firefox provides a search bar (text box) where you can use different search engines
for searching the Web, selected sites, or particular items. You have the option to display a
search bar either to the right of the address bar or at the bottom of the recent history list.
By default, the search bar is only shown at the bottom of the recent history list. It shows
alist of icons for the different search services, showing the name of the one your mouse
passes over. Upon clicking one, it moves you to that the page for the search service. To
the right of the icon list is a gear icon, which you can click to open Firefox Preferences at
the entry where you can choose to display the search bar in the toolbar instead. When
on the toolbar, the search bar is displayed to the right of the address bar. A pop-up menu
lets you select a search engine, showing small icons for the options. Currently included
are Google, Bing, Amazon, and eBay.

To the right of the address bar are buttons for history-bookmarks, displaying the
sidebar, and the Firefox menu. The history-bookmarks button displays a menu for
accessing your bookmarks, history, downloads, and screenshots, as well as Firefox
account supported features such as your pocket list and synced tabs.

To add a bookmark for a page, click the bookmark button on the right side of the
address bar. This displays an Page Bookmarked dialog with a pop-up menu for folders
and tags. The Folder menu is set to the Other Bookmarks folder by default. You can also
select the Bookmarks Toolbar or the Bookmarks Menu. Clicking on the down button to
the right expands a frame where you can edit your bookmark folders, adding new ones.
Selecting Bookmarks on the history/bookmarks menu (accessible form the toolbar)
displays the Bookmarks menu, showing a list of your bookmarks from which you can
select one to view. Here you can also bookmark a page. The Show All Bookmarks entry
at the bottom of the list opens the Library dialog where you can edit your bookmarks or
delete bookmarks.

To search a current page for certain text, enter Ctrl+f. This opens a search toolbar at
the bottom of Firefox from which you can enter a search term. You have search options
to highlight found entries or to match character case. The Next and Previous buttons let
you move to the next found pattern.

When you download a file using Firefox, the download is managed by the Download
Manager. You can download several files at once. Progress is displayed download button
on the toolbar, which you can click to see your downloads. You can cancel a download at
any time or just pause a download, resuming it later.
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Selecting History on the History/Bookmarks menu (accessible form the toolbar)
displays the History menu, showing a list of your recently accessed web pages from
which you can select one to view. You can also see recently closed tabs and Firefox
windows. To clear your recent history, choose the Clear Recent History entry. The
Show All History opens the Library dialog as the history entry, letting you edit, access,
bookmark, or remove previous pages.

The Firefox menu lets you perform web page tasks such as zooming, opening new
windows, printing and saving a page, and performing searches on a page. There are
also administrative options such as Preference, Add-ons, and the Library. The Library
dialog lets you manage all your history and bookmarks. On Preferences you can set your
privacy and search options, as well as setting your home page, language, fonts, download
location.

The Add-ons entry on the menu opens the Add-ons window with tabs for Get Add-
ons, Extensions, Themes, and Plugins. Click the one you want to open a brief description
and display the Add to Firefox button, which you click to open a download and install
dialog. The Extensions tab lists installed Extensions with buttons for Preferences,
Disable, and Uninstall for each. On the Plugins tab, you can disable or enable embedded
applications, such as DivX, iTunes, QuickTime, and Skype. The Themes tab lets you
choose a theme.

Firefox also supports profiles. You can set up different Firefox configurations, each
with preferences and bookmarks. This is useful for computers like laptops that connect
to different networks or are used for different purposes. You can select and create profiles
by starting up the profile manager. Enter the firefox command in a terminal window
with the -P option.

firefox -P

A default profile is already set up. You can create a new profile, which runs the profile
wizard to prompt you for the profile name and directory to use. Select a profile to use
and click Start Firefox. The last profile you used will be used again the next time you start
Firefox. You have the option to prompt for the profile to use at startup, otherwise run the
firefox -Pcommand again to change your profile.
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GNOME Web (Epiphany)

GNOME Web, formerly known as Epiphany, is a GNOME web browser with a simple
interface designed to be fast (see Figure 7-2). You can find out more about Epiphany at
https://wiki.gnome.org/Apps/Web. Web works well as a simple browser with a clean
interface. It is also integrated with the desktop, featuring a download applet that will
continue after closing Web. Web also supports tabbed panels for multiple website access.
Its applications menu lists options such as New Window, New Incognito Window, the
import and export of bookmarks, History, and Preferences. For page-specific operations
such as tabs, print, save, zooming, and find, click the menu button at the top right. You
can install GNOME Web using GNOME Software and searching under Epiphany or Web.
Install the GNOME Web package. Once installed, you can access it as Web.

@ hitps:/igetfedora.org/

Choose Freedom. Choose
Fedora.

Less setup, more innovation. Choose a flavor of Fedora
streamlined for your needs, and get to work right away.

Figure 7-2. Web (Epiphany) web browser

Chromium

Google’s Chromium web browser (https://ww.chromium.org) provides easy and very
secure access to the Web with full Google integration. You can install it using GNOME
Software, which will enable the Google repository from which it will be downloaded
(chromium). You can access Chromium from the Applications overview as Chromium
Web Browser. You are first prompted to enter your Google account email and password
so that your online preferences and bookmarks can be used, but you can pass.
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On Chromium, primacy is afforded to tabs. At the top of the Chromium window
are your tabs for open web pages, with a square image button at the end of the tabs for
opening a new tab (see Figure 7-3). Chromium features a simple toolbar with navigation

buttons and a bookmark button (star icon). To close a tab, click the x button to the right
of the tab title.
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Figure 7-3. Chromium Web browser

To the right of the URL box, a menu button displays a drop-down menu for menu
items for browser operations such as new tabs, print, zoom, history, bookmarks,
and downloads. To configure Chromium, select Settings from this menu to open the
Chromium Settings tab. Here you can set your home page, default search service, and
themes. Click the Advanced on the sidebar (top-left menu icon) to expand the Settings
dialog to let you manage passwords, languages, downloads, printing, and accessibility.

When you open a new tab, a thumbnail listing of recently closed and most visited
sites is displayed. Clicking a thumbnail moves you to that site. On a new tab, the
bookmark toolbar is also displayed, which you can use to access a site.
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Konqueror: KDE Web and FTP Access

The KDE Konqueror is a full-featured web browser and an FTP client. It includes a box
for entering either a pathname for a local file or a URL for a web page on the Internet

or your intranet. A navigation toolbar can be used to display previous web pages. The
Home button will always return you to your home page. When accessing a web page, the
page is displayed as on any web browser. With the navigation toolbar, you can move back
and forth through the list of previously displayed pages in that session.

You can set the view mode (View » View Mode menu) to use KHTML, WebKit, or
Embedded Advanced Text Editor. The editor displays the web page source code and
allows you to edit a copy of the page locally, or to the site, if you have permission.

Kongqueror also operates as an FTP client. When you access an FTP site, you navigate
the remote directories as you would your own. The operations to download a file are the
same as copying a file on your local system. Just select the file’s icon or entry in the file
manager window and drag it to the local directory where you want it downloaded, then
select the Copy entry from the pop-up menu that appears.

To configure Konqueror, select Configure Konqueror from a Konqueror window
Settings menu. You can perform configuration tasks such as specifying proxies and web
page displays, choosing fonts to use, managing cookies, and setting bookmarks.

The KDE Rekong Web Browser

Rekongq is the new web browser for KDE (see https://rekonq.kde.org for more
details). Rekonq is based on the WebKit layout engine, like Chrome and Apple’s Safari. A
navigation bar lets you move through accessed pages on a tab, refresh a site, or enter the
address of a new site (see Figure 7-4). On the right side of the navigation bar is a menu
button that displays Rekonq browser operations such as open, save, print, panel display,
help, and configuration. A bookmark navigation bar can be displayed.

260


https://rekonq.kde.org

CHAPTER 7  INTERNET APPLICATIONS: WEB AND FTP
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Figure 7-4. Rekonq web browser

Like Chrome, Rekonq is tab-based. Tabs can be reordered with a click-and-drag of
their tab thumbnails. To close a tab, click its x button to the right of its name. You add
new tabs by clicking the New Tab button to the right of an open tab. The new tab opens
to the Favorites page. Should you ever want to return to the Favorites page, just open a
new tab.

To configure Rekong, select Configure Rekonq from the menu. The General tab
specifies the page displayed on Rekong at startup, the default being a new tab page. You
can set it to your home page or to the last opened pages. Set your home page in the Home
Page URL text box. The Tabs tab determines new tab behavior, such as displaying your
Favorites page in a new tab or opening links in a new tab. Appearance is where you set the
default font and font size. WebKit sets WebKit and Plugin settings, such as image loading,
Java support, and storage use. Privacy controls your cache, cookies, and proxy settings.

Lynx and ELinks: Line-Mode Browsers

Lynx is a line-mode browser you can use without the X Window System. A web page is
displayed as text only. A text page can contain links to other Internet resources but does
not display any graphics, video, or sound. Except for the display limitations, Lynx is a
fully functional web browser. You can also use Lynx to download files or access local
pages. All information on the Web is still accessible to you. Because it does not require

261



CHAPTER 7  INTERNET APPLICATIONS: WEB AND FTP

much of the overhead that graphics-based browsers need, Lynx can operate much faster,
quickly displaying web page text. To start the Lynx browser, enter lynx on the command
line and press Enter.

Another useful text-based browser shipped with most distributions is ELinks. ELinks
is a powerful screen-based browser that includes features such as frame, form, and
table support. It also supports SSL secure encryption. To start ELinks, enter the elinks
command in a terminal window.

Enabling the Flash Plugin

Fedora includes two free and open source versions of Flash: swfdec and gnash. It is
preferable that you try these before attempting to use the version provided directly by
Adobe. The swfdec version is newer. Both are available on the Fedora repository.

You can also download and install the Adobe Flash plugin provided by Adobe for
Linux. Adobe maintains a repository compatible with Fedora that contains the Flash
plugin. Install the Adobe repository configuration package and then use dnf to download
and install the Flash plugins. The Fedora project Flash wiki refers to an Ask Fedora page
that explains the procedure in detail; see http://fedoraproject.org/wiki/Flash.

Once the repository is configured, you can use dnf to install the Flash package. The Flash
plugin package is flash-plugin.

sudo dnf install flash-plugin

The first time you install any package from the Adobe repository, you are prompted
to install its package key. A dialog will be displayed with the message “Do You Trust the
Source of the Packages?” Click Yes to install the Adobe repository package key.

Simply restart Firefox to enable your Flash plugin. On the Tools » Add-ons Plugins
tab, you will find an entry for Flash.

Java for Linux

To develop Java applications, use Java tools, and run many Java products, you use the
Java Software Development Kit (SDK) and the Java Runtime Environment (JRE). The
SDK is a superset of the JRE, adding development tools like compilers and debuggers.
Sun (now owned by Oracle) has open sourced Java as the Open]JDK project and supports
and distributes Linux versions. The JRE subset can be installed as java-1.8.0. The java-
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1.8.0-openjdk package installs the Java 8 runtime environment, and java-9-openjdk
installs both the JRE and the Java development tools for Java 9. Java packages and
applications are listed in Table 7-2. Install with Packages or dnf.

Table 7-2. Java Packages and Java Web Applications

Application Description
Java Development Kit, An open source Java development environment with a compiler,
OpendDK interpreters, debugger, and more (include the JRE), http://

openjdk.java.net, java-9-openjdk

Java Runtime Environment, An open source Java runtime environment, including the Java virtual

OpenJRE (java-1.8.0) machine, java-1.8.0-openjdk http://openjdk.java.net
Java Platform Standard Complete Java collection, including JRE, JDK, and AP,

Edition (JSE)

GNU Java Compiler GNU Public Licensed Java Compiler (GCJ) to compile Java programs

Several compatible GNU packages (Java-like) are provided that allow you to run Java
applets using GNU free Java support. These include GNU Java compiler (gcj) and the
Eclipse Java compiler (ecj).

BitTorrent Clients

GNOME and KDE provide very effective BitTorrent clients. With BitTorrent, you can
download very large files quickly in a shared distributed download operation where
several users participate in downloading different parts of a file, sending their parts of
the download to other participants, known as peers. Instead of everyone trying to access
a few central servers, all peers participating in the BitTorrent operation become sources
for the file being downloaded. Certain peers function as seeders for those who have
already downloaded the file but continue to send parts to those who need them.

For the Fedora desktop, you can install the GNOME BitTorrent client Transmission
or gBitTorrent. For KDE, you can use the KTorrent BitTorrent client. To perform a
BitTorrent download, you need the BitTorrent file for the file you want to download. The
BitTorrent file for the Fedora DVD ISO image is Fedora-Workstation-Live-x86 64-28.
torrent. When you download the file from the https://torrent.fedoraproject.org/
site, you will be prompted to open it directly with Transmission or to save it to a file.
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Transmission can handle several torrents at once. On the toolbar are buttons for
starting, pausing, and removing a download. The Add button can be used to load a
BitTorrent file (. torrent), thus setting up a download. You also can drag-and-drop a
torrent file to the Transmission window. When you first open a torrent file, the Torrent
Options window opens where you can specify the destination folder and the priority.
The option to start the download automatically will be selected by default. Figure 7-5
shows Transmission with two BitTorrent operations set up, one of which is active.

A progress bar shows how much of the file has been downloaded.

Transmission X

File Edit Torrent View Help
51 Open W - ¢« Properties

Show: All 2> All 2 - x

Fedora-Cinnamon-Live-x86_64-28

[§== 43.37 MB of 1.83 GB (2.3%) - 1 hour, 1 minute remaining
&}
Downloading from 30 of 41 peers - 107 kB/s » 0 kB/s «

Fedora-Workstation-Live-x86_64-28
i 39.83 MB of 1.79 GB (2.2%) - 4 hours remaining

8l
Downloading from 12 of 50 peers - 24 kB/s » 0 kB/s »

& =~ 132 kB/s ~ 0kB/s « Ratio: 0.0 &

Figure 7-5. Transmission BitTorrent client

You could set up Transmission to manage several BitTorrent operations, of which
only a few may be active, others paused, and still others complete but continuing
to function as seeders. From the first drop-down menu, you can select All, Active,
Downloading, Seeding, Paused, Finished, and Queued torrents. You can also choose
those verifying and those that have errors. From the second menu, you can choose
trackers, public or private torrents (privacy), and select by priority (high, normal, or low).

To remove a torrent, right-click it and select Remove. Choose Delete Files and
Remove to remove what you have downloaded so far.

To see more information about a torrent, select it and then click the Properties
button (see Figure 7-6). This opens a Properties window with tabs for Information,
Peers, Trackers, Files, and Options. On the Information tab, the Activity section shows
statistics such as the progress, times, and errors, and the Details section shows the origin,
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comment, and location of the download folder. Peers shows all the peers participating
in the download. Trackers displays the location of the tracker, which is the server that
manages the torrent operation. Files shows the progress of the file download (a torrent
could download more than one file). The Options tab lets you set bandwidth and
connection parameters, limiting the download or upload and the number of peers.

Fedora-Workstation-Live-x86_64-28 Properties x

Information Peers Trackers Files Options

Activity
Torrent size: 1.79 GB (6,821 pieces @ 256.0 KiB)
Have: 34.10 MB (1.9% of 100% Available); 7.36 MB Unverified
Uploaded: None (Ratio: 0.0)
Downloaded: 34.48 MB
State: Downloading

Running time: 1 minute, 35 seconds

Remaining time: 4 hours

Last activity: Active now
Error: No errors
Details
Location: /home/richard/Downloads
Hash: 97809d43ddc3c7340491625d0300baB%e6b3bb6b
Privacy: Public torrent
Origin: Created on 30 Apr 2018
Comment:

Close

Figure 7-6. Transmission BitTorrent client properties

The gBitTorrent client is a feature-rich and simple to use cross-platform client
available for Fedora (see Figure 7-7), https://www.qbittorrent.org/. It based on Qt
(KDE) graphical user interface. A sidebar lets you access your torrents by status, as well
as check errors and warnings. Use the toolbar to control torrents, add or remove torrents,
pause or resume, and rearrange the list. To see information about a particular torrent,
select it and use the buttons at the bottom of the window to display information, such as
general statistics (progress and speed), peers, and trackers.
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qBittorrent v4.1.0 x
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Figure 7-7. qBitTorrent client

FTP Clients

With File Transfer Protocol (FTP) clients, you can connect to a corresponding FTP
site and download files from it. These sites feature anonymous logins that let any user
access their files. Basic FTP client capabilities are incorporated into the Dolphin (KDE),
Nemo (Cinnamon), and Caja (Mate) file managers. You can use a file manager window
to access an FTP site and drag files to local directories to download them. Effective FTP
clients are also now incorporated into most web browsers, making web browsers the
primary downloading tool. Firefox, in particular, has strong FTP download capabilities.
Although file managers and web browsers provide effective access to public
(anonymous login) sites, to access private sites, you may need a stand-alone FTP client
like curl, wget, Filezilla, gFTP, lftp, or ftp. These clients let you enter usernames and
passwords with which you can access a private FTP site. The stand-alone clients are also
useful for large downloads from public FTP sites, especially those with little or no web
display support. Popular Linux FTP clients are listed in Table 7-3.
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Table 7-3. Linux FTP Clients

FTP Client Description

Dolphin KDE file manager

Nemo GNOME file manager

gFTP GNOME FTP client, gftp

ftp Command-line FTP client

Iftp Command-line FTP client capable of multiple connections
curl Internet transfer client (FTP and HTTP)

Filezilla Linux version of the open source Filezilla ftp client

Network File Transfer: FTP

With File Transfer Protocol (FTP) clients, you can transfer extremely large files directly
from one site to another. FTP can handle text and binary files. FTP performs a remote
login to another account on another system connected to you on a network. Once logged
in to that other system, you can transfer files to and from it. To log in, you must know the
login name and password for the account on the remote system; however, many sites
on the Internet allow public access using FTP. Such sites serve as depositories for large
files that anyone can access and download. These sites are often referred to as FTP sites,
and in many cases, their Internet addresses begin with the term ftp, such as ftp.gnome.
org. These public sites allow anonymous FTP login from any user. For the login name,
you use the word anonymous, and for the password, you use your email address. You can
then transfer files from that site to your own system.

Several FTP protocols are available for accessing sites that support them. The
original FTP protocol is used for most anonymous sites. FTP transmissions can also
be encrypted using SSH2, the SFTP protocol. More secure connections use FTPS for
TLS/SSL encryption. Some sites support a simplified version of FTP called File Service
Protocol, FSP. FTP clients may support different protocols, such as gFTP for FSP and
Filezilla for TLS/SSL. Most clients support both FTP and SSH2.
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Web Browser-Based FTP: Firefox

You can access an FTP site and download files from it with any web browser. Browsers
are useful for locating individual files, although not for downloading a large set of files.
A web browser is effective for checking out an FTP site to see what files are listed there.
When you access an FTP site with a web browser, the entire list of files in a directory is
listed as a web page. You can move to a subdirectory by clicking its entry. You can easily
browse through an FTP site to download files. To download a file, click the download
link. This will start the transfer operation, opening a dialog for selecting your local
directory and the name for the file. The default name is the same as on the remote
system. On many browsers, you can manage your downloads with a download manager,
which will let you cancel a download operation in progress or remove other downloads
requested. The manager will show the time remaining, the speed, and the amount
transferred for the current download.

GNOME Desktop FTP: Connect to Server

The easiest way to download files from an FTP site is to use the built-in FTP capabilities
of the GNOME file manager, GNOME Files. The FTP operation has been seamlessly
integrated into standard desktop file operations. Downloading files from an FTP site is
as simple as dragging files from one folder window to another, where one of the folders
happens to be located on a remote FTP site. Use the GNOME file manager (GNOME
Files) to access a remote FTP site, listing files in the remote folder, just as local files are
(see Figure 7-8). In a file manager's Location bar (Ctrl+l or Enter Location from the file
manager Files applications menu), enter the FTP site's URL using the prefix ftp:// and
press Enter. A dialog opens prompting you to specify how you want to connect. You

can connect anonymously for a public FTP site, or connect as a user by supplying your
username and password (private site). You can also choose to remember the password.
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Figure 7-8. GNOME FTP access with the file manager

Folders on the FTP site will be displayed, and you can drag files to a local folder
to download them. You can navigate through the folders as you would with any file
manager folder, opening folders or returning to the parent folder. To download a file,
just drag it from the FTP window to a local folder window. To upload a file, drag it from
your local folder to the window for the open FTP folder. Your file will be uploaded to that
FTP site (if you have permission to do so). You can also delete files on the site’s folders if
allowed.

You can also use the Connect to Server bar in the file manager (see Figure 7-9) to
connect, which remembers your previous FTP connections. To access the Connect to
Server bar, click on the Other Locations entry in any file manager sidebar. The Connect
to Server bar is displayed at the bottom of the file manager window. It shows a text box
for the server address, a menu button to display previous addresses, and a Connect
button. Enter the server address. The address is remembered and added to the previous
servers list. Then click the Connect button. A dialog opens letting you specify an
Anonymous login or enter a username and password. Click the Connect button to access
the site.
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Connect to Server ftp:/iftp.gnome.org € =  Connect
Cancel Connect Cancel
Enter password for ftp.gnome.org Enter password for ftp.gnome.org
Connect As () Anonymous Connect As  (s) Anonymous
) Registered User _) Reqistered User
Username Username
Password Passworc

(_) Forget password immediately Forget password immediately
*) Remember password until you logout *) Remember password until you logout

_) Remember forever Remember forever

Figure 7-9. GNOME FTP access with Connect to Server and the file manager

The top directory of the remote FTP site will be displayed in a file manager window.
Use the file manager to progress through the remote FTP site’s directory tree until you
find the file you want. Then, open another window for the local directory to which you
want the remote files copied. In the window showing the FTP files, select those you want
to download. Then click and drag those files to the window for the local folder. As files
are downloaded, a dialog appears showing the progress.

The file manager window's sidebar will list an entry for the FTP site accessed. An
eject button is shown to the right of the FTP site’s name. To disconnect from the site,
click this button. The FTP entry will disappear along with the FTP sites icons and file
listings.

The KDE File Managers: Konqueror and Dolphin

On the KDE Desktop, the desktop file managers (Konqueror and Dolphin) have built-
in FTP capability. The FTP operation has been seamlessly integrated into standard
desktop file operations. Downloading files from an FTP site is as simple as copying files
by dragging them from one directory window to another, with one of the directories
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located on a remote FTP site. On KDE, you can use a file manager window to access a
remote FTP site. Files in the remote directory are listed just as your local files are. To
download files from an FTP site, you open a window to access that site, entering the URL
for the FTP site in the window’s location box. Use the ftp:// protocol for FTP access.
Once connected, open the directory you want, and then open another window for the
local directory to which you want the remote files copied. In the window showing the
FTP files, select the ones you want to download. Then click-and-drag those files to the
window for the local directory. A pop-up menu appears with choices for Copy, Link,

or Move Select Copy. The selected files are then downloaded. Another window opens,
showing the download progress and displaying the name of each file in turn, along with
a bar indicating the percentage downloaded so far.

Filezilla

Filezilla is an open source FTP client originally implemented on Windows systems
(https://filezilla-project.org). Use Packages to install it. Once installed, you can
access it from the Applications overview. The interface displays a left and right pane for
local and remote folders. You navigate through folder trees, with the files of a selected
folder displayed below. To download a file, right-click a file in the Remote site pane
(right) and select Download. To upload, right-click the file in the Local site pane (left)
and select Upload. Text boxes at the top let you specify the host, username, password,
and port. A Quick Connect drop-down menu will connect you to a preconfigured site.

To configure a remote-site connection, use the Site Manager (File » Site Manager).
In the Site Manager window, click the New Site button to create a new site connection.
Four configuration tabs become active: General, Advanced, Transfer Settings, and
Charset. On the General tab, you can specify the host, user, password, and account. The
server type drop-down menu lets you specify a particular FTP protocol, such as SFTP for
SSH encrypted transmissions or FTPS for TLS/SSL encryption.

gFTP

The gFTP program is a simpler GNOME FTP client designed to enable standard FTP file
transfers. The package name for gFTP is gftp. You can access it from the Applications
overview. The gFTP window consists of several panes. The top-left pane lists files in
your local directory, and the top-right pane lists your remote directory. Subdirectories
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have folder icons preceding their names. The parent directory can be referenced by the
double period entry (. .) with an up arrow at the top of each list. Double-click a directory
entry to access it. The pathnames for all directories are displayed in boxes above each
pane. A drop-down menu to the far right lets you specify the FTP protocol to use, such as
FTP for a standard transmission, SSH2 for SSH encrypted connections, and FSP for File
Service Protocol transmissions.

Two buttons between the panes are used for transferring files. The left arrow button,
<-, downloads selected files in the remote directory, and the right arrow button, ->,
uploads files from the local directory. To download a file, click it in the right pane and
then click the left arrow button, <-. When the file is downloaded, its name appears in the
left pane, which is your local directory. Menus across the top of the window can be used
to manage your transfers. A connection manager enables you to enter login information
about a specific site. You can specify whether to perform an anonymous login or provide
a username and password. Click Connect to connect to that site. A drop-down menu for
sites lets you choose the site you want. Interrupted downloads can be restarted later.

wget

The wget tool lets you access web and FTP sites for particular directories and files.
Directories can be recursively downloaded, letting you copy an entire website. The wget
command takes as its option the URL for the file or directory you want. Helpful options
include -q for quiet, -1 for recursive (directories), -b to download in the background,
and -c to continue downloading an interrupted file. One of the drawbacks is that your
URL reference can be very complex. You must know the URL already. You cannot
interactively locate an item as you would with an FTP client. The following would
download the Fedora Workstation Live DVD in the background:

wget -b https://download.fedoraproject.org/pub/fedora/linux/releases/28/
Workstation/x86_64/iso/Fedora-Workstation-Live-x86 64-28-1.1.iso

Tip  With the GNOME wget tool (gwget package), you can run wget downloads
using a GUI interface.

272



CHAPTER 7  INTERNET APPLICATIONS: WEB AND FTP

curl

The curl Internet client operates much like wget but with much more flexibility. With
curl, you can specify multiple URLs on its command line. You can also use braces to
specify multiple matching URLs, like different websites with the same domain name. You
can list the different website hostnames within braces, followed by their domain name
(or vice versa). You can also use brackets to specify a range of multiple items. This can
be very useful for downloading archived files that have the same root name with varying
extensions, such as different issues of the same magazine. curl can download using any
protocol and will try to intelligently guess the protocol to use if none is provided. Check
the curl man page for more information.

The curl client output to the standard output by default. Use the -0 option to save
the output to a file, and a -0 to save it as the same name as the filename in the URL. The
following example downloads the Fedora Workstation Live DVD with curl.

curl -0 https://download.fedoraproject.org/pub/fedora/linux/releases/28/
Workstation/x86_64/iso/Fedora-Workstation-Live-x86 64-28-1.1.iso

ftp

The ftp client uses a command-line interface, and it has an extensive set of commands
and options you can use to manage your FTP transfers. It is the original FTP client used
on UNIX and Linux systems. See the ftp man page for more details. Alternatively, you
can use sttp for more secure access. The sftp client has the same commands as ftp but
provides SSH (Secure Shell) encryption. Also, if you installed the Kerberos clients (krb5-
clients), a Kerberized version of FTP is set up, which provides for secure authentication
from Kerberos servers. It has the same name as the FTP client (an ftp link to Kerberos
FTP) and the same commands.

You start the ftp client by entering the command ftp at a shell prompt. If you want
to connect to a specific site, you can include the name of that site on the command line
after the ftp keyword. Otherwise, you have to connect to the remote system with the
ftp command open. You are then prompted for the name of the remote system with the
prompt “(to).” When you enter the remote system name, FTP connects you to the system
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and then prompts you for a login name. After entering the login name, you are prompted
for the password. In the next example, the user connects to the remote system garnet
and logs in to the robert account:

$ ftp

ftp> open

(to) garnet

Connected to garnet.berkeley.edu.

220 garnet.berkeley.edu FTP server ready.
Name (garnet.berkeley.edu:root): robert
password required

Password:

user robert logged in

ftp>

Once logged in, you can execute Linux commands on either the remote system or
your local system. You execute a command on your local system in ftp by preceding the
command with an exclamation point. Any Linux commands without an exclamation
point are executed on the remote system. One exception exists to this rule. Whereas
you can change directories on the remote system with the cd command, to change
directories on your local system, you need to use a special ftp command called lcd
(local cd). In the following example, the first command lists files in the remote system,
while the second command lists files in the local system.

ftp> 1s
ftp> !ls

The ftp program provides a basic set of commands for managing files and directories
on your remote site, provided you have the permission to do so. You can use mkdir to
create a remote directory and rmdir to remove one. Use the delete command to erase
aremote file. With the rename command, you can change the names of files. You close
your connection to a system with the close command. You can then open another
connection if you want. To end the FTP session, use the quit or bye command.

ftp> close
ftp> bye
Good-bye

$
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To transfer files to and from the remote system, use the get and put commands. The
get command receives files from the remote system to your local system, and the put
command sends files from your local system to the remote system. In a sense, your local
system gets files from the remote and puts files to the remote. In the next example, the
file weather is sent from the local system to the remote system using the put command.

ftp> put weather

PORT command successful.
ASCII data connection
ASCII Transfer complete.
ftp>

Iftp

The Ilftp program is an enhanced FTP client with advanced features, such as the
capabilities to download mirror sites and to run several FTP operations in the
background at the same time.

It uses a command set similar to that for the ftp client. You use get and mget
commands to download files, with the -0 option to specify local locations for them. Use
lcd and cd to change local and remote directories.

When you connect to a site, you can queue commands with the queue command,
setting up a list of FTP operations to perform. With this feature, you could queue several
download operations to a site. The queue can be reordered and entries deleted, if you
wish. You can also connect to several sites and set up a queue for each one. The mirror
command lets you maintain a local version of a mirror site. You can download an entire
site or just update newer files, as well as remove files no longer present on the mirror.

You can tailor Iftp with options set in the . 1ftprc file. System-wide settings are
placed in the /etc/1ftp.conf file. Here, you can set features such as the prompt to use
and your anonymous password. The . 1ftp directory holds support files for command
history, logs, bookmarks, and startup commands. The Ilftp program also supports the
.netrc file, checking it for login information.

275



CHAPTER 7  INTERNET APPLICATIONS: WEB AND FTP

Social Networking: IM, VolP, and Social Desktop

Fedora provides integrated social networking support for microblogging, IM (Instant
Messenger), and VoIP (Voice over Internet Protocol). Instant messenger (IM) clients
allow users on the same IM system to communicate anywhere across the Internet. With
VoIP applications, you can speak over Internet connections, talking as if on a phone. The
GNOME Maps application displays maps for cities, as well as your current location.

Instant Messenger: Empathy and Pidgin

Instant messenger (IM) clients allow users on the same IM service to communicate
anywhere across the Internet (see Table 7-4). Currently, some of the major IM services
are Microsoft Network (MSN), Yahoo, ICQ, and Jabber. Some use an XML protocol called
XMPP, Extensible Messaging and Presence Protocol (https://xmpp.org).

Table 7-4. Talk and Messenger Clients

Client Description

Ekiga VolIP application

Skype VolIP application (Partner repository)

Empathy GNOME instant messenger

KDE empathy  KDE instant messenger client

Pidgin Older instant messenger client

Jabber Jabber IM service (gajim, psi, emacs, empathy)
Finch Command-line cursor-based IM client

Hexchat IRC client

Empathy

Fedora uses Empathy as the default IM application. Empathy is the GNOME replacement
for Pidgin. There is also a KDE version, called KDE Empathy, which is the default IM
application for the KDE desktop. Empathy is based on the Telepathy framework, which is
designed to provide IM support to any application that wants an IM capability. All major
IM services are supported, including Google Talk, AIM, Bonjour, MSN Messenger, Jabber
(XMPP), ICQ, and Yahoo.

276


https://xmpp.org

CHAPTER 7  INTERNET APPLICATIONS: WEB AND FTP

Empathy is accessible from the Applications overview (see Figure 7-10). Messages
can be sent and received using the Empathy dialog and the message bar at the bottom
of the screen. Empathy is integrated into the GNOME desktop, with its applications
menu on the top bar. From the menu, choose Accounts to open the Messaging and VoIP
Accounts dialog. Here, you can edit and add new accounts. Accounts are listed to the left.
Information for a selected account is shown on the right. Click the plus button on the
lower left to open the Adding New Account dialog. From a menu, you can choose from
supported chat services, such as Facebook Chat, Jabber, Yahoo, and MSN. You enter your
ID and password.

© Empathy ~
Contact List

Contacts

Rooms a

You need to set up an
account to see contacts

Previous Conversations

File Transfers

here.

Accounts

Preferences Account settings

Help

Figure 7-10. Empathy IM client

The login information will differ according to the chat service you choose. Facebook
requires only a username and password. Others, such as MSN and AIM, have an
advanced expansion set of entries from which you can specify the server and port.

A drop-down menu on the Contact List window lets you select your status, such as
Available, Busy, Away, Invisible, or Offline. You can specify a custom message for a

particular status.
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You can edit your configuration by clicking the Edit Connection Parameters on the
Messaging and VoIP Accounts dialog. This opens the Online Accounts dialog with the
service selected. You can then turn the chat service off, if you wish.

Telepathy provides IM support with connection managers, making IM services
easy to maintain and add. Current connection managers include telepathy-gabble for
Jabber/XMPP, telepathy-idle for IRC, telepathy-butterfly for MSN, telepathy-
salut for local network (1ink-local) XMPP connections, telepathy-sofiasip for
SIP, and telepathy-haze for Pidgin’s Yahoo, AIM, and other support (1ibpurple; see
https://telepathy.freedesktop.org).

Pidgin

Pidgin is the older IM application used on previous Fedora releases. Pidgin is a multi-
protocol IM client that works with most IM protocols, including AIM, MSN, Jabber,
Google Talk, ICQ, IRC, Yahoo, and more. Pidgin is accessible from the Applications
overview. Pidgin will open a Buddy List window with menus for Buddies, Accounts,
Tools, and Help (see Figure 7-11). Use the Buddies menu to send a message or join a

chat. The Accounts menu lets you configure and add accounts. The Tools menu provides
configuration features, such as preferences, plugin selection, privacy options, and sound.

@ Pidgin Internet Messeénger ~ Thu 18:39

Add Account

Buddies Accounts Tools Help
Basic  Advanced Proxy

Welcome to Pidgin!

Login Options

' 4 'Tm have no accounts enabled Protocol: "7 Bonjour
Bl Enable your IM accounts from the
Accounts window at
Accounts=+Manage Accounts. Once
you enable accounts, youll be able
to sign on, set your status, and talk
1o your friends Local alias

User Options

Figure 7-11. Pidgin’s Buddy List
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The first time you start Pidgin, the Add Account window is displayed with Basic,
Advanced, and Proxy tabs for setting up an account. Later you can edit the account
by selecting it in the Accounts window (Accounts » Manage) and clicking the Modify
button.

To create a new account, select Manage Accounts from the Accounts menu
(Accounts » Manage). This opens the Accounts dialog, which lists your current
accounts. Click the Add button to open the Add Account dialog with a Basic, Advanced,
and Proxy tabs. On the Basic tab, you choose the protocol from a pop-up menu that
shows items such as AIM, Bonjour, Yahoo!, and IRC, and then enter the appropriate
account information. You can also select a buddy icon to use for the account. On the
Advanced tab, you specify the server and network connection settings. Many protocols
will have a server entered already. The configuration entries for both the Basic and
Advanced tabs will change, depending on the protocol. On the Proxy tab, you can enter
specific proxy server host and connection information, should your network use a proxy.

To edit an existing account, click its entry in the Accounts menu and select Edit
Account to open a Modify Account dialog with the same Basic, Advanced, and Proxy tabs.
Make your changes and click Save. You can also select Accounts » Manage Accounts to
open the Accounts dialog, from which you can select the accounts you want to modify.

To configure your setup, select Preferences from the Tools menu (Tools »
Preferences) to open the Preferences dialog, from which you can set options for logging,
sounds, themes, and the interface display. You can find out more about Pidgin at
https://pidgin.im. Pidgin is a GNOME frontend that uses the libpurple library for its
IM tasks (formerly 1ibgaim). The 1ibpurple library is used by many IM applications,
including Finch.

Ekiga

Ekiga is GNOME's VoIP application. It provides Internet IP telephone and video
conferencing support (see Figure 7-12); see https://www.ekiga.org. Ekiga supports the
H.323 and SIP (Session Initiation Protocol) protocols. It is compatible with Microsoft’s
NetMeeting. H.323 is a comprehensive protocol that includes the digital broadcasting
protocols, such as digital video broadcast (DVB) and H.261 for video streaming, as well
as the supporting protocols such as the H.450 series for managing calls. You can access
Ekiga from the Applications overview. Ekiga has panel status icons that display Online,
Away, and Do Not Disturb.
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Chat Edit View Help
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Figure 7-12. Ekiga VolP

To use Ekiga, you will need an SIP address. You can obtain a free address from
https://www.ekiga.org. You first have to subscribe to the service. When you start
Ekiga, the Ekiga Configuration Assistant prompts you to configure your connection (SIP
address, callout account—if you wish, connection type, and audio and video devices).
Here, you can provide contact information, your connection method, sound driver,
and video device. Use the address book to connect to another Ekiga user. A white pages
directory lets you search for people who are also using Ekiga.

Skype (VolP)

Skype is one of the most popular VoIP applications. Skype provides a Fedora 16 1586
version that works on Fedora27. You can install Skype directly from the Skype website. To
install Skype from the Skype website, go to the Skype Download page at https://www.
skype.com/en/get-skype/.

On Fedora, your browser will display the download page for Linux. A button
titled Get Skype for Linux RPM should be displayed. Click on it to download the
skypeforlinux-64.rpm file and open it with GNOME Software. You can then install it.
With the install, the sypeforlinux.repo file is also installed in the /etc/yum.repos.d
directory, enabling access to the Skype repository and allowing you to update Skype as
well as remove and reinstall with your software managers.
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Once installed, you can access Skype from the Applications overview. You first sign
into your account. A sidebar lets you perform searches, start chats and phone calls, and
list contacts and notifications (see Figure 7-13).

Skype *

File Edit View Tools Help

a . 8 o Welcome, Richard

Afg Skype to Phone Add funds

©» | g

Who will you call first?

Not you? Check account .g

Figure 7-13. Skype on Linux

KDE Social Desktop

KDE provides a set of Internet applications as part of the KDE Social Desktop initiative.
The social desktop is based on a web API called the Open Collaboration Services (OCS)
that allows applications to interface easily with Internet services like blogging and
Twitter (https://freedesktop.org/wiki/Specifications/open-collaboration-
services). KDE provides a data engine for Plasma widgets supporting social desktop
features. In effect, it establishes an open source method for social networking. In
addition, the Geolocation data engine allows plasmoids to detect and respond to

users’ geographic locations. Currently, the social desktop supports plasmoids for
microblogging, knowledge bases, messaging, and social networking.
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Maps

GNOME Maps is a GNOME map utility that provides both street and satellite maps.
It can also detect your current location or close to it (see Figure 7-14). From the task
menu at the left, you can choose a street or satellite view. Use the zoom buttons, also at
the left, or mouse scroll button to zoom in and out. To search for a location, enter the
name in the search box, and options will be listed. To see your current location, click the

Geolocation button to the left. To trace routes, click the route planner button to the right
to open a dialog where you can enter the source and destination locations.
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Figure 7-14. GNOME Maps

Note

It is also possible to download Google Earth for Fedora Linux at https://
www.google.com/earth/download/gep/agree.html. Keep in mind that
Google Earth is a proprietary product.
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CHAPTER 8

The GNOME Desktop

The GNU Network Object Model Environment, also known as GNOME, is a powerful
and easy-to-use environment consisting primarily of a panel, a desktop, and a set of
desktop tools with which program interfaces can be constructed. GNOME is designed
to provide a flexible platform for the development of powerful applications. Currently,
GNOME is supported by several distributions and is the primary interface for Fedora
Linux. GNOME is free and released under the GNU Public License. GTK+ is the widget
set used for GNOME applications. The GTK+ widget set is entirely free under the Lesser
General Public License (LGPL). The LGPL enables developers to use the widget set with
proprietary software, as well as free software (the GPL is restricted to free software).

For detailed documentation, check the GNOME documentation site at
https://help.gnome.org. Documentation is organized by users, administrators,
and developers. GNOME Help provides a complete tutorial on desktop use. For
administrators, the “GNOME Desktop System Administration Guide” details how
administrators can manage user desktops. Table 8-1 offers a listing of useful GNOME sites.

Table 8-1. GNOME Resources

Websites Description
https://www.gnome.org Official GNOME website
https://help.gnome.org GNOME documentation website for users,

administrators, and developers
https://wiki.gnome.org/Personalization Desktop themes and background art
https://wiki.gnome.org/Apps GNOME software applications

https://developer.gnome.org GNOME developers site; see http://help.
gnome . org for developer documentation
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GNOME releases new versions on a frequent schedule. Fedora Linux uses GNOME
3.28.2. Key changes with GNOME 3.28 are described in detail at the following:

https://help.gnome.org/misc/release-notes/3.28/

The GNOME Desktop

GNOME is based on the gnome-shell, which is a compositing window manager (see
Figure 8-1). The key components of the gnome-shell are a top bar, an Activities overview,
and a notification/message tray feature. The top bar has a dialog for the date and time, a
universal access menu, and a status area menu for sound volume, network connections,
power information, and user tasks such as accessing settings and logging out. The
Activities overview lets you quickly access favorite applications, locate applications,
select windows, and change workspaces. The message tray and notification system
notifies you of recent events, such as updates and recently attached USB drives. To the
right of the Activities button is the Applications menu, which is a menu for the currently
selected open application, such as the Files menu for a file manager window. Most
applications have only a Quit entry, while others list key tasks.

Activities System Status Area
(dash, windows, Applications Date, Time, (network, sound, power,
and workspeces} menu for active window ~ and Notifications settings, shutdown, lock)

B Trash

+ Other Locations

o
.

File Ménager
Figure 8-1. GNOME Desktop
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You can configure desktop settings and perform most administrative tasks using the
GNOME configuration tools (see Table 8-1) listed in the GNOME Settings dialog, accessible
from the System Status Area menu (see Figure 8-2). Most use the GNOME 3 configuration
and administrative tools such as Background, Lock Screen, Users, and Power.

Wired Connected
Wi-Fi Not Connected

On

Fully Charged

Richard Petersen

Figure 8-2. System Status Area menu

You can enhance the GNOME desktop by adding third-party extensions, as noted
in Chapter 4 (see Figures 4-13, 4-14, and 4-15). These extensions are not guaranteed to
work, though some are already installed and activated. Open the GNOME Software Add-
ons category and click the Shell Extensions tab. First, enable the extensions. You will see
icons with names and descriptions of different extensions, such as Dash to Dock which
places a dash on the desktop instead of the Activities overview. Some extensions work as
added items on the top bar, like system monitor. To manage installed extensions, click the
Extension Settings button at the top of the Shell Extensions tab to pen a Shell Extension
dialog where you can both turn extensions on or off and configure them if possible.
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Top Bar

The screen displays a top bar, through which you access your applications, windows, and
such system properties as sound and networking. Clicking the sound and power icons

at the right of the top bar displays the system status area menu with options to set the
sound level, screen brightness (laptop), wired and wireless connections, Bluetooth, and
to shut down or lock the screen (see Figure 8-1). The center of the top bar has a button

to display your clock and calendar. To the left is the Activities button, which displays an
icon bar for favorite and open applications.

The System Status Area

Once logged in, the System Status Area is displayed on the right side of the top bar

(see Figure 8-2). The area will include status icons for features such as sound and

power. Clicking the button showing the sound, power, and down arrow icons displays
the System Status Area menu, with items for sound, brightness, wired and wireless
connections, the battery, the current user, in addition to buttons at the bottom for
opening GNOME Settings, activating the lock screen, and shutting down or rebooting
the system. The sound and brightness items feature sliding bars with which you can
adjust the volume and brightness. The Wi-Fi, Battery, and current user entries expand to
submenus with added entries. The buttons at the bottom open separate dialogs.

On systems that are not laptops, there will be no brightness slider or battery entry on
the System Status Area menu. If the system also has no wireless device, the WiFi entry
will also be missing. A system of this kind will only have a sound slider and a user entry.

To log out, you click the current user entry to expand the menu to show Switch User,
Log Out, and Account Settings entries. The Log Out returns you to the login screen,
where you can log in as another user. To switch to another user, click the Switch User
entry to display the login screen. You can then log in as another user. When you log out
or choose Switch User, you can then select the original user. When you log back in, your
session is restored.
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Activities Overview

To access applications and windows, you use the Activities Overview mode. Click the
Activities button at the left side of the top bar (or move the mouse to the left corner, or
press the super (Windows) key). The Activities Overview mode consists of a dash listing
your favorite and running applications, thumbnails of open windows, and workspace
thumbnails (see Figure 8-3). You can use the search box at the top center to locate
applications and files. Partially hidden thumbnails of your desktop workspaces are
displayed on the right side. Initially, there are two. Moving your mouse to the right side
displays the workspace thumbnails.

Window
Activities button  selection Segrch

b

Workspace
Switcher

Applications— i

Figure 8-3. GNOME 3 activities overview

You can manually leave the Activities Overview mode at any time by pressing the
Esc key.

Dash

The dash is a bar on the left side with icons for your favorite applications (see Figure 8-4).
Initially, on the Fedora Workstation version, there is the Firefox Web browser, the Evolution
mail application, the Rhythmbox music player, the Shotwell photo manager, the file
manager, and software. To open an application from the dash, click its icon, or right-click
and choose New Window from the pop-up menu. You can also click-and-drag the icon to
the windows thumbnail area or to a workspace thumbnail on the right side.
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Favorites are always displayed on the dash. When you run other applications,
they are also placed on the dash during the time they are running. To add a running
application to the dash as a favorite, right-click the icon and choose Add to Favorites.
You can later remove an application as a favorite by choosing Remove from Favorites.
You can also add any application to the dash from the Applications Overview, by
clicking-and-dragging its icon to the dash, or by right-clicking the icon and choosing Add
to Favorites from the menu (see Figure 8-4).

Untitled Document 1 - gedit

Activities

New Window

New Document

Add to Favorites

Show Details

Figure 8-4. Overview dash with favorites and running applications
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Window Thumbnails

You access windows using the window thumbnails on the Activities overview.
Thumbnails are displayed of all your open windows (see Figure 8-5). To select a window,
move your mouse over the window’s thumbnail. The selected window also shows an x
(close) button at the top right of the window’s thumbnail, which you can use to close the
window directly. To access the window, move your mouse over it and click. This displays
the window, exiting the overview and returning to the desktop.

Sat 1403 e

& Fedora @ Help for Fedora & GetFedora
Documentation Users

Figure 8-5. Window thumbnails

Moving your mouse to the right side of the screen displays the workspace selector
showing workspace thumbnails, with the current workspace highlighted (see Figure 8-6).
You can switch to another workspace by clicking its thumbnail. You can also move
windows or applications directly to a workspace. If your mouse has a scroll wheel, you
can press the Ctrl key and use the scroll wheel to move through workspaces, forward or
backward.
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Figure 8-6. Workspace thumbnails

Applications Overview

Clicking the Applications icon (last icon, grid button) on the dash opens the Applications
Overview, from which you can locate and open applications. Icons for installed
applications are displayed (see Figure 8-7). The Frequent button at the bottom of the
overview lets you see only your most frequently used applications. Click the All button

to see them all. A pager consisting of buttons, on the right side, lets you move quickly
through the list of applications. You can move anywhere to a page in the list using the
buttons. There are two special sub-folders: Utilities and Sundry. Clicking those icons
opens another, sub-folders, showing applications in those categories, such as Tweak Tool
and Backups in the Utilities overview. You can use the GNOME Software Installed tab to
create your own sub-folders and place application icons in them. Click an application
icon to open it and exit the overview. Should you return to the overview mode, you will
see its window in the overview. The super key (Windows key) with the a key (super+a)
will switch automatically from the desktop to the Applications Overview. Continuing to
press it switches between the Applications Overview and the window thumbnails.
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Window
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— Workspace
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Applications — BB

Figure 8-7. Applications Overview

You can also open an application by dragging its icon to a workspace thumbnail on
the right side, starting it in that workspace.

Also, as previously noted, to add an application as a favorite on the dash, you can
simply drag its icon from the Applications Overview to the dash directly.

Activities Search

The Activities search will search applications and files. Should you know the name of the
application you want, you can simply start typing, and the matching results are displayed
(see Figure 8-8). Your search term is entered in the search box as you type. The results
dynamically narrow the more you type. The first application is selected automatically.

If this is the one you want, just press Enter to start it. Results will also show Settings

tools and recently accessed files, as well as uninstalled applications. From the result

list you can click on an uninstalled application to open GNOME Software showing the
application and an Install button, which you can click to install it.
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Activities Fri 13:30

Figure 8-8. Activities search box

The search box for the Activities overview can be configured from the Settings
Search tab (see Figure 8-9). Here, you can turn search on or off and specify which
applications are to support searches. By default, these include Contacts, Documents,
the Files file manager, Passwords and Keys, and the Firefox Web browser. To specify
the folders to be searched, click the gear button on the lower right to open the Search
Locations dialog with switches for currently supported folders, bookmarks, or other
locations (see Figure 8-10). To add a folder of your choosing, go to the Other tab and
click the plus button.
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Figure 8-9. Activities: Search configuration
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Figure 8-10. Activities: Search Locations
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Managing Windows

The title bar and the toolbar for GNOME windows have been combined into a single
header bar, as shown in the following image of the file manager.

r -

G < fir Home » Qll=]||= x

The minimize and maximize buttons have been dropped, and a single close button
is always present. You can use Tweak Tool to add the minimize and maximize buttons if
you wish. Some applications change the header bar if the function changes, presenting a
different set of tools, as shown here for the GNOME Videos application.

Videos [ ELGES

Click on items to select them

Select All

Select None

Windows no longer have maximize and minimize buttons. These tasks can be
carried out by a dragging operation or by double-clicking the header bar. To maximize a
window, double-click its header bar or drag the header bar to the top edge of the screen.
To minimize, drag the title away from the top edge of the screen. You can also use a
window’s menu entries to maximize or minimize it. Right-click the header bar or press
Alt+spacebar to display the window menu.

Open application windows also have an Applications menu on the left side of the top
bar. For many applications, this menu holds only a Quit entry (see Figure 8-11). Others,
such as the file manager, list key tasks, such as Bookmarks, Preferences, and Help. The
Firefox web browser only lists a Quit button, whereas the GNOME file manager lists
items such as New Window, Bookmarks, Preferences, and Help, as well as Quit.
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Figure 8-11. Window with Applications menu

To minimize an open window so that it no longer displays on the desktop, right-click
the header bar and choose minimize. This will hide the window. You can then maximize
the window later, using the window’s thumbnails on the activities overview (Activities
button).

To close a window, click its close box or choose Close from the Window menu
(right-click on title bar). Many currently selected windows have an Applications menu
in the top bar to the left. Should an application not have a close button, you can click the
Applications menu button on the top bar and choose the Quit entry (see Figure 8-11).

To tile a window, click-and-drag its header bar to the left or right edge of the screen.
When your mouse reaches the edge of the screen, the window is tiled to take up that half
of the screen. You can do the same with another window for the other edge, showing two
windows side by side.

To resize a window, move the mouse to the edge or corner until it changes to an edge
or corner mouse, then click-and-drag.

The scroll bar to the right also features fine scrolling. When scrolling through a large
number of items, you can fine scroll to slow the scrolling when you reach a point to
search. To activate fine scrolling, click and hold the scroll bar handle, or press the Shift
key while scrolling.
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You can use the Window Switcher on the desktop to quickly search open windows.
Press the Alt+Tab keys to display an icon bar of open windows on the current workspace
(see Figure 8-12). While holding down the Alt key, press the Tab key to move through
the list of windows. Windows are grouped by application. Instead of the Tab keys, you
can use the forward and back arrow keys. For applications with multiple open windows,
press the tilde (~) key (above the Tab key) to move through a list of the open windows.

Activities [ Rhythmbax «

Rivythmbox

Bl Fedora Project - Start Page Tz

cu - el e | » v RS Not Playing

fe d OroB Library Edit Browse View All Import

O Play Cuecue
& Music
B Podcasts nown (2 Unknawn (2)

Unknown Unknewn 07
Unknown Unkngwn 819

Figure 8-12. Window Switcher (Alt+Tab)

On the GNOME Tweak Tool’s Windows tab, you can configure certain windows’
actions and components. Attached Modal Dialogs will attach a dialog that an application
opens to the application’s window (see Figure 8-13). You can use the switch to turn this
feature off, allowing you to move a modal dialog away from the application window.
Actions on the title bar (Titlebar Actions) are also defined, such as double-click to
maximize and secondary-click to display the menu. There are also switches to display
the Maximize and Minimize buttons on the title bar.
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Figure 8-13. GNOME Tweak Tool: Windows (dialogs and title bar)

Workspaces

You can organize your windows into different workspaces. Workspaces are managed
using the Workspace selector. In the overview, move your mouse to the right edge of the
screen to display the workspace selector, a vertical panel showing thumbnails of your
workspaces (see Figure 8-14). Workspaces are generated dynamically. The workspace
selector will show an empty workspace as the last workspace (see Figure 8-15). To add
aworkspace, click-and-drag a window in the overview to the empty workspace on the
workspace selector. A new empty workspace appears automatically below the current
workspaces.
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Figure 8-14. Workspace selector

Figure 8-15. Adding workspaces
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To remove a workspace, close all its open windows or move the windows to other
workspaces.

To move to another workspace, in the overview mode, move to the right edge to
display the workspace selector, then click on the workspace you want. You can also use
Ctrl+Alt with the up and down arrow keys to move to the next or previous workspaces.

To move a window to a workspace, on the Windows overview, click-and-drag the
window to the workspace selector (right edge) and then to the workspace you want.
You can also use the Window menu and choose Move to Workspace Down or Move to
Workspace Up. You can also use Ctrl+Alt+Shift and the up or down arrow keys to move
the window to the next workspace. Continue pressing the arrow to move it further
should you have several workspaces.

You can use the GNOME Tweak Tool’s Workspaces tab to change workspace creation
from dynamic to static, letting you specify a fixed number of workspaces (see Figure 8-16).

Sat 1413 e

Q Tweaks Workspaces

Appearance

Dynamic Workspaces
Extensions

Fonts Static Workspaces

Keyboard & Mouse
MNumber of Workspaces
Power

Display Handling
Sound

‘Workspaces on primary display only

Startup Applications
Top Bar Workspaces span displays

Windows

Figure 8-16. Static Workspaces: GNOME Tweak Tool Workspaces tab
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Notifications and Message Dialog

Notifications, such as software updates and removable device activation, are displayed
in the message tray that is to the left of the calendar accessed from the top-center of the
screen by clicking on the date. You can also press the super key with the m key to open
the message tray. File systems on removable media will appear automatically as entries
directly on your desktop notifications dialog (see Figure 8-17). A notice briefly appears at
the top of the screen that shows the name of the device. If you move your mouse to the
notice, an Open With notice appears, which you can click to open the device. Should you
not open the device at this time, you can later display it in the message tray. When you
eject aremovable device, a notice briefly appears letting you know you can remove it. A
notice will also appear on the message tray.

Tue 11:03 @

Figure 8-17. Notifications

GNOME Customization with Tweak Tool: Themes, Icons,
Fonts, Startup Applications, and Extensions

You can perform common desktop customizations using the GNOME Tweak Tool. Areas
to customize include the desktop icons, fonts, themes, startup applications, workspaces,
window behavior, and the time display. You can access Tweak Tool from the Applications
Overview » Utilities. The GNOME Tweak Tool has tabs for Appearance, Desktop,
Extensions, Fonts, Keyboard and Mouse, Power, Startup Applications, Top Bar, Typing,
Windows, and Workspaces (see Figure 8-18).

302



CHAPTER 8 THE GNOME DESKTOP

Q Tweaks Appearance x
Appearance
Extensions
Themes
Fonts Applications Adwaita (default)  ~
Keyboard & Mouse Cursor Adwaita (default) >
Power Icons Adwaita (default)  ~
Sound Shell o v
Startup Applications Background
Top Bar Image | f28.xml =
Windows Adjustment Zoom -
Workspaces pEck S e
Image ® f28.xml [
Adjustment Zoom -

Figure 8-18. GNOME Tweak Tool: Appearance tab (themes)

The Appearance tab lets you set the theme for your windows, icons, and cursor.
GNOME 3 uses the Adwaita Theme. This theme has a light and dark variant. The Global
Light Theme is the default, but you can use the switch on the Appearance tab to enable
the Global Dark Theme. The Global Dark Theme shades the background of windows to a
dark gray, while text and button images appear in white.

Desktop fonts for window titles, interface (application or dialog text), documents,
and monospace (terminal windows or code) can be changed in the Fonts tab. You can
adjust the size of the font or change the font style. Clicking the font name opens a Pick a
Font dialog from which you can choose a different font. The quality of text display can be
further adjusted with Hinting and Antialiasing options. To simply increase or decrease
the size of all fonts on your desktop interface, you can adjust the scaling factor.

At times, there may be certain applications that you want started up when you log in,
such as the Gedit text editor, the Firefox web browser, or the Videos movie player. On the
Startup Applications tab, you can choose the applications to start up. Click the plus (+)
button to open an applications dialog from which you can choose an application to start
up. Once added, you can later remove the application by clicking its Remove button.
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Extensions function much as applets did in GNOME 2. They are third-party
programs that enhance or modify the GNOME desktop, such as a window list, workspace
indicator, a removable drive menu, and an applications menu. Extensions appear on the
top bar or, in the case of the window list, in an added bottom bar. Installed extensions are
listed on the Extensions tab of Tweak Tool, where you can turn them on or off.

GNOME Desktop Help

The GNOME Help browser provides a browser-like interface for displaying the GNOME
Desktop Help and various GNOME applications, such as Brasero, Evince, and gedit
(Utilities » Help) (see Figure 8-19). It features a toolbar that enables you to move
through the list of previously viewed documents. You can even bookmark specific items.
You can search for topics using the search box, with results displayed in the drop-down
menu. Initially, the Desktop Help manual is displayed. To see other help pages and
manuals, choose All Help from the menu next to the close box (see Figure 8-20).

w5 | GNOME Help x| |Q| = x
P
© GNOME Help
Getting Started with GNOME
New to GNOME? Learn how to get around.
Introduction to GNOME
A visual introduction to your desktop, the top bar, and the Activities overview.
Log out, power off or switch users
Learn how to leave your user account, by logging out, switching users, and so on.
Start applications
Launch apps from the Activities overview.
Your deskto, Networking, web & email Sound, video & pictures
Calendar, notif keyboard shortcuts, Wireless, wired, conne ., web D cameras, iPods, editing photos, playing
i r browsing aill account videc
Files, folders & search User & system settings Hardware & drivers
Searching, delete files, backups, removable Keyboard, mouse, display, languages, user Hardware problems, printers, | ettings
drives. accounts color management, Bluetooth, ¢
Universal access Tips & tricks Get more help / \
obi raill o Special characters, middle click shortcuts Tips on using this guide, help improve this ' ’
quide, mailing list, IRC \Q ?
About o

Figure 8-19. GNOME Help browser
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> Help * || |=

All Help Documents

?

Archive Manager Help
Learn to use and manage compressed archives of files and folders.

Boxes
Learn to set up local virtual machines and to connect to remote virtual machines. You can also use Boxes to connect to remote
desktops.

Calculator Help

Cheese Webcam Application
Cheese lets you take photos and videos using your webcam. You can even add special effects!

Clocks
Use Clocks as a stopwatch, a timer, to set alarms and to check the time in different cities around the world.

Disk Usage Analyzer help
Disk Usage Analyzer is a graphical storage device scanner.

Documents
Organize, view and edit the documents that are stored locally on your computer or online.

Evince Document Viewer

Document Viewer, formally known as Evince, is made for viewing PDF documents. Learn how to get started with Document Viewer
and its features.

Evolution Mail and Calendar
Manage your email, contacts and schedule

Eye of GNOME Image Viewer
Help for the Eye of GNOME Image Viewer.

Figure 8-20. GNOME Help: All Documents

The GNOME Files File Manager

The GNOME file manager supports the standard features for copying, removing, and
deleting items as well as setting permissions and displaying items. The name used for

the file manager is Files, but the actual program name is still nautilus. When you select

a file manager window, a Files menu appears as the Applications menu on the top bar

to the left (see Figure 8-21). The Files menu has entries for opening a new file manager

window, displaying the sidebar, the file manager preferences, displaying the file manager
keyboard shortcuts, and help (see Table 8-2).
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Fri 13:36

© Recent

B Starred

Documents

[ Documents

~ Downloads

Jd Music

& Pictures Pictures Templates
wa Videos

& Trash

+ Other Locations

t

Figure 8-21. File manager with Files applications menu

Table 8-2. File Manager GNOME Menu

Menu ltem Description

New Window Open a new file manager window
Sidebar Toggle display of the file manager sidebar
Preferences Open the file manager Preferences dialog

Keyboard Shortcuts  Display a dialog listing keyboard shortcuts

Help Open GNOME desktop help
About Current GNOME release
Quit Close the file manager

Home Folder Subfolders

GNOME uses the Common User Directory Structure (xdg-user-dirs at
http://freedesktop.org) to set up subfolders in the user home directory. Folders
include Documents, Music, Pictures, Downloads, and Videos. These localized user
folders are used as defaults by many desktop applications. Users can change their folder
names or place them within each other using the GNOME file browser. For example,
Music can be moved into Videos or Documents into Pictures. Local configuration is
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held in the .config/user-dirs.dirs file (.config is a hidden directory). System-wide
defaults are set up in the /etc/xdg/user-dirs.defaults file. You can edit the local
configuration using a text editor and change the directories for the current ones.

File Manager Windows

When you click the Files icon on the dash, a file manager window opens showing

your home folder. The file manager window displays several components, including a
toolbar and a sidebar (see Figure 8-22). The sidebar displays sections for folder, device,
bookmark, and network items showing your file systems and default home folder
subfolders. You can choose to display or hide the sidebar toolbar by selecting its entry
in the View and Tools menu. The main pane (to the right) displays the icons or lists files
and subfolders in the current working folder. When you select a file and folder, a status
section at the bottom right of the window displays the number or name of the file or

folder selected and the total size.

Icon/list button

Navigation Searc| .
Title and Tool bar \ ‘ }enu (View and Tools)
S & = = * —Close window
© Recent
* Starred ml al o ot
N

F0|der8 Pl Deesktop Documents Downloads Music

& Downloads — ™ (™ e
Sidebar o=z

A Pictures Photos Pictures Publc Templates

- Videos

& Trash

Removable O Fedora-WS-Live-28_

» »

media = usaxro
Bookmarks——— m m=s
Network and =
—_— % Other Locations
Computer o

Figure 8-22. File manager with sidebar
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When you open a new folder, the same window is used to display it, and you can use
the forward and back arrows to move through previously opened folders (top left). As
you open subfolders, the main toolbar displays buttons for your current folder and its
parent folders, as shown here:

< > <« fxHome Pictures mypics

You can click a folder button to move to it directly. It also can display a location URL
text box instead of buttons, from which you can enter the location of a folder, either on
your system or on a remote one. Press Ctrl+l to display the text box. Press the Esc key to
revert back to the folder location buttons.

You can click anywhere on the empty space on the main pane of a file manager
window to display a pop-up menu with entries to create a new folder, open the current
folder in a terminal window with a command line prompt, and open the file manager
properties dialog (see Table 8-3).

Table 8-3. File Manager Pop-Up Menu

Menu ltem  Description

New Folder  Creates a new subfolder in the current folder.

Paste Pastes files that you have copied or cut, letting you move or copy files between
folders or make duplicates.

Select All Selects all files and folders in the current folder.

Properties Opens the Properties dialog for the directory.

The file manager displays a dialog for folder creation (see Figure 8-23). Be sure to
click the Create button once you have entered the folder name.
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Cancel New Folder

Folder name

mypics|

Figure 8-23. File manager New Folder dialog

File Manager Sidebar

The file manager sidebar shows file system locations that you would normally access:
folders, devices, bookmarks, and network folders (See Figure 8-24). The Recent folder
holds links to your recently used files. You can also mark files or folders as a favorites and
have them listed by clicking the Starred entry on the file manager sidebar. Should you
bookmark the current folder (the bookmark button on the file manager window's menu),
a bookmark for it will appear on the sidebar. To remove or rename a bookmark, right-
click its entry on the sidebar and choose Remove or Rename from the pop-up menu. The
bookmark’s name changes, but not the original folder name.

Open
I Open in New Tab
Open in New Window

d Music Add Bookmark A
Open Remove i Open I
Open in New Tab DT Open in New Tab Open
Open in New Window I Open in New Window Open in New Tab
Eject Open in New Window
REITID\J'E = Ré‘[‘-!f.}‘.-":’.
Rename... Propemes Rename... Remove
Format... - o
Properties Properties hename...
m ADATAUFD & Epptyili=st
@ mypics @ Pictures
@ Photos @ Febmws-— wa Videos @ Trash

Figure 8-24. File manager sidebar with menus for bookmarks, devices, folders,
and trash
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Selecting the Other Locations entry on the sidebar displays entries for Computer and
your networks. The Computer entry places you at the top of the file system, letting you
move to any accessible part of it. In the Network section, you can access systems and
shared folders on your network.

Tabs

The GNOME file manager supports tabs with which you can open several folders in

the same file manager window. To open a tab, select New Tab from the Tools menu

(see Figure 8-25) or press Ctrl+t. You can use the Tabs buttons to move from one tab to
another, or to rearrange tabs. You can also use the Ctrl+PageUp and Ctrl+PageDown keys
to move from one tab to another. Use the Shift+Ctrl+PageUp and Shift+Ctrl+PageDown
keys to rearrange the tabs. To close a tab, click its close (x) button on the right side of the
tab (see Figure 8-27) or press Ctrl+w. Tabs are detachable. You can drag a tab out to a
separate window.

{ > |« xHome Documents  » Q lE=|[= x
® Recent Home g Pictures Home
New Tab
* Starred [
e e v
Close Tab
[0 Documents 2
Desktop Documents Downloads Music
<, Downloads
dd Music | o | o e | o
A Pictures
v Videos Pictures Public Templates Videos
{) Trash

+ Other Locations

Figure 8-25. File manager window with tabs
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Displaying and Managing Files and Folders

You can view a folder's contents as icons or as a detailed list, which you can choose by
clicking the icon/list button between the search and menu buttons on the right side of
the toolbar as shown here. This button toggles between icon and list views.

- -

Qll=]|]| = b O e = X

Use the Ctrl key to change views quickly: Ctrl+1 for icons and Ctrl+2 for list (there
is no longer a Compact view). The List view provides the name, permissions, size, date,
owner, and group. Buttons are displayed for each field across the top of the main pane.
You can use these buttons to sort the list according to that field. For example, to sort
the files by date, click the Date button; to sort by size, click Size. Click again to alternate
between ascending and descending order.

Certain types of file icons display previews of their contents. For example, the icons
for image files display a thumbnail of the image. A text file displays in its icon the first few
words of its text.

You can click the menu button at the right of toolbar to display the file manager
menu with entries for managing and sorting your file manager icons (see Table 8-4). The
sort entries allow you to sort your icons by name (A-Z and Z-A), size, type, modification
date, and access date. You can also reverse the order by name and modification date (see
Figure 8-26).
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Table 8-4. File Manager Menu

Menu ltem

Description

New Folder button
Bookmark button
Tab button

Zoom In button
Zoom Out button
Undo

Redo

A-7

Z-A

Last Modified
First Modified
Size

Type

Show Hidden Files
Reload

Creates a new subfolder in the current folder
Creates a bookmark for current folder
Creates a new tab

Enlarges icon size

Reduces icon size

Undoes the previous operation
Redoes an undo operation

Sorts in alphabetic order

Sorts in reverse alphabetic order
Sorts by last modified date

Sorts by recent modified date

Sorts by file size

Sorts by file type

Shows administrative dot files

Refreshes file and directory list
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Ol lia=a]| B= x

=] 67%

Undo Rename

Redo

Sort

A-Z .
Z-A

Last Modified

First Modified

Size

Type

G K, &,
Show Hidden Files =] esssssssressnned —

Reload = 67% [+

Figure 8-26. File manager menu

You can also bookmark the folder, create a new folder, and create a new tab. The top
bar of the menu has buttons to create a new folder, create a bookmark for the current
folder, and create a new file manager tab. Below that bar is a zoom bar, with zoom in and
zoom out buttons, showing the zoom percentage between them. The zoom in button
(+ button) enlarges your view of the window, making icons bigger. The zoom out button
( - button) reduces your view, making them smaller. You can also use the Ctrl++ and
Ctrl+- keys to zoom in and out.

Previews

The file manager supports previews for many different types of files. Select a file you
want to preview, then press the spacebar. A dialog window opens, displaying the
contents. Picture files show the image (see Figure 8-27). You can scroll through text and
PDF files. Applications files such as LibreOffice files show information about the file.
Video files are played, with controls to pause and to expand to full screen.
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photos

P1390636.JPG

Figure 8-27. File previews (spacebar)

Navigating in the File Manager

The file manager operates similarly to a web browser, using the same window to display
opened folders. It maintains a list of previously viewed folders, and you can move back
and forth through that list using the toolbar buttons. The left arrow button moves you
to the previously displayed directory, and the right arrow button moves you to the next
displayed directory. Use the sidebar to access your storage devices (USB, DVD/CD, and
attached hard drives). You can also access your home folders, trash, and recent files.
From the sidebar Other Locations entry, you can also access mounted network folders.
As noted, the Computer entry on the Other Locations section opens your root (top)
system directory.

To open a subfolder, you can double-click its icon or right-click the icon and select
Open from the menu (see Table 8-5). To open the folder in a new tab, select Open in
New Tab.
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Table 8-5. The File and Folder Pop-Up Menu

Menu ltem

Description

Open With Application

Open in New Tab
Open in New Window

Open With Other
Application

Cut Copy

Move To

Copy To

Rename (F2)
Move To Trash
Compress
Send to

Star

Properties

Opens the file with its associated application. Directories are opened in
the file manager. Associated applications are listed.

Opens a folder in a new tab in the same window.
Opens a folder in a new file manager window.

Selects an application with which to open this file. An Open With dialog
lists the possible applications.

Cuts or copies the selected file.

Moves a file to the Home folder, desktop, or to a folder displayed in
another pane in the File Manager window.

Copies a file to the Home folder, desktop, or to a folder displayed in
another pane in the File Manager window.

Renames the file.

Moves a file to the Trash directory, where you can later delete it.
Archives the file using File Roller.

Emails the file.

Marks file or folder as a favorite to be displayed by the starred entry in
the sidebar.

Displays the Properties dialog.

To mark a file or folder as a favorite, right-click on it and choose Star from the pop-up

menu. It can then be also accessed by clicking the starred entry on the sidebar.

You can open any folder or file system listed in the sidebar by clicking it. You can also

right-click an entry to display a menu with entries to Open in a New Tab and Open in a

New Window (see Table 8-6). The menu for the Trash entry lets you empty the trash. You

can also remove and rename the bookmarks.
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Table 8-6. The File Manager Sidebar Pop-Up Menu

Menu ltem Description

Open Opens the file with its associated application. Folders are opened in the file
manager. Associated applications are listed.

Openin a New Tab Opens a folder in a new tab in the same window.

Openin a New Opens a folder in a separate window, accessible from the toolbar with a
Window right-click.

Remove Removes the bookmark from the sidebar.

Rename Renames the bookmark.

Entries for removable devices in the sidebar, such as USB drives, also have menu
items for Eject and Safely Remove Drive. Internal hard drives have an Unmount option
instead.

Managing Files and Folders

As a GNOME-compliant file manager, Files supports desktop drag-and-drop operations
for copying and moving files. To move a file or directory, drag-and-drop from one
directory to another. The move operation is the default drag-and-drop operation in
GNOME.

To copy a file to a new location, press the Ctrl key as you drag-and-drop. When
copying a large file or many files, an icon is displayed on the title bar to the right showing
a circle chart and the progress of the copy operation. Clicking on the icon displays a
menu showing the progress of the copy operation, with an x to the right you can click
to cancel the copy, as shown here. When the copy process for a file is completed, the x
becomes a checkmark. When the entire copy process is completed for all files, the icon
shows a fully dark circle.

Pl lal|l=]|l=| x @ lall=|l=]| x

Copying 3 files to “Downloads” Copied 3 files to “Downloads”

—_— x v
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Renaming, Removing, and Compressing Files and Folders

You can also perform remove, rename, and compress operations on a file by right-
clicking its icon and selecting the action you want from the pop-up menu that appears
(see Table 8-5). For example, to remove an item, right-click it and select the Move To
Trash entry from the pop-up menu. This places it in the Trash directory, where you can
later delete it.

To rename a file, you can either right-click the file’s icon and select the Rename entry
from the pop-up menu or click its icon and press the F2 function key. The file manager
displays a dialog file renaming (see Figure 8-28). When renaming a file, be sure to click
the Rename button once you have entered the new name.

e

m vacation.odt
rl L]

File name

( I——

Figure 8-28. File manager Rename dialog

You can also change several filenames at once by selecting the files and then right-
clicking and choosing Rename. A dialog opens listing the selected files and a text box for
specifying the new names (see Figure 8-29). You can add to the name or choose the Find
and Replace option to change a common part of the names. Clicking the Add button
lets you choose from a list of possible automatic number formats to add. The added
characters are encased in brackets in the text box, separated by commas, one for each
filename. The Original File Name entry add the original filename specifier to the text

box, should you remove it.
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Cancel Rename 3 Files Cancel Rename 3 Files

* Rename using a template Find and replace text Rename using a template () Find and replace text
[Original file name] +Add Existing Text | fig
Automatic Numbers Replace With | pic
fig3-8-50.png + fig3-8-5¢ 4 5 3 4
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Figure 8-29. Renaming several files at once with the file manager

You can also rename a file by entering a new name in its Properties dialog box
(Basic tab).

You can also compress and archive files and folders (see Figure 8-30). Select the
files or folders to compress, right-click, and choose the Compress option. A dialog
opens where you can specify the name of the compressed archive and the compression
method. Choose the form of the archive from the list below the name (zip, tar, and 7z).

Cancel Create Archive

Archive name

) .zZip ) tarxz )Tz

Compatible with all operating systems.

Figure 8-30. File manager: Compress and Archive dialogs

Grouping Files

You can select a group of files and folders by clicking the first item and then holding
down the Shift key while clicking the last item, or by clicking and dragging the mouse
across items you want to select. To select separated items, hold the Ctrl key down as you
click the individual icons. If you want to select all the items in the directory, choose the
Select All entry from the current folder's pop-up menu (see Table 8-3) or choose Ctrl+a.
You can then copy, move, or delete several files at once.
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Opening Applications and Files MIME Types

You can start any application in the file manager by double-clicking either the
application or a data file used for that application. If you want to open the file with a
specific application, you can right-click the file and select one of the Open With entries.
One or more Open With entries will be displayed for default and possible application,
such as Open With gedit for a text file. If the application you want is not listed, you can
select Open With Other Application to access a list of available applications.

To change or set the default application to use for a certain type of file, you open a
file’s Properties dialog and select the Open With tab. Here, you can choose the default
application to use for that kind of file. Possible applications will be listed, organized as
the default, recommended, related, and other categories. Click the one you want and
click the Set As Default button. Once you choose the default, it will appear in the Open
With list for this file.

If you want to add an application to the Open With menu, click the Other
Applications entry to list possible applications. Select the one you want and click the Add
button. If there is an application on the Open With tab that you do not want listed in the
Open With menu items, right-click it and choose Forget Association.

File and Directory Properties

In a file’s Properties dialog, you can view detailed information on a file and set options
and permissions (see Figure 8-31). A file’s Properties dialog has three tabs: Basic,
Permissions, and Open With. Folders will have an additional Local Network Share tab,
instead of an Open With tab. The Basic tab shows detailed information, such as type,
size, location, accessed, and date modified. The type is a MIME type, indicating the type
of application associated with it. The file’s icon is displayed at the top, with a text box
showing the file’s name. You can edit the filename in the Name text box. If you want to
change the icon image used for the file or folder, click the icon image (next to the name)
to open a Select Custom Icon dialog and browse for the one you want. The /usr/share/
pixmaps directory holds the set of current default images, although you can select your
own images (click the Other Locations » Computer entry to locate the pixmaps folder).
In the pixmaps folder, click an image file to see its icon displayed in the right pane.
Double-click to change the icon image.

319



CHAPTER 8 THE GNOME DESKTOP

vacation.odt Properties x
Basic Permissions Open With
Name: | vacation.odt
Type: OpenDocument Text (application/vnd.oasis.opendocument.text)
Size: 8.5 kB (8,531 bytes)
Parent Folder: /home/richard/Documents
Accessed: Fri 18 May 2018 12:57:11 PM PDT
Modified: Mon 28 Mar 2016 11:12:08 AM PDT

Figure 8-31. File properties

The Permissions tab for files shows the read, write, and execute permissions for
owner, group, and others, as set for this file. You can change any of the permissions
here, provided the file belongs to you. You configure access for the owner, the group,
and others, using drop-down menus. You can set owner permissions as Read Only or
Read and Write. For group and others, you can also set the None option, denying access.
Clicking the group name displays a menu listing different groups, allowing you to select
one to change the file’s group. If you want to execute this as an application, you check
the Allow Executing File as Program entry. This has the effect of setting the execute
permission.

The Open With tab for files lists all the applications associated with this kind of file.
You can select the one you want to use as the default. This can be particularly useful for
media files, for which you may prefer a specific player for a certain file or a particular
image viewer for pictures.

Certain kinds of files will have additional tabs, providing information about the
file. For example, an audio file will have an Audio tab listing the type of audio file and
any other information, such as a song title or the compression method used. An image
file will have an Image tab listing the resolution and type of image. A video file will
contain an Audio/Video tab showing the type of video file, along with compression and
resolution information.

The Permissions tab for folders operates much the same way, with Access menus for
Owner, Group, and Others. The Access menu controls access to the folder with options
for None, List Files Only, Access Files, and Create and Delete Files. These correspond
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to the read and execute permissions given to directories. To set the permissions for all
the files in the folder accordingly (not just the folder), click the Change Permissions
for Enclosed Files button to open a dialog where you can specify the owner, group, and
others permissions for files and folders in the folder.

File Manager Preferences

You can set preferences for your file manager in the Preferences dialog, accessible by
selecting the Preferences item in any file manager window’s application menu (Files »
Preferences).

The Views tab allows you to select how files are displayed by default, such as a list or
icon view. You also can set default zoom levels for icon and list views.

Behavior lets you choose how to select files, manage the trash, handle scripts, and
choose what information you want displayed in an icon caption, such as the size or date.

The List Columns tab lets you choose both the features to display in the detailed list
and the order in which to display them. In addition to the already-selected name, size,
date, and type, you can add permissions, group, MIME type, location, accessed, and
owner.

The Preview tab lets you choose whether you to show thumbnail content displayed
in the icons, search subfolders, or display the file count.

File Manager Search

Two primary search tools are available for your GNOME desktop: the GNOME dash
search and the GNOME file manager search. With GNOME file manager, you enter a
pattern to search. You can further refine your search by specifying dates and file types.
Click the Search button (looking glass icon) on the toolbar to open a Search box. Enter
the pattern to search, then press Enter. The results are displayed (see Figure 8-32). Click
the menu button to the right to add file-type (What) and date (When) search parameters,
or to search file text or just the filename. Selecting the When entry opens a dialog where
you can specify the document's last use or modification, by day, week, month, or year.

A calendar button to the right of the text box for the date opens a calendar to let you
choose a specific date. The What entry displays a menu with different file categories such
as music, Documents, folders, picture, and PDF.
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Figure 8-32. GNOME file manager search

GNOME Classic

As an alternative to the GNOME desktop, you can use the GNOME Classic desktop,
which uses an interface similar to GNOME?2 (see Figure 8-33). You can choose GNOME
Classic from the session menu. GNOME Classic displays a top panel with Applications
and Places menus. The System Status Area menu is the same. Also, application menus
continue to be displayed on the top panel, after the Places menu. The bottom panel
has a task bar and a workspace switcher menu. Icons for applications can be displayed
on the desktop. The Applications menu is organized into submenus by category, such
as Graphics, Office, and Sound & Video. The Activities Overview entry at the end of the
Applications menu starts up the GNOME 3 overview interface. Windows show three
buttons to the right on the title bar instead of one: the minimize, expand, and close
buttons.
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Figure 8-33. GNOME Classic
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Plasma Desktop:
The K Desktop
Environment (KDE)

Plasma is the desktop developed and distributed by KDE (the K Desktop Environment).
It is often referred to as simply the KDE desktop. Plasma includes the standard desktop
features, such as a window manager and a file manager, as well as an extensive set of
applications that cover most Linux tasks. The KDE Plasma version of Fedora Linux is
called the Fedora KDE Plasma Desktop and is available as a separate desktop DVD from
https://spins.fedoraproject.org/. The Plasma desktop is developed and distributed
by the KDE Project. KDE is open source software provided under a GNU Public License
and is available free of charge along with its source code. KDE Plasma development is
managed by the KDE Core Team. You can install it as an alternate desktop on a GNOME
system by installing plasma-desktop.

The KDE software development and distribution is organized into three projects:
Plasma, Applications, and Projects. KDE Applications include numerous applications
written specifically for KDE Plasma are accessible from the desktop. These include
editors, photo and image applications, sound and video players, and office applications.
Some applications have the letter K as part of their name, for example, KOrganizer. On
a system administration level, KDE provides several tools for managing your system,
such as the Discover and Apper Software Managers, and the KDE system monitor.

KDE applications also feature a built-in Help application. See https://www.kde.org/
applications/ for alist and descriptions of current applications.
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KDE Frameworks provides support libraries designed to work with the Qt libraries
that KDE plasma and applications depend on. Frameworks is designed to be cross-
platform, enabling any KDE application to run on systems that support the Qt libraries.
Frameworks can be used as a basis for any custom operating system, such as LXQt. KDE
Framework packages have the prefix kf5, such as the kf5-filesystem that provides
support for the KDE filesystem. Development for Plasma, Frameworks, and Applications
proceed at different paces. The KDE Frameworks version used in Fedora 28 Plasma
Desktop is 5.46.0, whereas the KDE Plasma version is 5.12.5.

Note As as noted in Chapter 6 for GNOME, you can install the same third-party
multimedia support and codecs on KDE from the RPM Fusion repository, as well as
dvdcss support from the Livna repository.

Table 9-1. KDE Websites

Website Description

https://www.kde.org KDE website
https://www.kde.org/plasma-desktop  KDE Plasma desktop website
https://www.kde.org/applications/ KDE Applications website

https://docs.kde.org KDE documentation site
https://www.qt.io/ Site for the Qt company
https://store.kde.org KDE Plasma desktop themes
https://mail.kde.org/mailman/ KDE mailing lists
listinfo/

KDE, initiated by Matthias Ettrich in October 1996, is designed to run on any UNIX
implementation, including Linux, Solaris, HP-UX, and FreeBSD. The official KDE
website is https://www.kde.org, which provides news updates, download links, and
documentation. Several KDE mailing lists are available for users and developers, including
announcements, administration, and other topics. Detailed documentation for the KDE
desktop and its applications is available at https://docs.kde.org. Development support
can be obtained at the KDE Techbase site at https://techbase.kde.org.
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Most applications are available on the Fedora Linux repositories and can be installed
directly from the Discover Software and Apper software managers. Various KDE websites
are listed in Table 9-1. KDE uses as its library of GUI tools the Qt library, currently
developed and supported by the Qt company, owned by Digia (https://www.qt.io).

It provides the Qt libraries as open source software that is freely distributable, though a
commercial license is also available.

KDE Plasma 5

The KDE Plasma 5 release is a major reworking of the KDE desktop. KDE Plasma 5.12.5
is included with the Fedora Linux 28 distribution. Check the Fedora Linux and KDE sites
for detailed information on KDE 5.

https://www.kde.org/announcements/plasma5.0/
For features added with KDE Plasma 5.5, check:
https://www.kde.org/announcements/plasma-5.12.0.php

For features added with KDE Plasma 5.12.5 (current Fedora Linux KDE edition),
check:

https://www.kde.org/announcements/plasma-5.12.5.php/

KDE development is organized into a plasma and applications releases. The plasma
release covers the desktop interface (the Plasma desktop shell), and the applications
release covers KDE applications. Plasma has containments and plasmoids (also called
widgets). Plasmoids operate similarly to applets, small applications running on the
desktop or panel. Plasmoids operate within containments. On KDE 5, there are two
Plasma containments, the panel and the desktop. In this sense, the desktop and the
panel are features of an underlying Plasma operation. They are not separate programs.
Each has their own set of plasmoids.

Each containment has a toolbox for configuration. The desktop has a toolbox at
the top left corner, and panels will have a toolbox on the right side. The panel toolbox
includes configuration tools for sizing and positioning the panel. KDE also supports
activities, which are multiple plasma desktop containments, each with their own set of
active plasmoids (widgets) and open windows.
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SDDM

KDE Fedora Linux uses the Simple Desktop Display Manager (SDDM) to manage logins.
A login greeter is displayed at the center of the screen where you can select a user icon
and enter a password (see Figure 9-1). Suspend, Restart, Shutdown, and Different User
buttons are displayed below the login button. Use the Different User button to login as a
user not displayed in the user list.

"L T08M

’ dheos 9.
Wednesdayjunoﬁ: 2018

Te1T12PM

: s®
Wednesday,‘ju’nu'& 2018
-1 fof a®

Figure 9-1. SDDM Display Manager, login screen

328



CHAPTER9  PLASMA DESKTOP: THE K DESKTOP ENVIRONMENT (KDE)

Upon choosing a user icon and entering the password, press Enter or click the login
button at the right end of the password text box. Your KDE session then starts up.

If you have more than one desktop installed on your system, such as Cinnamon,
Mate, or Xfce, then a Plasma menu item is displayed as one of the alternatives. Use this
menu to choose a different desktop to log in to.

You can change the theme of the login greeter using the Login Screen (SDDM) entry
in the Startup and Shutdown dialog (GNOME Settings » Startup and Shutdown in the
Workspace section). The theme section lists available theme. Currently, only Breeze is
listed. To change the background image, click on a theme to display it in the Customize
section to the right. Then click on the Background icon and choose the Load from File
option from the pop-up menu. On the Advanced tab, you can choose the default user,
the desktop for your session, and whether to automatically log in. You can also choose
a cursor theme and an alternative desktop (session). You can also manually configure
SDDM using the /etc/sddm. conf file.

The Plasma Desktop

One of KDE's aims is to provide users with a consistent integrated desktop (see Figure 9-2).
Plasma provides its own window manager (KWM)), file manager (Dolphin), program
manager, and desktop and panel (Plasma). You can run any other X Window System-
compliant application, such as Firefox, in Plasma, as well as any GNOME application.

In turn, you can also run any KDE application, including the Dolphin File Manager in
GNOME. The Plasma 5 desktop features the Plasma desktop shell with new panel, menu,
widgets, and activities. Keyboard shortcuts are provided for many desktop operations, as
well as plasmoid (widget) tasks (see Table 9-2).
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Table 9-2. Plasma Keyboard Shortcuts

Keys Description

Alt+F1 Kickoff menu

Alt+F2 Krunner, command execution, entry can be any search string for a relevant
operation, including bookmarks and contacts, not just applications

Up/Down Move among entries in menus, including Kickoff and menus

arrows

Left/Right Move to submenus menus, including Kickoff and Quick Access submenus menus

arrows

Enter Select a menu entry, including a Kickoff or QuickAccess

PageUp, Scroll up fast

PageDown

Alt+F4 Close current window

Alt+F3 Window menu for current window

Ctrl+Alt +F6  Command Line Interface

Ctrl+Alt +F8  Return to desktop from command line interface

Ctrl+r Remove a selected widget

Ctrl+s Open a selected widget configuration's settings

Ctrl+a Open the Add Widgets window to add a widget to the desktop

Ctrl+l Lock your widgets to prevent removal, adding new ones or changing settings

Alt+Tab Cover Switch or Box Switch for open windows

Ctrl+F8 Desktop Grid

Ctrl+F9 Present Windows Current Desktop

Ctrl+F10 Present Windows All Desktops

Ctrl+F11 Desktop Cube for switching desktops

To configure your desktop, you use the System Settings dialog (Computer|

System Settings), which lists icons for dialogs such as Workspace Theme, Font, Icons,
Applications Style Desktop Behavior, Search, Application Style, Window Management,
Driver Manager, and Bluetooth. Workspace Theme lets you choose desktop, cursor,
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and splash themes. Desktop Behavior is where you can set desktop effects and virtual
desktops. Windows Management controls window display features like window
switchers, title bar actions, and screen edge actions.

The desktop supports drag-and-drop and copy-and-paste operations. With the
copy-and-paste operation, you can copy text from one application to another. You can
even copy and paste from a Konsole terminal window.

Plasma Desktop Toolbox Plasma desktop (workspace) containment

QL Find ] preview [ split = contral

> Home

mgym O8E ®

% D4« 1:35PM =

\ g | ootoin Fi Network M gl :
\ Taskbar \Dolphln File Manager etwork Manager /
\ Digital Clock /

) Plasma panel containment System Tray
Kickoff Menus Plasma Panel Toolbox

Figure 9-2. The Plasma desktop

The KDE Help Center

The KDE Help Center provides a browser-like interface for accessing and displaying
KDE Help files and Linux Man and info files (see Figure 9-3). It may not be installed
by default. Install the khelpcenter package. The same documentation is available at
https://docs.kde.org. You can start the Help Center by searching for “help” in the
search box of the Kickoff Applications menu. The Help window displays a sidebar
that holds two tabs, one listing contents and one providing a glossary. The main pane
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displays currently selected document. A help tree on the contents tab in the sidebar lets
you choose the kind of Help documents you want to access. Here you can choose KDE
manuals, Man pages (UNIX manual pages), or info documents (Browse info Pages), or
even application manuals (Application Manuals). Online Help provides links to KDE
websites such as the KDE user forum and the KDE tech base sites. Click the Table of
Contents button to open a listing of all KDE help documents, which you can browse
through and click on to open.

A navigation toolbar enables you to move through previously viewed documents.
KDE Help documents contain links you can click to access other documents. The
Back and Forward buttons move you through the list of previously viewed documents.
The KDE Help system provides an effective search tool for searching for patterns in
Help documents, including Man and info pages. Click the Find button on the toolbar
or choose the Find entry from the Edit menu, to open a search box at the bottom of
the Help window, where you can enter a pattern to search on the current open help
document. The Options menu lets you refine your search with regular expressions,
case-sensitive queries, and whole words-only matches.

The Panel — Help Center

File Edit View Go Bookmarks Settings Help

() Table of Contents ¢ Back ~ > Forward [j copy Q_Find.. = 5* Increase Font Sizes  [¥] Decrease Font Sizes
K| The Panel |
Contents | Glossary Searcl < > Prev Using Plasma Next
B Fundamentals
+? Plasma Manual The Panel
= Introduction

The default panel holds a few Plasma widgets: starting from the left,

¥~ & Using Plasma there is the application launcher.

£ Plasma Components

Application Launcher
& The Panel Toolbox

£ Adding Applets o

= The Desktop bb

= Folder View Type to search...
£ KRunner

= o Web Browser
= Activities

= Shortcuts System Settings
& Credits and License 1
B Online Help

i# Application Manuals

File Manager

FAe® X

A immmmmd T Colibne

Figure 9-3. KDE Help Center
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Desktop Backgrounds (Wallpaper)

The background (wallpaper) is set from the desktop menu directly. Right-click on the
desktop to display the desktop menu and then select Configure Desktop to open the
Desktop Settings dialog (see Figure 9-4).

older Vie i P!
K Wallpaper
Wallpaper Layout: | Folder View b
. Wallpaper Type: | Image o
Mouse Actions Positioning: | Scaled z
»—
—

Location
—
L 11}
LL

lcons

y

Filter

ass

Tweaks
+ Add Image... || % Get New Wallpapers...

v OK v Aj ® cancel
Figure 9-4. Default Desktop settings, wallpaper

You can also select Desktop Settings from the activities menu in the upper-left corner
of the desktop. The background is called wallpaper in Plasma and can be changed in the
Wallpaper tab. You can select other wallpapers from the wallpaper icons listed or select
your own image by clicking the Open button.

You can add more wallpaper by clicking the Get New Wallpaper button to open
a Get Hot New Stuff dialog, which lists and downloads wallpaper posted on the www.
kde-1look.org site (see Figure 9-5). Each wallpaper entry shows an image, description,
and rating. Buttons at the upper right of the dialog let you view the entries in details (list)
or icon mode. You can refine the wallpaper listing by size (category), newest, rating,
and popularity (most downloads). Click the Install button to download the wallpaper
and add it to your Desktop Setting's Wallpaper tab. The wallpaper is downloaded and
the Install button changes to Uninstall. To remove a wallpaper, you can select installed
wallpapers to find the entry quickly. You can also search by pattern for a wallpaper.
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Get Hot New Stuff — Plasma

Download Wallpapers

Vivid Colorful Sky 4K o= gs
Size: 3.3 MiB  Install =
By Jike
3 resolutions @ Details Category:
- 4k, 2k and hd
\ A A
* * ) ER ke All Categories W
zoom the preview for a detailed
Red & Blue Glare 4K
- Order by:
Size: 998.0 KiB + Install o
‘ - By Jike (@) Newest
3 resolutions @ Details :
- ak, 2k and hd O Rating
) & & ‘e () Most downloads
zoom the preview for a detailed
Neon Fern 4K O Installed
Size: 844.7 KiB v Install
By Jike Search:
3 resolutions © Details Entar search
- 4k, 2k and hd '
) 6§ (BAE*
PP S S S -
[X] unknown Open Collaboration Service API error. (999) @ Close

Figure 9-5. Default Desktop settings, get new wallpapers

Themes

For your desktop, you can also select a variety of different themes, icons, and window
decorations. A theme changes the entire look and feel of your desktop, affecting the
appearance of desktop elements, such as scroll bars, buttons, and icons. Themes and
window decorations are provided for workspaces. Access the System Settings dialog
from the Kickoff Computer menu or the Applications » Settings menu. On the System
Settings dialog, click the Workspace Theme icon in the Appearance section. The
Workspace Theme dialog lets you choose overall look and feel, cursor themes, desktop
themes, and a splash screen (startup) themes. The Desktop Themes tab lists installed
themes, letting you choose the one you want. Click the Get New Themes button to open
a Get Hot New Stuff dialog, listing desktop themes from https://store.kde.org (see
Figure 9-6). Click a theme's Install button to download and install the theme.
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For window decorations, you use the Application Style dialog, Window Decorations
tab, where you can select window decoration themes. Click the Get New Decorations
button to download new decorations. Icons styles are chosen using the Icons dialog,
Icons tab, where you can choose the icon set to use and even download new sets (Get

New Themes).

Gt Hot New Stuff — System Settings

System Settings Add-On Installer

L

Indigo |

Size: 29.3 Kig + Install
By phoblan
Plasma theme loosely based on @ Details
those nice dark blue code editor - Order by:
schemes. ' & & Sy B Hewast
226 downloads =
EO Am ork () Rating
Size: 13.7 KiB W instal ) Most downloads
By eQuilibrium z 1=
£Q Ambience dark Plasma Sl D Installed
desktop theme TR
1243 downloads L & & 8ia search:
Carringbush + Install
- Size: 230.5 Kie

Ru nhahlan M Netails

[E unknown Open Collaboration Service APl error. (999) O Close

Figure 9-6. System Settings » Workspace Theme » Desktop Theme, Get New
Themes

Leave Plasma

To leave Plasma, click the Leave tab on the Kickoff menu (see Figure 9-7). Here you

will find options to log out, lock, switch user, suspend, shut down, and restart. There

are Session and System sections. The Session section has entries for Logout, Lock, and
Switch User. The System section lists the system-wide operations: Shut Down, Reboot,
Hibernate, and Suspend. When you select a leave entry, a dialog for that action appears
on the desktop, which you then click. The Shut Down entry will display the Shutdown
and Logout dialog with the Shutdown button selected (see Figure 9-8). The Logout
option displays the same dialog with the Logout button selected. The Switch User option
displays a dialog with the currently logged in users to choose from, along with a plus
button for a new login.
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Figure 9-7. The Kickoff menu includes the Leave tab

The Lock and Switch User display manager (SSDM) screens display both a button for
the current user and a plus button for starting a new session (Switch User shows the icon
for the user you selected). The new session button displays the login screen with its list of
users to log in as.

If you log out and more than one user is logged in from a previous Switch User
operation, then the Log Out display manager screen will show a logged in user button
and a plus button. Use the plus button to display the main login screen.
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Richard Petersen

Shutdown

Shutting down in 30 seconds

Figure 9-8. Shutdown and Logout dialog

If you have installed the Application Dashboard widget, you can click the logout,
shutdown, and restart button on the lower left. For a complete selection, choose the
Power/Session category on the right (see Figure 9-9).

uti

Power / Session

Figure 9-9. The Application Dashboard menu, Power/Session tab
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You can also press your computer's power button or right-click anywhere on the
desktop and select the Leave entry from the pop-up menu, to open a leave dialog with
the Logout button selected, as shown here. Buttons to the left let you choose between the
suspend, reboot, and shutdown operations.

If you just want to lock your desktop, you can select the Lock Screen entry (Lock on
the Kickoff and Application Dashboard menus), and your screen saver will appear. To
access a locked desktop, click on the screen and a box appears prompting you for your
login password. When you enter the password, your desktop reappears.

Kickoff Menus

The Kickoff application launcher (see Figure 9-10) organizes menu entries into tabs
that are accessed by icons at the bottom of the Kickoff menu. There are tabs for
Favorites, Applications, Computer, History, and Leave. You can add an application
to the Favorites tab by right-clicking on the application’s Kickoff entry and selecting
Add to Favorites. To remove an application from the Favorites menu, right-click

on it and select Remove from Favorites. The Applications tab shows application
categories. Click the Computer tab to list all your fixed and removable storage. The
History tab shows previously accessed documents and applications. Kickoff also
provides a search box where you can search for a particular application instead of
paging through menus. As you move through sub-tabs, they are listed at the top of
the Kickoff menu, below the search box, allowing you to move back to a previous tab
quickly. Click on a tab name to move directly to that tab.
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Figure 9-10. The Kickoff menu includes the Favorites tab

The Computer menu has Applications, Places, and Removable Storage sections
(see Figure 9-11). The Applications section has an entry for System Settings and Run
Command (Krunner). The Places section is similar to the Places menu in GNOME, with
entries for your home folder, root folder, network, and the trash. The root folder is the
same as the system folder on GNOME, the top-level directory in the Linux file system.
The Removable Storage section shows removable devices like USB drives and DVD/CD
discs.
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Figure 9-11. The Kickoff menu includes the Computer tab

The Applications menu has most of the same entries as those found on GNOME (see

Figure 9-12). You can find entries for categories such as Internet, Graphics, and Office.

These menus list both GNOME and KDE applications you can use. However, some of the

menus contain entries for alternate KDE applications, like KMail on the Internet menu.

Other entries will invoke the KDE version of a tool, like the Terminal entry in the System

menu, which will invoke the KDE terminal window, Konsole. There is no Preferences

menu.
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Figure 9-12. The Kickoff menu includes an Applications tab

Application Dashboard Menus

You can install the Application Dashboard as a desktop or panel widget. The Application
Dashboard menu launcher displays menu entries on a full-screen dashboard, showing
sections for applications, favorites, logout/shutdown options, and categories

(see Figure 9-13). Press the Esc key to leave the dashboard without making a selection. You
can add an application to the Favorites section by right-clicking on the application’s icon
and selecting Add to Favorites. To remove an application from the Favorites section, right-
click on it and select Remove from Favorites. The Applications section shows categories

to the right and the icons for a selected category to the left. There are also categories for
recent applications and documents. The Power/Section category lists the complete set

of leave options, including lock, suspend, and new session. The All Applications category

lists all your applications under alphabetic headings (see Figure 9-14).
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Figure 9-13. The Application Dashboard menu, Office tab
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Krunner

For fast access to applications, bookmarks, contacts, and other desktop items, you can
use Krunner. The Krunner widget operates as a search tool for applications and other
items such as bookmarks. To find an application, enter a search pattern; a listing of
matching applications is displayed. Click on an application entry to start the application.
You can also place an icon (application launcher) for an entry on the desktop by simply
clicking and dragging its entry for the list to the desktop. For applications where you
know the name, part of the name, or just its basic topic, Krunner is a very fast way to
access the application. To start Krunner, press Alt+F2, Alt+space, or right-click on the
desktop to display the desktop menu and select Run Command. Enter the pattern for the
application you want to search for and press Enter. The pattern “software” or “package”
would display an entry for Discover Software. Entering the pattern “office” displays
entries for all the LibreOffice applications, as well as additional office applications you
can install (see Figure 9-15).

Clicking the Settings button at the left opens the Configure Search dialog, which
lists plugins for searching applications, widgets, and bookmarks, as well as providing
capabilities such a running shell commands, opening files, and spell checking. The Clear
History button deletes earlier search results. You can also configure Krunner search
using the Plasma Search tab on System Settings Search (Workspace section).

= | office| € o
Applications # Calligra Sheets
4. Calligra Words
@ Contact Print Theme Editor
B Contact Theme Editor
Bl KAddressBook
® KMail
® KMail Header Theme Editor
** KOrganizer
B KTnef
1 Kontact
B Okular
* PIM Setting Exporter

® Sieve Editor

Figure 9-15. Krunner application search
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Removable Devices: Device Notifier

Installed on the system tray to the right is the Device Notifier. When you insert a
removable device like a CD/DVD disc or a USB drive, the New Device Notifier briefly
displays a dialog showing all your removable devices, including the new one. The Device
Notifier icon is displayed on the system tray. You can click on the New Device Notifier
any time to display this dialog. Figure 9-16 shows the New Device Notifier displayed on
the panel and its panel icon. The New Device Notifier is displayed only if at least one
removable device is attached.

Removable devices are not displayed as icons on your desktop. Instead, to open the
devices, you use the New Device Notifier. Click on the Device Notifier icon in the panel
to open its dialog. The device is unmounted initially with an unmount button displayed.
Click on this button to mount the device. An eject button is then displayed, which you
can later use to unmount and eject the device. Opening the device with an application
from its menu will mount the device automatically. Clicking on the eject button for a
DVD/CD disc will physically eject it. For a USB drive, the drive will be unmounted and
prepared for removal. You can then safely remove the USB drive.

Device Notifier

" USB30OFD

I4

fO Download Photos with Gwenview

B Open with File Manager

Device Notifier

[H use3oFD

»

2 actions for this device

To open a device, click on its entry in the Device Notifier, like one for your DVD/CD
disc or your USB drive (see Figure 9-16).

Removable media are also displayed on the File Manager window's side pane. You
can choose to eject removable media from the file manager instead of from the Device
Notifier by right-clicking on the removable media entry and selecting Safely Remove
from the pop-up menu.
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Figure 9-16. Device Notifier and its panel widget icon

Network Connections: Network Manager

On Plasma, the Network Manager plasma widget provides panel access for Network
Manager. This is the same Network Manager application but adapted to the Plasma
interface. The widget icon image changes for wireless only and wired connections.
Clicking on the widget icon in the panel opens a dialog listing your current available
wireless and wired connections. When you pass the mouse over an active connection,
a Disconnect buttons appear (see Figure 9-17). For entries not connected, Connect
buttons are displayed. To rescan your available connections, click the rescan button
(circle) located to the right of the Available Connections heading. Clicking on a
connected entry opens tabs for Speed and Details (see Figure 9-18).

Networks

—_— & .
. T = >
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0@ Never used, WPA2-PSK

. NETGEAR25
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Figure 9-17. Network Manager connections and panel icons
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Figure 9-18. Plasma Network Manager connection information: speed and
details

The toolbar at the top of the network plasma widget has buttons for wireless and
airplane mode connections (shown below). Check boxes next to each connection icon
show if it is enabled. Clicking on the check box for a connection will enable or disable
the connection. Disabled connections have an empty check box and a red icon.

Networks

n 7F “ ~

You can use the Connection Editor to configure your established connections. Either
click the Settings button on the right side of the toolbar at the top of the network dialog
or right-click on the network dialog to display a menu where you can choose Configure
Network Connections. The Connection editor then opens, which lists your connections
(see Figure 9-19). Select a connection and then click the Edit button on the toolbar to
open the Network Manager editor for Plasma, with the same General, Wired, Security,
and IPv4/IPv6 tabs for a wired or wireless connections, as described in Chapter 15 (see
Figure 9-17). To add a new connection manually, click the Add button on the Connection
editor to display a menu for different connection types.
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Figure 9-19. Plasma connection editor and Plasma Network Manager

Desktop Plasmoids (Widgets)

The Plasma desktop supports plasmoids. Plasmoids are integrated into the desktop
on the same level as windows and icons. Just as a desktop can display windows, it can
also display plasmoids. Plasmoids can take on desktop operations, running essential
operations, even replacing, to a limited extent, the need for file manager windows. The
name for plasmoids used on the desktop is widgets. The tools and commands on the
desktop that manage plasmoids, refer to them as widgets. For that reason, they will be
referred to as widgets.
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Managing Desktop Widgets

When you long click (click and hold for several seconds) your mouse on a widget, its
sidebar is displayed with buttons for resizing, rotating, settings, and removing the widget
(see Figure 9-18). Click and drag the resize button to change the widget size. Clicking the
Settings button opens that widget's settings dialog (see Figure 9-20).

To move a widget, long click on it to display its sidebar and while holding the click,
drag the icon to the position you want.

ot ] \nalog Clock Settings — Plasm

ﬁlﬂ ings — | 0 .i
® Appearance
Appearance Show seconds hand
Show time zone

...... 2

Keyboard

shortcuts

+ OK © cancel

Figure 9-20. Clock Widget with task sidebar and configuration dialog

To add a widget (plasmoid) to the desktop, right-click anywhere on the desktop and
select Add Widgets from the pop-up menu. This opens the Widgets dialog at the left side
of the desktop that lists widgets you can add (see Figure 9-21). Clicking on the Categories
button opens a pop-up menu with different widget categories like Date and Time, Online
Services, and Graphics. Double-click or drag a widget to the desktop to add it to the
desktop. You can enter a pattern to search for a widget using the search box located at
the top of the dialog.
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Figure 9-21. Adding a widget using the Widgets dialog
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To remove a widget, long click on the widget to display its toolbar, and then click
on the red Remove button at the bottom of the toolbar. When you remove a widget, a
notification message is displayed with an Undo button, as shown here. Clicking on the
Undo button will restore the widget.

. Rk ' - o
The widget "Analog Clock” has been Undo

removed

Figure 9-22 shows the folder, digital clock, notes, calculator, and CPU monitor
widgets. The desktop folder widget is just a folder widget set initially to the desktop
folder.

[£) B3T 4~ 504PM =

Figure 9-22. Folder, calculator, digital clock, CPU load monitor, and notes
widgets
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Folder and Icon Widgets

You can place access to any folders on the desktop by simply dragging their icons from
a file manager window to the desktop (see Figure 9-23). A small menu will appear that
includes options for the Icon and Folder View widgets. The Folder View option sets up a
Folder View widget for the folder showing icons for subfolders and files. The Icon entry
creates an Icon widget. The icon and folder view widgets are shown here.

Home > Documents

t » 0

» Move Here Shift A i

Copy Here Ctrl = @

oo Link Here Ctrl+Shift myletter vacation.odt =
Widgets

it Add Folder View
Add Icon

= Cancel Esc

Figure 9-23. Folder and Icon widgets

For any Folder View widget, you can use that widget's settings dialog to change the
folder it references. A Folder View widget has options for showing the desktop folder, a
folder on your Places list, or a specific folder. You can also specify a title. You can easily
create a Folder View widget for your home folder.

Activities

The Plasma desktop is designed to support multiple activities. Activities are different
plasma containments, each with its set of widgets. An activity is not the same as virtual
desktop. Virtual desktops affect space, displaying additional desktops. An activity has

its own set of widgets (widgets) and windows, displaying a different set of widgets and
windows for each activity. In effect, each activity has a different desktop and set of virtual
desktops. Technically, each activity is a Plasma containment that has its own collection
of widgets and windows. You can switch to a different activity (containment) and display
a different collection of widgets and windows on your desktop.
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An activity is often tailored for a certain task. You could have one activity for office
work, another for news, and yet another for media. Each activity could have its own set of
appropriate widgets, like clock, calculator, notes, and folder widgets for an office activity.
A media activity might have a Media Player widget and media applications open.

Multiple activities are managed using the Activities Manager, which is accessed
through the Activities entry on the desktop toolbox menu or the Activities widget, which
you can install on the panel or desktop. Both are shown here.

m [

[_] Refresh Desktop
Show Desktop

<+ Add widgets...

eoo Activities...

& Lock Widgets

i Open with Dolphin
e

o Configure Desktop

& Lock Screen

@ Leave n
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Files and folders can be attached to an activity, displaying them only on that activity.
Right-click on the folder or file icon in the File Manager and choose the Activities
submenu to choose an activity. Windows are set by default to display on the activity they
are opened on. The window switcher is configured to work only on the current activity.
The setting is configured in the Window Management dialog (Workspace section of the
System settings dialog). On the Task Switcher tab, the Filter Windows By section has
Activities checked and Current Activity selected.

To add an activity, click the Activities entry in the toolbox or desktop menus. If you
have added and Activities widget to the panel, you can click the Activities button. The
Activities Manager is displayed listing your activities on the left side of the screen (see
Figure 9-24). A default activity icon for your desktop will already be displayed. Click
the Create Activity button (plus button) to add a new activity. A Create a New Activity
window opens with entries for the name and description (see Figure 9-25). Click on the
Icon image to open a dialog where you can choose an icon for your activity. On the Other
tab, you can choose not to track usage and to set up a keyboard shortcut for the activity.
Click the Create button to add the new activity. An activity entry then appears on the
Activity Manager. To switch to another activity, click its icon.
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Activities Q = o

| Default

mydesktop

multimedia

<+ Create activity...

Figure 9-24. Activity toolbar and icons
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Moving the mouse over an activity icon displays Configure and Stop buttons. The
Configure button opens the Activity Settings dialog for that activity, which is the same as
the create dialog, with Name, Description, and Icon settings. The Stop button deactivates
the activity and places it at the bottom of the Activity Manager under the Stopped Activities
heading. To start a stopped activity, simply click its icon in the Stopped Activities list.

To remove an activity, first stop it, then move your mouse over the activity icon in the
Stopped activities section (see Figure 9-26). A remove button appears to the right of the
activity entry. Click it to remove the activity. You are prompted to confirm the deletion.

Create a New Activity — Plasma ? v A '

General Other

Activity information

Name: ‘mydesktop|

Description:

Icon

v Create ® Cancel

Figure 9-25. Create an activity

To add widgets to an activity, first click the activity to make it the current activity, and
then click the Add Widgets button to display the Widgets dialog. Widgets you add are
placed in the current activity.

To switch from one activity to another, first display the Activities Manager by
choosing Activities from the desktop toolbox menu (right-click on desktop) or the
Activates button on the panel (if installed). Then click on the Activity icon you want. The
new activity becomes your desktop (see Figure 9-27). To change to another activity, open
the Activities Manager again and click the activity icon you want. Your original desktop is
the first icon (Default).
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Stopped activities:

-

multimedia

Figure 9-26. Stop Activity icons
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Figure 9-27. Activity Manager and screen of selected activity

To move easily between activities, you can add the Activity bar widget, either to the
panel or to the desktop. On the panel, the Activity bar displays buttons for each activity.
Click to move to a different activity. On the desktop, the Activity bar displays a dialog
with an arrow button for moving from one activity to another.
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Windows

A Plasma window has the same functionality you find in other window managers and
desktops. You can resize the window by clicking and dragging any of its corners or sides.
A click-and-drag operation on a side extends the window in that dimension, whereas a
corner extends both height and width at the same time. The top of the window has a title
bar showing the name of the window, the program name in the case of applications, and
the current directory name for the file manager windows. The active window has the title
bar highlighted.

To move the window, click the title bar and drag it where you want. Right-clicking
the window title bar displays a pop-up menu with entries for window operations, such as
minimize, maximize, and moving the window to a different desktop or activity. The More
Actions submenu includes closing or resizing the window, the shade option to roll up
the window to the title bar, and full screen. Menus, icons, and toolbars for the particular
application are displayed in the window.

You can configure the appearance and operation of a window by selecting the
Window Manager Settings from the More Actions submenu in the Window menu (right-
click the title bar). Here you can set appearance (Window Decoration), button and key
operations (Actions), the focus policy, such as a mouse click on the window or just
passing the mouse over it (Focus), and how the window is displayed when moving it
(Moving). All these features can be configured also using the System Setting's Window
Behavior tool in the Workspace section.

Opened windows are shown as buttons on the Plasma taskbar located on the panel.
The taskbar shows buttons for the different programs you are running or windows you
have open. This is essentially a docking mechanism that lets you change to a window
or application by clicking its button. When you minimize a window, it is reduced to its
taskbar button. You can then restore the window by clicking its taskbar button. A live
thumbnail of a window on the taskbar is displayed as your mouse passes over its taskbar
button, showing its name, desktop, and image.

Taskbar buttons also function as progress bars, showing the progress of copy and
download operations. Music and video players also show basic multimedia controls,
such as pause, start, next, and previous.
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To the right of the title bar are three small buttons for minimizing, maximizing, or
closing the window (down, up, and x symbols). You can switch to a window at any time
by clicking its taskbar button. You can also maximize a window by dragging it to the top
edge of the screen.

From the keyboard, you can use the Alt+Tab key combination to display a list of
current open windows. Holding down the Alt key and sequentially pressing Tab moves
you through the list.

A window can be displayed as a tile on one half of the screen. Another tile can be
set up for a different window on the other side of the screen, allowing you to display
two windows side by side on the full screen (see Figure 9-28). You can tile a window by
dragging it to the side of the screen (over the side edge to the middle of the window). A
tile outline will appear. Add a second tile by moving a window to the other side edge.

You can add more windows to a tile by moving them to that edge. Clicking on a window's
taskbar button will display it on its tile.

The same process works for corners. You can tile a window to a corner by moving it
to that corner. You can then have four tiled windows open at each corner. You could even

have server windows open on the same corner, displaying the one you want by clicking
its taskbar icon.
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Figure 9-28. Window tiles
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Applications

You can start an application in Plasma in several ways. If an entry for it is in the Kickoff
Applications menu or Application Dashboard, you can select that entry to start the
application. You can right-click on any application entry in the Applications menu to
display a pop-up menu with Add to Panel and Add to Desktop entries. Select either to
add a shortcut icon for the application to the desktop or the panel. You can then start an
application by single-clicking its desktop or panel icon.

An application icon on the desktop is implemented as a desktop widget. Performing
along click on the application icon on the desktop displays a sidebar with the icon for
the widget settings. This opens a Settings window that allows you to specify a keyboard
shortcut.

You can also run an application by right-clicking on the desktop and selecting the
Run Command (or press Alt+F2 or Alt+space), which will display the Krunner tool
consisting of a box to enter a single command. Previous commands can be accessed
from a pop-up menu. You need only enter a pattern to search for the application. Results
will be displayed in the Krunner window. Choose the one you want.

Virtual Desktops: Pager

The Plasma desktop supports virtual desktops, extending the desktop area on which you
can work. You could have a web browser running on one desktop and be using a text
editor in another. Plasma can support up to 16 virtual desktops. To use virtual desktops,
add the Pager widget to your panel or desktop. On the panel, you can use the panel
editor (toolbox, right side) to move it to the location you want on the panel. The panel
and desktop pagers are shown here.
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The Pager widget represents your virtual desktops as miniature screens, showing

small squares for each desktop. It works much like the GNOME Workspace Switcher.
To move from one desktop to another, click the square for the destination desktop. The
selected desktop will be highlighted. Just passing your mouse over a desktop image on
the panel will open a message displaying the desktop number along with the windows
open on that desktop.

If you want to move a window to a different desktop, first open the window’s menu
by right-clicking the window’s title bar. Then select the To Desktop entry, which lists the
available desktops. Choose the one you want.

You can also configure Plasma so that if you move the mouse over the edge of a
desktop screen, it automatically moves to the adjoining desktop. You need to imagine the
desktops arranged next to each. You enable this feature by enabling the Switch Desktop
on Edge feature in the System Settings » Desktop Behavior » Screen Edges tab. This
feature will also allow you to move windows over the edge to an adjoining desktop.

- Virtual Desktops — System Settings T v A
£ Deskion Behavier Navigation, Number and Layout of Virtual C
.} Workspace pe—
B} Desitop Eftects o
[N screen Edges Mumber of desktops: 4
Y Touch Screen Mumber of rows: | 2
I screen Locking Deskiop Names
£ virual Desitops Duskiop 1. Desktop 1
s Activities Desktop 2 Desktop 2

Deskiop 3:  Deskiop 3

Deskiop 4 Deskiop 4

B Help | | [ Defaults

Virtual Desktops — System Settings Module

Navigation, Number and Layout of Virtual Desktops

Desktops | Switching
Layout

Number of desktops: | 4

£> || <>

Number of rows: | 2
Desktop Names
Desktop 1:  Desktop 1

Desktop 2: Desktop 2

Desktop 3. Desktop 3

Desktop 4: Desktop 4

 Help Y9 t | G- Defaults + OK " Apply @ cancel

Figure 9-29. Virtual desktop configuration (desktop behavior) and Pager
widget icon
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To change the number of virtual desktops, right-click on the Desktop Pager widget,
select the Configure Desktops entry in the pop-up menu to open the Virtual Desktops
dialog, and choose the Desktops tab, which displays entries for your active desktops. You
can also access the Virtual Desktops dialog from System Settings » Desktop Behavior
in the Workspace section (see Figure 9-29). The text box labeled Number of Desktops
controls the number of active desktops. Use the arrows or enter a number to change
the number of active desktops. You can change any of the desktop names by clicking an
active name and entering a new one.

To change how the pager displays desktops on the pager, right-click on the pager and
choose Pager Settings to open the Pager Settings dialog (see Figure 9-30). Here you can
configure the pager to display numbers or names for desktops, or show icons of open

windows.

Pager Settings — Plasma

E General
General Display: () Desktop number
() Desktop name
o ® No text
Keyboard
shortcuts (J tcons

[C] only the current screen
Selecting current desktop: (® Does nothing

() shows desktop

v OK v Apply © cancel

Figure 9-30. Pager Settings dialog

Tip Use the Ctrl key in combination with a function key to switch to a specific
desktop: for example, Ctrl+F1 switches to the first desktop and Ctrl+r3 to the third
desktop.
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Plasma Panel

The Plasma panel, located at the bottom of the screen, provides access to most Plasma
functions (see Figure 9-31). The panel is a specially configured Plasma containment,
just like the desktop. The panel can include icons for menus, folder windows, specific
programs, and virtual desktops. These are widgets that are configured for use on the
panel. At the left end of the panel is a button for the Kickoff menu, a KDE Kicon.

To add an application to the panel, right-click on its entry in the Kickoff menu to
open a pop-up menu and select Add to Panel.

-
9 & Home — Dolphin

320 5% a 6:27PM =

OF = oo i 4~ 6:28PM

Figure 9-31. The Plasma panel

To add a widget to the panel, right-click on any panel widget on the panel to open
a pop-up menu and select Panel Options submenu, from which you can select the
Add Widgets entry. This opens the Add Widgets dialog that lists widgets you can add to
the panel (see Figure 9-32). A drop-down menu at the top of the window lets you see
different widget categories, like Date and Time, Online Services, and Graphics. Another
way to open the Add Widgets dialog is to click on the panel toolbox on the right side of
the panel and click the Add widgets button.
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Figure 9-32. Plasma Add Widgets for panel

The Plasma panel supports several kinds of Windows and Tasks widgets, including
the taskbar (Task Manager) and system tray. To the right of the system tray is the
digital clock. The system tray holds widgets for desktop operations like update notifier,
the clipboard, Bluetooth, device notifier, sound settings (kmix), media player (if a
multimedia player is active), and network manager, as shown here.

IHHe&8 X ¢ -

The pop-up menu (arrow icon) on the right side of the system tray display widgets
that are not in use, or not often used (see Figure 9-33). The Battery and Brightness entry
displays a dialog to see battery charges and set screen brightness.
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Figure 9-33. System tray

To configure the system tray, right-click on the system tray menu (arrow icon) and
choose System Tray Settings to open the system tray configuration dialog at the General
tab, where you can decide what items to display or entries to make visible or remove (see
Figure 9-34). In the Extra Items list, you can check items that you also want displayed
on the system tray, such as Printers and Instant Messaging. When you click the Apply
button the items are displayed. Items not in use are in the menu. The Entries tab shows
how selected items are to be displayed (auto, shown, or hidden).
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Figure 9-34. Plasma panel system tray settings
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Plasma Panel Configuration

To configure a panel, changing its position, size, and display features, you use the

panel's toolbox, located at the right side of the panel. Click on it to open an additional
configuration panel with buttons for adding widgets, moving the panel, changing its size,
and a More Settings menu for setting visibility and alignment features. Figure 9-35 shows
the configuration panel as it will appear on your desktop. Figure 9-36 provides a more
detailed description, including the More Settings menu entries.

Scroen Edge He ght + Add Widgets... | oo Add Spacer | = More Settings... @
B 210 4+ 6:36PM =

Figure 9-35. Plasma Panel Configuration

With the configuration panel activated, you can also move widgets around the panel.
Clicking on a widget will overlay a movement icon, letting you then move the widget icon
to a different location on the panel.

As you move your mouse over a widget in the panel, a pop-up dialog opens showing
the widget's name, a settings button, and a delete button (see Figure 9-35). To remove
the widget from the panel, click its delete button.

The lower part of the configuration panel is used for panel position settings. On the
left side is a slider for positioning the panel on the edge of the screen. On the right side
are two sliders for the minimum (bottom) and maximum (top) size of the panel.

The top part of the panel has buttons for changing the location and the size of the
panel. The Screen Edge button lets you move the panel to another side of the screen (left,
right, top, bottom). Just click and drag. The height button lets you change the panel size,
larger or smaller. The Add Widgets button will open the Add Widgets dialog, letting you
add new widgets to the panel. The Add Spacer button adds a spacer to separate widgets.
Right-click on the spacer to set the flexible size option or to remove the spacer.

366



CHAPTER9  PLASMA DESKTOP: THE K DESKTOP ENVIRONMENT (KDE)
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Figure 9-36. Plasma Panel Configuration details and display features

The More Setting menu lets you set Visibility and Alignment features. You can
choose an AutoHide setting that will hide the panel until you move the mouse to its
location. The Windows Can Cover option lets a window overlap the panel. For smaller
panels, you can align to the right, left, or center of the screen edge. The More Settings
menu also has an entry to remove the panel. Use this entry to delete a panel you no
longer want.

When you are finished with the configuration, click the red x icon the upper-right
side.

Desktop Effects

Desktop effects can be enabled on the System Settings Desktop Effects tab in the Desktop
Behavior dialog in the Workspace section (System Settings » Desktop Behavior). For
virtual desktop switching, you can choose Slide, Fade Desktop, and Desktop Cube
Animation (see Figure 9-37). The more dramatic effects are found in the Windows
Management section. Desktop Effects requires the support of a capable graphics chip
(GPU). You may have to install the proprietary graphics driver (System Settings » Driver
Manager).
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Hint: To find out or configure how to activate an effect. look at the effect's settings.
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Virtual Desktop Switching Animation

Desktop Cube Ani "
Animate desktop switching with a cube
Fade Desktop

Fade between virtual desktops when switching between them

Slide

Slide windows across the screen when switching virtual desktops
Window Management

Desktop Cube

Display each virtual desktop on a side of a cube

Desktop Grid

Zoom out so all desktops are displayed side-by-side in a grid

Flip Switch

Flip through windows that are in a stack for the alt+tab window switcher

Present Windows

Zoom out until all opened windows can be displayed side-by-side

Resize Window

Resizes windows with a fast texture scale instead of updating contents

8 Help [ Defaults 9 Reset

Figure 9-37. Desktop Effects selection

Table 9-3. KWin Desktop Effects Keyboard Shortcuts

W

Key

Operation

Alt+Tab
Ctrl+F8
Ctrl+F9
Ctrl+F10
Ctrl+F11

Cover Switch, Thumbnail, or Breeze for open windows

Desktop Grid (use mouse to select a desktop)

Present Windows Current Desktop

Present Windows All Desktops

Desktop Cube (use mouse or arrow keys to move, ESC to exit)

14

it

WA

* Get New Effects...

8| |8 |8 |8

8

Several windows effects are selected by default, depending on whether your graphics
card can support them. A check box is filled next to active effects. If there is a dialog icon
to the right of the effects entry, it means the effect can be configured. Click on the icon to
open its configuration dialog. Figure 9-38 shows the configuration dialog for the Desktop
Grid effect. For several effects, you use certain keys to start them. The more commonly
used effects are Cover Switch, Desktop Grid, Present Windows, and Desktop Cube. The
keys for these effects are listed in Table 9-3.
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- Desktop Grid — System Settings ?2v A0
Appearance Activation
Zoom duration: | Default & Search: ||
Border width: | 10 S Action v Global
Desktop name alignment: | Disabled W RN
Show Desktop Grid > Ctrl+F8
Layout mode: | Pager b

|m| Use Present Windows effect to layout the windows

(W] show buttons to alter count of virtual desktops

[ Reset Defaults v OK v Apply © cancel

Figure 9-38. Desktop Effects configuration

Window switching using Alt+Tab is controlled on the Windows Management dialog’s
Task Switcher tab, not from Desktop Behavior's Desktop Effects tab. In the Visualization
section, you can choose the window switching effect you want to use from the drop-
down menu. These include Breeze, Thumbnails, Grid, Cover Switch, and Flip Switch,
as well as smaller listings such as informative, compact, text icons, and small icons. The
Alt+Tab keys implement the effect you have chosen. Continually pressing the Tab key
while holding down the Alt key moves you through the windows. Thumbnails displays
windows in a boxed dialog (see Figure 9-39), whereas Cover Switch arranges windows
stacked to the sides, and Flip Switch arranges the windows to one side (see Figure 9-40).
The default is Breeze, which arranges the window images to the left side of the screen
(see Figure 9-39).
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Figure 9-39. Thumbnail and Breeze switch: Use Alt+Tab
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The Present Windows effect displays images of the open windows on your screen
with the selected one highlighted (see Figure 9-41). You can use your mouse to select
another. This provides an easy way to browse your open windows. You can also use
Ctrl+F9 to display windows on your current virtual desktop statically and use the arrow
key to move between them. Use Ctrl+F10 to display all your open windows across all
your desktops. Press the Esc key to return to the desktop.

Home — Dolphin

Figure 9-40. Cover Switch: Use Alt+Tab

Desktop Grid will show a grid of all your virtual desktops (Ctrl+F8), letting you see
all your virtual desktops on the screen at once (see Figure 9-42). You can then move
windows and open applications between desktops. Clicking on a desktop makes it the
current one. The plus and minus keys allow you to add or remove virtual desktops.
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IMG_1124.JPG - 3072x2304 - 11% — Gwenview

Fedora Project - Start Page - Mozilla Firefox

Figure 9-41. Present windows (windows effects): Use Ctrl+F9 for current desktop
and Ctrl+F10 for all desktops

— o
WS o Bree Sam Bows

- ——
I

Figure 9-42. Desktop Grid: Ctrl+F8
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Desktop Cube will show a cube of all your virtual desktops, letting you move to
different desktops around a cube (see Figure 9-43). Stop at the side you want to select.
Press Ctrl+11 to start the Desktop Cube. You can then move around the cube with the
arrow keys or by clicking and dragging your mouse. Alternatively, if you have a touchpad,
you can use a two-finger drag to start and move through the Desktop Cube. When you
are finished, press the Esc key to return to the desktop. Desktop Cube Animation will use
cube animation whenever you switch to a different desktop using the Desktop Pager.

Figure 9-43. Desktop Cube: Ctrl+F11, drag-mouse, or use the right/left arrow keys
(or two-finger drag on a touchpad)

Plasma File Manager: Dolphin

Dolphin is Plasma's dedicated file manager (see Figure 9-44). A navigation bar shows the
current directory either in a browser or edit mode. In the browse mode it shows icons

for the path of your current directory, and in the edit mode, it shows the path name in

a text-editable box. You can use either to move to different folders and their subfolders.
Use the Ctrl+l key or click to the right of the folder buttons to use the edit mode. You can
also choose Control » Location Bar » Editable Location. Clicking on the checkmark at
the end of the editable text box returns you to the browser mode.
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The Dolphin menu bar has been hidden by default. The menus are displayed when
clicking the Control button on the right end of the toolbar (see Figure 9-45). You can
redisplay the menu bar by choosing Show Menubar from the Control (or View) menu
(Ctrl+m). You can hide the menu bar again by choosing Show Menubar from the Settings
menu (or pressing Ctrl+m).

You can open a file either by clicking it or by right-clicking it, then choosing the Open
With submenu to list applications to open it with. If you want to just select the file or
folder, you need to hold down the Ctrl key while you click it. A single click will open the
file. If the file is a program, that program starts up. If it is a data file, such as a text file,
the associated application is run using that data file. Clicking a text file displays it with
the Kate editor, while clicking an image file displays it with the Gwenview image viewer.
If Dolphin cannot determine the application to use, it opens a dialog box prompting
you to enter the application name. You can click the Browse button on this box to use a
directory tree to locate the application program you want.

Location bar  Configuration menu

Home — Dolphin

M split

Toolbar T EE E;: :E Q Find

> Home

= Control

Preview
Places

|
B Network

B9 Root
[ Trash

@
v

Places
Panel —
Recently Saved
Today
Yesterday
I® This Month
¥ Last Month

Documents Downloads Music Pictures

Desktop

Search For

= Documents Public Templates Videos

£l Images

J? Audio Files

H videos

Devices

£ Fedora-KDE-Live-28-1-1
B 50.0 GiB Hard Drive

Bl 406.7 GiB Hard Drive
M 1.0 GiB Hard Drive

Removable

Devices —

& USB30FD

Status bar

8 Folders

.

377.8 GiB free

"

Size slider bar

Figure 9-44. The Dolphin File Manager (Plasma desktop)

374



CHAPTER9  PLASMA DESKTOP: THE K DESKTOP ENVIRONMENT (KDE)

-—
ame 8- 98 | Q, Find Preview [7] Split
> Home
F B Select All Ctrl+A
Bl Network P—
B3 Root . D
B Trast L 88 View Mode
il Trash <
Desktop Documents | S Name
1 Tod D B — Additional Information Size
oday
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P S| Foldere First Link Destination
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Figure 9-45. The Dolphin File Manager menus

Dolphin can display panels to either side (Dolphin refers to these as panels, although
they operate more like standalone tabs). The Places panel will show icons for often-used
folders like Home, Network, and Trash, as well as removable devices. To add a folder to
the Places panel, just drag it there. The files listed in a folder can be viewed in several
ways, such as icons, detailed listing (Details), and columns (Control » View Mode
menu). See Table 9-4 for keyboard shortcuts.
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Table 9-4. Dolphin File Manager Keyboard Shortcuts

Keys

Description

Alt+left arrow, Alt+right arrow
Alt+up arrow

Enter

Left/Right/Up/Down arrows
Page Up, Page Down
Cirl+c

Ctrl+v

Ctrl+s

Cirl+

Ctrl+f

Ctrl+q

Backward and Forward in history

One directory up

Open a file/directory

Move among the icons

Scroll fast

Copy selected file to clipboard

Paste files from clipboard to current directory
Select files by pattern

URI text box location bar

Find files

Close window

The Additional Information submenu in the Control menu (or View menu) lets you

display additional information about files such as the size, date, type, and comments.

Type-specific information can also be displayed such as album, track, and duration for

audio files, and word and line counts for documents. You can also display the full path,

permissions, and group information (other submenu).
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Figure 9-46. The Dolphin File Manager with sidebars
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Figure 9-47. The Recently Saved panel of the Dolphin File Manager

You can display additional panels by selecting them from the Control » Panels
submenu. The Information panel displays detailed information about a selected file or
folder, and the Folders panel displays a directory tree for the file system. The panels are
detachable from the file manager window (see Figure 9-46). Be sure to choose Unlock
Panels in the Panels menu to make them detachable.
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The Places panel use the file metadata to provide easy access to files by category
and date. The Places panel has four sections: Places, Recently Saved, Search For, and
Devices. As in previous versions, the Places section holds your folders, including root,
trash, and network, and the Devices section holds your attached devices, including
removable devices. The Recently Saved section lets you display files you access fairly
recently: today, yesterday, this month, and last month (see Figure 9-47). The Search For
section lets you displays files of specified types: documents, images, audio files, and
videos.

Dolphin supports split views, where you can open two different folders in the same
window. Click the Split button in the toolbar. You can then drag folder and files from one
folder to the other (see Figure 9-48).

= Documents — Dolphin woA °
< > |IEBll 8 98 | Q Find Preview [f] Close = Control

Places > Home > Documents Home

El Network

™ Root
[ Trash

Recently Saved

Today

[ Yesterday
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Last Month

Search For
£ Documents

Ed Images
3 Audio Files

e

!
.

myletter vacation.odt

2 Files (8.4 KiB) =

A
!

Desktop

Downloads

Pictures

Documents

Music

Public

* 377.8 GiB free Downloads (fo... == == « 377.8 GiB free

Figure 9-48. The Dolphin File Manager with split views

To configure Dolphin, click Configure Dolphin from the Setting menu to open the
Dolphin Preferences dialog with tabs for Startup, View Modes, Navigation, Services,
Trash, and General (see Figure 9-49). On the Startup tab, you can specify features like
the split view and the default folder to start up with. On the View Modes tab, you can
set display features for the different display modes (Icons, Details, and Column), like
the icon size, font type, and arrangement. The Navigation tab sets features like opening
archives as folders. The Services tab is where you specify actions supported for different
kinds of files, like play a DVD with Dragon Player, install a true type font file or display
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image files. The Trash tab lets you configure trash settings like deleting items in the

trash after a specified time and setting the maximum size of the trash. The General tab
has sub-tabs for Behavior, Previews, Confirmations, and Status Bar. The Behavior tab

is where you can enable tooltips and show selection markers. Preview lets you choose
which type of files to preview. The image, jpeg, and directories types are already selected.
On Confirmations, you can require confirmation prompts for file deletion, moving files
to the trash, or closing multiple tabs. On the Status tab, you can choose to show the zoom
slider and the amount of free storage.

t';ol_;;lﬁn Preferences — Eoi_pl'ﬁn

@ Home Folder
e e Location: /homejrichard a n
’_ Use Current Location Use Default Location
Navigation
[] split view mode
P [] Editable location bar
SERIEEE ("] show full path inside location bar
D' ["] show filter bar
Trash [_] show full path in title bar
5]
General
Defaults v OK v Apply ® Cancel

Figure 9-49. The Dolphin File Manager configuration

Navigating Directories

Within a file manager window, a single-click on a folder icon moves to that folder and
displays its file and sub-folder icons. To move back up to the parent folder, you click
the back arrow button located on the left end of the navigation toolbar. A single-click
on a folder icon moves you down the folder tree, one folder at a time. By clicking the
back arrow button, you move up the tree. The Navigation bar can display either the
folder path for the current folder or an editable location box where you can enter in a
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pathname. For the folder path, you can click on any displayed folder name to move you
quickly to an upper-level folder. To use the location box, click to the right of the folder
path. The Location box is displayed. You can also select Show Full Location in the

View » Location Bar » Editable Location menu item (or press Ctrl+L or F6). The
navigation bar changes to an editable text box, where you can type a path name. To
change back to the folder path, click the checkmark to the right of the text box.

Like a web browser, the file manager remembers the previous folder it has displayed.
You can use the back and forward arrow buttons to move through this list of prior
folders. You can also use several keyboard shortcuts to perform such operations, like
Alt+back arrow to move up a folder, and the arrow keys to move to different icons.

The Copy, Move, Delete, Rename, and Link Operations

To perform an operation on a file or folder, you first have to select it by clicking the file’s
icon or listing. To select more than one file, hold down the Ctrl key down while you click
the files you want. You can also use the keyboard arrow keys to move from one file icon
to another.

To copy and move files, you can use the standard drag-and-drop method with
your mouse. To copy a file, you locate it by using the file manager. Open another file
manager window to the folder to which you want the file copied. Then drag-and-drop
the file icon to that window. A pop-up menu appears with selections for Move Here,
Copy Here, or Link Here. Choose Copy Here. To move a file to another directory, follow
the same procedure, but select Move Here from the pop-up menu. To copy or move a
folder, use the same procedure as for files. All the folder’s files and subfolders are also
copied or moved. Instead of having to select from a pop-up menu, you can use the
corresponding keys: Ctrl for copy, Shift for move, and Ctrl+Shift for link (same as for
GNOME).

To rename a file, Ctrl+click its icon and press F2, or right-click the icon and select
Rename from the pop-up menu. A dialog opens where you can enter the new name for
the file or folder.

You can delete a file either by selecting it and deleting it, or placing it in the Trash
folder to delete later. To delete a file, select it and then choose the Delete entry in the
File menu, File » Delete (also Shift+Del key). To place a file in the Trash folder, drag-
and-drop it to the Trash icon on the Places panel, or right-click the file and choose
Move To Trash from the pop-up menu. You can later open the Trash folder and delete
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the files. To delete all the files in the Trash folder, right-click the Trash icon in Dolphin
File Manager Places panel and select Empty Trash from the pop-up menu. To restore
files in the Trash bin, open the Trash window and right-click on the file to restore and
select Restore.

Each file or directory has properties associated with it that include permissions, the
filename, and its directory. To display the Properties dialog for a given file, right-click the
file’s icon and select the Properties entry. On the General tab, you see the name of the file
displayed. To change the filename, replace the name there with a new one. Permissions
are set on the Permissions tab. Here, you can set read, write, and execute permissions for
user, group, or other access to the file. The Group entry enables you to change the group
for a file.

Search Bar and Filter Bar

The Dolphin search tool provides a simplified search bar for files and folders. Dolphin
also supports a filter bar to search files and folders in the current folder. You can also use
the Filter Panel to refine searches by metadata such as type, date, ratings, and tags. For
quick access to basic categories and recent use, you can use the Places panel's Recently
Accessed and Search For entries, as noted previously.

Search Bar

To search for files, click the Find button on the icon bar to open the search bar, which
displays a search text box. You can also choose Find from the Edit menu or press Ctrl+f.
The search bar displays a search text box, where you enter the pattern of the file or folder
you are searching for. Click the red x button to the left to close the find bar and use the
black x button in the text box to clear the search pattern.

Buttons below the search box provide options to qualify the search. The Filename
button (the default) searches on the filename. The Content button will search the
contents of text files for the pattern. The From Here button searches the user's home
folders, and the Everywhere button (the default) searches the entire file system (see
Figure 9-50).
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Figure 9-50. The Dolphin search bar

The search results are displayed in the main pane. You can click a file to have it open
with its appropriate application. Text files are displayed by the Kate text editor, images
by Gwenview, and applications are run. When you are finished searching, click the Close
button.

When you pass your mouse over an icon listed in the Query Results, information
about it is displayed on the information panel to the right (if the information panel is
displayed). Links are shown for adding tags and comments. Right-clicking on this panel
lets you open a configure dialog where you can specify what information to display.

The search operation uses the Dolphin implementation of Baloo desktop search. To
configure desktop search, choose System Settings » Workspace » Search, File Search
tab. On the File Search tab, you can enable or disable file searching and choose folders
not to search.

Filter Bar

For a quick search of the current folder, you can activate the Filter bar (Control »

Tools » Show Filter Bar or Ctrl+i), which opens a Filter search box at the bottom of the
window. Enter a pattern and only those file and directory names containing that pattern
are displayed. Click the x button at the right of the Filter box to clear it (see Figure 9-51).
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Figure 9-51. The Dolphin filter bar

Plasma Configuration: System Settings

With the Plasma configuration tools, you can configure your desktop and system,
changing the way it is displayed and the features it supports. The configuration dialogs
are accessed on the System Settings window (see Figure 9-52). On Plasma, you can
access System Settings from the System Settings entry in the Kickoff Computer or
Favorites menus, or from Applications » Settings » System Settings. On the Application
Dashboard, you can access it in the Favorites section and in the Settings category.

The System Settings window can be displayed three ways: tree view, icon view, and
sidebar view. Use the Configure dialog » General tab to choose the view you want.
You can access the Configure dialog from the menu on the sidebar view (upper-left
corner) or the Configure button on the icon view (top toolbar). The sidebar view is the
current default (see Figure 9-52). The icon view was the default in previous releases
(see Figure 9-53). With the sidebar view, System Settings shows an icon list of setting
categories arranged in several sections: Appearance, Workspace, Personalization,
Network, Hardware, and System Administration (see Figure 9-54). Click an entry
to display a new icon list in the sidebar with configuration entries for that category.
Selecting an entry shows the configuration settings on the right pane (see Figure 9-55).
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The Appearance section lets you set the desktop theme, manage fonts, choose icon
sets, and select application and window styles. The Workspace section lets you set
desktop effects, virtual desktops, window actions, startup applications, desktop search.
The Network section holds icons for configuring networking preferences, Bluetooth
connections, and sharing. Personalization lets you set the settings for user management,
the date and time, notifications, online accounts, and file/application associations.
Hardware lets you set the printer configuration, power management, multimedia devices
(sound), your display resolution, and manage drivers.

Alternatively, you can display the System Settings window using the classic
tree format. Click the System Settings Configure entry from the menu to open the
configuration dialog and select Classic tree on the General tab. Setting sections are
displayed as expandable trees on the left pane, with dialogs for a selected section
displayed to the right.
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Figure 9-52. Plasma system settings, sidebar view

384



¢ All settings {8 Help

[ Appearance
Workspace Colors
neme
[ Workspace
—

Desktop Window
Behavior Management

| Personalization

Account Regional
settings

Details

| Network

¢ 8

Settings Connectivity

CHAPTER9  PLASMA DESKTOP: THE K DESKTOP ENVIRONMENT (KDE)

System Settings
Search

= Configure

. — o —
L1l ]
L1
Fonts lcons Application
Style

Shortcuts Startup and Search
Shutdown

Accessibility Online
Accounts

PN

Notifications  Applications

“ )

Bluetooth

Connections
| Hardware
TE—
- O = 90 e
Input Display and  Multimedia Power Color KDE Connect Printers
Devices Monitor Management Corrections

| System administration
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Figure 9-55. Plasma System Settings » Application Style, Widget Style

Plasma has administration tools comparable to the Cinnamon and Mate desktops.
For example, user management is provided by Kuser, accessible from the System Settings
» Account Details (Personalization section), User Manager entry (see Figure 9-56).
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Email Address: | john.doe@example.com
Password:

(W) Enable administrator privileges for this user
[} Log in automatically

+ | =

8l Help | [+ Defaults | S Reset « Apply

Figure 9-56. Plasma System Settings » User Manager
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Plasma Software Management: Discover and Apper

Discover is Plasma's corresponding application to GNOME Software. It uses a simple
interface to let you quickly locate and install software. Applications can be easily
removed with a click. With Discover, you can also install Plasma (KDE) desktop add-
ons, including widgets for desktop and panel. Discover shows a sidebar on the left and
a list of applications to the right (see Figure 9-57). You use the Discover sidebar to locate
software packages. The Applications entry expands to software categories on the sidebar,
which, when selected, will display a list of available and installed packages in the right
pane. Clicking on a package entry expands it to a software description with an Install
button (installed packages have a Remove button; see Figure 9-58).

The Installed entry lists all your installed packages with the Remove button for easy
deletion. You can also use the Search box at the top of the sidebar to locate a package.
The Settings entry lists your repositories, which you can enable or disable.

The Plasma add-ons entry on the sidebar provides an extensive set of add-ons to
different parts of the Plasma desktop. There are categories for fonts, themes, icons,
window effects, window switching, and wallpapers, among others. You use the Plasma
Widgets entry to manage your desktop and panel widgets.

The Application Addons entry lists add-ons for particular applications, such as
calendar events for KOrganizer.

Graphics _ Discover

< Back

Install

. =
30 3 .“) D
Drawing 3D modeling, animation, rendering and post-production

Painting and Editing

=W . GNU Image Manipulation Program Install
otogra

bl £ B Painting and Editing
Publishing LY Create images and edit photographs

Scanning and OCR

Viewers In ks{_app_ Install
Drawing

Installed "™ Create and edit Scalable Vector Graphics images

Settings

Figure 9-57. Discover Software Manager
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Graphics — Discover

Inkscape Install

Inkscape
search in 'Graphics Create and edit Scalable Vector Graphics images
{ Back
3D : -.; F
ey
"1
Drawing ; |
o |
Painting and Editing —“ !
o |
Photography a 1
¥ ] >
Publishing i — i "
Scanning and OCR i o
An Open Source vector graphics editor, with capabilities similar to lllustrator, CorelDraw, or Xara X, using
Viewers the W3C standard Scalable Vector Graphics (SVG) file format.
Inkscape supports many advanced SVG features (markers, clones, alpha blending, etc.) and great care is
taken in designing a streamlined interface. It is very easy to edit nodes, perform complex path operations,
trace bitmaps and much more. We also aim to maintain a thriving user and developer community by using
open, community-oriented development.
Addons
Show reviews (36)...
Installed Category: Drawing
Version: 0.92.2-6.fc28
Settings Size: 18.5 MiB
Source: fedora (Fedora)
® No Updates License: GPL-2.0+ AND CC-BY-3.0
Homepage: http://inkscape.org/

Figure 9-58. Discover Software Manager, application description

For software management, you can also use Apper, which replaced KPackagekit
software manager. It is not installed by default. Similar to GNOME PackageKit, it lets
you search on filenames and descriptions. The Apper dialog shows a toolbar and two
sections of icons: Lists and Categories (see Figure 9-59).
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(s I8 4 Apper v~

< | ‘ Q_ Find by name v~ 7 Filters =

Lists

v @
Installed  Updates
Software

Groups

@ @ W O € =~ o 8 B 0

Admin  Development Education Fonts GNOME Games Graphics Internet KDE Legacy
tools desktop desktop

2 o R BE e B 2 B

Localization  Multimedia Newest Office Other Others Package Publishing  Servers
packages desktops collections

E B -

System  Virtualization XFCE
desktop

Figure 9-59. Apper software manager: package categories

The toolbar at the top shows a search box with a menu to qualify the search, along
with filters (installed or new packages). A Pending Changes button shows the packages
you have decided to install or remove. The configuration button lists a History and
Settings. Use Settings to configure Apper. The Lists section has icons for Installed
Software and Updates. Use Updates to update your applications and Installed Software
to see what software is installed.
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Shells

The shellis a command interpreter that provides a line-oriented interactive and
noninteractive interface between the user and the operating system. You enter
commands on a command line. They are interpreted by the shell and then sent as
instructions to the operating system (interactive). The command-line interface is
accessible from GNOME and KDE through a terminal window. You can also place
commands in a script file, to be consecutively executed much like a program (non-
interactive). This interpretive capability of the shell provides for many sophisticated
features. For example, the shell has a set of file-expansion characters that can generate
filenames. The shell can redirect input and output, as well as run operations in the
background, freeing you to perform other tasks.

Several different types of shells have been developed for Linux: the Bourne-Again
shell (BASH), the Korn shell, the TCSH shell, and the Z shell. All shells are available for
your use, although the BASH shell is the default. You need only one type of shell to do
your work. Fedora Linux includes all the major shells, although it installs and uses the
BASH shell as the default. If you use the command-line shell, you will be using the BASH
shell, unless you specify another. This chapter discusses the BASH shell, which shares
many of the same features as other shells.

You can find out more about shells at their respective websites, as listed in Table 10-1.
In addition, a detailed online manual is available for each installed shell. Use the man
command and the shell’s keyword to access them—bash for the BASH shell, ksh for the
Korn shell, tsch for the TSCH shell, and zsh for the Z shell. For example, the command
man bash will access the BASH shell online manual.
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Table 10-1. Linux Shells

Shell Website

www.gnu.org/software/bash  BASH website, with online manual, FAQ, and current releases

www.gnu.org/software/bash/ BASH online manual

manual/bash.html

www.zsh.org Z shell website, with referrals to FAQ and current downloads

www.tcsh.org TCSH website, with detailed support, including manual, tips,
FAQ, and recent releases

www. kornshell. com Korn shell site with manual, FAQ, and references

Note You can find out more about the BASH shell at www. gnu.org/software/
bash. A detailed online manual is available on your Linux system, using the man
command with the bash keyword.

The Command Line

The Linux command-line interface consists of a single line into which you enter
commands with any of their options and arguments. From GNOME or KDE, you can
access the command-line interface by opening a terminal window. Should you start
Linux with the command-line interface, you will be presented with a BASH shell
command line when you log in.

By default, the BASH shell has a dollar sign ($) prompt, but Linux has several other
types of shells, each with its own prompt (such as % for the C shell). The root user will
have a different prompt, the #. A shell prompt, such as the one shown following, marks
the beginning of the command line:

$

At the prompt, you can enter a command, along with options and arguments. For
example, with an -1 option, the 1s command will display a line of information about
each file, listing such data as its size and the date and time it was last modified. In the
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following example, the user enters the 1s command, followed by a -1 option. The dash
before the -1 option is required. Linux uses it to distinguish an option from an argument.

$ 1s -1

If you wanted only the information displayed for a particular file, you could add that
file’s name as the argument, following the -1 option.

$ 1s -1 mydata
-Tw-r--r-- 1 chris weather 207 Feb 20 11:55 mydata

Tip Some commands can be complex and take some time to execute. If you
mistakenly execute the wrong command, you can interrupt and stop it with the
interrupt key (press Ctrl+c).

You can enter a command on several lines by typing a backslash (\) just before you
press Enter. The backslash “escapes” the Enter key, effectively continuing the same
command line to the next line. In the next example, the cp command is entered on
three lines. The first two lines end in a backslash, effectively making all three lines one
command line.

$cp -i\
mydata \
/home/george/myproject/newdata

You can also enter several commands on the same line, by separating them with a
semicolon (; ). In effect, the semicolon operates as an execute operation. Commands
will be executed in the sequence in which they are entered. The following command
executes an 1s command followed by a date command:

$ 1s ; date

You can also conditionally run several commands on the same line with the &&
operator. A command is executed only if the previous command is true. This feature is
useful for running several dependent scripts on the same line. In the next example, the
1s command runs only if the date command is successfully executed.

$ date && 1s
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Tip Commands can also be run as arguments on a command line, using their
results for other commands. To run a command within a command line, you encase
the command in back quotes.

Command-Line Editing

The BASH shell, which is your default shell, has special command-line editing
capabilities that you may find helpful as you learn Linux (see Table 10-2). You can easily
modify commands you have entered before executing them, moving anywhere on

the command line and inserting or deleting characters. This is particularly helpful for
complex commands.

Table 10-2. BASH Command-Line Editing Operations

Movement Command  Operation

Ctrl+f, right-arrow Moves forward a character

Ctrl+b, left arrow Moves backward a character

Ctrl+a or Home
Ctrl+e or End
Alt+f

Alt+b

Ctrl-+l

Editing Command

Ctrl+d or Del

Ctrl+h or Backspace

Ctrl+k
Ctrl+u
Ctrl+w

Ctrl+c

Moves to beginning of line

Moves to end of line

Moves forward a word (not on terminal window)
Moves backward a word

Clears screen and places line at top

Operation

Deletes character cursor is on

Deletes character before the cursor

Cuts remainder of line from cursor position
Cuts from cursor position to beginning of line
Cuts previous word

Cuts entire line and starts a new one
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Table 10-2. (continued)

Editing Command Operation

Alt+d Cuts the remainder of a word

Alt+Del Cuts from the cursor to the beginning of a word

Ctrl+y Pastes previous cut text

Alt+y Pastes from set of previously cut text

Ctrl+y Pastes previous cut text

Ctrl+v Inserts quoted text; used for inserting control or meta (Alt)
keys as text, such as Ctrl-b for backspace or Ctrl-t for tabs

Alt+t Transposes current and previous word

Alt-+l Lowercases current word

Alt+u Uppercases current word

Al+-c Capitalizes current word

Ctrl+Shift+_ Undoes previous change

You can press Ctrl+f or use the right arrow key to move forward a character, or the
Ctrl+b or left arrow key to move back a character. Ctrl+d or Del deletes the character the
cursor is on, and Ctrl+h or Backspace deletes the character preceding the cursor. To add
text, you use the arrow keys to move the cursor to where you want to insert text and type
the new characters.

You can even cut words with the Ctrl+w or Alt+d keys and then press the Ctrl+y keys
to paste them back in at a different position, effectively moving the words. As a rule, the
Ctrl version of the command operates on characters, and the Alt version works on words,
such as Ctrl+t to transpose characters, and Alt+t to transpose words. At any time, you
can press Enter to execute the command. For example, if you make a spelling mistake
when entering a command, rather than reentering the entire command, you can use the
editing operations to correct the mistake. The actual associations of keys and their tasks,
along with global settings, are specified in the /etc/inputrc file.

The editing capabilities of the BASH shell command line are provided by Readline.
Readline supports numerous editing operations. You can even bind a key to a selected
editing operation. Readline uses the /etc/inputrc file to configure key bindings.
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This file is read automatically by your /etc/profile shell configuration file when you
log in. Users can customize their editing commands by creating an . inputrc file in their
home directory (this is a dot file). It may be best to first copy the /etc/inputrc file as
your .inputrc file and then edit it. The /etc/profile will first check for alocal . inputrc
file before accessing the /etc/inputrc file. You can find out more about Readline in the
BASH shell reference manual at www. gnu.org/manual/bash.

Command and Filename Completion

The BASH command line has a built-in feature that performs command and filename
completion. Automatic completions can be affected by pressing the Tab key. If you enter
an incomplete pattern as a command or filename argument, you can press the Tab key to
activate the command and filename completion feature, which completes the pattern. A
directory will have a forward slash (/) attached to its name. If more than one command
or file has the same prefix, the shell simply beeps and waits for you to press the Tab key
again. It then displays a list of possible command completions and waits for you to add
enough characters to select a unique command or filename. For situations in which you
know multiple possibilities are likely, you can just press the Esc key instead of two Tabs.
In the next example, the user issues a cat command with an incomplete filename. When
the user presses the Tab key, the system searches for a match and, when it finds one, fills
in the filename. The user can then press Enter to execute the command.

$ cat pre <tab>
$ cat preface

The automatic completions also work with the names of variables, users, and hosts.
In this case, the partial text has to be preceded by a special character, indicating the type
of name. A listing of possible automatic completions follows:

Filenames begin with any text or /.
Shell variable text begins with a $ sign.
Username text begins with a ~ sign.
Hostname text begins with a @.

Commands, aliases, and text in files begin with normal text.
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Variables begin with a $ sign, so any text beginning with a dollar sign is treated as a
variable to be completed. Variables are selected from previously defined variables, such
as system shell variables. Usernames begin with a tilde (~). Hostnames begin with a
@ sign, with possible names taken from the /etc/hosts file. For example, to complete the
variable HOME given just $HOM, simply press a Tab key.

$ echo $HOM <tab>
$ echo $HOME

If you entered just an H, then you could press the Tab key twice to see all possible
variables beginning with H. The command line is redisplayed, letting you complete the

name.

$ echo $H <tab> <tab>
$HISTCMD $HISTFILE $HOME $HOSTTYPE HISTFILE $HISTSIZE $HISTNAME
$ echo $H

You can also specifically select the kind of text to complete, using corresponding
command keys. In this case, it does not matter what kind of sign a name begins with.

For example, pressing Alts+~ will treat the current text as a username. Pressing
Alt+@ will treat it as a hostname, and Alt+$, as a variable. Pressing Alt+! will treat it
as a command. To display a list of possible completions, press the Ctrl+x key with the
appropriate completion key, as in Ctrl+x+$ to list possible variable completions. See
Table 10-3 for a complete listing.

Table 10-3. Command-Line Text Completion Commands

Command (Ctrl+r for Listing Possible Description

Completions)

Tab Automatic completion

Tab Tab or Esc Lists possible completions

Alt+/, Ctrl-+r+/ Filename completion, normal text for automatic

Alt+$, Ctrl+r+$ Shell variable completion, $ for automatic

Alt+~, Ctrl+-r+~ Username completion, ~ for automatic

Alt+@, Cirl+r+@ Hostname completion, @ for automatic

Alt+!, Ctrl+r+! Command-name completion, normal text for automatic
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History

The BASH shell keeps a history list of your previously entered commands. You can
display each command, in turn, on your command line by pressing the up arrow key.
Press the down arrow key to move down the list. You can modify and execute any of
these previous commands when you display them on the command line. The list of
history command is kept in your .bash_history file.

Tip The ability to redisplay a command is helpful when you have already
executed a command you had entered incorrectly. In this case, you would be
presented with an error message and a new, empty command line. By pressing the
up arrow key, you can redisplay the previous command, make corrections to it, and
then execute it again. This way, you don’t have to enter the whole command again.

History Events

In the BASH shell, the history utility keeps a record of the most recent commands you
have executed. The commands are numbered, starting at 1, and a limit exists to the
number of commands remembered. The default is 500. The history utility is a kind of
short-term memory, keeping track of the most recent commands you have executed. To
see the set of your most recent commands, type history on the command line and press
Enter. A list of your most recent commands is then displayed, preceded by a number.
Table 10-4 lists the different commands for referencing the history list.

history

cp mydata today
vi mydata

mv mydata reports
cd reports

1s

Ui B W N P
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Table 10-4. History Commands and History Event References

History Command

Description

Ctrl+n or down arrow
Ctrl+p or up arrow
Alt+<

Alt+>

Alt+n

Alt+p

Ctrl+s

Ctrl+r

fc event-reference

History Event Reference
levent num

I

Icharacters
I?pattern?

I-event num

L num-num

Moves down to the next event in the history list
Moves up to the previous event in the history list
Moves to the beginning of the history event list
Moves to the end of the history event list

Forward search, next matching item

Backward search, previous matching item

Forward search history, forward incremental search
Reverse search history, reverse incremental search

Edits an event with the standard editor and then executes itOptions:
-1 lists recent history events; same as history command -e
editor event-reference invokes a specified editor to edit a
specific event

References an event with an event number
References the previous command

References an event with beginning characters
References an event with a pattern in the event
References an event with an offset from the first event

References a range of events

Each of these commands is technically referred to as an event. An event describes

an action that has been taken—a command that has been executed. The events are

numbered according to their sequence of execution. The most recent event has the

highest number. Each of these events can be identified by its number or beginning

characters in the command.

The history utility lets you reference a former event, placing it on your command line

so that you can execute it. The easiest way to do this is to use the up arrow and down arrow

keys to place history events on the command line, one at a time. You need not display

the list first with history. Pressing the up arrow key once places the last history event on
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the command line. Pressing it again places the next history event on the command line.
Pressing the down arrow key places the previous event on the command line.

You can use certain control and meta keys to perform other history operations, such
as searching the history list. A meta key is the Alt key, and the Esc key on keyboards that
have no Alt key. The Alt key is used here. Pressing Alt+< will move you to the beginning
of the history list; Alt+n will search it. Ctrl+s and Ctrl+r will perform incremental
searches, displaying matching commands as you type in a search string.

Tip If more than one history event matches what you have entered, you will hear
a beep, and you can then enter more characters to help uniquely identify the event.

You can also reference and execute history events using the ! history command. The
I is followed by a reference that identifies the command. The reference can be either the
number of the event or a beginning set of characters in the event. In the next example,
the third command in the history list is referenced first by number and then by the
beginning characters:

$ 13
mv mydata reports
$ !'mv my

mv mydata reports

You can also reference an event using an offset from the end of the list. A negative
number will offset from the end of the list to that event, thereby referencing it. In the next
example, the fourth command, vi mydata, is referenced using a negative offset and then
executed. Remember that you are offsetting from the end of the list—in this case, event
five—up toward the beginning of the list, event one. An offset of 4 beginning from event
five places you at event two.

$ 1-4
vi mydata

To reference the last event, you follow it with an !, as in !'!. In the following example,
the command ! | executes the last command the user executed—in this case, 1s:

$ 11
1s
mydata today reports
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You can also perform a search of the listing of previous commands by entering
Ctrl-r on the command line. You are prompted to enter a pattern for a search.

$ (revrse-isarch) 'vi' : vi mydata

Filename Expansion: *, 2, [ ]

Filenames are the most common arguments used in a command. Often, you will know
only part of the filename, or you will want to reference several filenames that have the
same extension or begin with the same characters. The shell provides a set of special
characters that search out, match, and generate a list of filenames. These are the asterisk,
the question mark, and brackets (*, ?, and [ ]). Given a partial filename, the shell uses
these matching operators to search for files and expand to a list of filenames found.

The shell replaces the partial filename argument with the expanded list of matched
filenames. This list of filenames can then become the arguments for commands such as
1s, which can operate on many files. Table 10-5 lists the shell’s file-expansion characters.

Table 10-5. Shell Symbols

Common Shell Symbol Execution

Enter Executes a command line.

; Separates commands on the same command line.

" command” Executes a command as part of another command, using the

command's output as a parameter to the primary command.

$(command) Executes a command and uses the output of that command in
whatever statement or command it is used in.

[] Matches on a class of possible characters in filenames.

\ Quotes the following character; used to quote special characters.

| Pipes the standard output of one command as input for another
command.

& Executes a command in the background.

! References a history command.

(continued)
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Table 10-5. (continued)

File-Expansion Symbol Execution

* Matches on any set of characters in filenames.

? Matches on any single character in filenames.

[] Matches on a class of characters in filenames.

Redirection Symbol Execution

> Redirects the standard output to a file or device, creating the file if it

does not exist and overwriting the file if it does exist.

> The exclamation point forces the overwriting of a file if it already
exists.

< Redirects the standard input from a file or device to a program.

>> Redirects the standard output to a file or device, appending the output

to the end of the file.

Standard Execution
Error-Redirection Symbol

2> Redirects the standard error to a file or device.
2>> Redirects and appends the standard error to a file or device.
2581 Redirects the standard error to the standard output.

Matching Multiple Characters

The asterisk (*) references files beginning or ending with a specific set of characters. You
place the asterisk before or after a set of characters that form a pattern to be searched for
in filenames.

If the asterisk is placed before the pattern, filenames that end in that pattern are
searched for. If the asterisk is placed after the pattern, filenames that begin with that
pattern are searched for. Any matching filename is copied into a list of filenames
generated by this operation.

In the next example, all filenames beginning with the pattern doc are searched for
and a list is generated. Then all filenames ending with the pattern day are searched
for and a list is generated. The last example shows how the * can be used in any
combination of characters.
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$ 1s

doc1 doc2 document docs mydoc monday Tuesday
$ 1s doc*

doc1 doc2 document docs

$ 1s *day

monday tuesday

$ 1s m*d*
monday

$

Filenames often include an extension specified with a period and followed by a
string denoting the file type, such as . c for C files, . cpp for C++ files, or even . jpg
for JPEG image files. The extension has no special status and is only part of the
characters making up the filename. Using the asterisk makes it easy to select files
with a given extension. In the next example, the asterisk is used to list only those
files with a . c extension. The asterisk placed before the . c constitutes the argument
for 1s.

$ 1s *.c

calc.c main.c

You can use * with the rm command to erase several files at once. The asterisk
first selects a list of files with a given extension, or beginning or ending with a given
set of characters, and then it presents this list of files to the rm command to be
erased. In the following example, the rm command erases all files beginning with the
pattern doc:

$ rm doc*

Use the * file-expansion character carefully and sparingly with the rm command. The
combination can be dangerous. A misplaced * in an rm command without the -1 option
could easily erase all the files in your current directory. The -1i option will first prompt
you to confirm whether the file should be deleted.
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Matching Single Characters

The question mark (?) matches only a single incomplete character in filenames. Suppose
you want to match the files doc1 and docA, but not the file called document. Whereas

the asterisk will match filenames of any length, the question mark limits the match to
one extra character. The following example matches files that begin with the word doc,
followed by a single differing letter:

$ 1s

doc1 docA document
$ 1s doc?

doc1 docA

Matching a Range of Characters

Whereas the * and ? file-expansion characters specify incomplete portions of a filename,
the brackets ([ ]) enable you to specify a set of valid characters to search for. Any
character placed in the brackets will be matched in the filename. Suppose you want to
list files beginning with doc but ending only in 1 or A. You are not interested in filenames
ending in 2 or B, or any other character. Here is how it is done:

$ 1s

doc1 doc2 doc3 docA docB docD document
$ 1s doc[1A]

doc1 docA

You can also specify a set of characters as a range, rather than listing them one by
one. A dash placed between the upper and lower bounds of a range of characters selects
all characters in that range. The range is usually determined by the character set in use.
In an ASCII character set, the range “a-g” will select all lowercase alphabetic characters
from a through g, inclusive. In the next example, files beginning with the pattern doc
and ending in characters 1 through 3 are selected. Then, those ending in characters B
through E are matched.

$ 1s doc[1-3]
docl doc2 doc3
$ 1s doc[B-E]
docB docD
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You can combine the brackets with other file-expansion characters to form flexible
matching operators. Suppose you want to list only filenames ending in either a .c or
.0 extension but no other extension. You can use a combination of the asterisk and
brackets: * [co]. The asterisk matches all filenames, and the brackets match only
filenames with extension .c or .0.

$ 1s *.[co]
main.c main.o calc.c

Matching Shell Symbols

At times, a file-expansion character is actually part of a filename. In these cases, you
have to quote the character by preceding it with a backslash (\) to reference the file. In
the next example, the user must reference a file that ends with the ? character, called
answers?. The ? is, however, a file-expansion character and would match any filename
beginning with “answers” that has one or more characters. In this case, the user quotes
the ? with a preceding backslash to reference the filename.

$ 1s answers\?
answers?

Placing the filename in double quotes will also quote the character.

$ 1s "answers?"
answers?

This is also true for filenames or directories that have whitespace characters such
as the space character. In this case, you can either use the backslash to quote the space
character in the file or directory name or place the entire name in double quotes.

$ 1s My\ Documents
My Documents
$ 1s "My Documents”
My Documents
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Generating Patterns

Although not a file-expansion operation, {} is often useful for generating names that you
can use to create or modify files and directories. The braces operation only generates a
list of names. It does not match on existing filenames. Patterns are placed in the braces
and separated with commas. Any pattern placed in the braces will be used to generate a
version of the pattern, using either the preceding or following pattern, or both. Suppose
you want to generate a list of names beginning with doc, but ending only in the patterns
ument, final, and draft. Here is how it is done:

$ echo doc{ument,final,draft}
document docfinal docdraft

Because the names generated do not have to exist, you could use the {} operation in
a command to create directories, as follows:

$ mkdir {fall,winter,spring}report
$ 1s
fallreport springreport winterreport

Standard Input/Output and Redirection

The data in input and output operations is organized like a file. Data input at the
keyboard is placed in a data stream arranged as a continuous set of bytes. Data

output from a command or program is also placed in a data stream and arranged as a
continuous set of bytes. This input data stream is referred to in Linux as the standard
input, while the output data stream is called the standard output. A separate output data
stream is reserved solely for error messages; it is called the standard error.

Because the standard input and standard output have the same organization as that
of a file, they can easily interact with files. Linux has a redirection capability that lets you
easily move data in and out of files. You can redirect the standard output so that instead
of displaying the output on a screen, you can save it in a file. You can also redirect the
standard input away from the keyboard to a file, so that input is read from a file instead of
from your keyboard.

406



CHAPTER 10  SHELLS

When a Linux command is executed that produces output, this output is placed
in the standard output data stream. The default destination for the standard output
data stream is a device—in this case, the screen. Devices, such as the keyboard
and screen, are treated as files. They receive and send out streams of bytes with the
same organization as that of a byte-stream file. The screen is a device that displays a
continuous stream of bytes. By default, the standard output will send its data to the
screen device, which will then display the data.

For example, the 1s command generates a list of all filenames and outputs this list to
the standard output. Next, this stream of bytes in the standard output is directed to the
screen device. The list of filenames is then printed on the screen. The cat command also
sends output to the standard output. The contents of a file are copied to the standard
output, whose default destination is the screen. The contents of the file are then displayed
on the screen. Table 10-6 lists the different ways you can use the redirection operators.

Table 10-6. The Shell Operations

Command Execution
Enter Executes a command line.

; Separates commands on the same command line.
command\opts args Enters a backslash before a carriage return, to continue entering
a command on the next line.

" command” Executes a command.
Special Characters for Execution

Filename Expansion

* Matches on any set of characters.

? Matches on any single characters.

[] Matches on a class of possible characters.

\ Quotes the following character; used to quote special characters.

(continued)
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Table 10-6. (continued)

Redirection Execution

command > filename Redirects the standard output to a file or device, creating the file
if it does not exist and overwriting the file if it does exist.

command < filename Redirects the standard input from a file or device to a program.

command >> filename Redirects the standard output to a file or device, appending the
output to the end of the file.

command 2> filename Redirects the standard error to a file or device.

command 2>> filename Redirects and appends the standard error to a file or device.

command 2>&1 Redirects the standard error to the standard output in the Bourne
shell.

command >& filename Redirects the standard error to a file or device in the C shell.

Pipe Execution

command | command Pipes the standard output of one command as input for another
command.

Redirecting the Standard Output: > and >>

Suppose that instead of displaying a list of files on the screen, you would like to save this
listin a file. In other words, you would like to direct the standard output to a file rather
than the screen. To do this, you place the output redirection operator, the greater-than
sign (>), followed by the name of a file on the command line, after the Linux command.
In the following example, the output of the 1s command is redirected from the screen
device to afile:

$ 1s -1 *.c > programlist

The redirection operation creates the new destination file. If the file already exists,
it will be overwritten with the data in the standard output. You can set the noclobber
feature to prevent overwriting an existing file with the redirection operation. In this case,
the redirection operation on an existing file will fail. You can overcome the noclobber
feature by placing an exclamation point after the redirection operator. You can place
the noclobber command in a shell configuration file to make it an automatic default
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operation. The following example sets the noclobber feature for the BASH shell and then
forces the overwriting of the oldarticle file if it already exists:

$ set -o noclobber
$ cat myarticle >! oldarticle

Although the redirection operator and the filename are placed after the command,
the redirection operation is not executed after the command. In fact, it is executed before
the command. The redirection operation creates the file and sets up the redirection
before it receives any data from the standard output. If the file already exists, it will be
destroyed and replaced by a file of the same name. In effect, the command generating
the output is executed only after the redirected file has been created.

In the next example, the output of the 1s command is redirected from the screen
device to a file. First the 1s command lists files, and in the next command, 1s redirects its
file list to the 1istf file. Then the cat command displays the list of files saved in 1istf.
Notice that the list of files in 1istf includes the 1istf filename. The list of filenames
generated by the 1s command includes the name of the file created by the redirection
operation—in this case, 1istf. The 1istf file is first created by the redirection operation,
then the 1s command lists it along with other files. This file list output by 1s is then
redirected to the 1istf file, instead of being printed on the screen.

$ 1s

mydata intro preface

$ 1s > listf

$ cat listf

mydata intro listf preface

Errors occur when you try to use the same filename for an input file for the command
and for the redirected destination file. In this case, because the redirection operation is
executed first, the input file, because it exists, is destroyed and replaced by a file of the
same name. When the command is executed, it finds an input file that is empty.

You can also append the standard output to an existing file using the >> redirection
operator. Instead of overwriting the file, the data in the standard output is added at the
end of the file. In the next example, the myarticle and oldarticle files are appended
tothe allarticles file. The allarticles file will then contain the contents of both
myarticle and oldarticle.

$ cat myarticle »>> allarticles
$ cat oldarticle >> allarticles
409



CHAPTER 10  SHELLS

The Standard Input

Many Linux commands can receive data from the standard input. The standard input
itself receives data from a device or a file. The default device for the standard input is

the keyboard. Characters typed on the keyboard are placed in the standard input, which
is then directed to the Linux command. Just as with the standard output, you can also
redirect the standard input, receiving input from a file rather than the keyboard. The
operator for redirecting the standard input is the less-than sign (<). In the next example,
the standard input is redirected to receive input from the myarticle file, rather than the
keyboard device (use Ctrl+d to end the typed input). The contents of myarticle are read
into the standard input by the redirection operation. Then the cat command reads the
standard input and displays the contents of myarticle.

$ cat < myarticle
hello Christopher
How are you today

$

You can combine the redirection operations for both standard input and standard
output. In the next example, the cat command has no filename arguments. Without
filename arguments, the cat command receives input from the standard input and
sends output to the standard output. However, the standard input has been redirected
to receive its data from a file, while the standard output has been redirected to place its
data in a file.

$ cat < myarticle > newarticle

Pipes: |

You may encounter situations in which you have to send data from one command to
another. In other words, you may want to send the standard output of a command to
another command, rather than to a destination file. Suppose you want to send a list of
your filenames to the printer to be printed. You need two commands to do this: the 1s
command to generate a list of filenames and the 1pr command to send the list to the
printer. In effect, you have to take the output of the 1s command and use it as input for
the 1pr command. You can think of the data as flowing from one command to another.
To form such a connection in Linux, you use what is called a pipe. The pipe operator
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(|, the vertical bar character) placed between two commands forms a connection
between them. The standard output of one command becomes the standard input for
the other. The pipe operation receives output from the command placed before the pipe
and sends this data as input to the command placed after the pipe. As shown in the next
example, you can connect the 1s command and the 1pr command with a pipe. The list
of filenames output by the 1s command is piped into the 1pr command.

$ 1s | lpr

You can combine the pipe operation with other shell features, such as file-expansion
characters, to perform specialized operations. The next example prints only files with
a .c extension. The 1s command is used with the asterisk and . c to generate a list of
filenames with the . c extension. Then this list is piped to the 1pr command.

$ 1s *.c | lpr

In the preceding example, a list of filenames was used as input. What is important
to note is that pipes operate on the standard output of a command, whatever that might
be. The contents of whole files or even several files can be piped from one command to
another. In the following example, the cat command reads and outputs the contents of
the mydata file, which are then piped to the 1pr command:

$ cat mydata | lpr

Linux has many commands that generate modified output. For example, the sort
command takes the contents of a file and generates a version with each line sorted
in alphabetic order. The sort command works best with files that are lists of items.
Commands such as sort that output a modified version of its input are referred to as
filters. Filters are often used with pipes. In the next example, a sorted version of mylist is
generated and piped into the more command for display on the screen. The original file,
mylist, has not been changed and is not sorted. Only the output of sort in the standard
output is sorted.

$ sort mylist | more

The standard input piped into a command can be more carefully controlled with the
standard input argument (-). When you use the dash as an argument for a command, it
represents the standard input.
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Values from UNIX Commands: Back Quotes

Although you can create variable values by typing in characters or character strings,
you can also obtain values from other commands. To assign the result of command

to a variable, you first need to execute the command. If you place a command in back
quotes on the command line, that command is first executed and its result becomes an
argument on the command line. In the case of assignments, the result of a command can
be assigned to a variable by placing the command within back quotes to first execute it
The back quotes can be thought of as a kind of expression consisting of a command to
be executed whose result is then assigned to the variable. The characters making up the
command itself are not assigned. In the next example, the command 1s *.c is executed
and its result is then assigned to the variable 1istc. 1s *.c generates a list of all files
with an . c extension. This list of files will then be assigned to the 1istc variable.

$ listc="1s *.c’
$ echo $listc
main.c prog.c lib.cs

You could also use the $(command) operation to the same effect.

$ listc=$(1s *.c)
$ echo $listc
main.c prog.c lib.cs

You need to keep in mind the difference between single quotes and back quotes. Single
quotes treat a command as a set of characters. Back quotes force execution of the UNIX
command. There may be times when you accidentally enter single quotes, when you mean
to use back quotes. In the following first example, the assignment for the 1scc variable has
single quotes, not back quotes, placed around the 1s *.c command. In this case, 1s *.c
are just characters to be assigned to the variable 1scc. In the second example, back quotes
are placed around the 1s *.c command, forcing evaluation of the command. A list of
filenames ending in . c is generated and assigned as the value of 1scc.

$ 1lscc='ls *.c'
$ echo $1lscc
1s *.c

$ 1scc="1s *.c’
$ echo $lscc
main.c prog.c
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Linux Files

You can name a file using any letters, underscores, and numbers. You can also include
periods and commas. Except in certain special cases, you should never begin a filename
with a period. Other characters, such as slashes, question marks, or asterisks, are
reserved for use as special characters by the system and should not be part of a filename.
Filenames can be as long as 256 characters. Filenames can also include spaces, although
to reference such filenames from the command line, be sure to encase them in quotes.
On a desktop such as GNOME or KDE, you do not have to use quotes. A filename cannot
have the same name as a subdirectory within the same directory. Directories are treated
as type of file.

You can include an extension as part of a filename. A period is used to distinguish
the filename proper from the extension. Extensions can be useful for categorizing your
files. You are probably familiar with certain standard extensions that have been adopted
by convention. For example, C source code files always have a . c extension. Files that
contain compiled object code have an .0 extension. You can make up your own file
extensions. The following examples are all valid Linux filenames. Keep in mind that to
reference the name with spaces on the command line, you have to encase it in quotes,
for example, “New book review.”

preface
chapter2
9700info

New Revisions
calc.c
intro.bk1

New book review

Special initialization files are also used to hold shell configuration commands. These
are the hidden, or dot, files, which begin with a period. Dot files used by commands and
applications have predetermined names, such as the .mozilla directory used to hold
your Mozilla data and configuration files. Recall that when you use 1s to display your
filenames, the dot files will not be displayed. To include the dot files, you must use 1s
with the -a option.

The 1s -1 command displays detailed information about a file. First, the
permissions are displayed, followed by the number of links, the owner of the file, the
name of the group to which the user belongs to, the file size in bytes, the date and time
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the file was last modified, and the name of the file. Permissions indicate who can access
the file: the user, members of a group, or all other users. The group name indicates the
group permitted to access the file object. The file type for mydata is that of an ordinary
file. Only one link exists, indicating the file has no other names and no other links. The
owner’s name is chris, the same as the login name, and the group name is weather.
Other users probably also belong to the weather group. The size of the file is 207 bytes,
and it was last modified on February 20 at 11:55 a.m. The name of the file is mydata.

If you want to display this detailed information for all the files in a directory, simply
use the 1s -1 command without an argument.

$1s -1

-Tw-r--I-- 1 chris weather 207 Feb 20 11:55 mydata
-Tw-IW-Y-- 1 chris weather 568 Feb 14 10:30 today
-Tw-Tw-I-- 1 chris weather 308 Feb 17 12:40 monday

All files in Linux have one physical format, a byte stream, which is simply a sequence
of bytes. This allows Linux to apply the file concept to every data component in the
system. Directories are classified as files, as are devices. Treating everything as a file
allows Linux to organize and exchange data more easily. The data in a file can be sent
directly to a device, such as a screen, because a device interfaces with the system using
the same byte-stream file format used by regular files.

This same file format is used to implement other operating system components.
The interface to a device, such as the screen or keyboard, is designated as a file. Other
components, such as directories, are themselves byte-stream files, but they have a
special internal organization. A directory file contains information about a directory,
organized in a special directory format. Because these different components are treated
as files, they can be said to constitute different file types. A character device is one file
type. A directory is another file type. The number of these file types may vary according
to your specific implementation of Linux. Five common types of files exist, however:
ordinary files, directory files, first-in first-out (FIFO) pipes, character device files, and
block device files. Although you may rarely reference a file’s type, it can be useful to know
when searching for directories or devices.

Although all ordinary files have a byte-stream format, they may be used in
different ways. The most significant difference is between binary and text files.
Compiled programs are examples of binary files. However, even text files can be
classified according to their different uses. You can have files that contain
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C programming source code or shell commands, or even a file that is empty. The file
could be an executable program or a directory file. The Linux file command helps
you determine what a file is used for. It examines the first few lines of a file and tries
to determine a classification for it. The file command looks for special keywords or
special numbers in those first few lines, but it is not always accurate. In the following
example, the file command examines the contents of two files and determines a
classification for them:

$ file monday reports
monday: text
reports: directory

If you have to examine the entire file byte by byte, you can do so with the od (octal
dump) command, which performs a dump of a file. By default, it prints every byte in its
octal representation. However, you can also specify a character, decimal, or hexadecimal
representation. The od command is helpful when you have to detect any special
character in your file or if you want to display a binary file.

The File Structure

Linux organizes files into a hierarchically connected set of directories. Each directory
may contain either files or other directories. In this respect, directories perform two
important functions. A directory holds files, much like files held in a file drawer, and
a directory connects to other directories, like a branch in a tree is connected to other
branches. Because of the similarities to a tree, such a structure is often referred to as a
tree structure.

The Linux file structure branches into several directories, beginning with a root
directory, /. Within the root directory, several system directories contain files and
programs that are features of the Linux system. The root directory also contains
a directory called home that contains the home directories of all the users in the
system. Each user’s home directory, in turn, contains the directories the users have
made for their own use. Each of these can also contain directories. Such nested
directories branch out from the user’s home directory. Table 10-7 lists the basic
system directories.
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Table 10-7. Standard System Directories in Linux

Directory Function

/ Begins the file system structure, called the root.

/home Contains users’ home directories.

/bin Holds all the standard commands and utility programs.

/ust Holds those files and commands used by the system; this directory breaks down
into several subdirectories.

/usr/bin Holds user-oriented commands and utility programs.

/usr/sbin Holds system administration commands.

/usr/1ib Holds libraries for programming languages.

/usxr/share/  Holds Linux documentation.

doc

/usxr/share/  Holds the online man files.

man

/var/spool Holds spooled files, such as those generated for printing jobs and network transfers.

/sbin Holds system administration commands in the system.

/var Holds files that vary, such as mailbox files.

/dev Holds file interfaces for devices such as the terminals and printers (dynamically
generated by udev; do not edit).

/etc Holds system configuration files and any other system files.

/sys The sysfs file system listing configuration information for all the devices on your
system.

/proc An older process file system listing kernel information, including device information.

Home Directories

When you log in to the system, you are placed within your home directory. The name

given to this directory by the system is the same as your login name. Any files you create

when you first log in are organized within your home directory. Within your home

directory, you can create more directories. You can then change to these directories and
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store files in them. The same is true for other users on the system. Each user has a home
directory, identified by the appropriate login name. Users, in turn, can create their own
directories.

You can access a directory either through its name or by making it your working
directory. Each directory is given a name when it is created. You can use this name in file
operations to access files in that directory. You can also make the directory your working
directory. If you do not use any directory names in a file operation, the working directory
will be accessed. The working directory is the one from which you are currently working.
When you log in, the working directory is your home directory, which usually has the
same name as your login name. You can change the working directory by using the cd
command to move to another directory.

Pathnames

The name you give to a directory or file when you create it is not its full name. The full
name of a directory is its pathname. The hierarchically nested relationship among
directories forms paths, and these paths can be used to identify and reference any
directory or file uniquely or absolutely. Each directory in the file structure can be said
to have its own unique path. The actual name by which the system identifies a directory
always begins with the root directory and consists of all directories nested below that
directory.

In Linux, you write a pathname by listing each directory in the path, separated
from the last by a forward slash. A slash preceding the first directory in the path
represents the root. The pathname for the chris directory is /home/chris. If the
chris directory has a subdirectory called reports, then the entire pathname for the
reports directory would be /home/chris/reports. Pathnames also apply to files.
When you create a file within a directory, you give the file a name. The actual name
by which the system identifies the file, however, is the filename combined with the
path of directories from the root to the file’s directory. As an example, the pathname
for monday is /home/chris/reports/monday (the root directory is represented by the
first slash). The path for the monday file consists of the root, home, chris, and reports
directories and the filename monday.

Pathnames may be absolute or relative. An absolute pathname is the complete
pathname of a file or directory beginning with the root directory. A relative pathname
begins from your working directoryj; it is the path of a file relative to your working
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directory. The working directory is the one you are currently operating in. Using the
previous example, if chris is your working directory, the relative pathname for the file
monday is reports/monday. The absolute pathname for monday is /home/chris/reports/
monday.

The absolute pathname from the root to your home directory can be especially
complex and, at times, even subject to change by the system administrator. To make it
easier to reference, you can use the tilde (~) character, which represents the absolute
pathname of your home directory. You must specify the rest of the path from your
home directory. In the next example, the user references the monday file in the reports
directory. The tilde represents the path to the user’s home directory, /home/chris, then
the rest of the path to the monday file is specified, as follows:

$ cat ~/reports/monday

System Directories

The root directory that begins the Linux file structure contains several system directories
that contain files and programs used to run and maintain the system. Many also contain

other subdirectories with programs for executing specific features of Linux. For example,
the directory /usr/bin contains the various Linux commands that users execute, such as
1pr. The directory /bin holds system level commands.

Managing Directories: mkdir, rmdir, Is, cd, and pwd

You can create and remove your own directories, as well as change your working
directory, with the mkdir, rmdir, and cd commands. Each of these commands can

take as its argument the pathname for a directory. The pwd command displays the
absolute pathname of your working directory. In addition to these commands, the
special characters represented by a single dot, a double dot, and a tilde can be used

to reference the working directory, the parent of the working directory, and the home
directory, respectively. Taken together, these commands enable you to manage your
directories. You can create nested directories, move from one directory to another, and
use pathnames to reference any of your directories. Those commands commonly used to
manage directories are listed in Table 10-8.
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Table 10-8. Directory Commands

Command

Execution

mkdir directory
rmdir directory
1s -F
1s -R

cd directory

pwd

Creates a directory.

Erases a directory.

Lists the directory name with a preceding slash.

Lists the working directory as well as all subdirectories.

Changes to the specified directory, making it the working directory. cd
without a directory name changes back to the home directory:$ cd
reports

Displays the pathname of the working directory.

directory /filename A slash is used in pathnames to separate each directory name. In the

~/pathname

j pattern

jumpstat

case of pathnames for files, a slash separates the preceding directory
names from the filename.

References the parent directory. You can use it as an argument or as
part of a pathname:$ cd ..$ mv ../larisa oldarticles

References the working directory. You can use it as an argument or as
part of a pathname:$ 1s .

The tilde is a special character that represents the pathname for the
home directory. It is useful when you have to use an absolute pathname
for a file or directory:$ cp monday ~/today

Use the autojump command to quickly jump to a frequently used
directory using a matching pattern.

Statistics showing frequently used directories accessible with autojump.

Creating and Deleting Directories

You create and remove directories with the mkdir and rmdir commands. In either case,

you can also use pathnames for the directories. In the next example, the user creates the

directory reports. Then the user creates the directory articles, using a pathname.

$ mkdir reports

$ mkdir /home/chris/articles
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If the intervening parent directories in a pathname do not yet exist, you can have
them created automatically with the -p option. In the following example, the intervening
parent subdirectories project/newproject, indicated by the pathname, do not yet exist.
Using the -p option creates them automatically, creating the project, newproject, and
proposals subdirectories. Without the -p option, you would receive an error stating the
directories do not exist.

$ mkdir -p /home/chris/project/newproject/proposal

You can remove a directory with the rmdir command followed by the directory
name. In the following example, the user removes the directory reports with the rmdir
command:

$ rmdir reports

To remove a directory and all its subdirectories, you use the rm command with the -r
option. This is a very powerful command and could be used to erase all your files. You
will be prompted for each file. To remove all files and subdirectories without prompts,
add the -f option. The following example deletes the reports directory and all its
subdirectories:

m -rf reports

Displaying Directory Contents

You have seen how to use the 1s command to list the files and directories in your working
directory. To distinguish between file and directory names, however, you must use the 1s
command with the -F option. A slash is then placed after each directory name in the list.

$ 1s

weather reports articles

$ 1s -F

weather reports/ articles/

The 1s command also takes as an argument any directory name or directory
pathname. This enables you to list the files in any directory without first having to
change to that directory. In the next example, the 1s command takes as its argument the
name of a directory, reports. Then the 1s command is executed again, only this time,
the absolute pathname of reports is used.
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$ 1s reports

monday tuesday

$ 1s /home/chris/reports
monday tuesday

$

Moving Through Directories

The cd command takes as its argument the name of the directory to which you want

to move. The name of the directory can be the name of a subdirectory in your working
directory or the full pathname of any directory on the system. If you want to change
back to your home directory, you need to enter only the cd command by itself, without a
filename argument.

$ cd reports
$ pwd
/home/chris/reports

As a complement to the cd command, you can use the autojump command. Install
the autojump package. autojump keeps a record of your frequently accessed directories.
You can then use the j command with a partial-matching pattern to quickly jump (cd) to
that directory.

$ j xep
$ pwd
/home/chris/reports

Jumpstart keeps a database of your cd operations and uses it to determine the
directory you want. The jumpstat command displays the ranked directories.

Referencing the Parent Directory

A directory always has a parent (except, of course, for the root). For example, in the
preceding listing, the parent for reports is the chris directory. When a directory is
created, two entries are made: one represented with a dot (. ), and the other with double
dots (. .). The dot represents the pathnames of the directory, and the double dots
represent the pathname of its parent directory. Double dots, used as an argument in a
command, reference a parent directory. The single dot references the directory itself.
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You can use the single dot to reference your working directory, instead of using its
pathname. For example, to copy a file to the working directory retaining the same name,
the dot can be used in place of the working directory’s pathname. In this sense, the
dot is another name for the working directory. In the next example, the user copies the
weather file from the chris directory to the reports directory. The reports directory is
the working directory and can be represented with a single dot.

$ cd reports
$ cp /home/chris/weather .

The .. symbol is often used to reference files in the parent directory. In the next
example, the cat command displays the weather file in the parent directory. The
pathname for the file is the . . symbol (for the parent directory), followed by a slash and
the filename.

$ cat ../weather
raining and warm

You can use the cd command with the .. symbol to step back through successive
parent directories of the directory tree from a lower directory.

Listing, Displaying, and Printing Files: Is, cat, more,
less, and lpr

One of the primary functions of an operating system is the management of files. You may
be required to perform certain basic output operations on your files, such as displaying
them on your screen or printing them. The Linux system provides a set of commands
that perform basic file-management operations, such as listing, displaying, and printing
files, as well as copying, renaming, and erasing files. These commands are usually made
up of abbreviated versions of words. For example, the 1s command is a shortened

form of “list” and lists the files in your directory. The 1pr command is an abbreviated
form of “line print” and will print a file. The cat, less, and more commands display the
contents of a file on the screen. Table 10-9 lists these commands with their different
options. When you log in to your Linux system, you may want a list of the files in your
home directory. The 1s command, which outputs a list of your file and directory names,
is useful for this. The 1s command has many possible options for displaying filenames
according to specific features.
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Displaying Files: cat, less, and more

You may also have to look at the contents of a file. The cat and more commands display
the contents of a file on the screen. The name cat stands for “concatenate.”

$ cat mydata
computers

The cat command outputs the entire text of a file to the screen at once. This presents a
problem when the file is large, because its text quickly speeds past on the screen. The more
and less commands are designed to overcome this limitation, by displaying one screen
of text at a time. You can then move forward or backward in the text at your leisure. You
invoke the more or less command by entering the command name, followed by the name
of the file you want to view (less is a more powerful and configurable display utility).

$ less mydata

When more or less invoke a file, the first screen of text is displayed. To continue to
the next screen, you press the f key, the spacebar, or PageUp keys. To move back in the
text, you press the b or PageDown keys. You can quit at any time by pressing the q key.

Table 10-9. Listing Displaying, and Printing Files

Command or Option Execution

1s Lists file and directory names.

cat filenames Used to display a file. It can take filenames for its arguments. It outputs the
contents of those files directly to the standard output, which, by default, is
directed to the screen.

more filenames Displays a file screen by screen. Press the spacebar to continue to the next
screen and the g key to quit.

less filenames Also displays a file screen by screen. Press the spacebar to continue to the
next screen and the q key to quit.

lpr filenames Sends a file to the line printer to be printed; a list of files may be used as
arguments. Use the -P option to specify a printer.

1pg Lists the print queue for printing jobs.

lprm Removes a printing job from the print queue.
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Printing Files: Ipr, Ipq, and Iprm

With the printer commands, such as 1pr and 1prm, you can perform printing operations
such as printing files or canceling print jobs (see Table 10-9). When you have to print
files, use the 1pr command to send files to the printer connected to your system. In the
following example, the user prints the mydata file:

$ lpr mydata

If you want to print several files at once, you can specify more than one file on the
command line after the 1pr command. In the following example, the user prints the
mydata and preface files:

$ lpr mydata preface

Printing jobs are placed in a queue and printed one at a time in the background. You
can continue with other work as your files print. You can see the position of a particular
printing job at any given time with the 1pq command, which gives the owner of the
printing job (the login name of the user who sent the job), the print job ID, the size in
bytes, and the temporary file in which it is currently held.

If you have to cancel an unwanted printing job, you can do so with the 1prm
command, which takes as its argument either the ID number of the printing job or the
owner’s name. It then removes the print job from the print queue. For this task, 1pq is
helpful, as it provides you with the ID number and owner of the printing job you must
use with 1prm.

File and Directory Operations: find, cp, mv, rm, and In

As you create more and more files, you may want to back them up, change their names,
erase some of them, or even give them added names. Linux provides several file
commands that you can use to search for, copy, rename, or remove files (see Table 10-11).
If you have a large number of files, you can also search them to locate a specific one.
The commands are shortened forms of full words, consisting of only two characters. The
cp command stands for “copy” and copies a file; mv stands for “move” and renames or
moves a file; rm stands for “remove” and erases a file; and 1n stands for “link” and adds
another name for a file, often used as a shortcut to the original. One exception to the
two-character rule is the find command, which performs searches of your filenames
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to find a file. All these operations can be handled by the GUI desktops, such as GNOME
and KDE. To quickly search for a file, you can use the locate command. The locate

command reads from a database of file locations compiled daily by updatedb.

Searching Directories: find

Once a large number of files has been stored in many different directories, you may have

to search them to locate a specific file, or files, of a certain type, as well as directories. The

find command enables you to perform such a search from the command line. The find

command takes as its arguments directory names, followed by several possible options

that specify the type of search and the criteria for the search. It then searches within

the directories listed and their subdirectories for files that meet these criteria. The find

command can search for a file by name, type, owner, and even the time of the last update

(see Table 10-10).

$ find directory-list -option criteria

Table 10-10. The find Command

Command or Option

Execution

find

-name pattern
-1name pattern
-group name

-gid name

-user name

-uid name

-mtime num
-context scontext

-print

Searches directories for files according to search criteria. This command
has several options that specify the type of criteria and actions to be taken.

Searches for files with the pattern in the name.

Searches for symbolic link files.

Searches for files belonging to the group name.

Searches for files belonging to a group according to group ID.
Searches for files belonging to a user.

Searches for files belonging to a user according to user ID.
Searches for files last modified num days ago.

Searches for files according to security context (SELinux).

Outputs the result of the search to the standard output. The result is
usually a list of filenames, including their full pathnames.

(continued)
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Table 1